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Introduction
Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along with 
the matching definition. To understand how to use these functions in a production context, read the User 
guide. 

In the Reference guide, you will learn about the various parameters available in dialog boxes, menus, nodes, 
toolbars, views, and windows. 

The Preferences guide provides additional details about each individual preference. 
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Chapter 1: Dialog Boxes
Dialog boxes contain controls such as options and lists through which you can carry out a particular command 
or task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A 
typical dialog box looks as follows:

Add Column Dialog Box 16

Add Drawing Layer Dialog Box 18

Add Frames Dialog Box 20

Add Prefix or Suffix Dialog Box 22

Add Synced Drawing Layer Dialog Box 23

Advanced Save Dialog Box 25

Auto-Matte Dialog Box 30

Close Gaps Dialog Box 31

Column Properties Dialog Box 32

Column Types Dialog Box 34

Configure Line Art to Colour Art Dialog Box 35

Convert to Synced Drawing Layer Dialog Box 37

Create Cycle Dialog Box 38

Create Drawing from Drawing Selection Dialog Box 39

Create Function Step On Dialog Box 40
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Create Palette Dialog Box 43

Create Palette from Selection Dialog Box 44

Database Selector Dialog Box 46

Edit Default Paste Preset Dialog Box 48

Edit Exposure Paste Preset Dialog Box 50

Edit Pencil Lines 52

Element Manager Dialog Box 57

Export Images Dialog Box 59

Export OpenGL Frames Dialog Box 66

Export to Animated GIF Dialog Box 79

Export to Easel JS Dialog Box 82

Export to Flash Movie Dialog Box 85

Export to Video Dialog Box 87

Export to Sprite Sheet Dialog Box 92

Extend Exposure Dialog Box 96

Fill Cells Randomly Dialog Box 97

Fill Selection Dialog Box 98

Hold Timing 99

Import Images Dialog Box 102

Loop Node 109

Manage Local Cache Dialog Box 112

Manage Tool Presets Dialog Box 114

Marker Dialog Box 116

Mini Playback Dialog Box 118

Movie Options Dialog Box (macOS) 119

QuickTime Movie Settings Dialog Box (Windows) 123

New Scene Dialog Box 127

New Tool Preset Dialog Box 129

Onion Skin and Light Table Transparency Dialog Box 131

Palette Browser Dialog Box 132
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Windows Media Video Settings Dialog Box (Windows) 223
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Add Column Dialog Box
The Add Column dialog box lets you add a column in the Xsheet view.

By default, when you create a new scene, there is one drawing column in the Xsheet view and one 
corresponding drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the 
Timeline view, and a node in the Node view.

How to access the Add Column dialog box

 1. Do one of the following:

 l In the Xsheet menu, right-click a column and select Add Columns. 

 l Click the Add Columns  button. 

 l Press Shift + C.

Parameter Description

Name Lets you give the new column a meaningful name.

Type
Lets you select a type of column to create. Choices include: Drawing, Timing, 
Sound, 3D Path, 3D Rotation, Bezier Curve, Ease Curve, Expression and 
Annotation. 

Drawing Layer Options
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Line Art Creates a vector or bitmap drawing column in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing column in the Colour Art layer. 

Element

Create New Element Creates an independent column with its own drawing folder.

Vector
Select this option if you want the layer to contain vector drawings. Deselect this  
option if you want the layer to contain bitmap images. Most of the time, the 
Vector option will be enabled.

Bitmap Format
Lets you select the type of bitmap image to insert in the column. Select SCAN 
from the list if you are planning to scan drawings using the Toon Boom Harmony 
Advanced Scan module.

Scan Type
If you chose SCAN from the Bitmap Format list, select the kind of scanning you 
want to achieve.

Field Chart
When importing traditional animation, lets you indicate the size of paper on which 
the animation or background was drawn. If you are not using perforated 
animation paper, leave the 12 field default value as is.

Use Existing Element

Uses drawings from an existing column in the new column. Both columns will be 
attached to the same set of drawings, but their timing will remain  independent  
from one another. If you modify one of the drawings, it will be modified in both 
columns. This is the same principle as the Clone column.

Name Lets you select the column to which you want to link your new column.

Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.
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Add Drawing Layer Dialog Box
The Add Drawing Layer dialog box lets you add a drawing layer  to your project. 

By default, when you create a new scene, there is one drawing column in the Xsheet view and one 
corresponding drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the 
Timeline view, and a node in the Node view.

How to access the Add Drawing Layer dialog box

 1. Do one of the following: 

 l In the Timeline view, click the Add Drawing Layer  button.

 l From the top menu, select Insert > Drawing.

 l Press Ctrl + R (Windows/Linux) or ⌘  + R (macOS).

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 

Extend Exposure for Scene 
Duration

Automatically create and empty drawing exposure on each layer and expose 
them for the duration of the scene.
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Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.
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Add Frames Dialog Box
The Add Frames dialog box allows you to add a given amount of frames at a specific point in your scene. The 
new frames are added to every layer in your scene and will offset all the keyframes and drawings after the 
insertion point.

How to access the Add Frames dialog box

 1. In the Timeline  or Xsheet view, select a frame or a range of frames. 

 

 2. Do one of the following:

 l From the top menu, select Scene > Frame > Add Frames at Start, Add Frames at End, Add 
Frames Before Selection or Add Frames After Selection. 

 l In the Xsheet view, right-click and select Frame > Add Frames at Start, Add Frames at End, 
Add Frames Before Selection or Add Frames After Selection.

 l In the Xsheet toolbar, click the  Add Frames  button to add frames after your selection. 

 l Press Ctrl + G (Windows/Linux) or ⌘  + G (macOS) to add frames before the selection, or 
Ctrl + H to add frames after the selection.

The Add Frames dialog box appears.

Parameter Description

Number of frames to add The amount of frames to add.
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Parameter Description

Ripple Scene Markers

If checked, scene markers after the insertion point will be offset forward to remain 
synchronized with the keyframes and drawings in your scene. If unchecked, scene 
markers will remain in place while everything else after the insertion point  is 
offset.

Extend Drawing Exposure

If checked, drawings that are exposed just before the insertion point will be 
exposed throughout the added rames. If unchecked, no drawing will be exposed 
in the added frames. 

NOTE 

This option has no effect when adding frames at the start of the scene.
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Add Prefix or Suffix Dialog Box
The Add Prefix or Suffix dialog box lets you add or remove a prefix or suffix for a multi-layer selection.

How to access the Add Prefix or Suffix dialog box

 1. In the Timeline view, select all the layers to rename or press Ctrl + A (Windows/Linux) or ⌘  + A 
(macOS).

 2. In the Timeline View toolbar, click the Add Prefix or Suffix Script  button. If the Timeline View 
toolbar is not visible, you can display it by selecting Windows > Toolbars > Timeline View from 
the top menu. If the Add Prefix or Suffix Script  button is not visible in the Timeline View toolbar.

The Add Prefix or Suffix dialog box opens.

Parameter Description

Suffix
Allows you put a defined set of characters (letters, numbers, symbols) after the 
pre-existing layer name.

Prefix
Allows you put a defined set of characters (letters, numbers, symbols) before the 
pre-existing layer name.

Insert Text Enter a set of characters to be added to the selected layers.

Remove Text Enter a set of characters to be removed from the selected layers.
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Add Synced Drawing Layer Dialog Box
The Add Synced Drawing Layer dialog box lets you add a drawing layer  to your project that will automatically 
be synced with the currently selected layer.

Depending on whether the Support Overlay and Underlay Arts option was selected in the Advanced tab of the 
Preferences panel, the Add Synced Drawing Layer dialog box may look one of two ways.

How to access the Add Synced Drawing Layer dialog box

 1. In the Timeline view, right-click on the drawing layer you would like to sync with another layer.

 2. From the right-click menu, select Add Synced Drawing Layer.

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 

Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.
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Close Closes the dialog box.
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Advanced Save Dialog Box
In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an 
existing version, set a new current version, display a list of modified drawings, colour palettes, and modified 
colour palette lists. 

How to access the Advanced Save dialog Box

 1. Make sure that you have the necessary rights to save the current scene version. If you do not, you 
can acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify 
Scene from the top menu.  

 2. From the top menu, select File > Advanced Save. 

The Advanced Save dialog appears.
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File Tab

Parameter Description

Save

‣ Enable this option if you want to save the modifications made to the 
current scene. 

‣ Deselect the Save option if you only want to save specific components of 
your scene listed in the Drawings, Palettes or Palette Lists tabs. This will 
disable all option in the File tab. 

This Version (number)
Saves the current version of the scene. You can rename the current version by 
typing a new name into the field. 

New Version (number)
Saves the current scene as a new version. You can name this new version by 
typing a name into the field. 

Overwrite Existing Version Lets you select an existing version of your scene from the list to overwrite it.

Description
Use this field to add or edit an existing description for the scene version you want 
to save. 

Mark as Current
Lets you set this scene version as the current one. This version will be 
automatically selected as the default current version when the scene is selected 
in the Database Selector dialog box
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Drawings (Harmony Server only) 

The Drawings tab lists the modified drawings.

Parameter Description

Drawing list
Lets you select the modified drawings to save, and deselect the ones you do not 
want to save.

Select All Selects all modified drawings in list.

Deselect All Deselects all modified drawings in the list.

Palettes Tab

The Palette tab lists the modified colour palettes.
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Parameter Description

Colour Palette list
Lets you select the colour palette to save, and deselect the ones you do not want 
to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified colour palettes in the palette list.

Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists Tab

The Palette Lists tab lists all the modified colour palette lists.
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Parameter Description

Palette Lists
Lets you select the modified palette list to save, and deselect the ones you do not 
want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified palette lists in the list.

Deselect All Deselects all modified palette lists in the list.
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Auto-Matte Dialog Box
The Auto-Matte dialog box lets you generate a matte for a drawing. 

How to access the Auto Matte dialog box

 1. In the Camera or Drawing view, select the drawing you want to create a matte for.

 2. Do one of the following: 

 l From the top menu, select Drawing > Generate Auto-Matte. 

 l In the Camera or Drawing menu, select Drawing > Generate Auto-Matte.

Parameter Description

Settings

Apply to all Drawings Creates a matte for all the drawings included in layer.

Radius
Lets you increase or decrease the radius value depending on the precision or 
roughness of your line. Use a lower value, the closer to your lines’ contours the 
matte will be shaped. The higher the value, the looser the matte will be shaped.

Source Art
Lets you select the layer from which you want the matte created: Line ArtColour 
Art.

Destination Art
Lets you select the layer on which you want the matte to be created: Line 
ArtColour Art.

Clear Destination Art First Deletes existing artwork on the destination layer before adding a matte to it.

Copy Strokes in Destination
Copies the contour of your lines as invisible lines in the matte drawing. This is 
useful if you need to reuse the lines later.
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Close Gaps Dialog Box
The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen 
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two 
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few 
millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box

 1. Select View > Show > Show Strokes or press K to see a preview of the result.

 2. To flatten the strokes you draw, click the Auto-Flatten  button in the Tool Properties view.

 3. Select Drawing > Clean Up > Close Gaps or press Shift + F10 (Windows/Linux only).

The Close Gaps dialog box opens.

Parameter Description

Size Lets you set the size of the gap you want to be closed.

Apply to all drawings Closes all gaps in the drawing of the selected layer.
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Column Properties Dialog Box
The Column Properties dialog box lets you add, delete or modify elements (drawing folders) in your scene.

How to access the Drawing dialog box

 1. In the Xsheet view, double-click on a column name. Do not click on the drawing folder name that 
the column is linked to (this also appears in the column header just below the column name).

Parameter Description

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to enable 
the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Advanced Scan 
module, select the scan type from the list.
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Field Chart
If you're importing traditional animation, select the size of the paper on which the 
animation was drawn.
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Column Types Dialog Box
The Columns Types dialog box lets you show or hide columns in the exposure sheet. 

How to access the Columns Types dialog box

 1. In the Xsheet view, select View > Column Types Manager.

The Column Types dialog box opens.

Parameter Description

Column Types Lets you select the types of columns to display in the Xsheet view.

Save as Default Makes these new settings the default ones used each time you start Harmony.

Restore Default Returns the settings to their defaults.
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Configure Line Art to Colour Art Dialog Box
The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

How to access the Configure Line Art to Colour Art dialog box

 1. In the Tools toolbar, select the Select tool. 

 2. In the Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line 
Art button.

Parameter Description

Use rendered version of the 
drawing

Renders the drawing and vectorize it to calculate the position of the centreline 
that will produce the colour art stroke.

Maximum Resolution for 
rendered image

The size of the rendered image.

Threshold for rendered 
image

The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered 
Beziers

This value represents how precise the fitting of the colour art zone in relation to 
the line art will be.

Source layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created from.

Destination layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created on.

Clear Destination Art Layer Deletes the content before the colour art is added. This is useful when you 
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First already have artwork on the destination layer.

Perform Line Art to Colour 
Art Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.
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Convert to Synced Drawing Layer Dialog Box
The Sync Layer feature allows for drawings to be separated on different layers, but to have the same timing.

How to access the Convert to Synced Drawing Layer dialog box

 1. right-click on a drawing layer you would like to sync with another layer. 

 2. From the right-click menu, select Sync Layers With.

In the Choose the Parent Drawing Layer drop-down list, with the exception of the selected layer, 
every layer in your scene is listed.

 3. To sync a layer with your currently selected layer, from the drop-down list, select a parent drawing 
layer and click OK. The child layer immediately updates to the parent layer's timing.
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Create Cycle Dialog Box
The Create Cycle dialog box lets you create cycles from a series of drawings and exposures. 

When you create a drawing cycle, all the repeated drawings are linked to the same original files. When 
modify, repaint, or correct a drawing named “1” for example, all drawings named “1” are updated 
simultaneously. In order to modify a drawing independently from its other exposures, you must duplicate the 
drawing.

How to access the Create Cycle dialog box

 1. In the Timeline or Xsheet view, select the cell range to loop.

 2. In the Timeline toolbar, click the Create Cycle  button (you may have to customize the toolbar to 
display it).

The Create Cycle dialog box opens.

Parameter Description

Number of Cycles Lets you specify the number of cycles, including the current selection.
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Create Drawing from Drawing Selection Dialog Box
The Create Drawing from Drawing Selection dialog box lets you cut a part of a drawing and send it to a new or 
existing layer.  

How to access the Create Drawing from Drawing Selection dialog box

 1. From the top menu, select Edit > Create Drawing From Drawing Selection or press F9 
(Windows/Linux) or ⌘  + F9 (macOS).

The Create Drawing From Drawing Selection dialog box opens.

Parameter Description

Layer Name Lets you enter a name for the layer using the naming convention you established.

Cut Artwork From Source Lets you cut the selected artwork from the model.
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Create Function Step On Dialog Box
The Create Function Step On dialog box lets you  hold the same value over a selected number of frames for 
multiple parameters (pos x, scale y, etc.). This works well when you are animating drawings on 2s or 3s, for 
example, and you want to hold the same value for a function over those two or three frames.

How to access the Create Function Step On dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l right-click on the empty space near the top of the interface  and from the quick-access menu 
selecting Scripting.

 l right-click on the empty space near the top of a view and from the quick-access menu 
selecting Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager 
window.

 3. In the Scripts Manager, in the Files section, select the file TB_CreateStepsOn.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_CreateStepsOn.

The Add script to toolbar button becomes active.

40



 5. Click on the Add script to toolbar button.

The TB_CreateStepsOn script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Timeline view, select the layer whose parameter values you would like to hold. 

 9. In the Scripting toolbar, click on the TB_CreateStepsOn script  button.

The Create Function Step On dialog box appears.

Parameter Description

Settings

Every Number of Frames Enter in the number of frames you would like to hold your functions.
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Selection

First Frame

Enter in the frame number of where you would like the stepped holds to 
start.  The playhead location determines the lowest value you can enter 
for the first frame. You need to move the playhead to frame one if you 
would like to set frame one as the lowest possible starting value. 

Last Frame
Enter in the frame number of where you would like the stepped holds to 
stop.
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Create Palette Dialog Box
The Create Palette dialog box allows you to create a colour palette for your scene. Palettes created with this 
dialog box are added to your scene's palette list, and stored in your scene's palette-library subdirectory.

How to access the Create Palette dialog box

 1. Do one of the following:

 l In the Colour View, click the New Palette  button over the palette list.

 l From the Colour view menu, select Palettes  > New

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose the palette type to create:

 l Colour: A colour palette can contain colours, gradients and bitmap textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 
transparency filters to pencil lines, in combination to their line colour, to create 
various styles of pencil lines.
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Create Palette from Selection Dialog Box
The Create Palette from Selection dialog box allows you to create a palette that contains all the colours used 
by all the drawings in the selected drawing layers. 

This can be useful, for example, if the colour design for a character model or rig, a background or another kind 
of asset was made using several different palettes, and you need to consolidate all of the colours used by the 
asset into its own dedicated palette. 

NOTES 

 l The Create Palette from Selection dialog uses the colours in all the drawings in the selected 
layers, even drawings that are not exposed. 

 l For tasks related to this dialog box, see the User Guide.

How to access the Create Palette from Selection dialog box

 1. In the Timeline, Xsheet, Camera or Node view, select one or more drawing layers. 

 2. In the top-left corner of the  Colour view, open the  View Menu and select Palettes > New 
Palette from Selected Drawings. 

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose one of the type of palette to create:

 l Colour: Creates a palette containing all the colours, gradients and bitmap 
textures used in the selected drawing layers.

 l Pencil Texture: Creates a palette containing all the pencil textures used in the 
selected drawing layers.

Generate New Colour 
IDs and Recolour 
Selected Drawings

By default, the Create Palette from Selection dialog box generates the palette by 
copying the colour swatches used in the selected drawings from their original palette 
into a new palette, along with their colour ID. This means that the colour swatches in the 
generated palette will use the same colour IDs as the ones in the original palettes.
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If you select this option, Harmony will generate a palette with new colour IDs, and will 
replace the old colour IDs in your artwork with the new ones. This will usually have no 
visible effect, and will prevent the swatches in the new palette from having the same 
colour IDs as the swatches you originally used to colour your artwor. When two palettes 
have a swatch with the same colour ID, Harmony uses the swatch from the top-most 
palette in the palette list. 

NOTE 

If your artwork uses Colour-Override effects, the colour IDs used by these Colour-
Override will not be replaced with the new colour IDs, making the Colour-Override 
ineffective unless you reconfigure them manually. Hence, you should avoid using 
this parameter if you are consolidating the palette of a character rig that uses a lot 
of Colour-Overrides. 
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Database Selector Dialog Box
The Database Selector dialog box lets you connect to your studio's central database when working on 
Harmony Server. 

NOTE 

When you connect to the database, you cannot create new scenes directly from Harmony. The 
available scenes must have been already created using the Control Center module. 

How to access the Database Selector dialog box

 1. Start Harmony

 2. In the log-in dialog, select Connect to Database.

 3. In the User Name field, type in your Harmony Server username.

 4. Click on OK.

The Database Selector dialog box opens.

Parameter Description

Environments Lets you select the scene's environment (project, movie).
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Jobs Lets you select the scene's job (episode, sequence). 

Scenes Lets you select the scene.

Get rights to modify the 
scene

Allows you to modify the selected version of the scene as well as to manage and 
overwrite other versions. Other users will not be able to open a different version 
of the scene until you close the scene.

Get rights to modify the 
scene version

Allows you to modify the currently selected scene version only. Unless the Get 
rights to modify the scene option is also checked, you will not be able to change 
other versions of the scene. This allows other users to modify different versions of 
the scene while you are working on the selected version.

Get rights to modify all scene 
assets

Automatically gets the rights to modify all of the scene's assets, locking other 
users from making changes to them until you close the scene. This means that 
you will have the rights to modify all the scene's versions, drawings, palettes, its 
palette list, but not its library folder. If this option is unchecked, drawings and 
palettes will be locked unless you unlock them manually. This can allow another 
user to work on the scene's drawings and palettes in Paint while you are working 
on the scene's timing or staging in Harmony.

Cache scene assets locally

Downloads the scene's drawings to your computer before opening the scene. 
Harmony will then load the drawings from your computer during the session, 
instead of loading them from their original location over the network. This can 
significantly increase performance, especially with resource-heavy scenes. 

When you save your scene, the updated drawings will be uploaded automatically 
to the database, so you do not have to re-upload them manually. 

NOTE 

If this option is checked, it may take a while to download all of the scene's 
assets when opening a particularly heavy scene.

Version If you saved different versions of a scene, this lets you select one to open.
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Edit Default Paste Preset Dialog Box
The Edit Default Paste Preset dialog box lets you modify settings for the keyframe and exposure paste 
presets, as well as setting the defaults.

How to access the Edit Default Paste Preset dialog box

 1. From the Timeline menu, select Edit > Modify Paste Presets > All or Key Frame or Exposure.

Parameter Description

Drawings

Add/Remove 
Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved when 
pasting. No key exposures are added. This is the default behavior when pasting.
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Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.

Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.
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Edit Exposure Paste Preset Dialog Box
The Edit Exposure Paste Preset dialog box lets you reuse key exposures as you animate.  

How to access the Edit Exposure Paste Preset dialog box

 1. From the Timeline view menu, select Edit > Modify Paste Presets > Exposure.

The Edit Exposure Paste Preset dialog box opens.

Parameter Description

Drawings

Add/Remove 
Exposure

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when do they do not exist: When adding exposures 
to a drawing layer, new drawings will be created only when drawings with the 
same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure Creates a key exposure on the same drawing.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.
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Fill to Next Key Exposure Fills selected area till the next key exposure.

Keyframes

Add/Remove Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End:  Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.

Reset to Default Return all values to their defaults.
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Edit Pencil Lines
The Edit Pencil Lines Dialog Box lets you edit the pencil lines’ properties such as pencil texture and line 
thickness. 
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Icon Parameter Description

  Presets

Allows you to add and delete 
presets. This can be done using the 
Add Preset and Delete Preset 
buttons on the right of the list.

The default preset  name is Custom.

Presets are saved in a file in the user 
preferences. 

NOTE 

When modifying a saved 
preset, the name will 
revert back to Custom. Any 
changes in values made 
will in turn be treated as a 
new preset without 
altering the original.

  Texture

Allows you to select a texture for the 
pencil line. 

Selecting <Remove Texture> will 
remove any existing texture from the 
line before alterations.

Selecting <Keep Texture As Is> will 
maintain the existing texture and 
allow it to be altered.

  Thickness Multiplier
Will allow you to thicken or thin a 
line  by a specified value.

  Apply Multiplier to Tips
Check Apply Multiplier to Tips 
below to apply the multiplication to 
the pencil line tips.

  Additional Tip Multiplier

Apply an additional multiplier to 
extend the line tips. This will affect 
the quality of the line’s head and tail.

A lower number will create a flatter, 
more abrupt head and tail.

A higher value will create a rounder 
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Icon Parameter Description

and tapered appearance. 

  Set Thickness

Will convert the pencil line thickness 
to the specified numerical value.

NOTE 

Must choose to use either 
the Thickness Multiplier 
or the Set Thickness 
option. They cannot be 
used simultaneously.

  Apply to All Colours

When checked, modifications are 
made to all pencil lines, regardless of 
their colours. 

This option will be beneficial if there 
are multiple coloured lines being 
stylized in the same way. 

NOTE 

This checkbox will not be 
available if only one pencil 
colour is selected.

  Apply to Colours

This dropdown menu will allow you 
to select one or more coloured lines 
to be affected. 

This is useful when you want one or 
more specific coloured lines to be 
influenced but not all.  

NOTE 

This dropdown will not be 
available if only one pencil 
colour is selected.

  Apply to All Drawings
When checked, the pencil style 
changes will apply to all selected 
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Icon Parameter Description

pencil lines on all layers. 

When unchecked, the pencil style 
changes will only apply to the pencil 
lines of the currently selected layer. 

  Preview Drawings

The dropdown field is enabled when 
multiple drawings are selected. The 
dropdown will list all of the selected 
drawing layers. The drawing you 
select will appear in the preview 
window below.

Slider

Allows you to adjust background 
colour. The background colour can be 
shifted between black and white.  
This allows for greater visibility of 
certain colours.

  Zoom In

Will zoom in to the drawing being 
previewed.

TIP 

You can zoom in using the 
mouse wheel.

  Zoom Out
Will zoom out of the drawing being 
previewed.
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TIP 

You can zoom out using 
the mouse wheel.

NOTE 

You can pan your drawing by clicking and dragging anywhere within the preview area. This ability 
is most beneficial when the drawing selected is larger than the preview area. 
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Element Manager Dialog Box
The Element Manager window lets you Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing folders that are not linked to a column in 
your scene, use the Element Manager to delete them if needed. See xref Reference > Windows > Element 
Manager.

How to access the Element Manager window

 1. From the top menu, select Scene > Element Manager.

Parameter Description

Elements

Delete Elements Deletes the selected elements.

Delete Elements and 
Directories

Deletes  the selected layer and its directories (drawing folder).

Add/Modify Element

Name
Type in a new name in this field to create an element or to rename the 
selected element.

Vector
Select this option if the new element is a vector drawing or if you want to 
enable the parameters on the selected element in the Elements list.
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Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Advanced 
Scan module, select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on which 
the animation was drawn.

Add
Creates a new element with the current parameters entered in the 
Add/Modify Element section.

Modify Applies the parameter changes made to the selected element.
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Export Images Dialog Box
The Export Images dialog box allows you to export your scene as a sequence of image files, with one image 
for each frame.

How to access the Export Images dialog box

 1. In the top menu, select File > Export > Images.

Parameter Description

Output

Prefix
The prefix for the file name of each exported image file. Each file name will start with the 
value in this field, followed by the number of the frame. 

Path

The directory in which to export the rendered frames. 

You can click Browse... to open a dialog allowing you to navigate your file system and 
select a directory, or Default to set this to the frames sub-directory of your scene’s 
directory.

Format

File Type
The image format in which the exported frames will be saved. The following formats are 
supported:
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Parameter Description

 

Format Description

TGA

Truevision TGA/TARGA (*.tga)

A standard image format with lossless compression and support for 
transparency. 

TGA files use more disk space than PNG files, but rendering in TGA is 
faster. 

SGI

Silicon Graphics Image (*.sgi)

A highly capable format with lossless compression as well as support for 
double precision and transparency.

PSD

Photoshop Document (*.psd)

An Adobe Photoshop proprietary format used for image editing. 

PSD files exported by Harmony contain a single background layer with 
the rasterized image. 

NOTE 
PSD files exported from Harmony are tagged with their colour 
space information in their metadata, except for PSD files 
exported in greyscale. 

YUV

Y'UV frame (*.yuv)

A legacy format optimized for NTSC television. The image information is 
encoded in the Y'UV color space, which means Luma (Y') and 
Chrominance (UV). 

NOTE 
YUV images must be exported in NTSC resolution (720 x 540), or 
they will not be legible.

PAL
PAL frame (*.pal)

A legacy format optimized for PAL television.
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Parameter Description

Format Description

NOTE 
PAL images must be exported in PAL resolution (768 x 576), or 
they will not be legible. 

SCAN

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used by Scan to store scanned image 
information along with its registration (peg), resolution and field chart 
metadata. SCAN files are in gresycale. 

PNG

Portable Network Graphics (*.png)

A highly portable image format with high lossless compression as well 
as support for transparency and double-precision. PNG is typically used 
for Web applications, graphical user interfaces and image sharing. 

Rendering in PNG takes more time than rendering in TGA or in 
uncompressed image formats, but saves a lot of disk space. 

NOTE 
PNG files exported from Harmony are tagged with their colour 
space information in their metadata.

JPG

Jpeg (*.jpg)

A very compact image format with lossy compression. It is typically used 
for Web pages and photo sharing. Because it does not preserve image 
quality, it is recommended to never render in Jpeg format unless you are 
exporting stills for a Web page or are making quick render tests. 

BMP

Bitmap (*.bmp)

A standard uncompressed image format commonly used on Microsoft 
operating systems. 

OPT

Toon Boom Optimized image (*.opt)

A legacy Toon Boom proprietary format that stores bitmap image data 
with lossless compression. It supports transparency.

VAR Toon Boom Variable Header image (*.var)
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Parameter Description

Format Description

A legacy Toon Boom proprietary format that stores greyscale bitmap 
image data with lossless compression.

TIF

Tagged Image File Format (*.tiff)

An image format with many compression and encoding settings. It is 
often used for image exchange in visual arts and publishing.

TIFF images exported by Harmony are uncompressed, encoded on a per-
pixel (interleaved) basis in PC byte order. 

DPX

Digital Picture Exchange (*.dpx)

A professional photo format that supports various different approaches 
to storing colour information, which can be used for storing, exchanging 
and editing raw information recorded by cameras. It is commonly used in 
film production. 

EXR

OpenEXR (*.exr)

A highly capable deep image format. Each pixel in an EXR file is exported 
with its Z-depth information. Additionally, if a pixel is semi-transparent, 
the color and depth information of pixels further back is stored along with 
it. If your scene has multiplane or 3D elements, this format can be used 
for compositing your animation with other graphical elements in 3D 
animation software.

NOTES 
 l OpenEXR files exported from Harmony are tagged with the 

white point and primaries coordinates for their colour space.

 l OpenEXR files are always exported by Harmony always 
have 1 line Zip compression if they contain a 3D image.

PDF

Portable Document File (*.pdf)

Typically, PDF files are used to store, archive, share and print documents. 
However, Harmony uses the PDF format for its capability to store bitmap 
images and vector graphics.

If the write node is connected to a vector drawing layer or to a vector 
composite, the exported PDF files will contain the image as a vector 
graphic. It will ignore bitmap layers, effects and deformations. Otherwise, 
the PDF files will contain the rendered image as a bitmap.
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Parameter Description

Format Description

DTEX

Deep Texture (*.dtex)

A commonly used deep image format. Each pixel in an DTEX file is 
exported with its Z-depth information. Additionally, if a pixel is semi-
transparent, the color and depth information of pixels further back is 
stored along with it. If your scene has multiplane or 3D elements, this 
format can be used for compositing your animation with other graphical 
elements in 3D animation software.

NOTE 
Exporting in Deep Texture requires RenderMan to be installed on 
the machine and the path to RenderMan properly configured in 
Harmony. For more information, see the Setting 3D Renderer 
Paths topic of the User Guide.

Colours

Depending on the selected file type, you can select one of the following colour modes:

 l Colour: Exports images in three channels: red, green and blue.

 l Colour + Alpha: Exports images in four channels: red, green, blue and alpha. 

 l Greyscale: Exports images in a single channel, grey.

NOTE 

Only some file types support Colour + Alpha and Greyscale. 

Depth

Depending on the selected file type, you can select one of the following colour depth:

 l 8-bits / channel: The standard colour depth. Each channel can have a value 
ranging from 0 and 255. Displays typically only support this much precision.

 l 16-bits /channel: Also known as double-precision. Each channel can have a value 
ranging from 0 to 65,536. Although displays typically can’t display at this 
precision, this allows compositing several images with effects and feathering 
without causing any dithering. 

Colour Space

The colour space in which to render your frames. The rendered frames will be converted 
from your scene’s working colour space to the selected colour space.

The following colour spaces are supported in Harmony:

 l Scene Working Colour Space: The same colour space as the one selected in the 
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Parameter Description

Colour Space tab of the Scene Settings dialog. 

 l ACES2065-1: An ACES linear colour space that uses the AP0 colour primaries 
and is intended for image file interchange.

 l ACEScg: An ACES linear colour space that uses the AP1 colour primaries and is 
intended for CGI rendering and compositing.

 l Linear Rec.709 (sRGB): The colour space that uses the same primaries and white 
point as sRGB and Rec. 709, but with no gamma transfer curve applied to the 
colour values. 

 l Linear Rec. 2020:  A colour space used for Ultra High Definition TV (UHDTV). It 
has a complex gamma transfer curve and primaries that cover more of the human-
perceivable colour space than other colour spaces, especially in the area of 
human-perceivable greens. 

 l Linear P3-D65: The same as Display P3, except with no gamma transfer curve. 
This colour space is useful for compositing intermediary images that are meant to 
be rendered in Display P3.

 l Display P3: A colour space commonly used for digital projection. It has the same 
primaries as DCI-P3, the same white point as sRGB and the same gamma transfer 
curve as sRGB.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and white 
point as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a gamma 
transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists because some 
editing systems use a gamma transfer curve of 2.4 instead of the standard gamma 
curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It has a 
complex gamma transfer curve and primaries that cover more of the human-
perceivable colour space than other colour spaces, especially in the area of 
human-perceivable greens.

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple gamma 
transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists because some 
editing systems use a gamma transfer curve of 2.4 instead of the standard gamma 
curve for Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It has the 
same primaries and white point as Rec. 709, but has a different gamma transfer 
curve.

Range
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Parameter Description

All Frames Exports all the frames in your scene.

Selected 
Frames

Allows you to specify the frame range to export using the two input fields to the right. 
The first input field is for specifying the first frame to export, and the second one is for 
specifying the last frame to export. All the frames in-between, including the ones 
specified, will be exported.

Preview If checked, the rendered frames will be opened in the Play application.

OK Renders the frames with the selected settings and closes the dialog box.

Cancel Closes the dialog box without rendering frames.
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Export OpenGL Frames Dialog Box
The Export OpenGL Frames dialog box allows you to export your scene as a sequence of images as they 
appear in the OpenGL View mode of the Camera view. This means they are exported without effects, 
antialiasing and proper compositing. This allows you to quickly preview the animation in your scene without 
having to wait through the full rendering process.

How to access the Export to OpenGL Frames dialog box

 1. In the top menu, select File > Export > OpenGL Frames.

Parameter Description

Output

Location

The directory in which to export the frames or movie file. 

You can click Browse... to open a dialog allowing you to navigate your file system 
and select a directory.

Filename

The name of the file to export. 

If you are exporting frames, the file name of each frame will start with this value, 
followed by the number of the frame. 

Format
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Parameter Description

Image Sequence Select this option to create an image sequence.

Movie Exports the frames into a movie file. 

Frames Exports each frame as an individual image file. 

Suffix Allows you to select the number of digits in the number used to identify each frame.

Drawing Type

Format Specification Description

TGA                                              Full colour

Truevision TGA/TARGA (*.tga)

A standard image format with lossless 
compression and support for 
transparency. 

TGA files use more disk space than 
PNG files, but rendering in TGA is 
faster. 

TGA1                                              Greyscale

TGA3                                              Full colour

TGA4                                              
Full colour with 
transparency

SGI                                              
Full colour / 8 bits 
per channel

Silicon Graphics Image (*.sgi)

A highly capable format with lossless 
compression as well as support for 
double precision and transparency.

SGI1                                              
Greyscale / 8 bits 
per channel

SGI3                                              
Full colour / 8 bits 
per channel

SGI4                                              
Full colour with 
transparency / 8 
bits per channel

SGIDP                                              
Full colour / 16 bits 
per channel

SGIDP3                                              
Full colour / 16 bits 
per channel
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Parameter Description

Format Specification Description

SGIDP4                                              
Full colour with 
transparency / 16 
bits per channel

SGIDP4                                              
Full colour with 
transparency / 16 
bits per channel

SGIDP4                                              
Full colour with 
transparency / 16 
bits per channel

PSD                                              
Full colour / 8 bits 
per channel

Photoshop Document (*.psd)

An Adobe Photoshop proprietary 
format used for image editing. 

PSD files exported by Harmony 
contain a single background layer with 
the rasterized image. 

NOTE 
PSD files exported from 
Harmony are tagged with 
their colour space 
information in their 
metadata, except for PSD 
files exported in greyscale. 

PSD1                                              
Greyscale / 8 bits 
per channel

PSD3                                              
Full colour / 8 bits 
per channel

PSD4                                              
Full colour with 
transparency / 8 
bits per channel

PSDDP                                              
Full colour / 16 bits 
per channel

PSDDP1                                              
Greyscale / 16 bits 
per channel

PSDDP3                                              
Full colour / 16 bits 
per channel

PSDDP4                                              
Full colour with 
transparency / 16 
bits per channel

YUV                                              

Y'UV frame (*.yuv)

A legacy format optimized for NTSC 
television. The image information is 
encoded in the Y'UV color space, 
which means Luma (Y') and 
Chrominance (UV). 
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Format Specification Description

NOTE 
YUV images must be 
exported in NTSC 
resolution (720 x 540), or 
they will not be legible.

PAL                                              

PAL frame (*.pal)

A legacy format optimized for PAL 
television.

NOTE 
PAL images must be 
exported in PAL resolution 
(768 x 576), or they will 
not be legible. 

SCAN                                              

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used 
by Scan to store scanned image 
information along with its registration 
(peg), resolution and field chart 
metadata. SCAN files are in gresycale. 

PNG                                              
Full colour / 8 bits 
per channel

Portable Network Graphics (*.png)

A highly portable image format with 
high lossless compression as well as 
support for transparency and double-
precision. PNG is typically used for 
Web applications, graphical user 
interfaces and image sharing. 

Rendering in PNG takes more time 
than rendering in TGA or in 
uncompressed image formats, but 
saves a lot of disk space. 
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Parameter Description

Format Specification Description

NOTE 
PNG files exported from 
Harmony are tagged with 
their colour space 
information in their 
metadata.

PNG4                                              
Full colour with 
transparency / 8 
bits per channel

PNGDP                                              
Full colour / 16 bits 
per channel

PNGDP3                                              
Full colour / 16 bits 
per channel

PNGDP4                                              
Full colour with 
transparency / 16 
bits per channel

JPG                                              

Jpeg (*.jpg)

A very compact image format with 
lossy compression. It is typically used 
for Web pages and photo sharing. 
Because it does not preserve image 
quality, it is recommended to never 
render in Jpeg format unless you are 
exporting stills for a Web page or are 
making quick render tests. 

BMP                                              Full colour Bitmap (*.bmp)

A standard uncompressed image 
format commonly used on Microsoft 
operating systems. BMP4                                              

Full colour with 
transparency
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Parameter Description

Format Specification Description

OPT                                              Full colour

Toon Boom Optimized image (*.opt)

A legacy Toon Boom proprietary 
format that stores bitmap image data 
with lossless compression. It supports 
transparency.

OPT1                                              Greyscale

OPT3                                              Full colour

OPT4                                              
Full colour with 
transparency

VAR                                              

Toon Boom Variable Header image 
(*.var)

A legacy Toon Boom proprietary 
format that stores greyscale bitmap 
image data with lossless compression.

TIF                                              

Tagged Image File Format (*.tiff)

An image format with many 
compression and encoding settings. It 
is often used for image exchange in 
visual arts and publishing.

TIFF images exported by Harmony are 
uncompressed, encoded on a per-pixel 
(interleaved) basis in PC byte order. 

DPX                                              
8 bits per channel / 
Full color / RGB 
channel order

Digital Picture Exchange (*.dpx)

A professional photo format that 
supports various different approaches 
to storing colour information, which 
can be used for storing, exchanging 
and editing raw information recorded 
by cameras. It is commonly used in film 
production. 

DPX3_8                                             
8 bits per channel / 
Full color / RGB 
channel order

DPX3_10                                             
10 bits per channel 
/ Full color / RGB 
channel order

DPX3_12                                            
12 bits per channel 
/ Full color / RGB 

71

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Parameter Description

Format Specification Description

channel orderchannel orderchannel order

DPX3_16                                           
16 bits per channel 
/ Full color / RGB 
channel order

DPX3_10_
INVERTED_
CHANNELS                                             

10 bits per channel 
/ Full color / BGR 
channel order

DPX3_12_
INVERTED_
CHANNELS                                             

12 bits per channel 
/ Full color / BGR 
channel order

DPX3_16_
INVERTED_
CHANNELS                                             

16 bits per channel 
/ Full color / BGR 
channel order

EXR                                              
16 lines Zip 
compression

OpenEXR (*.exr)

A highly capable deep image format. 
Each pixel in an EXR file is exported 
with its Z-depth information. 
Additionally, if a pixel is semi-
transparent, the color and depth 
information of pixels further back is 
stored along with it. If your scene has 
multiplane or 3D elements, this format 
can be used for compositing your 
animation with other graphical 
elements in 3D animation software.
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Parameter Description

Format Specification Description

NOTES 
 l OpenEXR files 

exported from 
Harmony are tagged 
with the white point 
and primaries 
coordinates for their 
colour space.

 l OpenEXR files are 
always exported by 
Harmony always have 
1 line Zip compression 
if they contain a 3D 
image.

EXR_ZIP_1LINE
1 line Zip 
compression

PDF                                              

Portable Document File (*.pdf)

Typically, PDF files are used to store, 
archive, share and print documents. 
However, Harmony uses the PDF 
format for its capability to store bitmap 
images and vector graphics.

If the write node is connected to a 
vector drawing layer or to a vector 
composite, the exported PDF files will 
contain the image as a vector graphic. 
It will ignore bitmap layers, effects and 
deformations. Otherwise, the PDF files 
will contain the rendered image as a 
bitmap.

DTEX                                              

Deep Texture (*.dtex)

A commonly used deep image format. 
Each pixel in an DTEX file is exported 
with its Z-depth information. 
Additionally, if a pixel is semi-
transparent, the color and depth 
information of pixels further back is 
stored along with it. If your scene has 
multiplane or 3D elements, this format 
can be used for compositing your 
animation with other graphical 
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Parameter Description

Format Specification Description

elements in 3D animation software.

NOTE 
Exporting in Deep Texture 
requires RenderMan to be 
installed on the machine 
and the path to 
RenderMan properly 
configured in Harmony. 
For more information, see 
the Setting 3D Renderer 
Paths topic of the User 
Guide.

Image Format

Drop list with all formats listed alphabetically. 

 l BMP

 l DPX

 l DTEX

 l EXR

 l JPG

 l OPT

 l PAL

 l PDF

 l PNG

 l PSD

 l SCAN

 l SGI

 l TGA

 l TIF

 l TVG

 l VAR

 l YUV
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Parameter Description

Colours

Drop list with colour modes. Available modes depend on the selected file type.

 l Greyscale

 l Colour

 l Colour + Alpha

Depth 
(bits/channel)

Drop list with bit depth value and a label next to it "bits/channel". Available bit depth 
depends on the selected file type.

 l 8

 l 10

 l 12

 l 16

       

Compression

Drop list that appears for EXR and TIF formats only.

 l Zip (per scanline)

 l Zip (16 scanlines)

Inverted Channels A checkbox that appears for DPX only in 10, 12, 16 bit depths.

Movie options

Opens the movie settings dialog box for your selected video format, in which you can 
set the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on Windows: ,

 l QuickTime Movie (*.mov) on macOS: 

 l Windows Media Video (*.wmv): 

NOTE 

This button is available on Windows and macOS only.

Video options 

Opens the video settings dialog box, which allows you to set the video compression 
settings for your video file.

NOTE 

This button is available on GNU/Linux only.
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Parameter Description

Sound options 

Opens the audio settings dialog box, which allows you to set the audio compression 
settings for your video file. 

NOTE 

This button is available on GNU/Linux only.

Movie Format

Allows you to choose one of the following movie formats:

 l QuickTime Movie (*.mov): The Apple QuickTime format. This is the default 
export format and is recommended for its portability, and also because it 
allows you to choose among several video codecs.

NOTES 
 l On Windows, Apple QuickTime must be installed to allow 

Harmony to export QuickTime movies. You can configure the export 
of QuickTime movies to use any codec that is compatible with 
QuickTime, including H.264, MPEG-4 and Animation.

 l On macOS, Harmony uses Apple AVFoundation to export 
QuickTime movies, which allows you to export using codecs such as 
H.264, Apple ProRes 422 and Apple ProRes 4444, among others.

 l If you are looking to export a QuickTime movie with transparency, 
be sure to choose a codec that supports encoding with an alpha 
channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime library to export 
QuickTime movies. This only allows you to export videos in non-
proprietary formats such as Motion-JPEG, Photo JPEG, PNG or 
Uncompressed (RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 codec, 
which is supported by most web browsers.

NOTES 
 l Using this format does not require additional software. However, if 

this is the first time you export a movie in H.264/MPEG-4 format, 
you will be prompted to download the OpenH264 library from 
Cisco. Simply click Yes when prompted, and Harmony will 
automatically download the library, then export the movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 4096×2304. Each 
dimension must be a multiple of 16 pixels. 

 l Audio exported in this format is encoded in PCM 16-bit stereo, 
22.05 kHz.
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Parameter Description

 l Windows Media Video (*.wmv): The native format for Windows Media 
Player.

NOTES 
 l Windows Media Video (.wmv) files can only be exported on 

Windows. 

 l Video players and editors on non-Windows systems can generally 
not open Windows Media Video (.wmv) files.

Options

Open in Player

If checked, the exported images or movie will be opened after the export is finished:

 l If you are exporting frames, they will be opened in the Play application.

 l If you are exporting a movie, it will be opened in your operating system’s 
movie player.

Resolution

Allows you to specify a resolution to export in, relative to your scene's actual 
resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as your 
scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width and 
height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width and 
height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width and 
height.

 l Custom: Allows you specify the preferred resolution of your exported video 
file, in pixels, in the Width and Height fields.

Range

Allows you to specify the range of frames in your scene to export:

 l All Frames: Exports all the frames in your scene.

 l From / to: Allows you to specify the frame range to export using the two 
input fields to the right. The first input field is for specifying the first frame to 
export, and the second one is for specifying the last frame to export. All the 
frames in-between, including the ones specified, will be exported.

 l Current Frame: Exports the current frame only.
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Parameter Description

 l Selected Frames: Allows you to select which frames to export. You can 
enable or disable exporting a specific frame by clicking on it. You can also 
toggle exporting a range of frames by clicking and dragging over that range in 
the list. 

OK Exports OpenGL frames with the selected settings and closes the dialog box.

Cancel Closes the dialog box without exporting anything.
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Export to Animated GIF Dialog Box
Using the Export to Animated GIF dialog box, you can export your scene, or an excerpt of it, as an animated 
GIF image. 

Animated GIFs are a portable format commonly used for exchanging short animations and clips on the web. 
They can be played in any web browser and in many image viewers. 

Animated GIFs are a convenient sharing format, but they are not a publishing format. They are not as 
optimized for fast download and playback as movie files, cannot contain audio and, most importantly, can only 
contain up to 256 different colours throughout the entire animation. Hence, if your animation contains textures 
or gradients, it is likely to lose quality when exported as an animated GIF, as Harmony will have to limit the 
amount of different colours used in the exported image. 

NOTE 

For steps on how to use the Export to Animated GIF dialog box, see the User Guide.

How to access the Export to Animated GIF dialog box

 1. In the top menu, select File > Export > Animated GIF.

The Export to Animated GIF dialog box appears. 

Parameter Description

Output                     
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Parameter Description

Output The full path and file name of the GIF file to export.

Browse 
Opens a dialog allowing you to browse to the desired export directory and enter 
the desired file name. 

Export Range

All Exports all the frames in your scene.

Frames Allows you to specify a range of frames to render. 

Resolution

Resolution list

Lets you specify a resolution to export in relative to your scene's actual resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as 
your scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width 
and height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width 
and height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width 
and height.

 l Custom: Allows you specify the preferred resolution of your exported 
video file, in pixels, in the Width and Height fields.

Width
If you selected the Custom resolution, use this field to specify the width, in pixels, 
of the exported movie. 

Width
If you selected the Custom resolution, use this field to specify the height, in pixels, 
of the exported movie. 

Options Options

Dithering

Since GIF images can only have up to 256 colours, you have the option to add 
dithering to the rendered image. Dithering blends pixels of different colours 
where the image contains gradients to simulate colours that do not exist in the 
GIF image's colour palette. 
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Parameter Description

 l None: No dithering will be applied. Each pixel rendered is rendered with 
the colour in the palette that is the closest to its actual colour. 

 l Diffusion: Blends pixels in irregular patterns to blend pixels and simulate 
the colour as closely as possible. 

 l Pattern: Blends pixels in regular checkered patterns to simulate the 
colour without created clusters of pixels. 

Loop
If this option is checked, the exported GIF animation will loop when previewed in 
web browsers and other image viewers that support animated GIFs. Otherwise, it 
will only play once and stop. 
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Export to Easel JS Dialog Box
The Export to Easel JS window lets you flatten an image sequence of your animation. Even if you have a fully 
rigged puppet or a single drawing layer with your animation sequence, the outcome will still be a flattened 
output of each frame, grouped together in your sprite sheet. This allows for more flexibility and freedom of 
work as you have access to any tools or effect modules you want to use. However, this can result in heavier 
files depending on the length, complexity and export size of your animation.

How to access the Export to Easel JS window

 1. Select Windows > Toolbars > Game.

 2. Click the Export to Easel JS  button.

Parameter Description

Select Directory
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Save Path The folder path where you want to save your export.

Save Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder Displays the clips in the folder.

Scene Options

Display

Here, you must select the Display of your character. This is the one that will be 
used to render out all of the information attached to that Display node. If the 
Unconnected_Display option is selected, all of the visual information in your 
scene will be rendered out.

Sprite Sheet Preferences

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.

Max Height

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, 
only 2 of those pixels need to be different from my other drawing in order to 
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create a new one. The higher the threshold, the fewer similar drawings you will 
have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.
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Export to Flash Movie Dialog Box
The Export to Flash Movie dialog box lets you export your animation as a Flash (.swf) movie.  

How to access the Export to Flash Movie dialog box

 1. From the top menu, select File > Export > SWF.

The Export to Flash Movie (.swf) dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Export Range

All Exports all the frames of your movie.

Frames Export a frame range which you specify

Options

Frame Rate
Lets you enter a Frame rate (fps). By default, it will be set to match the fps of your 
Harmony project. If you choose a lower frame rate, your export playback will be 
faster than your actual project. The reverse is also true for a higher frame rate. 
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Jpeg Quality

Lets you select a JPEG quality:

‣ 100 = Full quality

‣ 50 = Average quality at about 1/5th of the size.

‣ 25 = Medium quality where loss of high image resolution starts to 
occur.

‣ 10 = Low quality where “macro-blocking” or large pixelation become 
obvious.

‣ 1 = Lowest quality where there is extreme loss of colour and detail 
and the image becomes nearly unrecognizable. 

Protect from Import Prevents the movie from being imported into another application.

Convert Pencil Lines 
to Brush Lines

Retains the thickness of pencil lines.

Compress Movie
Compresses the movie for a lighter format. The movie may lose some quality, but 
the file will be lighter.

Do Not Export

Lets you select the effects you do NOT want to be rendered in the SWF movie.

NOTE 

Certain Harmony effects are not listed in this section as they are not 
compatible and therefore not available for SWF export. These effects will 
not appear in the SWF render. 

86



Export to Video Dialog Box
The Export to Video dialog box lets you export your animation as a movie file. 

How to access the Export to QuickTime Movie dialog box

 1. From the top menu, select File > Export > Movie.

Parameter Description

Output                     

Video Format

Allows you to choose one of the following movie formats:

 l QuickTime Movie (*.mov): The Apple QuickTime format. This is the 
default export format and is recommended for its portability, and also 
because it allows you to choose among several video codecs.
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NOTES 
 l On Windows, Apple QuickTime must be installed to allow 

Harmony to export QuickTime movies. You can configure 
the export of QuickTime movies to use any codec that is 
compatible with QuickTime, including H.264, MPEG-4 and 
Animation.

 l On macOS, Harmony uses Apple AVFoundation to export 
QuickTime movies, which allows you to export using codecs 
such as H.264, Apple ProRes 422 and Apple ProRes 4444, 
among others.

 l If you are looking to export a QuickTime movie with 
transparency, be sure to choose a codec that supports 
encoding with an alpha channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime library to 
export QuickTime movies. This only allows you to export 
videos in non-proprietary formats such as Motion-JPEG, 
Photo JPEG, PNG or Uncompressed (RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 
codec, which is supported by most web browsers.

NOTES 
 l Using this format does not require additional software. 

However, if this is the first time you export a movie in 
H.264/MPEG-4 format, you will be prompted to download 
the OpenH264 library from Cisco. Simply click Yes when 
prompted, and Harmony will automatically download the 
library, then export the movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 4096×2304. Each 
dimension must be a multiple of 16 pixels. 

 l Audio exported in this format is encoded in PCM 16-bit 
stereo, 22.05 kHz.

 l Windows Media Video (*.wmv): The native format for Windows 
Media Player.

NOTES 
 l Windows Media Video (.wmv) files can only be exported on 

Windows. 

 l Video players and editors on non-Windows systems can 
generally not open Windows Media Video (.wmv) files.

Output file The full path and file name of the movie file to export.

88

http://apple.com/quicktime/download


Browse 
Opens a dialog allowing you to browse to the desired export directory and 
enter the desired filename. 

Export Range

All Exports all the frames in your scene.

Frames

Allows you to specify the frame range to export using the two input fields to 
the right. The first input field is for specifying the first frame to export, and the 
second one is for specifying the last frame to export. All the frames in-
between, including the ones specified, will be exported.

Resolution

Resolution list

Allows you to specify a resolution to export in, relative to your scene's actual 
resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as 
your scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width 
and height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width 
and height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width 
and height.

 l Custom: Allows you specify the preferred resolution of your exported 
video file, in pixels, in the Width and Height fields.

Width / Height
Lets you specify the width and height of video file you wish to export, in pixels. 
To preserve your scene's aspect ratio, changing the value of the Width or 
Height field will automatically update the other field with a proportional value. 

Colour Space

The colour space in which to render your movie. The rendered frames will be 
converted from your scene’s working colour space to the selected colour 
space.

The following colour spaces are supported in Harmony:

 l Scene Working Colour Space:The same colour space as the one 
selected in the Colour Space tab of the Scene Settings dialog. 

 l ACES2065-1: An ACES linear colour space that uses the AP0 colour 
primaries and is intended for image file interchange.

 l ACEScg: An ACES linear colour space that uses the AP1 colour 
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primaries and is intended for CGI rendering and compositing.

 l Linear Rec.709 (sRGB): The colour space that uses the same primaries 
and white point as sRGB and Rec. 709, but with no gamma transfer 
curve applied to the colour values. 

 l Linear Rec. 2020:  A colour space used for Ultra High Definition TV 
(UHDTV). It has a complex gamma transfer curve and primaries that 
cover more of the human-perceivable colour space than other colour 
spaces, especially in the area of human-perceivable greens. 

 l Linear P3-D65: The same as Display P3, except with no gamma 
transfer curve. This colour space is useful for compositing intermediary 
images that are meant to be rendered in Display P3.

 l Display P3: A colour space commonly used for digital projection. It has 
the same primaries as DCI-P3, the same white point as sRGB and the 
same gamma transfer curve as sRGB.

 l Rec. 709: The colour space used for HDTV. It has the same primaries 
and white point as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with 
a gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space 
exists because some editing systems use a gamma transfer curve of 
2.4 instead of the standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). 
It has a complex gamma transfer curve and primaries that cover more 
of the human-perceivable colour space than other colour spaces, 
especially in the area of human-perceivable greens.

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a 
simple gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour 
space exists because some editing systems use a gamma transfer 
curve of 2.4 instead of the standard gamma curve for Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It 
has the same primaries and white point as Rec. 709, but has a different 
gamma transfer curve.

Options

Movie Options

Opens the movie settings dialog box for your selected video format, in which 
you can set the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on Windows: ,

 l QuickTime Movie (*.mov) on macOS: 

 l Windows Media Video (*.wmv): 
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NOTE 

This button is available on Windows and macOS only.

Video Options 

Opens the video settings dialog box, which allows you to set the video 
compression settings for your video file.

NOTE 

This button is available on GNU/Linux only.

Sound Options 

Opens the audio settings dialog box, which allows you to set the audio 
compression settings for your video file. 

NOTE 

This button is available on GNU/Linux only.
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Export to Sprite Sheet Dialog Box
The Export to Sprite Sheets Publish for Game Engine window exports to multiple resolutions, generating 
multiple .xml files and one or multiple sprites sheets depending how many sprite resolutions you defined.

This saves different animations of the same character into the same name. For example, if there's an idle, run, 
and jump animation, these should all share the same Asset Name. You can think of it as the overall collection 
of animations. Inside are the different saved scene versions whose drawings you can reuse for all the 
animations in that character set. Each scene version will be displayed as an item in the list.

When you export an animation, only the drawings used in that scene are exported. All the drawings are 
exported individually first and then atlased together into a sprite sheet.

If you saved multiple animations to the same Asset Name (i.e. SpaceDuck: run, idle), then it will re-atlas the 
sprite sheet to include all the drawings from all the animations in that folder, creating a new animation file, but 
reusing the same skeleton.

How to access the Export to Sprite Sheets window

 1. Select Windows > Toolbars > Game.
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 2. Click the Export to Sprite Sheets  button.

Parameter Description

Select Directory

Asset Path The folder path where you want to save your export.

Asset Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder

Preview Window
Displays a list of pre-existing clips in the same export folder location, most  likely 
exported there from a previous time.

Use Scene Markers to 
Export Clips

Uses scene markers to define the export range, instead of exporting the entire 
scene.

Project Settings

Unit Scale

Lets you change the scale when exporting to Unity to accommodate the size of 
the export without it affecting the Harmony scene. This helps you resize assets 
properly for Unity without having to resize them in Harmony. The basic scale is 
one Animation Field for one Unity unit.

Preset
Lets you select the unit conversion from Harmony to Unity, by selecting one of 4 
presets. Note: a field is a unit of measure in traditional animation grid.

Sprite Sheet

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.
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Max Height
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, 
only 2 of those pixels need to be different from my other drawing in order to 
create a new one. The higher the threshold, the fewer similar drawings you will 
have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.

Palettes
Allows you to exclude certain palettes that you don’t want included in your 
exported file, This will cover all possible variations of palettes that will result in 
different colours showing on the character

Delete Existing Clips Select this option to delete any pre-existing clips in the export location.

Bake Animation Curves
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.

Clear Texture Folder
Removes any information from the texture folder within the Harmony file. This 
has no incidence towards the Unity export but contributes to a lighter Harmony 
file.
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Export Sprites Individually
Exports each drawing separately instead of putting them inside a spritesheet. 
This allows the game engine to deal with sprite sheets or sprite atlases at the 
import.

Encode to TBG

Zips the XML files to the TBG custom file format so that they may be imported to 
Unity with Unity custom importers. When the files are imported, they will be 
treated like any asset in Unity and will contain sub-assets for textures, sprites, 
and animations. This improves the ergonomics of creating and moving character 
data and checking changes into source control.
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Extend Exposure Dialog Box
The Extend Exposure dialog box lets you extend the exposure of a selected cell in the Timeline or Xsheet. 

How to access the Extend Exposure dialog box

 1. Select a cell and do one of the following:

 l From the top menu, select Animation > Cell > Extend Exposure.

 l Press F5.

The Extend Exposure dialog box opens.

Parameter Description

Extend to Frame
Lets you enter the frame up to which you want to extend the exposure. You can 
expose the drawing in the frames and replace the drawings that were originally 
there or move the subsequent frames forward in time.

Overwrite
Lets you expose the drawing in the frames and replace the drawings that were 
orginally there.

Insert
Lets you expose the drawing in the frames and move the subsequent frames 
forward in the Timeline view.
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Fill Cells Randomly Dialog Box
The Fill Cells Randomly dialog box lets you Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to choose the random values from. The 
selection can be over one cell or a cell range in one column or more or an entire column or many entire 
columns.

How to access the Fill Cells Randomly dialog box

 1. Do one of the following:

 l Select Animation > Cell > Fill Cells Randomly.

 l In the Xsheet view, click the Fill Cells Randomly  button  (you may have to 
customize the toolbar to display it).

The Fill Cells Randomly dialog box opens.

Parameter Description

Minimum Value The lowest value to be used in the randomized exposure or keyframe value.

Maximum Value The highest value to be used in the randomized exposure or keyframe value.

Hold The exposure holding value.

Whole Numbers
If you are applying this to a drawing column, this option lets you avoid having 
decimal points.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection.

97

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Fill Selection Dialog Box
The Fill Selection dialog box lets you Lets you fill the same value over an entire selection. The selection can be 
over one cell, a cell range in one column, a cell range over many columns, an entire column, or many columns. 
You can use numbers, words, letters, or any alphanumeric value.

How to access the Fill Selection dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 1. Do one of the following: 

 l From the top menu, select Animation > Cell > Fill Selection. 

 l In the Xsheet toolbar, click the Fill Selection  button. Note that you may have to add this 
button to your toolbar by right-clicking on it and selecting Customize.

 l Press Ctrl + T (Windows/Linux) or ⌘  + T (macOS)).

The Fill Selection dialog box opens.

Parameter Description

Value This is the value to be used in the filled selection.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection. 
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Hold Timing

The Hold Timing node exists as Hold Timing (for Images) and Hold  Transformation Timing (for Pegs and 
Transformations). This node is used to apply holds to the input transformation or images, in order to expose 
certain frames for specific durations. These nodes can be used to change the exposure increments of input 
images and transformations so that the output updates at the appropriate frames. This is particularly useful 
for retiming the animated content.

The Hold Timing node takes an image input and output, and will provide the retimed transformation and 
render of that image with sections held given the settings of the node.

The Hold  Transformation Timing node takes a transformation input and output, and will provide the retimed 
transformation with sections held given the settings of the node.

How to access the Hold Timing and Hold Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.
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 l Hold Mode: Defines the mode in which the held frame transformations and renders are applied. 
You can select the value from the drop-down list.

 l Dynamic: Dynamic mode will scan all connected modules in the in-port and will also 
calculate the most reasonable timing based on all connected nodes’ attribute keyframes and 
timing. The dynamic mode aims for a maximum exposure as defined in the hold value 
attribute, and will divide up timed-sections based on attached keyframes and the 
appropriate amount of subdivisions possible in that section, while considering the timing of 
the animation.

 l Hold Value: Hold Value mode will use the value defined in the Hold Value attribute, and 
will only update the transformation or render in increments of that value. Setting a keyframe 
on this attribute will start a new section of exposures and all subsequent exposures will be 
based on the last keyframe. This is useful for retiming sections on twos and adding sections 
on ones by simply adding a keyframe.

 l Hold Between Stop-Motion Keyframes: Hold Between Stop-Motion Keyframes uses the 
keyframes and tweens in the Hold Keyframes attribute to define regions that will update 
and render new images and transformations. The node will only output the current frame 
from the input when a key, or tween, is present on that frame, otherwise it will hold the last 
value it has previously output.

 l Bake Dynamic Holds:  Bake Dynamic Holds will convert the dynamic mode to another mode that is 
static and no longer dependent on the input nodes. When clicking the Bake Dynamic Holds button, 
a prompt will request the type of mode to convert the dynamic values into. This prompt allows the 
user to select the mode into which the values are baked.

 l Hold Value: Defines the exposure increments in which the image or transformation is updated and 
output. This attribute is used when the node is in Dynamic and Hold Value mode.

 l Hold Keyframes: Defines the keys in which the image or transformation is updated and output. 
This attribute is used when the node is in Hold Between Stop-Motion Keyframes mode.
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 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Import Images Dialog Box
T-HFND-007-011

The Import Images dialog box lets you  import bitmap images and vectorize them, making the images editable. 
Then you can use a variety of drawing tools to edit the image. Or you can always keep the original bitmap 
image as is.

Also, you can choose to import bitmap images on bitmap or vector layers depending on your project.

How to open the Import Images dialog box

 1. Do one of the following:

 l From the top menu, select File > Import > Images. 

 l In the File toolbar, click the Import Images  button.

 l In the Xsheet view, right-click anywhere in the frame area and select Import > 
Images.

The Import Images dialog box opens.
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Parameter Description

Files

Browse Lets you find and select images on your computer.

Layer

Create Layers(s) Create layers for imported images.

Create Single Layer 
Named

Creates a new layer with the specified name and imports the images into it.

Create Layer(s) 
Based on Filenames

Creates a layer based on each unique filename prefix. For example, if you import 
three files named a-1.tga, a-2.tga and b-1.tga, this will create two layers, one 
named "a" and one named "b". Layer "a" will contain the two first images and "b" 
will contain the third one.

Add to Existing Layer

Imports the images into the specified layer. Note that you can only import into 
layers that are compatible with your import options. For example, if you're 
importing images as vector drawings, you can only import them into vector 
drawing layers. 

Import Options
Depending on how you choose to import images, the Alignment section offers 
different options.

Keep as Original 
Bitmap

Retains an imported image as a bitmap. In the Alignment section, decide on the 
size and placement of your image within the camera frame. Depending on the 
Scene Settings (the height and width in pixels that you chose for your project), an 
image that you import may get scaled to the point where all its individual pixels 
become visible.

Import as Toon Boom 
Bitmap Drawing

Imports a drawing into a vector layer where you can edit the image using the 
drawing tools.

Convert to Toon 
Boom Vector 
Drawing

Imports a drawing and converts it to a Toon Boom vector drawing.

Alignment (Keep As Original Bitmap)
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Rules

Fit:

Adjusts the image's size to fit completely within the scene's field, both vertically 
and horizontally, making sure the entire image is visible. 

If the image's orientation is portrait, then it will adjust the image's height to fit the 
field's height, without affecting the image's aspect ratio:

If the image orientation is landscape, then it will adjust the image's width to fit the 
field's width, without affecting the image's aspect ratio:

Pan: 

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the 
field's width, without affecting its aspect ratio:
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If the image's orientation is landscape, it will adjust the image's height to fit the 
field's height, without affecting its aspect ratio:

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the 
field's width, without affecting its aspect ratio:
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This has the opposite effect 
to the fit parameter. The 
image's smallest dimension 
will be made to fit the scene 
frame's matching dimension, 
and the image's largest 
dimension will be adjusted 
proportionally, making the 
image fill the entire scene 
field, and bleed past its 
boundaries it if its aspect 
ratio does not match the 
field's aspect ratio. This 
option can be used to import 
a panning background image, 
also referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the field's 
width, without affecting its 
aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the 
field's height, without 
affecting its aspect ratio:

This has the opposite effect 
to the fit parameter. The 
image's smallest dimension 
will be made to fit the scene 
frame's matching dimension, 
and the image's largest 
dimension will be adjusted 
proportionally, making the 
image fill the entire scene 
field, and bleed past its 
boundaries it if its aspect 
ratio does not match the 
field's aspect ratio. This 
option can be used to import 
a panning background image, 
also referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the field's 
width, without affecting its 
aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the 
field's height, without 
affecting its aspect ratio:

Project Resolution: Scales 
the image to fit the scene's 
resolution, making each pixel 
in the image take one pixel in 
the scene's field. For 
example, if the image's 
dimensions in pixels are half 
of the scene's resolution in 
pixels, then the image's 
dimensions will appear to be 
half of the scene field's 
dimensions. 

Alignment (Import as Toon Boom Bitmap Drawing)

Rules

Horizontal Fit: 

Adjusts the image's size so that its width matches the scene's width, without 
affecting its aspect ratio.

Vertical Fit: 

Adjusts the image's size so that its height matches the scene's height, without 
affecting its aspect ratio.
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Actual Size: Imports the image in its actual size, without adjusting its size relative 
to the scene's resolution. For example, if the image's dimensions in pixels are half 
of the scene's resolution in pixels, then the image's dimensions will appear to be 
half of the scene field's dimensions. 

Transparency

Alpha

Premultiplied with White: The colour values of semi-transparent pixels in the 
image have been encoded so that the more transparent they are, the closer to 
white they are. When an image that is premultiplied with white is loaded in a 
software that does not support transparency, it appears blended with a white 
background. Select this to make Harmony reverse this premultiplication so that 
the image blends properly with other visual elements in your scene.

Premultiplied with Black:The colour values of semi-transparent pixels in the 
image have been encoded so that the more transparent they are, the closer to 
black they are. When an image that is premultiplied with black is loaded in a 
software that does not support transparency, it appears blended with a black 
background. Select this to make Harmony reverse this premultiplication so that 
the image blends properly with other visual elements in your scene.

Straight: The colour of semi-transparent pixels in the image is encoded 
independently from their transparency. When an image that is not premultiplied 
is loaded in a software that does not support transparency, semi-transparent 
pixels simply appear fully opaque, making its edges appear pixelated. 

Clamp Colour to Alpha:This is the same as Premultiplied with Black, except 
that it also prevents the colour values for a given pixel from being higher than 
that pixel's alpha value. This option is only useful if you are working with images 
that are supposed to be premultiplied with black, but where the colour values of 
pixels have been increased without their alpha values being adjusted accordingly.  
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Vectorization

Black and White
Vectorizes drawings with a solid black line. This creates a 100% vector-based 
drawing and paints it with the Vectorized Line colour swatch from your scene's 
palette.

Grey
Vectorizes the image as a mix of vector contour and greyscale bitmap filling. Lines 
keep the texture from the scan, and the white of the paper becomes transparent.

New Preset Lets you create a new preset.

Delete Preset Lets you delete any preset in the list.

Edit Preset Lets you edit the vectorization parameters for the selected preset.
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Loop Node

The Loop node exists as both Loop (for Images) and Loop Transformation (for Pegs and Transformations). This 
node is used to create looping sections in the Timeline by referencing the input content at different frames. 
The Loop node is able to start a loop at a given frame, loop a section of frames a number of times, and 
continue after looping is required.

The Loop node takes an image input and output, and will provide the retimed transformation and render of 
that image, looping over a number of frames.

The Loop Transformation node takes a transformation input and output, and will provide the retimed 
transformation looping over a number of frames.

How to access the Loop and Loop Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.
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 l Cycle Mode: Defines the way in which the output frames are calculated when cycling.

 l Repeat: It will simply cycle the looping frames, and will repeat the cycle from the first frame 
when finished. 1,2,3,4,1,2,3,4

 l Ping Pong: It will cycle the looping frames, and will repeat the cycle backwards when 
finished. 1,2,3,4,3,2,1,2,3 . . .

 l Frames to Cycle:  This area defines the input range to be used in the looped content. 

 l First: The first frame to be used in the looping content.

 l Last: The last inclusive frame to be used in the looping content.

 l Offset: Offsets the internal frame of the loop by this amount. This is useful for reusing loops, 
but simply offsetting their starting frame.

 l Use Output Range: Defines whether the loop is considered infinite (when disabled) or, if the loop is 
mapped to a specific output range and will have a start and ending range in the Timeline.

 l Disabled: The loop will begin at frame one, and will persist for the total length of the scene.

 l Enabled: The loop will begin at the start frame and plays to the end frame.

 l Start: The output frame number that defines where the loop begins in the output frames. 
The input images or transformation will play normally up until this point.

 l End: The inclusive output frame number that defines where the loop ends in the output 
frames. The loop will continue until one frame after this value is reached, and will resume its 
output based on the resume behaviour of the node.
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 l Resume Behaviour: Defines the node’s behaviour after the end frame has been reached 
when the output range is enabled.

 l Hold: Holds the final output frame’s value after the end frame has been reached.

 l Continue from Looped Frame: Continues from the input frame that was last played 
in the Timeline when the end frame of the loop has been reached.

 l Continue from Timeline Frame: Continues from the actual Timeline frame, 
regardless of the looping frame or output range, once the end frame of the loop has 
been reached.

 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Manage Local Cache Dialog Box
The Manage Local Cache dialog box displays a list of all the Harmony Server scenes for which you have 
cached drawings. In this dialog, you can check if the drawings you have in a scene's cache match the drawings 
in the database server, you can delete unused caches and you can change the directory in which scene data is 
cached. 

NOTE 

A scene's data is cached on your computer when you check the Cache scene assets locally option 
in the Database Selector before opening the scene—see Database Selector Dialog Box on page 
46. 

How to access the Manage Local Cache dialog box

 1. In the top menu, select File > Manage Local Caches.

The Manage Local Caches dialog appears.

Parameter Description

List of scene 
caches

The list of caches stored on your computer. There is one item for each scene for which there is 
cached data. Each item is identified by the scene's environment, followed by its job, then its 
name, in this format: 

Environment/Job/Scene

If you select a scene cache in the list, the Manage Local Caches dialog will compare the 
drawings that are cached on your computer to the drawings in the actual scene in the 
database, and report if they are identical or not in the Local Cache Status field. 
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Parameter Description

Local Cache 
Status

If you select a cache, the Manage Local Cache dialog will analyze whether the data in the 
selected cache matches the data in the actual scene in the Harmony Server database. 

If it displays Scene's Local Cache is identical to the database, then the drawings in the 
selected cache on your computer are identical to the drawings in the corresponding scene in 
the database, meaning that your cache and that the database are up to date. 

If it displays Scene's Local Cache is different than database, then some drawings in the 
selected cache on your computer are different from the drawings in the corresponding scene in 
the database. This usually means one of the following:

 l If the selected cache is the cache of the currently opened scene and you just saved your 
scene, Harmony may still be uploading the updated drawings to the database. In this 
case, you can close the dialog, wait a few seconds, and reopen it to see if Harmony is 
done uploading the drawings. If it is, it will report that the cache is identical to the 
database.

 l If this is not the cache of the currently opened scene, it is likely that the database scene 
has been changed by someone else since the last time you opened it. That would mean 
that the database version is more up to date than your cache. This is not a problem, as 
next time you open the scene, your cache will be updated. 

Local Cache 
Root Folder

Indicates where scene caches are stored on your computer. By default, scene caches are stored 
in a folder named Toon Boom Harmony Local Cache, inside your Documents folder.

Browse

Allows you to change the folder where caches are downloaded when you open a scene. 

NOTE 

The caches that are currently stored on your machine will not be moved to their new 
location. Hence, when you change the local cache root folder, the list of scene caches will 
become empty until you open a scene. 

Remove

Deletes the selected scene cache from your computer.

NOTE 

This button is greyed out if the selected scene cache is for the currently opened scene, as 
this cache is currently in use by Harmony. 

Close Closes the dialog.
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Manage Tool Presets Dialog Box
The Tool Presets window lets you create new tool presets and manage them. 

How to access the Manage Tool Presets window

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the Manage Presets  button.

Parameter Description

Icon Lets you select a preset to manage.

Import Lets you import an existing preset.

Export Lets you export a preset for use in other projects.
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Delete Removes the preset from the list of tool presets.

Name Lets you change the name of the preset.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the new preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 

Update
After adjusting the settings for a preset, the current properties are applied to 
the presets, as well as any other changes you made in the Manage Tool 
Presets window.

115

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Marker Dialog Box
The Timeline Scene Marker dialog box lets you create and manage scene markers in the Timeline view. 

Scene markers are visual indicators displayed at the top of the Timeline view in the frame counter area. You 
can use it to denote anything relevant to your work. You can indicate the frames you want to clean up, a 
change in action, an impact, or where you intend to apply an effect. You can also add a note to a scene marker. 
If you hold the mouse cursor over a scene marker, its name, starting frame, duration and note will be displayed 
in the tool tip box.

How to access the Timeline Scene Marker dialog box

 1. In the Timeline view, do one of the following:

 l If you want to create a scene marker at a single frame, select that frame on any layer.

 l If you want to create a scene marker that spans over several frames, select this range of 
frame on any layer.

 2. Right-click on the ruler at the top of the Timeline view and, in the context menu, select Scene 
Markers > Create Scene Marker.

116



NOTE 

If your scene already contains scene markers, you can also open this dialog box by clicking on 
a scene marker to select it, then right-clicking anywhere on the timeline ruler and selecting 
Scene Markers > Edit in the contextual menu.

Parameter Description

Name The name of the marker.

Time The frame number at which the marker starts.

Duration

The amount of frames during which the marker spans. 

TIP 

You can set the duration to zero to make a marker that just points at the 
starting frame.

Colour Allows you to select a colour for the scene marker.

Note Allows you to type a description for the scene marker.
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Mini Playback Dialog Box
The Mini Playback dialog box alllows you to configure and start Mini Playback. Mini Playback allows you to 
quickly preview a short span of animation starting a few frames before the current frame and ending a few 
frames after the current frame, at a customizable frame rate. 

How to access the Mini Playback dialog

 1. Do one of the following:

 l In the top menu, select Play > Mini Playback.

 l In the Mini Playback toolbar, click on the  Mini Playback Dialog button. 

Icon Parameter Description

  Frame Rate
The speed at which Mini Playback should play your animation. By default, it is 
set to Same as Scene to play at the same pace as your scene's frame rate. 
Otherwise, you can choose among a set of commonly used frame rates. 

  Before The amount of frames before the current frame at which to start Mini Playback. 

Play
Starts Mini Playback. Playback will start at the amount of frames in the Before 
field before the current frame, and end at the amount of frames in the After 
field after the current frame, at the frame rate in the Frame Rate drop-down. 

  After The amount of frames after the current frame at which to end Mini Playback. 
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Movie Options Dialog Box (macOS)
The Movie Options dialog box allows you to configure the video and audio settings when exporting a movie in 
QuickTime Movie (.mov) format on macOS. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 

How to access the Movie Settings dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the Movie Settings dialog box from the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

Parameter Description

Video

Codec

Allows you to select which algorithm to use to compress the video data. The following 
video codecs are supported:

 l H.264 Legacy: A very effective lossy compression algorithm that is commonly 
supported by web browsers and media players. 

 l H.265  Legacy: Same compression quality as H.264, but with a smaller compression 
size. This is useful for videos intended for the web and mobile devices. Not 
supported on all major browsers or operating systems. 

 l Apple ProRes 422  Legacy: A nearly lossless compression algorithm commonly 
used for video editing on Apple systems. This codec is optimized for preserving 
video quality, but not for publishing or streaming.

 l Apple ProRes 422 HQ  Legacy: Preserves visual quality at the same high level as 
Apple ProRes 4444 but for 4:2:2 image sources (cleaner footage for things like 
green screening). Heavier than Apple ProRes 422 for real-time editing performance.

 l Apple ProRes 422 LT  Legacy: A more highly compressed codec than Apple ProRes 
422, with roughly 70 percent of the data rate and 30 percent smaller file sizes. This 
codec is perfect for environments with limited storage capacity and data rates.
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Parameter Description

 l Apple ProRes 422 Proxy  Legacy: An even more highly compressed codec than 
Apple ProRes 422 LT, intended for use in offline workflows that require low data 
rates but full-resolution video.

 l Apple ProRes 4444  Legacy: A nearly lossless compression algorithm commonly 
used for video editing on Apple systems. Compared to Apple ProRes 422, this codec 
preserves more colour detail and supports transparency. However, it results in 
heavier file sizes.

Alpha

Check this option if you want to export a video with transparency.

NOTE 

This option is only available when exporting with the Apple ProRes 4444 codec. Other 
codecs do not support transparency.

Sound Uncheck this checkbox if you want to export a movie without an audio track.

Rate

Allows you to select the sample rate, or frequency, in which to export the audio track for the 
movie.

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 kHz. If you select a 
higher sample rate, your project's audio will be upsampled, which means it will take 
more disc space without increasing in quality. 

Use

Allows you to select whether to export the movie's audio track using the Mono or Stereo 
channel mode.

NOTE 

Stereo sound has a separate track for the left and right speakers, whereas mono sound 
only has a single audio track for all speakers. 
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QuickTime Movie Settings Dialog Box (Windows)
The Movie Settings dialog box allows you to configure the video and audio compression settings when 
exporting a QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Movie Settings dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Movie Settings dialog box from the Export OpenGL 
Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

Parameter Description

Video

Settings

Opens the Standard Video Compression Settings dialog box. This is where you 
can set the video compression settings for the movie you will export—see 
QuickTime Standard Video Compression Settings Dialog Box (Windows) on page 
199.

Filter
Opens the Choose Video Filter dialog box, where you can select from a range of 
filters to apply to your video export.

Size
Opens the Export Size Settings dialog box. This dialog is available because of the 
way the Apple QuickTime interface is designed, but its settings are not taken in 
account by Harmony. The size of the exported video is determined by Harmony.

Sound

Settings
Opens the Sound Settings dialog box. This is where you can you set the sound 
compression settings for the movie you will export—see QuickTime Sound 
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Settings Dialog Box (Windows) on page 195.

Prepare for Internet 
Streaming

If this option is enabled, the video will be optimized to start playing while it is 
downloading, as videos do in web browsers and web-based streaming 
applications. 

 l Fast Start: The video plays as soon as enough data required to start 
playback has been downloaded.

 l Fast Start - Compressed Header: Same as Fast Start, except the header 
is compressed for an even faster start. Requires QuickTime 3.0 or later.

 l Hinted Streaming: Allows you to optimize the movie file for streaming 
through QuickTime Server Software. Click on the Settings button to 
configure how hints are created in your movie file.
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New Scene Dialog Box
The New Scene window lets you create a new scene.

How to access the New Scene window

 1. Do one of the following:

 l From the top menu, select File > New. 

 l In the File toolbar, click the New  button. 

 l Press Ctrl + N (Windows/Linux) or ⌘  + N (macOS).

The New Scene dialog box opens.

Parameter Description

Name Lets you type in a name for the new scene.

Location Lists the locations you used most frequently for storing scenes.

Browse
Opens a browser in which you can specify a location for the new scene that 
is not listed in the Location list.

127

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Camera Size Opens a list of resolutions.

+ (Create Custom 
Resolution)

Opens the New Resolution window in which you can create a custom 
resolution that is added to the Camera Size list.

- (Delete Custom Resolution) Lets you remove a custom resolution from the Camera Size list.

Width Indicates the width of the resolution you chose from the Camera Size list.

Frame Rate
Indicates the frame rate of the resolution you chose from the Camera Size 
list.
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New Tool Preset Dialog Box
The New Tool Preset dialog box lets you create new tool presets and manage them. 

Tool presets let you save a variety of settings and are very efficient for accessing the tools you use most often. 
That way, the tool is already set with the desired properties, such as colour, line thickness, whether to enable 
Draw Behind or Auto Flatten mode, and so on. You can create presets for these tools and many more: Brush, 
Pencil, Eraser, Rectangle, Ellipse, and Line. 

The difference between a tool preset and a brush preset is that when you save a tool preset, you have the 
option of saving the colour and assigning a shortcut, which you cannot do with brush presets.

How to access the New Tool Preset dialog box

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the New Tool Preset   button.

Parameter Description

Name Lets you give the preset a meaningful name.

Icon list Lets you select an icon for the preset.
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Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 
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Onion Skin and Light Table Transparency Dialog Box 
T-ANIMPA-006-009

This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box 

 l In the Drawing view toolbar, click on the Top Light button to open the Onion Skin and Light 
Table Transparency dialog box.

Command Description

Onion Skin Opacity
Sets the maximum opacity value for the onion skin opacity display.  Moving the 
slider all the way to the left = 0% opacity. Moving the slider all the way to the 
right = 100% opacity.

Lighttable Opacity
Sets the maximum opacity value for the light table display. Moving the slider all 
the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity.

LightTable Wash
Sets the washed-out value for the light table display.  Moving the slider all the 
way to the left = 0% opacity. Moving the slider all the way to the right = 100% 
opacity.

Bitmap Background 
Wash

Sets the maximum opacity value for the background wash.   Moving the slider all 
the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity. Only works for bitmap layers.

Pencil Lines Opacity
Sets the maximum opacity value for central vector lines (lines made by the 
Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity. 
Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box
The Palette Browser dialog allows you to decide the level of palette list and palette storage to use when you 
want to create, clone, link to or import a palette. 

This dialog only appears if you have the Advanced Palette Lists preference enabled, which is disabled by 
default. When Advanced Palette Lists mode is disabled, Harmony automatically stores palettes in a scene's 
palette list, inside the scene's palette-library subdirectory. 

How to access the Palette Browser dialog box

 1. Start  and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

 4. In the Palette Operations dialog box that opens, select the palette you want to clone at the location 
and level in which it was stored. 

 5. Click Clone.

Parameter Description

Palette Location

This allows you to browse for the physical location of the palette file in your 
database.

If you are using Harmony Stand Alone, you can still select the scene's own job or 
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environment as a location. Stand alone scenes have a provisional job and 
environment storage space inside the scene's directory. The files in these storage 
spaces can be imported into a database scene's actual job and environment when 
importing the scene to a Harmony database. If you never intend to use Harmony 
Server, you should keep your palettes inside your scene or element's palette 
libraries. 

Environment

Stores the palette file in the selected environment's palette library. Environments 
are typically used to contain a whole production, series or feature film. 

 l In Harmony Server, this stores the palette in /USA_DB/environments/
[environment name]/palette-library.

 l In Harmony Stand Alone, this stores the palette inside the scene's 
directory, under environments/Digital/palette-library.

Job

Stores the palette file in the selected job's palette library. Jobs are typically used 
to contain episodes in a series, or any set of scenes that is intended to be put in 
the same sequence. 

 l In Harmony Server /USA_DB/jobs/[job name]/palette-library. 

 l In Harmony Stand Alone, this stores the palette inside the scene's 
directory, under jobs/Digital/palette-library.

Scene
Stores the palette file in the selected scene's palette library, which is the 
palette-library subdirectory of the scene's directory.

Element
Stores the palette file inside the  selected element's palette library. This library is 
located inside the scene's directory, under elements/[element 
name]/palette-library.

Palette This lists the existing palettes in the selected location. 

New Palette Name
If you are creating or cloning a palette, use this field to enter the palette file's 
name. The palette will be listed under this name in your palette list. On your file 
system, it will be named after its palette name, followed by the extension .plt. 

Palette Type

When creating a palette, you can choose between the following palette types:

 l Colour: A colour palette can contain colours, gradients and bitmap 
textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 
transparency filters to pencil lines, in combination to their line colour, to 
create various styles of pencil lines.
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Palette List
This allows you to decide if you want the palette to be added to your scene's 
palette list, or to the currently selected element's palette list. 

Scene Palette List

Adds the palette to the scene's palette list. Palettes in the scene's palette list are 
available to all the elements in your scene. This is especially useful if you are 
doing digital animation, where character models can be made of many layers that 
need to use the same palette. 

Element Palette List

Adds the palette to the currently selected element's palette list. Palettes in an 
element's palette list can only be used by the drawings in this element, and will 
only be listed in the Colour view when this element is selected. This can be useful 
if you are doing traditional animation, where each character is usually drawn on a 
single layer, and you want each layer to have its own palette. 

134



Palette Operations Dialog Box
When you start Toon Boom Harmony Advanced connected to the database, you can access the Palette 
Operations dialog box which lets you clone, rename, or delete palettes in your database, without having to 
open a scene or browse the database's file system in your operating system's shell. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is 
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 
directory in a palette-library folder unless you specify a different location.

There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box

 1. Start  and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

Parameter Description

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.
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Clone
Opens the Palette Browser dialog box from which you can select the level in 
which to store the palette file.

Rename Lets you rename a palette.

Delete

Lets you delete a palette.

NOTE 

It is not recommended to disable the warning message that appears when 
you are attempting to delete a palette as this operation cannot be undone.

Close Closes the Palette Operations dialog box.
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Paste Preset Dialog Box
When pasting key frames and exposures, you can modify the existing presets to your liking. There are three 
presets you can modify: the default presets for both key frames and exposures, key frames only and exposures 
only.

Parameter Description

Drawings

Add/Remove 
Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved when 
pasting. No key exposures are added. This is the default behavior when pasting.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.
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Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.
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Paste Special Dialog Box
The Paste Special dialog box lets you determine how templates and symbols are imported in the Timeline 
view. 

When you import a template in the Timeline view, all layers are created as well as drawings and keyframes. 
You can choose to import only the keyframes without the drawings or import only the drawings that are not 
already in your layers. You can adjust the behaviour using the Paste Special dialog box.When you import a 
symbol in your scene, its full length is exposed by default. If you import a symbol in the Timeline view’s left 
side, all the frames will be exposed. However, if you import it into an existing layer, you can use the Paste 
Special dialog box to adjust the import behaviour to fit your requirements.Once you set the parameters, 
Harmony will reuse them each time you import a symbol in the Timeline view’s right side until you set new 
parameters.

How to access the Paste Special dialog box

 1. In the Library view, select the symbol or template to import.

 2. Do one of the following:

 l While holding down the Alt key, click and drag on the template, then drop it on the Timeline 
view, over the layer and at the frame where you want to paste it.

 l Press Ctrl + C (Windows/Linux) or ⌘  + C (macOS). Then, in the Timeline view, click on the 
frame where you want to paste the template and press Ctrl + B (Windows/Linux) or ⌘  + B 
(macOS)

The Paste Special dialog box opens.
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Parameter Description

Drawings

Do Nothing Does not create or overwrite drawings.

Update Drawing 
Pivot

Revises the drawing pivot in the destination to use the same drawing pivot as the 
first drawing in the template. If you have a range of drawings selected in the 
destination, the pivot points of all selected drawings will be updated.

Add/Remove 
Exposure

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Replace existing drawings. Create drawing files when they do not exist: 
Replace drawings with the same names to update a scene with new modified 
drawings and preserve the animation.

Tip: If you don't want to lose the existing animation when pasting 
a template,  such as when placing new drawings after the 
animation, then delete the template's animation.  It will still have 
updated the drawings but not override the existing animation.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure: If there are key exposures that exist on copied drawings, 
they are preserved when pasting. No key exposures are added. This is the default 
behavior when pasting.

Fill Gap with Previous Drawing: Fills selected area in the Xsheet or Timeline 
view with the previous drawing.

Fill to Next Key Exposure: Fills selected area till the next key exposure.

Paste all frames of the symbol (full movie): When enabled, the Paste Special 
command exposes all the symbol's frames instead of only the first one.
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Symbols

Copy symbols if they 
do not exist

This is the default setting for this operation and will prevent Symbols in an Action 
template from being copied.

Duplicate symbols
Creates a duplicate of the symbol instead of linking the Symbol instance to the ori-
ginal one. The new Symbol is created in the Library.

Paste all Frames of 
the symbol (full 
movie)

When enabled, the Paste Special command exposes all the symbol's frames 
instead of only the first one.

Add Remove/Keyframes

Motion Copies the properties of the selected motion keyframe to the new frame.

Velocity Copies the properties of the selected velocity keyframe to the new frame.

Rotation Copies the properties of the selected rotation keyframe to the new frame.

Scale Copies the properties of the selected scale keyframe to the new frame.

Skew Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at 
Function's Beginning 
and End

 Adds a keyframe to the beginning and end of the pasted function, reproducing 
the source function.

Offset Keyframes
When pasting functions, offsets keyframes from the function's last frame value 
by the values in the pasted function. This will continue the progression of a 
function instead of repeating the values.

Options

Palettes

Do nothing: Does not create, overwrite, merge or link palettes.

Reuse palettes. Copy palettes if they do not exist: Palettes in the destination 
drawings are left as they are.

Copy and overwrite existing palettes: Overwrites destination palettes with the 
palettes from the source drawings.

141

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Copy and create new palette files: Creates new palette files, placing them at the 
same relative environment and scene level as the source. If the palettes in the 
templates were stored at the environment level of the source scene, the paste 
operation will place the palettes in the environment level of the destination 
scene.

Copy and create new palette files in element folder: Creates new palette files in 
the element folders of the destination scene, rather than in the same relative job 
or environment.

Copy palette and merge colours. Add new colours only: Adds new colours to 
the destination palettes and ignores colours that are the same in the two palettes.

Copy palettes and update existing colours: Adds new colours to the destination 
palette and updates duplicate colours in the destination with colour values from 
the source.

Link to original palettes (colour model): Links the colour palettes in the 
destination scene to the palettes in the source. Use this to link drawings to the 
palettes in a colour model.

Copy scene palettes and merge colours. Add new colours only: Adds new 
colours to the destination scene palettes and ignores colours that are the same in 
the two palettes.

Copy scene palettes and update existing colours: Adds new colours to the 
destination scene palette and updates duplicate colours in the destination with 
the colour values from the source.

Cycles

Normal (forward):Pastes your selection as is, starting with the first cell and end-
ing with the last.

Reverse: Pastes your selection in reverse, starting with the last cell and ending 
with the first.

Forward > Reverse:Pastes your selection as a yo-yo, starting with the first cell, 
going to the last one and ending with the first cell.

Reverse > Forward: Pastes your selection as a reverse yo-yo, starting with the 
last cell, going to the first one and ending with the last cell.

Nodes
Create New Columns: A new column is created when you copy and paste nodes 
from the layer in the Timeline view. If the layers are linked to function curves, the 
function curves, drawings and timing will be duplicated.

Elements
Reuse existing elements: Lets you paste existing elements without creating new 
ones. This should be used only when pasting within versions of the same scene.

Validation
Match by Node/Layer Name: When pasting a template with a hierarchy onto 
another hierarchy, this option looks to match the pasting elements with the same 
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layer or node name, rather than the same hierarchical structure. This means that 
even if the two hierarchies are different, a new pose of a character's body part will 
still be pasted on the correct body part layer, as long as both layers are named 
the same.
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Pen Pressure Feel Dialog Box
The Pen Pressure Feel dialog box allows you to configure how Harmony processes the pressure you put on 
your tablet pen to apply it to the size of your drawing tool.

By default, Harmony applies the pressure you put on your pen to your tool in a linear fashion. That is, if you put 
25% of the maximum pressure on your pen, your tool's size will be 25% of the way between its minimum and 
maximum size. If you put 75% of the maximum pressure on your pen, your tool's size will be 75% of the way 
between its minimum and maximum size. 

However, you may find that it would feel more natural, or that it would make it easier to control the size of 
your drawing strokes, if Harmony interpreted the pressure you put on your pen differently. For example, you 
may want Harmony to make your brush strokes small unless you put a lot of pressure on your pen, or you may 
want Harmony to make your brush strokes big unless you put very little pressure on your pen. This is where 
the Pen Pressure Feel dialog box comes in handy.

NOTE 

For information on how to use the Pen Pressure Feel dialog, refer to the User Guide.

How to access the Pen Pressure Feel dialog

 1. Add the Pen Settings toolbar to your workspace by doing one of the following:

 l In the top menu, select Windows > Toolbars > Pen Settings.

 l Right-click on any existing toolbar and, in the context menu, select Pen Settings.

 2. In the Pen Settings toolbar, click on the  Pen Pressure Feel button.

The Pen Pressure Feel dialog appears.
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Parameter Description

Min Pressure

The percentage of your pen's maximum pressure you must apply before Harmony registers 
that you are drawing. If you increase this setting, you can lightly brush your tablet with your 
pen without drawing, and you must apply a certain amount of pressure on it to draw. 

For example, if you set this to 15%, you can apply up to 15% of your pen's maximum pressure 
without actually drawing. If you apply exactly 15% of your pen's maximum pressure, Harmony 
will draw a stroke in your tool's minimum size.

By default, this is set to 0%, which means that just brushing the tablet with your pen will draw 
in your tool's minimum size. You can increase this setting up to 25%. 

Curve Preset Allows you to instantly apply a curve preset to the pressure curve below. 

Max Pressure

The percentage of your pen's maximum pressure at which point your drawing tool should draw 
in its maximum size.

For example, if you set this to 80%, your drawing tool will draw in its maximum size if you 
apply 80% of your tablet pen's maximum pressure. 

By default, this is set to 100%, which means you have to press your tablet pen all the way to 
draw in your drawing tool's maximum size. You can decrease this setting down to 75%.

Pressure  Curve

This curve determines how to process the amount of pressure you apply to your tablet pen into 
your drawing tool's size.

By default, it is linear, meaning that the amount of pressure you put on your tablet pen is 
directly applied to the size of your drawing tool. By moving the two Bezier handles between 
the extremities of the curve, you can change the curve's shape.

 l If you make an ease-in curve like the one below, the size of your drawing strokes will 
tend to be closer to the minimum size of your drawing tool, unless you apply a lot of 
pressure on your tablet pen.

 l If you make an ease-out curve like the one below, the size of your drawing strokes will 
tend to be closer to the maximum size of your drawing tool, unless you apply very little 
pressure on your tablet pen.
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Parameter Description

 l If you make an ease-in-ease-out curve like the one below, the size of your drawing 
strokes will tend to be closer to the minimum size of your drawing tool when applying 
light pressure, and to be closer to the maximum size of your drawing tool when 
applying more pressure, but it will rarely be the median between the minimum and the 
maximum size.

 l If you make an ease-out-ease-in curve like the one below, the size of your drawing 
strokes will tend to be closer to median between the minimum and maximum size of 
your drawing tool, unless you apply very little or a lot of pressure on your tablet pen.
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Pose Copier Dialog Box
T-RIG3-007-007

The pose copier contains many buttons and other information to facilitate the insertion of poses in the 
animation.

Parameter Description

Preview Window
Based on master template's generated thumbnails, previews currently selected 
frames.

Load Selected Template Updates the template with the newly selected template.

Template Name Name of the currently selected template.

Vertical Slider (SLV) Linked to the slv- node of the node system.

Horizontal Slider 1 (SLH)
Linked to the slh- node of the node system. Default slider for the pose copier if 
no guide layers are created.
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Horizontal Slider 2 (SLX) Linked to the slx- node of the node system.

Fill to Next Key Exposure
Having this option checked will automatically extend the exposure of the 
pasted frame up to the next key.

Use Default Destination 
Module

When enabled, the pasted keys will automatically refer to the destination 
defined in the option Set Default Destination Module.

Paste by Layer Name
When this option is checked the pasted layers will look for the individual layer 
name instead of matching the hierarchy of the template. 

Set Default Destination Module
Instead of selecting the destination every time, the layer set as default 
destination will automatically paste the keys onto those layers.

Find This will center on the default destination in the timeline.

Paste Paste the current position of the pose copier onto the destination.

Vertical 
Currently selected frame on the vertical slider. (based on frame name in slv-
node)

Horizontal 1 
Currently selected frame on the horizontal slider 1. (based on frame name in 
slh-node)

Horizontal 2
Currently selected frame on the horizontal slider 2. (based on frame name in 
slx-node)

Frame Frame number of the selected frame within the master template.
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Preferences Dialog Box
The Preferences dialog box allows you to adjust preferences to suit your workflow and your production's 
needs.

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

How to open the Preferences dialog box

 1. Do one of the following:

 l Windows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.
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 l macOS:

 l In the top menu, select Harmony Advanced > Preferences.

 l Press ⌘  + U.

Paramet
er

Description

Preferenc
e Set

This drop-down allows you to select among one of the available preference presets.

The different preference presets have a lot of settings in common. The following table lists how each 
preset differs for specific preferences:

Tab / 
Location

Preference

Preference Set

Basic
Compositin

g

Cutout 
Animatio

n

Paperless 
Animatio

n
Rigging

General

Focus on 
Mouse 
Enter

Off On On On On

Default 
Separate 
Position for 
Pegs

Off Off On Off On

Stop-
Motion 
Keyframes

Off Off On Off On

Timeline

Reduce 
Indentation

Off On On Off On

Drawing 
Substitutio
n: Create 
Key 
Exposure

On Off Off Off On

Advance
d

Support 
Overlay Off On On Off On
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Paramet
er

Description

Tab / 
Location

Preference

Preference Set

Basic
Compositin

g

Cutout 
Animatio

n

Paperless 
Animatio

n
Rigging

and 
Underlay 
Arts

Advanced 
Palette List

Off On On On On

Advanced 
Element 
Mode

Off On Off Off Off

Element 
Node 
Animate 
Using 
Animation 
Tools

On On Off On Off

Pencil 
Tool 
Propertie
s

Auto Close 
Gap

On On On On Off

Save... Allows you to export your current preference settings as an XML file, which you can import later.

Load... Allows you to browse for and import a preference file that was exported with the Save... button.

Preferenc
e Tabs

Where you can browse for and change preferences. 

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.
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Paramet
er

Description

Restore 
All 
Defaults

Restores all your preferences to their default setting for the selected preference set.

OK Commits your changes to the preferences and closes the dialog.

Cancel Undoes your changes to the preferences and closes the dialog.
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Recolour Drawings Dialog Box
The Recolour Drawing dialog box allows you to replace all instances of a colour or texture in drawings with a 
different colour or texture swatch in one of the scene's palettes. This replaces the colours or textures in the 
drawings without requiring you to modify the palettes. You can use this dialog to perform colour replacement 
in the current drawing, in all the drawings in one or several layers or in all drawings in your scene.

This dialog will replace the colour or texture that is currently selected in the Colour view with the colour or 
texture that you select inside the dialog. 

How to access the Recolour Drawings dialog

 1. In the Colour view, select the colour or texture swatch you want to replace by doing one of the 
following:

 l Select the palette in which the colour or texture swatch is located, then select the swatch 
you wish to replace. 

 l If the drawing in the Camera or Drawing view contains the colour or texture you want to 
replace, select the Colour Eyedropper  tool in the Tools toolbar, then click on that colour 
or texture in the drawing. The Colour view will automatically select that colour or texture's 
palette as well as that colour or texture's swatch.
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 2. Do one of the following:

 l Right-click on the swatches list, then select Recolour Drawings.

 l Open the Colour view menu , then select Colours > Recolour Drawings.

Parameter Description

Replace Colour In

Allows you to select which drawings will be affected by the colour replacement:

 l Current drawing: Replaces the selected colour in the currently selected 
drawing only.

 l All drawings in the currently selected layers: Replaces the selected 
colour in all the drawings in the layer that is currently selected in the 
Timelime or Xsheet Timeline view. 

NOTE 

This option can work with several drawing layers selected. 

 l All drawings in the scene: Replaces the selected colour in every drawing 
in the current scene.

Replacement Colour
Allows you to select the palette and colour or texture swatch to replace the 
selected colour or texture with.
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Remove Dirt Dialog Box
The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box

 1. Do one of the following:

 l From the top menu, select Drawing > Clean Up > Remove Dirt.

 l From the Camera or Drawing View  menu, select Drawing > Clean Up > Remove Dirt.

 l Press Shift + D.

Parameter Description

Slider

Lets you adjust the amount of detail removed from the layer. 

Raising the Remove Dirt level will select bigger dots. When selecting larger dots, 
be careful not to lose small details like pupils and nostrils. Once you have chosen 
the level, you can apply it to the current drawing or the entire animation 
sequence. This is a quick way to get rid of most dirt and dust.

During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.
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Remove Frames Dialog Box
The Add Frames dialog box allows you to remove a range of frames from your scene. All the keyframes and 
the exposed drawings in the removed range will be deleted, and the keyframes and exposed drawings after 
the removed range will be offset backwards, so as to close the gap. 

How to access the Remove Frames dialog box

 1. In the Timeline or Xsheet view, select a frame or a range of frames. 

 

 2. Do one of the following:

 l From the top menu, select Scene > Frame > Remove Selected Frames.

 l In the Xsheet view, right-click and select Frame > Remove Selected Frames.

The Add Frames dialog box appears.

Parameter Description

Number of frames to remove
The amount of frames to remove. The range of frame that will be removed starts 
from the selected frame—or the first selected frame, if a range of frames is 
selected—and ends after the selected number of frames. 
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Parameter Description

By default, this is set to the amount of selected frames. 

Ripple Scene Markers

If checked, scene markers after the removed frames will be offset backward to 
remain synchronized with the keyframes and drawings in your scene. If 
unchecked, scene markers will remain in place while everything else after the 
removed frames is offset.

157

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

Remove Hair Dialog Box
The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick 
lines or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the 
drawing.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box

 1. In the Timeline or Xsheet view, select the drawing containing the drawing to clean.

 2. From the top menu, select View > Show > Show Strokes to display the invisible lines or press K.

 3. In the top menu, select Drawing > Clean Up > Remove Hair.

Parameter Description

Slider Lets you adjust the number of length of hairs selected. 

Apply to all drawings Applies the operation to all drawings in the layer.
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Rigid Point Deform Node

The Rigid Point Deformer is a type of weighted-deformation that prioritizes rigid transformations over 
deformations and is applied by tracking the position of attached pegs. It is particularly useful for tracking and 
deforming textures on characters and animated surfaces and is used with the Weighted Deformer node.

How to access the Rigid Point Deform Node dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.

 l Weight: A percentage value that defines the weight of all points connected to the Rigid Point 
Deform. This weight is considered when calculating the influence of all points, curves and Rigid 
Point Deforms connected to the Weighted Deform. These weights are relative to one another in the 
Weighted Deform system. A weight of 50% would have half the influence in the Weighted 
Deformation system than a weight of 100% when connected to that same system.

 l Minimum Distance: The Rigid Deform considers the proximity of the elements in the drawing and 
the points influence is based on that distance. When a minimum distance is defined, any points 
within that minimum distance are completely influenced by that point and this influence falls off as 
it approaches the maximum distance.
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 l Maximum Distance: Similar to the Minimum Distance, the Maximum Distance defines the distance 
in which the point has little to no control over the surrounding elements in the drawing.

The Minimum and Maximum distance are useful in defining particular regions of control within a 
Weighted Deformation system.
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Save Dialog Box
The Save dialog box appears when you save a scene for the first time in Harmony Server.

How to access the Save dialog Box

 1. Make sure you have the necessary rights to save the current scene version. If you do not, you can 
acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene in 
the top menu. 

 2. Do one of the following: 

 l In the top menu, select File > Save.

 l In the File toolbar, click on the  Save button.

 l Press Ctrl + S (Windows/Linux) or ⌘  + S (macOS). 

When saving the scene for the first time, the Save dialog box opens, prompting you to name the 
version.

Parameter Description
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This Version Allows you to enter the name of the current version.

Description Enter a short description of the current version.
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Scene Settings Dialog Box
The Scene Settings dialog box lets you select settings for the resolution of your scene, its alignment and the 
resolution of bitmap drawings and textured brush strokes. 

You are already required to select resolution and alignment settings when creating a scene, but those settings 
can also be modified later using the Scene Settings dialog box.

How to access the Scene Settings dialog box

 1. In the top menu, select Scene > Scene Settings.

The Scene Settings dialog box opens.

Resolution Tab

The resolution tab allows you to set the width and height of your scene in pixels as well as whether the angle 
of the field of view. 

Icon Parameter Description

  Resolution Presets

You can select your project’s resolution (camera frame size) from 
this preset list.

 l HDTV_1080p24: The standard definition for high definition 
television at 24 frames per second, mostly used in the 
Americas and some Asian countries that used the NTSC 
standard for analogue television.
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Icon Parameter Description

 l HDTV_1080p25: The standard definition for high definition 
television at 25 frames per second, usually for broadcasting 
in European, African, Asian and Australian countries that 
used the PAL or SECAM standard for analogue television.

 l HDTV_1080p23.976: The standard definition for high 
definition television at 23.976 frames per second. This is 
useful if the remainder of your pipeline uses the 23.976 
framerate for legacy reasons. 

 l HDTV_720p24: The former standard high definition 
resolution at 24 frames per second. 

 l 4K_UHD: A standard ultra HD (4K) format for television 
productons. 4K implies that the width of the image is of, give 
or take, 4000 pixels.

 l film-2K: A standard HD format for film projectors with a low 
aspect ratio.

 l film-4K: A standard ultra HD (4K) format for film projectors 
with a low aspect ratio. 

 l film-1.33_H: The standard resolution for the academy film 
format that conforms to the standard 4:3 aspect ratio.

 l film-1.66_H: The standard resolution for widescreen film 
format that conforms to the 16:9 aspect ratio.

 l film-1.66_V: The standard resolution for widescreen film 
format, but with a vertical field of view.

 l Cineon: The standard format for 35 mm Kodak/Cineon film.

 l NTSC: The standard resolution and framerate for analogue 
standard definition televisions in most of the Americas 
(except Brazil, Paraguay, Uruguay and Argentina), Japan, 
Taiwan, South Korea, the Philippines and Myanmar.

 l PAL: The standard resolution and framerate for analogue 
standard definition televisions in Europe, Africa, Australia, 
most of Asia, Brazil, Uruguay and Argentina. 

 l 2160p-240p: A series of standard widescreen presets 
named after their resolution heights.                             

 l low: A resolution based on NTSC with half of its standard 
dimensions.

 l Web_Video: A legacy format for web streaming.

 l Game_512: A preset for the gaming pipeline, with a square 
canvas. 
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 l WebCC_Preview: The preset used by WebCC to render 
previews of scenes in a Harmony Server database.

 l HDTV: The standard definition for high definition television 
at 24 frames per second, with a horizontal fit field of view.

 l HDTV_Vertical: The standard definition for high definition 
television at 24 frames per second, with a vertical fit field of 
view.

  Selected Resolution Preset
Displays the name of the selected resolution preset just below the 
presets list. If you have made any changes to the resolution since 
selecting a preset, this will display "(custom)".

Save Resolution Setting 

Allows you to save the current resolution settings as a new preset. If 
you have a resolution preset selected, this button is only available if 
you have made changes to the resolution since selecting the preset. 
You will be prompted to type in the name of the new resolution 
preset. If using Harmony Server, you will also be asked to select in 
which part of the database you want the preset to be saved.

  Resolution

The resolution of the scene defines the width and height of the 
canvas in pixels. By default, the scene will be rendered in this 
resolution. If using bitmap layers or textured brush strokes, the 
definition of the pixels in your artwork will also be based on the 
scene's resolution. 

Scene Width The width of the resolution for the scene, in pixels. 

Scene Height The width of the resolution for the scene, in pixels. 

  Aspect Ratio
Displays the ratio between the horizontal and vertical dimensions of 
the scene. For example, if the scene width and height are the same 
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Icon Parameter Description

value, this ratio equals 1. The standard aspect ratio for widescreen 
televisions is 1.777. For legacy displays, it is 1.333.

  Field of View

The angle of the field of view, which determines the size of the 
camera cone as well as the way the field grid used to position 
elements is adjusted to fit the scene. 

 l Horizontal Fit: The field of view is automatically adjusted so 
that the field grid and camera cone fit the horizontal length 
of the scene.

 l Vertical Fit: The field of view is automatically adjusted so 
that the field grid and camera cone fits the vertical length of 
the scene.

  Frame Rate

The amount of animation frames to play each second. Increasing the 
FPS will make your animation play faster, and decreasing it will 
make it play slower.

 l Preset: Allows you to select a frame rate for your scene 
among one of many commonly used preset frame rates.

 l FPS:Allows you to type in the frame rate for your scene. 

NOTE 

The standard framerate for film production is 24 frames per 
second. However, televisions in some countries play at 25 
frames per second. Some productions may use 23.976 
frames per second to preserve compatibility with legacy 
standard displays. 

Alignment Tab

The alignment tab is used to determine the aspect ratio, the position and the size of the field grid used to 
position elements in the scene.

In Harmony are positioned in fields, a unit used in traditional animation which traditionally ranges from 0 to 12 
followed by a cardinal direction, and in which 0,0 is the center of the scene.

The default Alignment setting in Harmony is based on such a traditional 4:3 drawing grid. In a scene with an 
aspect ratio of 4:3, this means that positioning an element 12 fields in any direction will make it reach one of 
the edges of the camera field. For example, 12 North is the vertical position of the upper edge of the camera 
field, and 12 East is the horizontal position of the right edge of the camera field.
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However, since the most commonly used scene resolutions have an aspect ratio of 16:9, and the default grid is 
in a 4:3 proportion, the grid used to position element will not be in the same proportions as the camera field. 
The way this is handled is determined by the Field of View setting in the Resolution tab. If your field of view is 
set to Horizontal fit, the field grid will be made to fit the scene horizontally, and stretch beyond the vertical 
edges of the scene. This means that 12 East will still be the right edge of the screen, but the position of the 
upper edge of the scene will be about 9.36 North. Likewise, if the field of view is set to Vertical Fit, the upper 
edge of the field will be at 12 North, but the right edge will be at about 16 East. 

Some artists or studios may prefer to use a square fields grid, where fields have the same size horizontally and 
vertically. 

Parameter Description

Alignment

The list of alignment presets. By default, Harmony has these two alignment 
presets:

 l 4:3 12 Fields: Defines the units of your project to have a 4:3 ratio and sets 
up 12 of these units to run both vertically and horizontally in four cardinal 
quarters (NW, NE, SW, SE). This is the default setting, and it corresponds 
to an animation grid used in traditional animation. Hence, coordinates 
based on a traditional animation grid can be entered in Harmony as is to 
position elements where they are expected to be.

 l Square 12 Fields: Defines the units of your project to have a 1:1 or square 
ratio and sets up 12 units to run both vertically and horizontally in four 
cardinal quarters (NW, NE, SW, SE). 
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Parameter Description

NOTE 

When the Grid is displayed in the Camera and Drawing view, it is always 
based on the 4:3 12 Fields alignment preset, regardless of your scene's 
alignment setting. To display the grid, from the top menu, select View > 
Grid > Show Grid.

Units Aspect Ratio

The aspect ratio of each field. This describes the proportional difference between 
the width and the height of the field. By default, it is set to 4:3, which means the 
width of each field will take 4 unites of length for each 3 units the height of the 
field takes. In other words, the width of a field is 1.333 times its height. If set to, 
for example, 1:1, the fields will be perfectly square. 

Number of Units

The number of fields the grid should have in each direction. In the Number of 
Units fields, enter the number of horizontal, vertical and depth units for your 
scene’s grid.

The grid is a specific size based on the scene's resolution and field of view angle. 
Changing the amount of units for each direction will not change the size of the 
grid, but rather, the size of the units. Hence, if an element is offset at 3 North, 4 
East, and you change the number of horizontal and vertical units from 24 to 12, 
the element will become offset twice as far from the centre as it originally was.

The third setting in this field determines the amount of units across the Z axis. 
This determines how far each unit will take an element further or closer to the 
camera when moved on the Z-axis. By default, the grid has 12 fields across the Z-
axis, which is half the amount of fields on the X and Y axes by default. Hence, 
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Parameter Description

each field on the Z-axis is worth exactly twice the length of a field on the 
horizontal axis. 

Animators who are familiar with traditional animation method will understand 
the default setting of 24 units horizontal by 24 units vertical as it corresponds to a 
traditional animation grid. 

Coordinates at Centre

The offset for the centre of the fields grid. The centre of the fields grid is where 
elements are positioned by default, when they themselves are at coordinates 0,0. 
To change the centre, you must enter its offset from the actual centre of the grid 
in fields. For example, if your fields grid is 24 x 24, and you want the centre to be 
at the top-left corner, you should enter -12,-12. 

Save
Saves your current Alignment settings and be able to select them later from the 
list.

TIP 

If you prefer working in pixel-based positions, you must set the aspect ratio of your units to be the 
same as the aspect ratio of your scene resolution, set the horizontal number of units to the  width of 
your scene in pixels, the vertical number of units to the height of your scene in pixels, and the 
depth number of units to the width of your scene in pixels. This way, each unit will translate to 
exactly 1 pixel, in all directions. 

NOTE 

Each layer also has an alignment rule, which determines how it is positioned relative to the fields 
grid. By default, it is set to "Centre First Page". However, this alignment rule is made to be 
compatible to 4:3 fields grids. Hence, if you change your scene's alignment rules, your layers will 
be offset. To avoid this issue, change the alignment rules of your layers to "Centre" via the 
Advanced tab of the Layer Properties view.

Drawing Resolution Tab

The drawing resolution tab is used to set the pixel density of bitmap drawings as well as of bitmap textures in 
textured brush strokes in vector drawings. Also, it is used to set the size of the canvas for bitmap drawings 
relative to the size of the scene. 

169

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

NOTE 

These settings are applied to newly created drawings in the scene, but not to existing drawings in 
your scene. To change the pixel density of existing vector drawings, you must select Drawing > 
Change Vector Drawing Brush Resolution from the top menu. To change the pixel density and 
canvas size of existing bitmap drawings, you must select Drawing > Change Bitmap Drawing 
Resolution from the top menu.

NOTE 

You can change the default drawing resolution settings for new scenes in the Drawing tab of the 
Preferences dialog. 

Parameter Description

Scene Resolution
This indicates the currently selected scene resolution preset and its dimensions in 
pixels. 

Default Texture Density for 
Vector Drawings

Pixel Density:Determines the amount of pixels to store in textured brush strokes 
for each pixel that displays when the drawing is not zoomed in or scaled up. For 
example, at 100%, zooming in or scaling up textured brush strokes will make 
them lose texture quality. If set to 200%, textured brush strokes can be zoomed in 
or scaled up until they're twice their original size without losing picture quality.

Default Canvas Size and Width: The default width of the canvas when creating drawings in a bitmap 
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Parameter Description

Pixel Density for Bitmap 
Drawings

drawing layer. The percentage is relative to the width of the scene. Its default 
value, 200%, makes the width of the canvas twice the width of the stage. 

Height: The default height of the canvas when creating drawings in a bitmap 
drawing layer. The percentage is relative to the height of the scene. Its default 
value, 200%, makes the height of the canvas twice the height of the stage.

Pixel Density: Determines the amount of pixels to store for each pixel that 
displays on the screen when the drawing is not zoomed in or scaled up. For 
example, at 100%, zooming in or scaling up a bitmap drawing will make it lose 
picture quality. If set to 200%, bitmap drawings can be zoomed in or scaled up 
until they're twice their original size without losing picture quality.

Colour

Parameter Description

Colour Space Management

Working Colour 
Space

The working colour space of a project is the one used internally by Harmony. It is also the 
default colour space used for decoding the colours in drawing layers as well as for exporting 
images and movies. However, those can be configured to be different from the project colour 
space if needed.

The following colour spaces are available in Harmony:

 l No Colour Space Management: No colour space conversion will be done in the entire 
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Parameter Description

project, even if you set the colour space for your drawing layers or for rendering your 
scene.

 l ACES2065-1: An ACES linear colour space that uses the AP0 colour primaries and is 
intended for image file interchange.

 l ACEScg: An ACES linear colour space that uses the AP1 colour primaries and is 
intended for CGI rendering and compositing.

 l Linear Rec.709 (sRGB): The colour space that uses the same primaries and white point 
as sRGB and Rec. 709, but with no gamma transfer curve applied to the colour values. 

 l Linear Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It has a 
complex gamma transfer curve and primaries that cover more of the human-
perceivable colour space than other colour spaces, especially in the area of human-
perceivable greens.  

 l Linear P3-D65: The same as Display P3, except with no gamma transfer curve. This 
colour space is useful for compositing intermediary images that are meant to be 
rendered in Display P3.

 l Display P3: A colour space commonly used for digital projection. It has the same 
primaries as DCI-P3, the same white point as sRGB and the same gamma transfer 
curve as sRGB.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and white point 
as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a gamma 
transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists because some 
editing systems use a gamma transfer curve of 2.4 instead of the standard gamma 
curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It has a complex 
gamma transfer curve and primaries that cover more of the human-perceivable colour 
space than other colour spaces, especially in the area of human-perceivable greens.

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple gamma 
transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists because some 
editing systems use a gamma transfer curve of 2.4 instead of the standard gamma 
curve for Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It has the same 
primaries and white point as Rec. 709, but has a different gamma transfer curve.

By default, your drawing layers are read in the same colour space as your project, and your 
rendered frames are created in the same colour space as your project as well. However, if the 
colour space for the project is different from the colour space used for drawing layers or from 
the colour space used for rendering your scene, the project colour space serves as the 
“intermediary” colour space. 

This means that, in the process of rendering your scene, your drawing layers are converted to 
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Parameter Description

the project’s colour space, after which they are composited together along with your scene’s 
visual effects, and finally the rendered image is converted to the colour space selected for 
rendering your scene.

Hence, from a compositing perspective, it is recommended to set your project’s workspace to 
the linear variant of the colour space used for your drawing layers and for rendering your 
scene. Working this way ensures that calculations made on the colour values for compositing 
visual elements effects are not affected by the colour space’s gamma curve.

Texture 
Swatches 
Colour Space

Colour space used for the Texture Swatches. The options are the same as above for the 
Working Colour Space.

Processing Bit 
Depth

Allows you to select either 16 bits or 32 bits per channel processing. The default value is 32 
bits.
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Scripts Manager Dialog Box
The Scripts Manager dialog allows you to create buttons in the Scripting toolbar. Each button you create can 
run a specific function in one of your scripts. You can also choose an icon and a tool tip for the button, if you 
want. 

NOTE 

For tasks related to this dialog box, see the User Guide.

How to access the Scripts Manager Dialog Box

 1. Add the Scripting toolbar to your workspace by doing one of the following:

 l In the top menu, select Windows > Toolbars > Scripting.

 l Right-click on any existing toolbar and select Scripting.

 2. In the Scripting toolbar, click on the  Manage Scripts  button.

The Scripts Manager dialog box opens.

Parameter Description

Files A list of the available JavaScript files.
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Functions A list of the available functions for the selected script.

In Toolbar The list of script functions already added to the Scripting toolbar. 

Execute

Runs the selected function.

TIP 

Press Esc to interrupt the execution of the script.

Customize Icon
Allows you to select an icon for the toolbar button. Clicking on this button will 
open an Open dialog prompting you to browse for and select a .png, .jpg, .xpm 
or .svg file.

Customize Tooltip Allows you to type in a custom tooltip for the toolbar button. 
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Select Colour Dialog Box
The Select Colour dialog box lets you set the colour of layers and columns.  Using colours for layers and 
columns helps to differentiate them visually, making them easy to identify. The colours you choose will be 
reflected in the Node view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the 
HSV or RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom 
colour that you can reuse.

How to access the Select Colour dialog box in the Timeline view

 1. In the Timeline view, click the Change Track Colour  button of the layer you want to modify. 

The Select Colour dialog box opens.

How to access the Select Colour dialog box in the Xsheet view

 1. In the Xsheet view, select one or more columns to modify.

 2. Right-click on the column’s header and select Colour > Change Columns Colour.

The Select Colour dialog box opens.

Parameter Description

Basic colours A basic set of colours to choose from.
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Custom colours
Displays the custom colours you previously stored using the Add to Custom 
Colours button.

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.

Value slider
Once you select a colour, you can drag the slider to change the intensity and see it 
previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness (value) 
of the colour.

Red, Green, Blue Lets you set the red, green and blue values.
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Selection Presets Dialog Box
As you're animating, you might find that you are constantly selecting the same pegs, drawing layers, bezier 
points on a deformation envelope, part of a character rig, etc. You can create a preset that automatically 
selects any defined element or group of elements.

How to access the Selection Presets dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l right-click on the empty space near the top of the interface  and from the quick-access menu 
selecting Scripting.

 l right-click on the empty space near the top of a view and from the quick-access menu 
selecting Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager 
window.

 3. In the Scripts Manager, in the Files section, select the file TB_SelectionPreset.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_SelectionPreset.

The Add script to toolbar button becomes active.
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 5. Click on the Add script to toolbar button.

The TB_SelectionPreset script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Scripting toolbar, click on the TB_SelectionPreset  button.

The Selection Presets window opens.

Parameter Description

Refresh Removes any highlighted zones from the Group column.

Add Selection Preset 

Opens the Save Selection As Preset dialog box. After entering a name for the 
new preset and clicking OK, a new Selection Preset is added to the Selection 
Presets list. Note: before clicking on the Add button, make a selection in your 
scene of the elements for which you wish to create a Selection Preset.

Delete Selection Preset Deletes the selected Selection Preset from the list.

Group
Double-click in this area, next to the  Selection Preset you wish to use, to select 
the elements defined by the preset.

Name Displays the name of the preset.
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Apply to Selection Selects the elements defined by the selected preset from the Name list.

Close Closes the Selection Presets window.
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Sequence Fill Dialog Box
The Sequence Fill dialog box lets you Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a cycle, and so on. The selection can be over 
one cell or a cell range in one column or more or an entire column or many entire columns.

How to access the Sequence Fill dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 2. Do one of the following:

 l From the top menu, select Animation > Cell > Sequence Fill. 

 l In the Timeline view, right-click and select Exposure > Sequence Fill.

 l In the Xsheet toolbar, click the Sequence Fill  button (you may have to customize 
the toolbar to display it).

 l Press Ctrl + M (Windows/Linux) or ⌘  + M (macOS)).

The Sequence Fill dialog box opens.
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Parameter Description

Starting Value The first number in the sequence.

Increment
Lets you type the number by which the drawing number will increase from frame 
to frame. For example, an increment of 1 gives you: 1-2-3-4; an increment of 2 
gives you: 1-3-5-7; and -2 gives you this: 8-6-4-2.

Hold The exposure holding value.

Cycle
Enable this option to cycle the values and enter the number of cycles in the Cycle 
field.

End Frame
Enable this option to stop the fill at a specific frame within the selection. Indicate 
the frame number in the End Frame field.

Padding
Enable this option to add a 0 padding before the drawing name. In the Padding 
field, enter as many hash symbols (#) as digit you want in your drawing name, 
including the value itself.

Add Key Exposure After
Inserts a key exposure on the frame following the last cell of the new fill 
selection. 
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Set Ease for Multiple Parameters Dialog Box
The Edit Set Ease for Multiple Parameters dialog box lets you apply ease to multiple functions and keyframes. 
You can display the function curve and modify the Bezier or Ease curve.

How to access the Set Ease for Multiple Parameters dialog box

 1. In the Timeline view, select a keyframe on one or more layers.

 2. Do one of the following:

 l In the Timeline view, right-click and select Set Ease For Multiple Parameters. 

 l In the Timeline toolbar, click the Set Ease For Multiple Parameters  button.

The Set Ease For Multiple Parameters dialog box opens.

Parameter Description

Filters

Motion

 

Motion: Applies the easing parameters to the selected Position X, Position Y, 
Position Z and 3D Path functions.

Rotation: Applies the easing parameters to the selected Angle functions.
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Parameter Description

Scale: Applies the easing parameters to the selected Scale functions.

Skew: Applies the easing parameters to the selected Skew functions.

Morphing: Applies the easing parameters to the selected Morphing Velocity 
functions. Note that it applies to the Morphing velocity function found in the Layer 
Properties window, not the basic morphing ease in the Tool Properties view.

Other: Applies the easing parameters to all the other the selected functions, such 
as all functions created to animate effect parameters.

Left and Right Time Ratio
Lets you type the percentage value corresponding to the length of time you want 
the easing to last. Stay between 0% and 100%. If you go beyond 100%, your 
motion will overshoot. 

Left and Right Value Ratio
Lets you type the percentage value of how strong you want the easing out to be. 
Stay between 0% and 100%. If you go beyond 100%, your motion will overshoot. 

Apply/Previous
Applies the easing parameters to the selected keyframes and then selects the 
previous keyframe in the timeline.

Apply Applies the easing parameters to the selected keyframes.

Apply/Next
Applies the easing parameters to the selected keyframes and then selects the 
next keyframe in the timeline.

Close
Close the dialog box. If you did not apply the modifications, they will be 
cancelled.
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Set Ease on Keyframes Dialog Box
The Set Ease on Keyframes dialog box allows you to quickly change the percentage of ease before and after a 
selection of keyframes. 

This dialog box is designed to quickly adjust the “time ratio” of the ease on your animations. To give you a 
better idea of its effect, select a keyframe and open the Set Ease for Multiple Paramters dialog box. This dialog 
box allows you to adjust the ease of your animations using Bezier handles. Moving the Bezier handle laterally 
changes the time ratio of the ease, and moving it vertically changes its value ratio.

How to access the Set Ease on Keyframes dialog box

 1. In the Timeline view, select one or several animation keyframes.

 2. In the Timeline toolbar, click on the  Set Ease on Selected Keyframes button.

The Set Ease on Keyframes dialog box appears.

Parameter Description

Ease In (left)

Allows you to adjust the ease left of the selected keyframes.

 l If the checkbox is unchecked, the ease left of the selected keyframes will be 
unchanged.
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Parameter Description

 l If the checkbox is checked, the ease left of the selected keyframes will be set to the 
percentage in the input-field right of the checkbox. 

Ease Out (right)

Allows you to adjust the ease right of the selected keyframes.

 l If the checkbox is unchecked, the ease right of the selected keyframes will be 
unchanged.

 l If the checkbox is checked, the ease right of the selected keyframes will be set to the 
percentage in the input-field right of the checkbox. 

OK Applies the selected changes and closes the dialog box.

Cancel Closes the dialog box without making any changes.
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Show Hidden Columns Dialog Box
The Show Hidden Columns dialog box lets you display all the columns contained in the exposure sheet. It can 
be used to hide individual columns.

How to access the Show Hidden Columns dialog box

 1. In the Xsheet view, do one of the following:

 l Click the thick grey line that represents a hidden column. 

 l Right-click on the column header and select Show Hidden Columns.

 l Press Alt + Shift + H.

The Show Hidden Columns dialog box opens.

Parameter Description
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Show Lets you select the hiddens columns to display in the Xsheet view.

Name Name of the drawing.

Type Indicates the column type such as column, timing, and expression.

Check Selects all columns.

Uncheck Deselects all selected columns.
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Sound Element Editor Dialog Box
When you double-click on a sound layer in the Timeline view, the Sound Element Editor appears.

How to access the Sound Element Editor dialog box

 1. Do one of the following:

 l In Xsheet view, select the Sound column.

 l In the Layer Properties view, select Sound Editor.

 l Double-click on a sound layer in the Timeline view.

Parameter Description

Mute/Unmute This button mutes and unmutes the sound layer during the scene play back.

Layer Name This field displays the layer's name.

Sound Editor This button opens the Sound editor.

Start Frame/End Frame These fields determine the start and end frame of the sound file.

Detect This button launches the automated lip-sync detection.
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Parameter Description

Map This button opens the Map Lip-sync dialog box.

Mouth Shapes
: This section shows the automated lip-sync detection during the scene play 
back. Click on the thumbnail image of each mouth to change the phoneme 
assigned to the current frame.
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OpenQuickTime Sound Options Dialog Box (GNU/Linux)
The OpenQuickTime Sound Options dialog box (titled MediaSettings) allows you to configure the audio 
compression settings when exporting a QuickTime movie on Linux. 

On GNU/Linux, Harmony uses the OpenQuickTime framework to export QuickTime movies. This framework 
uses its own user interfaces to allow you to configure the video and audio compression settings for a movie. 
Because OpenQuickTime only comes bundled with non-prorprietary codecs, its compression options are 
limited.

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on GNU/Linux.

How to access the OpenQuickTime Sound Options  dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the OpenQuickTime Sound Options  dialog box from the Export 
OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Sound Options button.

Parameter Description

codec

Lets you select a codec. By default, the following codecs will be available:

 l A-Law 2:1: This codec uses logarithms to compress audio data. The 
resulting audio stream requires half the disk space of uncompressed audio 
data, but is of noticeably lower quality.

 l IMA 4:1: This codec compresses audio data to require a quarter of the disk 
space required for uncompressed audio data. It is not supported by a lot of 
software.

 l Twos Complement - Little Endian PCM: A standard uncompressed audio 
codec. 

 l Twos Complement - Big Endian PCM: A legacy standard uncompressed 
audio codec. This codec may be compatible with older editing interfaces. 

 l (mu)-Law 2:1: Similarly to A-Law, this codec uses logarithms to 
compress audio data. The resulting audio stream requires half the disk 
space of uncompressed audio data, but is of noticeably lower quality.
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NOTE 

It is recommended to leave this option to its default value, Twos 
Complement - Little Endian PCM, as it is commonly used for storing 
uncompressed audio. Other encoding formats are likely to sacrifice audio 
quality for negligible savings in disk space.

Sample rate
The sample rate at which to export your scene's audio. The only available option 
is 22050 Hz, as it is the sample rate used internally by Harmony.
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QuickTime Sound Settings Dialog Box (Windows)
The Sound Settings dialog box allows you to set the audio compression settings when you want to export a 
QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Sound Settings dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.

 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).
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 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Sound Settings dialog box from the Export OpenGL 
Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.
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The QuickTime Movie Settings dialog box appears.

 5. In the Sound section, click Settings.

Parameter Description

Compressor

Allows you to select the compression algorithm to use the compress the movie's 
audio track. 

NOTE 

It is recommended to leave this setting to None, as other formats are likely 
to sacrifice audio quality for negligible savings in disk space.

Rate

Allows you to select the sample rate, or frequency, in which to export the audio 
track for the movie.

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 kHz. If 
you select a higher sample rate, your project's audio will be upsampled, 
which means it will take more disc space without increasing in quality. 

Size
Allows you to select the bit depth in which to encode the audio track. This 
determines the amount of precision to record each wavelength in the audio track. 
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Parameter Description

NOTE 

The standard bit depth is 16-bit. If you choose 8-bit, the amount of disk 
space the audio track of your movie file requires will be halved, but the 
audio quality will be significantly lower.

Use

Allows you to select whether to export the movie's audio track using the Mono or 
Stereo channel mode.

NOTE 

Stereo sound has a separate track for the left and right speakers, whereas 
mono sound only has a single audio track for all speakers. 
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QuickTime Standard Video Compression Settings Dialog Box 
(Windows)
The Standard Video Compression Settings dialog box allows you to configure the video compression settings 
when exporting a QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Standard Video Compression Settings dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Standard Video Compression Settings dialog box from 
the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

The QuickTime Movie Settings dialog box appears.

 5. In the Video section, click Settings.

Parameter Description

Compression Type
Allows you to select the codec to use to compress the video stream of your 
movie. It is recommended to use one of the following codecs, depending on your 
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Parameter Description

usage scenario:

 l H.264: A very effective lossy compression algorithm that is commonly 
supported by web browsers and most media players.

 l MPEG-4 Video: A very effective lossy compression algorithm that is 
commonly supported by media players, but less so by web browsers.

 l Animation: A high quality compression algorithm that is commonly used 
for media interchange and video editing. 

 l QuickTime ProRes Movie: A codec developed by Apple designed for 
high-quality editing in Final Cut Pro. In Harmony, The Apple ProRes 4444 
and 422 codecs are available on Windows, Linux and macOS as export 
formats.

NOTES 
 l On macOS, the Apple ProRes options from previous versions are 

still available for compatibility with scenes created in those 
versions. These export formats are labelled with “Legacy” in 
parentheses.

 l ProRes 4444 XQ is not supported prior to macOS Catalina (10.15)

TIPS 
 l You can export a video with transparency by selecting the Animation 

codec and setting the Depth setting to Millions of Colors+.

 l You can export a video with virtually lossless compression by selecting 
the Animation codec and setting Quality setting to Best.

Motion

Frame Rate
The amount of frames per second for the video stream. Leave this setting to 
Current to use your project's frame rate. 

Key Frames

Some codecs compress the video by recording a limited amount of keyframes, 
which are frames in which the entire picture is encoded, pixel by pixel and, in-
between, recording deltas, which are frames that are only defined by their 
difference with the previous frame. This significantly reduces the size of the movie 
file. However, the less keyframes a movie has, the more it is likely to encounter 
decoding errors, and the harder it is for players to scrub or jump to a specific time 
in the video. This option allows you to decide when keyframes are inserted in the 
video stream. 
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Parameter Description

Automatic: Lets the encoder decide when keyframes should be inserted.

Every ... frames:  Allows you to set the exact interval, in frames, at which 
keyframes should be inserted. 

All: Encodes every frame as a keyframe. This option will significantly impact file 
size, but will make it easier to scrub through the video without causing any 
rendering error. 

NOTE 

If you are using the H.264 codec, you must set the Key Frames option to All, 
or you will get an error message when you confirm the compression 
settings.

Frame Reordering
Encodes frames in a different order than the one at which they are meant to be 
displayed. This allows for more efficient compression, but may not be compatible 
with some players. 

Compressor

Depth

Allows you to set the colour depth for your video. A lower colour depth will 
reduce the size of the video stream but will have significant impacts on picture 
quality. 

TIP 

Set this to Millions of Colors+ if you want to export a video with 
transparency. 

Quality

Lets you choose a quality setting for the video compression. A higher quality 
setting will increase the size of the movie file, but will look better. A lower quality 
setting will reduce the size of the movie file, but will cause blurriness and 
compression artifacts to appear in the picture. 

Scan Mode / 
Interlaced

Allows you to choose between the following scan modes:

 l Interlaced: Frames are encoded starting with their odd-numbered 
scanlines, then their even-numbered scanlines.

 l Progressive: Frames are encoded whole, from the highest scanline to the 
lowest scanline. 
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Parameter Description

NOTE 

Some codecs will display a drop-down allowing you to select Interlaced or 
Progressive, while others will simply have an Interlaced checkbox. 

Aspect Ratio

Allows you to select one of the following aspect ratios:

 l 4:3: For output on standard definition displays. 

 l 16:9: For output to widescreen displays. 

Filter

When exporting with the PNG compression type, this determines the algorithm 
with which each pixel is encoded relative to other pixels. Leaving this option to 
Best will export in the most space-efficient filter, without compromising picture 
quality. Picking a filter may increase rendering speed a bit, at the expense of  some 
disk space.

Data Rate

Automatic Lets the encoder use the optimal bit rate for your compression settings. 

Restrict To

Allows you to specify the encoding bit rate. 

NOTE 

This setting will override other compression settings, so that the specified 
bit rate is respected. 

Optimized For

Optimize the encoding to be responsive depending on the intended viewing 
method:

 l CD/DVD-ROM: Optimizes the bit rate for a video that will be played using 
an optical disc player.

 l Download: Optimizes the bit rate for a file that is going to be 
downloaded, then viewed from the user's hard drive.

 l Streaming: Optimized the bit rate for a video that will be streamed from 
the web and played as the video is being downloaded. 
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Tint Offset/Blend  Dialog Box 
You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

How to access the Tint Offset/Blend dialog box

 1. From the Colour View  menu, select Palettes > Tint Panel or right-click and select Tint Panel.

The Blend/Offset Tint panel opens.

Parameter Description

Offset
Offsets the selected colours by the adjustments made using the HSB and RGB 
sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider 
to adjust the opacity of the selected colour. 

Blend

Blends the selected colours with the colour swatch in the top-right corner. Use 
the Amount slider to adjust the degree of blend. A blend of 100% turns the 
selected colours into the same colour as the swatch. Adjusting the HSB and RGB 
sliders affect the swatch colour, which in turn affects the selected colours on the 
left. Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just 
beneath to mix the Base and Tint colours by different amounts. This will affect 
the mixed swatch whether it is selected or not. Select either the Tint or Base 
swatch and use the HSB and RGB sliders to adjust its colour. This will affect the 
mixed swatch colour, which in turn affects the selected colours on the left.
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Timing Node

The Timing-nodes exist in a new category of nodes called “Timing” in the node-library. These nodes are used 
to either show a different render at the given frame, or to transform the content with a transformation from a 
different frame. The Timing-nodes exists as both Retime (for Images) and Retime Transformation (for 
transformations).

The Retime node takes an image input and output, and will provide the retimed transformation and render of 
that image.

The Retime Transformation node takes a transformation input and output, and will provide the retimed 
transformation.

How to access the Retime and Retime Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.

206



 l Retime Mode: Defines the way in which this node calculates the target frame to output.

 l Target Frame: It will use the Value attribute as an exact frame and outputs the content from 
that frame.

 l Frame Offset: It will use the Value attribute as an offset to the current frame and outputs 
the content from that offset frame.

 l Value: It provides the target frame or offset frame, depending on the retime mode.

 l Hold First Frame: This defines the node’s render behaviour. In the event that the retimed frame is 
less than 1 When enabled, the hold first frame option will cause the node to display the first frame 
until the Retime node hits a valid frame above 1. When disabled, the node will remain blank until a 
valid retimed frame is reached.

 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Toolbar Manager Dialog Box
The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite 
tools to a toolbar for an efficient workflow.

How to access the Toolbar Manager dialog box

 1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if 
you right-click on a disabled icon.

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.

Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar with its default items.
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Vectorization Parameters Dialog Box
The Vectorization Parameters dialog box lets you vectorize pencil drawings, along with any red, blue or green 
pencil marks you may have used to indicate highlights and shadows. The drawing will be vectorized into pure 
red, blue, green and black (RGB values), while creating colour art zones wherever lines connect. After painting 
in your tones and highlights, change your pure RGB colours to transparent (0 Alpha) in the Colour Picker 
window and watch the indicator colour zone lines disappear.

How to open the Vectorization Parameters dialog box

 1. From the top menu, select File > Import > From Scanner.
You can also open it from any other import option that allows you to customize the vectorization 
parameters (i.e. from the scanner).

 2. In the Scan Drawings window, do the following:

 l In the Layer section, decide on the layer options.

 l In the Import Options section, select the Convert to Toon Boom Vector Drawing 
option

 l Click Preview.

 3. In the Vectorization section, click the Vectorization Parameters button.
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Options Tab

The Options tab contains the main vectorization settings. More settings are available in the Help tab.

Parameter Description

Input The input filters are applied to the bitmap image before it is vectorized.

One Pass
One threshold value is applied to both the Line and Colour Art. For drawings with 
distinct vector-style lines of mattes, you only need one pass.

Two Passes
Applies a different threshold value to each layer. For greyscale drawings, you 
may want to perform the vectorization process twice to apply different threshold 
values to the Line and Colour Art layers.

Threshold
Determines which values in the scanned image are considered part of the Line 
and Colour Art layer and what will be eliminated from the vectorized drawing; 
0% is white and 100% is black. The threshold is between these two values.

Expand Bitmap
Lets you enter a value to scale the bitmap to detect small variations in the line. 
Use this option if you scanned a greyscale image and want to preserve small 
variations in the texture to apply to the line art.

Jag Filter
Lets you enter a value to scale back the bitmap to remove some of the line’s 
roughness. This is useless when you have a drawing that appears quite rough; the 
Jag filter will eliminate excess strokes in the final drawing.

Line Art Threshold 
(%)

Determines which values in the scanned image are considered part of the Line Art 
layer and what will be eliminated from the vectorized drawing; 0% is white and 
100% is black. The threshold is between these two values.
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Colour Art Threshold 
(%)

Determines which values in the scanned image are considered part of the Colour 
Art layer and what will be eliminated from the vectorized drawing; 0% is white 
and 100% is black. The threshold is between these two values.

Output The output filters are applied during the vectorization process.

No Colour Art Does not generate filling zones in the Colour Art layer.

No Texture
Does not generate texture in the Line Art layer in the final images. Select this 
option to create solid lines in the final line art.

Generate Matte in 
Underlay Layer

Creates an opaque zone behind your drawing’s lines to avoid seeing through the 
layers.

Colour as Texture Converts colour values into a texture layer.

Optical Registration
The optical registration options are used to automatically align drawings based 
on the position of the peg holes on the animation paper. The peg holes must 
appear in the scanned drawings for the optical registration to work.

DPI
Lets you enter the dots-per-inch value of your image. You must enter the same 
value as the DPI used to scan the image.

Peg Side
Lets you select the position of the peg holes on your drawings. Identify whether 
they are on the top, bottom, left or right.

Strictness

Determines how exact the location of the peg holes must be for the software to 
recognize them. There are two values to choose from:

Strict: The peg holes must be in a tightly defined area to be recognized.

Loose: The peg holes can be recognized somewhere in a larger area. This is the 
recommended setting.

Field Chart Lets you indicate the size of the animation paper, 12 or 16.

Post Processing The Post Processing filters are applied to the final vector images.

Remove Holes Removes holes of a specified value that might make painting difficult.

Remove Dirt Removes stray marks and dirt of a specified value. Try a value around 500.
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Remove Hair Size Removes small strokes that have no line art.

Remove Hair: 
Number of Passes

The number of times the drawing will be analyzed to identify hair marks.

Miscellaneous

Close Gaps Closes gaps in the Colour Art so you can paint it.

Smooth Passes for 
Line Art Before 
Breaking Triangles

The number of times the smoothing operation runs before creating the triangles 
that break lines in the drawing. If unnecessary triangles are appearing in the 
drawing, increase this value.

Smooth Passes for 
Line Art

The number of times the smoothing operation is performed after the triangles 
have been created. This further smooths the line art.

Preview

Show Strokes Shows the strokes in the Vectorized Image panel.

Stroke Thickness Shows the size of the strokes.

Help Tab

The Help tab contains the most advanced vectorization settings which you type in the Advanced Option fields 
at the bottom of the Vectorization Parameters dialog box.

File IO Options

-file <filename (including extension)> [ options ]
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-infile <filename (including extension)>; same as -file

-outfile <filename>; alternate output file

-informat <format>; the input format. Used if reading from stdin

-debug; turn on debug mode

-noforce; don't force output if image is inconsistent

-version; print version information and quit

-output_version <version>; output files of this version. Valid versions can be: 0 or 604

-force_unamed_palette_for_texture; will generate a texture in TVG's internal palette

Registration Options 

-register <dpi side strictness>; perform optical registration.

• Side can be one of left, right, top, bottom or l, r, t, b.

• Strictness can be either loose, strict or l, s.

-register_center_peg_holes; will use only round holes in 16 fields page

-rcph; short form of register_center_peg_holes

-registration_looseness_factor <factor>; registration looseness factor (default 2.000000)

-rlf; short form of registration_looseness_factor

-rdebug; output registration debug messages

-pegpitch <inch (default 8.000000)>; distance between peg bars

-threshr < (default 0.500000)>; threshold for optical registration; range 0.0 to 1.0

-rmargin <inch (default 1)>; region size where to look for peg bars 

-peg_distance_from_center <inch (default 5.25)>; peg distance from centre of the image 

-pdfc; short form of -peg_distance_from_center 

-out_peg_position <side (default same)>; wanted position of the peg on the drawing.

• Can be one of right, left, top, bottom (or r, l, t, b) or same.

• A rotation will be performed if it is different from the side passed to -register.

-output_peg_matrix; output the peg transformation matrix on standard output.

-scanner_calibrate; < (default 1.0000 1.0000) > x and y scale factors to be applied to scanner image.

Filtering Options 

-pixel <pixel_shape (default '4x3')>; Valid values: 4x3
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-gap <worldUnits (default 10)>; close gaps up to this big

-pencil; generate line art only

-keep_dirt; don't filter out dirt

-thresh <threshold (default 0.2)>; range 0.0 to 1.0

-rmv_hairs <worldUnits (default 1)> <passes (default 1)> 

• remove hairs of size smaller than "size" in "passes" passes 

-rmv_holes <area (default 7)>; remove holes smaller than "area" 

-rmv_dirt <area (default 1)>; remove dirt smaller than "area" 

• try values between 100 and 500 for rmv_holes and rmv_dirt. The area is in world units squared

-rmv_triangles <worldUnits (default 30.000000)>; remove triangles at "pixels" 

• distance from each other. Use -no_break to remove all triangles

-no_texture; don't generate textured strokes

-color_as_texture; will vectorize the alpha channel and put the RGB colour in a textured colour

-noclosegap; disable all gap closing algorithms

-no_break; disable the breaking of line art

-jag_filter <pixels (default 0>; expand the pixels in the vectorization bitmap

-expand_bitmap <pixels (default 0>; expand the pixels in the vectorization bitmap

-fit_errorc <error (default 1.000000>; fitting error for the colour art

-fit_errorl <error (default 1.000000>; fitting error for the line art

-smoothl <passes (default 1>; number of smooth passes for line art

-smoothc <passes (default 1>; number of smooth passes for colour art

-first_smooth <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothl <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothc <passes (default 0>; number of smooth passes for line art in colour art pass (needs -2pass)

-2pass; specify two sets of parameters; one for line art "l", one for colour art "c"

(-thresh, -rmv_holes and -rmv_dirt will be overridden by -threshl, threshc, -rmv_holesl,

-rmv_holesc, -rmv_dirtl and -rmv_dirtc)

-threshl <threshold for line art (default 0.5)>; range 0.0 to 1.0

-threshc <threshold for color art (default 0.5)>; range 0.0 to 1.0

-jag_filterl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art
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-jag_filterc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-expand_bitmapl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-expand_bitmapc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-rmv_holesl <area (default 7)>; remove line art holes smaller than "area" 

-rmv_holesc <area (default 7)>; remove colour art holes smaller than "area" 

-rmv_dirtl <area (default 1)>; remove line art dirt smaller than "area" 

-rmv_dirtc <area (default 1)>; remove colour art dirt smaller than "area" 

try values between 100 and 500 for rmv_holesl, rmv_holesc, rmv_dirtl and rmv_dirtc. The values are in 
world units squared 

-margins <inch (default 0.25)>; remove margin around bitmap 

-top_margin <inch (default 0.25)>; remove margin at top of bitmap 

-bottom_margin <inch (default 0.25)>; remove margin at bottom of bitmap 

-left_margin <inch (default 0.25)>; remove margin at left of bitmap 

-right_margin <inch (default 0.25)>; remove margin at right of bitmap 

-remove_peg_bars; remove the peg bar holes

-field_size <fields (default 12 or use value in scan file)>; set the drawing to this field size

-fs; short hand for -field_size

-peg_bar_size <inch (default 1)>; the size of the peg bar region

-noframe; do not put a frame around the colour art

-frame_fields <default -1.000000>; put a frame of the specified dimension around the colour art

-downscale_input <default 1>; downscale the raw input by this integer factor

-downscale_texture <default 1>; downscale the output texture by this integer factor

-buildmatte; generate a matte on underlay for line test

-buildmatte_colourart; generate a matte on colour art for line test

NOTE 

-buildmatte and -buildmatte_colourart are mutually exclusive

-copystrokes; copy original strokes when building matte.

Options for bitmap that has no registration information 

-pixel_margins <inch (default 0)>; remove margin around bitmap 
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-top_pixel_margin <inch (default 0)>; remove margin at top of bitmap 

-bottom_pixel_margin <inch (default 0)>; remove margin at bottom of bitmap 

-left_pixel_margin <inch (default 0)>; remove margin at left of bitmap 

-right_pixel_margin <inch (default 0)>; remove margin at right of bitmap 

-dpi <(default -1)>; dpi information of input bitmap 

RGB Keying Options 

-rgb; generate separate zones for red, green and blue lines

-rgb_alpha <value (default 255)>; generate red, green and blue colour with alpha of this value

-no_red; ignore red colour in vectorization

-no_green; ignore green colour in vectorization

-no_blue; ignore blue colour in vectorization

-flatten; flatten the drawing after generating colours

-rmv_rgb_dirt <threshold area default 0.0>; remove red, green and blue regions smaller than area

-expand_bitmap_rgb <pixels (default 0>; expand the pixels in the vectorization bitmap for rgb

-threshrgb <value> <threshold for rgb vectorization default 0.200000>;

-threshsv <saturation threshold default 0.500000> <value threshold default 0.500000>; thresholds on 
saturation and value to consider a pixel to be grey

Colour Vectorization Options 

-color_vectorize; perform a colour vectorization

-file2 <colour art filename>; specify the colour art bitmap

-penstyle <center alpha (0.0-20.0)> <edge alpha (0.0-20.0)> <gamma (0-10)><centre pressure effect (0.0-
1.0)> <edge pressure effect (0.0-1.0)><texture bitmap downscaling (0.2-20)> <texture bitmap file (valid 
filename or "" if no file)>; generate brush texture for the line art

-pressure_variation <strategy (0, 1 or 2)> <min pressure (0.0-1.0)> <max pressure (0.0-1.0)> <max variation 
(0.0-1.0)>; specify a pressure strategy for the centre line. 

-blur_radius <pixels (default 0)>; blur the penstyle texture generated

-color_contour_smooth_passes <times (default 3)>; perform number of smooth passes on contour before 
computing texture

-ccsp <times (default 3)>; short for -color_contour_smooth_passes

-color_rmv_holesl <world units (default 0.000000)>; remove holes of this size when computing texture

-color_fill_holesl <world units (default 0.000000)>; fill holes of this size for colour line art
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Bubble Usage (implemented only for colour vectorization's line art)

-create_bubbles; add bubbles into the LineArt. Implemented for colour vectorization only 

-bubble_gap <value (default 3)>; max number of colour art points between 2 bubbles

-bubble_length <value (default 10)>; max number of circles in a bubble

-min_radius <value (default 1.5000)>; min radius of a circle in a bubble relative to the line thickness (must be 
>= 1.0)

-max_radius <value (default 3.5000)>; max radius of a circle in a bubble relative to the line thickness (must be 
>= 1.0)

-uniform_gap; the space between bubbles is constant 

4 Colour Vectorization

-4colours [key:value] ... [key:value] ; The key value list can be empty. The list of keys is:

rgbdiff:value ; between [0.0-1.0] or [0-255]

dark:value    ; between [0.0-1.0] or [0-255]

grey:value    ; between [0.0-1.0] or [0-255]

white:value   ; between [0.0-1.0] or [0-255]

dirt:value    ; dirt area. 200 is a good value

rt:value      ; between [0.0-1.0] or [0-255]

gt:value      ; between [0.0-1.0] or [0-255]

bt:value      ; between [0.0-1.0] or [0-255]

NOTE 

There must be no space between the colon and the key/value. For example: -4colours rgbdiff:20 
dark:20 grey:120 white:250 dirt:200 rt:240 gt:240 bt:240
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Versions Dialog Box
The Versions window lets you delete any unnecessary versions of scenes when working with Harmony 
Server. When working with multiple versions of a scene, you may to clean up the database by deleting the 
ones you no longer need.

How to access the Versions window

 1. Make sure you have the necessary rights. If you do not, select File > Rights to Modify Scene. 

 2. Select File > Manage Versions. 

Parameter Description

Existing Versions Displays the different versions of a scene that you can delete.

Description Displays information about the selected version.

Delete

Removes the selected version of a scene. 

IMPORTANT 

This operation cannot be undone.
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OpenQuickTime Video Options Dialog Box (GNU/Linux)
The OpenQuickTime Video Options dialog box (titled MediaSettings) allows you to configure the video 
compression settings when exporting a QuickTime movie on Linux. 

On GNU/Linux, Harmony uses the OpenQuickTime framework to export QuickTime movies. This framework 
uses its own user interfaces to allow you to configure the video and audio compression settings for a movie. 
Because OpenQuickTime only comes bundled with non-prorprietary codecs, its compression options are 
limited.

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on macOS.

How to access the OpenQuickTime Video Options  dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.

219

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the OpenQuickTime Video Options  dialog box from the Export 
OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Video Options button.

Parameter Description

codec

Allows you to select a video compression algorithm. By default, the following 
codecs are available:

 l Motion-JPEG A: A very portable codec that performs lossy JPEG 
compression and interlaces the frames. Motion-JPEG A compression is 
less efficient than Photo JPEG in terms of quality and file size, but may be 
a more portable alternative for software that does not support Photo 
JPEG. 

 l Photo JPEG: Encodes the movie as a sequence of JPEG images. JPEG 
images have lossy compression. This is the most efficient codec for file 
size. 

 l Portable Network Graphics (PNG): Encodes the movie as a sequence of 
PNG images. PNG images have lossless compression.

 l Tag Image File Format (TIFF): Encodes the movie as a sequence of 
uncompressed TIFF images. This codec is lossless. 

 l Uncompressed (RGB): Encodes the movie as uncompressed bitmap data. 
This codec is lossless. 
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NOTE 

Portable Network Graphics (PNG) and Photo JPEG are the only codecs in 
this list that are natively supported by both Harmonyand GNOME's Totem 
Video Player. Other codecs may require additional software to play on 
GNU/Linux workstations. 

quality
When using a JPEG-based codec, this allows you to set the JPEG compression 
quality. By default, this will be set to 85. Possible values range from 0 to 100. The 
higher the quality, the more disk space the resulting video file will take.

fieldDominance

For codecs with interlacing. This is set to 1 by default. If set to 1, the first field will 
be encoded on odd frames, and the second field will be encoded on even frames. 
If set to 2, the first field will be encoded on even frames, and the second field will 
be encoded on odd frames.

compression
The amount of lossless compression to perform when exporting in PNG format. 
PNG compression is lossless, but higher compression settings will take longer to 
encode and decode.

packbits
For movies encoded in TIFF. When enabled, this option adds extra lossless 
compression to the encoding.

lendian
For movies encoded in TIFF. When enabled, the video data is encoded in little 
endian byte order, instead of big endian. 
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Windows Media Video Settings Dialog Box (Windows)
The WMV Settings dialog box allows you to configure the video and audio settings when exporting a movie in 
Windows Media Video (.wmv) format. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows.

How to access the WMV Options dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.

 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

223

Harmony 24 Advanced Reference Guide                          



Chapter 1: Dialog Boxes

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the WMV Options dialog box from the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select Windows Media Video (*.wmv).

 4. Click on the Movie Options button.
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Parameter Description

Video

Variable Bit Rate 
Quality

Allows you choose a quality setting ranging from 5 to 100 for the video stream. 
The higher the quality of the export, the larger the resulting file.

Sound

Uncheck this checkbox if you want to export a movie without an audio track.

NOTE 

The Sound section of this dialog is not available if you are exporting an 
EDL/AAF/XML sequence, as this type of export creates video files with no 
audio track and export sound clips in separate sound files. 

Profile

Allows you to select one of the preset combinations of audio sample rates, 
sample sizes and channel modes for the audio stream:

 l Sample rate: Available sample rates are 8000 Hz, 16000 Hz, 22050 Hz 
and 44100 Hz. The higher the sample rate, the better the audio quality. 

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 
kHz. If you select a higher sample rate, your project's audio will be 
upsampled, which means it will take more disc space without 
increasing in quality. 

 l Sample size: Also known as bit depth, this determines the amount of 
precision used to record each wavelength in the audio track. The standard 
size is 16-bit. If you choose 8-bit, the amount of disk space the audio track 
of your movie file requires is halved, but the audio quality will be 
significantly lower.

NOTE 

Exporting in 8-bit audio requires Apple QuickTime to be installed. 

 l Channel mode:  Available channel modes are Stereo and Mono. Stereo 
sound has a separate audio track for the left and the right speakers, 
whereas mono sound uses a single track for all speakers.
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Xsheet Column Width Dialog Box
The Xsheet Column Width dialog box lets modify the width of a column in the Xsheet view and use it as the 
default column width.

How to access the Xsheet Column Width Dialog Box

 1. In the Xsheet view, select a column.

 2. From the Xsheet menu, select View > Set Columns Width.

The Xsheet Column Width dialog box opens.

Parameter Description

Columns Width (pixels) Lets you set the width of the selected columns (in pixels).

Apply
Applies the value you entered to the selected column without closing the dialog 
box.

Set As Default Uses the value you entered as the default for all columns in the Xsheet.
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Chapter 2: Menus
The Menus section covers all the menu entries available in Harmony. There are several types of menus in 
Harmony: main menus, quick-access menus and view menus. Menus contains most of the functions available. 
They may also have a toolbar button or keyboard shortcut equivalent.

Main Menus 229

Animation Menu 230

Drawing Menu 238

Edit Menu 247

File Menu 251

Help Menu 254

Insert Menu 256

Play Menu 258

Scene Menu 260

View Menu 262

Windows Menu 269

View Menus 271

Camera View Menu 272

Colour View Menu 289

Drawing View Menu 292

Function View Menu 305

Library View Menu 307

Reference View Menu 309

Onion Skin View Menu 311

Perspective View Menu 313

Script Editor View Menu 319

Side View Menu 324

Timeline View Menu 329

Top View Menu 334

Xsheet View Menu 339
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Main Menus
The top menu contains most of the commands available in Harmony. Depending on the view you're working in 
and the selected element, some commands are available and others not. The top menu is always located at 
the very top of the interface.

On macOS, there is also a Harmony Advanced category that contains the following commands: Preferences, 
About, and Quit.

Animation Menu 230

Drawing Menu 238

Edit Menu 247

File Menu 251

Help Menu 254

Insert Menu 256

Play Menu 258

Scene Menu 260

View Menu 262

Windows Menu 269
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Animation Menu

The Animation menu lets you access tools, adjust animation timing, set morphing and  parameters, lock or 
unlock layers, and select elements in the Xsheet and Timeline views.

How to access the Animation menu

 l At the top of the interface, select Animation.

Command Description

Animate

Animate Current Frame

When this option is selected, every time you use the  Transform or 
 Advanced Animation tools to manipulate an element 

in your scene, the position of the element will be stored in a keyframe 
at the current frame. This allows you to animate elements in your 
scene without creating keyframes manually.

Animate Onion Skin Range

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformations to an 

element in your scene, the transformations will be stored as keyframes 
at the beginning and at the end of the current Onion Skin range, as 
well as on every existing keyframe in-between. This can be useful if 
you want to reposition an element that you have already animated, but 
only during a specific range of frames, which you can define by 
enabling Onion Skin and setting the Onion Skin range to cover that 
range of frames.

Animate Off

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformation to an 

element in your scene, the transformations will affect the element 
throughout the whole scene. This can be useful if you want to 
reposition an element after you have already animated it. 

Stop-Motion Keyframe

Converts the selected keyframes to stop-motion keyframes. Between 
a stop-motion keyframe and the next keyframe, Harmonydoes not 
generate any animation and the element remains static until the next 
keyframe. 

Delete Keyframe Deletes the selected keyframes.
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Tools

Transform
Allows you to select drawing layers and position, rotate, scale and 
skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an 
object up to make it larger or down to make it smaller. Press Shift to 
scale the element while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you 
move them towards or away from the camera.

Spline Offset

Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 
fields. If your elements were drawn in a different location than the 
centre of the drawing area, it will look like the trajectory is not aligned 
with your drawing. Also, if you have several elements attached to one 
trajectory, you might want your trajectory to be at a different location 
to represent the group's motion better.

Cell

Increase Exposure

Adds one more exposure to a selected cell; repeating this action adds 
an extra cell each time. This is an efficient way to extend a drawing's 
exposure and is always set in Insert mode. Increasing an exposure 
pushes the existing exposure forward.

Decrease Exposure

Decreases exposure of a selected cell by one; repeating this action 
decreases one exposure adds an extra cell each time. This is an 
efficient way to shorten a drawing's exposure. Decreasing an exposure 
pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure Lets you enter the frame up to which you want to extend the exposure. 
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You can expose the drawing in the frames and replace the drawings 
that were originally there or move the subsequent frames forward in 
time. 

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure Removes key exposures from the selected cells.

Remove Duplicate Key Exposure

When working with drawings to adjust the timing of a mouth in a 
lipsync, for example, and forcing the use of specific key exposures, 
unnecessary key exposures will be created. You can delete these 
duplicates without affecting the rest of the drawing. The first drawing 
of the selection will be used for the range.

NOTE 

Duplicate key exposures may occur when pasting with the 
Enforce Key Exposure option selected.

Fill Empty Cells

Fills the empty frames in the selection with the exposure just before. 
For example, if you select a range of frame that starts with an exposed 
drawing and then ends with empty cells, all of the empty cells in the 
selection will be filled with the exposed drawing just before the empty 
cells. 

Insert Blank Cell Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and Pull
Replaces the exposure from the selected cell with exposures that 
follow it.

Fill Selection

Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many 
columns, an entire column, or many columns. You can use numbers, 
words, letters, or any alphanumeric value.

Sequence Fill

Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a 
cycle, and so on. The selection can be over one cell or a cell range in 
one column or more or an entire column or many entire columns.
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Fill Cells Randomly

Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to 
choose the random values from. The selection can be over one cell or a 
cell range in one column or more or an entire column or many entire 
columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Morphing

Create Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the 
current layer. 

Insert Morphing Key Drawing Creates a morphing keyframe from a selected morphing frame.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire 
sequence between the two keyframes.

Convert Morphing to Drawing

Lets you convert your morphing inbetweens to real drawings you can 
edit. This is useful when manually editing a morphing sequence or if 
you prefer to have animation timing in double frame (on twos) instead 
of single frame (on ones). 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; 
in other words, on Contour vectors. It allows you to control the line 
thickness and contour position. Also, if a contour is not animated 
correctly, you can use hints to correct the animation. For example, if a 
flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough 
away from the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity 
rule. The Zone Hint is placed in the centre of the colour zone. 
Sometimes a colour zone is not associated with the corresponding one 
by default. For example, in a splash animation there are many water 
droplets that are the same colour. Harmony automatically morphs the 
droplet to the nearest one. This is not always the one you may have 
predicted. A Zone Hint will force a colour zone to morph with another 
one.

Zone Hint points are cyan in colour.
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Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as 
central vector. It can be used on drawings that were done using the 
Pencil, Polyline, Ellipse, Line and Rectangle tools. Like the Contour 
Hint, the Pencil Hint snaps to the central vector. Make sure to place it 
far enough away from the line so you will see it snap when you move 
it.

Pencil Hint points are magenta in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an 
appearing shape. A shape will appear in the destination drawing when 
there is no corresponding shape in the source drawing. If you do not 
place an Appearing Point Hint to control the point of appearance, the 
shape will appear from its centre and expand outwards.

Appearing Point Hint points are violet in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing 
shape. A shape will vanish from the source drawing when there is no 
corresponding shape in the destination drawing. If you do not place a 
Vanishing Point Hint to control the point of disappearance, the shape 
will vanish into its centre.

Vanishing Point Hint points are green in colour.

Switch Between Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. 
This option is useful while setting hints. You can use the default 
keyboard shortcut F4 to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame
Goes to the previous frame of the selected frame in the morphing 
sequence.

Go to Next Frame
Goes to the next frame of the selected frame in the morphing 
sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest Hints
Automatically sets hint points on key drawings as a help tool. If you're 
not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints Temporarily hides the hint points from the key drawings. Use this 
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option when you have a series of hint points hiding some lines you 
would like to see.

Lip-Sync

Change Mouth Shape to
Lets you change the mouth shape to one of the following: A, B, C, D, E, 
F, G, X.

Auto Lip-Sync Detection Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps drawings in an element to the mouth chart you 
have generated for a sound. This can save time when you are lip-
synching a voice track.

Flip

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Flip Scale X

Once your drawing layer is rotated, the original horizontal and vertical 
axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original 
X-axis of the layer and flips the element following it.

Flip Scale Y
Remembers the original Y-axis of the layer and flips the element 
following it.

Linear Motion Switches between a linear and curved corner.

Lock in Time

Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it 
freely as other points are being added, moved, or adjusted (control 
point).

No Z Dragging
Keeps the Z value constant when you drag a character using the 
Transform or Translate tool.

Substitute Drawing Previous
Replaces the drawing or cell's symbol on the current frame by the 
previous drawing.
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Substitute Drawing Next
Replaces the drawing or cell's symbol on the current frame by the next 
drawing.

Go to Previous Keyframe Goes to the previous keyframe.

Go to Next Keyframe Goes to the next keyframe.

Select Previous Keyframe /Point Select the previous keyframe/point.

Select Next Keyframe /Point Select the next keyframe/point.

Select Child
Lets you select the first element parented to the selected peg element 
in the Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in 
the Timeline view.

Select Parent
Lets you select the parent of the selected element in the Timeline 
view.

Select Previous Sibling
Lets you select the previous element (above current element) in the 
Timeline view.

Select Next Sibling
Lets you select the next element (below current element) in the 
Timeline view.

Lock

Lock Locks one or a multiple selection of layers. 

Unlock Unlocks one or a multiple selection of locked layers.

Lock All Locks all the layers in the Timeline view. 

Unlock All Unlocks all the layers in the Timeline view. 

Lock All Others Locks every layer except the selected ones.

Reset Returns the value of the selected element to the initial value of the 
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active tool. For example, if the Rotate  tool is active, the transformation 
angle will be reset to 0 and if the Transform  tool is active, all the 
transformation values will be reset.

Reset All
Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting 
value. All transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often 
have a particular Z ordering for the different views of a character. You 
might want to reset the transformation, but not necessarily the Z 
position. 
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Drawing Menu

The Drawing menu lets you access many tools related to drawing, painting, dirt removal, optimizing strokes, 
and more.

How to access the Drawing menu

 l At the top of the interface, select Drawing.

Command Description

Drawing Tools Allows you to select one of the drawing tools available in Harmony.

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil 
lines, shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes in 
your artwork. You can add, remove, tweak and move vector points, move the 
Bezier handles of the vector points as well as  deform vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Allows you to adjust the thickness of a pencil line at its different points and 
corners, tweak the shape of its extremities and scale its texture.

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate and skew 
it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making 
them easier to edit. 

Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope
Allows you to deform and warp artwork by moving points and tweaking lines in a 
grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

238



Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want 
its location to be.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central 
vector lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking 
to create each point in the sequence of line segments. 

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush   Like the Brush tool, but only paints over existing brush strokes. 

Close Gap Allows you to close open shapes so that they can be filled with the Paint tool. By 
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drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.

Stroke
Allows you to create invisible lines that can serve as colour zones that can be 
filled, or close the gaps in existing colour zones.

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and textures in a 
colour zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like with a real animation 
disc.

Shift and Trace
Allows you to temporarily move drawings so you can trace over them in other 
drawings using Onion Skin. 

Clean Up

Remove Dirt
Opens the Remove Dirt dialog box where you can specify the number and size of 
dots removal from a selected drawing.

Remove Hair

Opens the Remove Hair dialog box where you can specify the number and length 
of hairs for removal from a selected drawing. This removes any small strokes 
created in the Colour Art layer from very thick lines or filled zones. Increase the 
value to select larger strokes for removal from the drawing. 

Close Gaps

Closes small gaps in a drawing by creating small, invisible strokes between the 
two closest points to close the colour zone. You do not need to trace directly over 
the gap. You can draw it a few millimeters away. The two closest points 
automatically close the gap.

Remove Art Inside 
Selection

Removes any art inside a selection. It is recommended that you clean your Colour 
Art level as well. If you have a stroke accumulation in the Colour Art, it can result 
in large output files, especially if you work in high definition resolutions. 

Remove Art Inside 
Selection on All 
Drawings

Removes any art inside all drawings selected with the Permanent Selection  
option in the Select tool.
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Remove Art Outside 
Selection

Removes any art existing outside a selection. It is recommended that you clean 
the Colour Art level as well. If you have a stroke accumulation in the Colour Art, it 
can result in large output files, especially if you work in high-definition 
resolutions.

Remove Art Outside 
Selection on All 
Drawings

Removes any art outside all drawings selected with the Permanent Selection  
option in the Select tool.

Paint

NOTE 

The Paint commands require you to use the Permanent Selection option in the Select tool so you can maintain a 
selection over multiple drawings.

Unpaint Selection Unpaints any art existing inside a selection. 

Unpaint Selection on 
All Drawings

Unpaints all art contained inside a selection on all the drawings within the same 
layer.

Unpaint Outside 
Selection

Unpaints any art existing outside a selection. If no selection have been drawn 
using the Select tool, the entire drawing will be unpainted.

Unpaint Outside 
Selection on All 
Drawings

Unpaints all art outside a selection on all the drawings within the same layer. 

Repaint Selection Repaints any art inside a selection.

Repaint Selection on 
All Drawings

Repaints any art inside a selection on all the drawings contained within the same 
layer. 

Repaint Outside 
Selection

Repaints any art outside a selection. If no selection has been drawn using the 
Select tool, the entire drawing will be repainted.

Repaint Outside 
Selection on All 
Drawings

Repaints any art outside a selection on all the drawings contained within the 
same layer. 
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Convert

Pencil Lines to Brush 
Strokes

Converts the selected centreline pencil strokes into contour strokes brush lines.

Brush Strokes to 
Pencil Lines

Converts selected contour strokes into centreline pencil strokes. The brush stroke 
thickness will be lost.

Strokes to Pencil 
Lines

Converts the selected invisible line to a pencil line.

Break Apart Text 
Layers

Text is treated as a single drawing object. This separates the text so each 
character becomes an individual drawing object you can select and modify 
independently.

Optimize

Flatten

Merges drawing objects and brush strokes into a single layer. If you draw new 
lines to fix a drawing or line with many brush strokes, it can be useful to flatten 
them all into a single shape. By default, lines are drawn one on top of each other. 
If you intend to repaint the lines or modify their shape, it will be easier if they are 
flattened. 

Smooth Smooths selected drawing strokes and removes extra points.

Create Contour 
Strokes

Adds a permanent invisible line around a shape that was drawn directly in 
Harmony. This allows you to unpaint lines with the Paint  tool but maintain the 
shape of the lines, should you need to repaint later.

Remove Contour 
Strokes

Remove any permanently invisible lines that were created while scanning and 
vectorizing drawings or manually adding contour strokes. This is useful for 
removing the intersection triangles created during vectorization.

Remove Extra Strokes
Removes strokes inside painted area. This option only works after the painted 
drawing is flattened.

Optimize

Reduces the number of layers, such as overlapping brush strokes, in the selected 
drawing objects. Drawing objects will only be flattened and optimized if the 
selected objects do not change the appearance of the final image when they are 
merged. 
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Crop Brush Textures

Crops an unnecessarily large texture bitmap that lies unseen beneath the vector 
contour of a textured line. This often occurs when you cut and paste textured 
lines from one drawing into another. If you cut a portion from a textured line and 
paste it into a different drawing, Harmony pastes the entire unseen texture 
bitmap from the source drawing into the new one, even if you only took a small 
portion of the source drawing. Using the Crop Brush Texture command will crop 
away extraneous texture that does not touch the vector area. If there are many 
textured lines in your scene, this will greatly reduce the file size.

Reduce Drawing 
Texture Resolution

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Transform

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 CW Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW Rotates the current selection 90 degrees counter-clockwise.

Rotate 180 Rotates the current selection 180 degrees.

Arrange

Bring to Front Moves the selected art to the front (on top).

Bring Forward Moves the selected art one level forward (closer to the front).

Send Backward Moves the selected art one level lower (behind).

Send to Back Moves the selected art behind everything (bottom / back).

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may already be 
exposed in that cell and the following ones until it meets another drawing, key 
exposure or a blank cell. 

Duplicate Drawings Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
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will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Delete Selected Drawings
Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Rename Drawing with Prefix
Lets you rename a drawing sequence with a prefix, which can be quite useful for 
cut-out puppet breakdown and deformation animation. This applies to any 
deformation work done in pre-Harmony 12 versions.

Rename by Frame
Lets you rename a series of drawings relative to their frame position. This is 
useful in hand-drawn animation.

Select Strokes with Current 
Colour

Lets you select drawing elements and painted areas with the same colour as the 
currently selected colour in your colour palette.

Distribute to Layers

Every selected stroke in the Camera view is placed on separate layers; one layer 
per stroke. If artwork is composed of several strokes, you must group them to put 
them on the same layer. 

This operation cannot be done in the Drawing view.

Create Colour Art from Line 
Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Create Breaking Triangles

Useful for brush strokes, creates triangular breaks at natural line intersections. 
These intersections are the probable locations where colour line breaks may 
occur, such as where a sleeve meets a hand. 

This makes it easier to soft trace lines in different colours when there are 
flattened or unflattened clean brush strokes.
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Generate Auto-Matte
Fills colour based on currently selected colour swatch on different drawing 
layers (overlay, underlay) so overlapping lines are more visible during a line test.

Adjust Line Texture Opacity Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Vector Drawing 
Brush Resolution

Allows you to change the pixel density of textured brush strokes in vector 
drawings in your scene. 

NOTE 

When you create a new vector drawing, its pixel density for textured brush 
strokes is based on the settings in the Drawing Resolution tab of the Scene 
Settings dialog. 

Change Bitmap Drawing 
Resolution

Allows you to change the pixel density and canvas size of existing bitmap 
drawings in your scene. 

NOTE 

When you create a new bitmap drawing, its canvas size and pixel density 
are based on the settings in the Drawing Resolution tab of the Scene 
Settings dialog. 

Previous Drawing When a cell is selected in the Timeline view, displays the previous drawing.

Next Drawing When a cell is selected in the Timeline view, displays the next drawing.

Previous Layer When a cell is selected in the Timeline view, displays the previous layer.

Next Layer

Once a cell is selected in the Timeline view, you can navigate between the 
drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

When a cell is selected in the Timeline view, displays the next layer.

Colour Protection

Toggle Current 
Colour Protection

Temporarily enables/disables the Colour Protection feature so you can quickly 
correct wrongly inked or painted areas under protected colour without 
readjusting the Current Colour Protection option.

Respect Colour In the Colour view, you can protect a colour swatch to avoid repainting or 
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Protection
unpainting the zones linked to that swatch. If you using the Paint tool and this 
option is deselected, you will repaint or unpaint the protected colours on your 
drawings until you enable the option again.
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Edit Menu

The Edit menu lets you repeat and undo actions, cut/copy/paste selected objects, select and manipulate 
objects, work with symbols, and access the Preferences dialog box.

How to access the Edit menu

 l From the top menu, select Edit.

Command Description

Undo
Removes the last change made to your project. Harmony supports 
multiple undo, so you can undo changes you made in the order you 
made them.

Redo
Redoes an operation you have undone. This command is active only 
after you use the Undo command.

Cut
Removes selected objects. You can then paste the object or its 
properties to another object.

Copy Copies selected objects and properties.

Paste Drawing Object
Places an object you cut or copied into the location you select in a 
view.

Paste Drawing Object in Place Pastes the copied object in the same place as the original.

Paste Special

Opens the Paste Special dialog box which lets you determine how 
templates and symbols are imported in the Timeline view. 

There are advanced paste options for drawings, timings, keyframes, 
layers, as well as palettes and symbols.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the 
number of cycles to paste and select a type of cycle: Normal, Reverse, 
Forward-Reverse and Reverse-Forward.

Paste Reverse Reverses the timing of drawings or keyframes in range of selection 

247

Harmony 24 Advanced Reference Guide                          



Chapter 2: Menus

after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the 
Drawing, Timeline and Camera views. This helps you manage multiple 
objects as one when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that 
were not selected. For example, if some lines are selected in a 
drawing, this command will deselect them and select any other lines 
in the drawing that were not selected.

Auto-Apply

Automatically applies changes you make to a property window or 
dialog box. Harmony applies the modification automatically and 
displays the result in the Camera view. When working on a heavy 
scene, it is useful to turn off this option.If you want to always work in 
Auto-Apply mode, you can deselect the Auto-Apply option in the 
Preferences dialog box (General tab). Then, each time you start 
Harmony, the Auto-Apply  mode will be off. You must click the Apply 
button to see any modifications.

Create Symbol
Creates a symbol from selected drawing elements in the Drawing or 
Camera view or a layer or cells in the Timeline view.

Open Merge Editor
Lets you bring together (merge) the layer or drawings from different 
versions of the same scene.

Expand Symbol

Extracts a symbol's contents and places it on the root timeline. Its 
contents will be copied and inserted into the root timeline. The symbol 
will not be removed from the Timeline view once it is expanded. 

The symbol's layers will be parented to it in case you created motions 
and transformations on the drawing layer that contain the symbol. 
Breaking the hierarchy could result in the loss of any scaling and 
animation you may have created.

Expand Selected Symbol in Groups
Expands a symbol within a group to avoid crowding the timeline with 
a series of layers. When you expand the symbols, the layers will be 
contained in a group node that you can expand to see the content.
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Duplicate Selected Symbol
Creates a duplicate of a selected symbol. If other symbols are nested 
inside the new symbol, they are not duplicated. If you modify them, the 
original and other instances will also be modified.

Create Drawing from Drawing Selection
Breaks a character into its main body parts. There is no need to create 
any layers prior to this process. Make sure your model is well centered 
and sized in the Camera view.

Clone: Drawings Only
Creates a copy of the drawings in the selected layer in the Timeline 
view. The timing it not copied.

Clone: Drawings and Timing
Creates a copy of the drawings and their timings in the selected layer 
in the Timeline view.

Duplicate

Duplicates a layer to have a copy of the drawings that are independent 
from the original ones, as well as an independent timing (exposure). 
When you need the drawings to be modified independently, you will 
want to duplicate the layer instead of cloning it.

Merge

There are two methods of merging drawings. 

 l You can merge selected drawings in adjacent elements. The 
columns and layers will be left intact, and each new merged 
drawing will reside in the frames of the left-most column or 
lower layer.

 l You can merge elements. All drawings will be merged. Unused 
columns and layers will be deleted, but the original drawing 
files are still accessible.

Group

Group Groups selected drawing objects in the Camera or Drawing view.

Ungroup
Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

Edit Drawing Mode

When the Auto-Get Rights to Modify Drawings option is selected in 
the Preferences dialog box (General tab), the system automatically 
gets the rights to modify drawings when you select a drawing. 
Otherwise, you must manually get the rights to modify drawings.

Edit Palette List Mode When the Auto-Get Rights to Modify Palette option is selected in the 
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Preferences dialog box (General tab), the system automatically gets 
the rights to modify palettes and palette lists when you select a colour 
from a palette. Otherwise, you must manually get the rights to modify 
a palette or palette list.

Get Rights to Modify Drawing Manually releases the rights to modify a selected drawing.

Release Rights to Modify Drawing Manually releases rights to modify a selected drawing.

Force Release Rights to Modify Drawing
This option is always available even if the Get Rights to Modify All 
Scene Assets option is not selected in the Database Selector dialog 
box.

Preferences
Opens the Preferences dialog box where you can set your preferences 
for Harmony.
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File Menu

The File menu lets you open, close, save, scan, print, and import and export files.

How to access the File menu

 l From the top menu, select File.

Command Description

New
Creates a new scene while closing any scene already open. The New Scene dialog 
box opens, asking for directory, name, and resolution information.

Open
Displays the Open Scene dialog box where you can browse for a scene file.  You can 
open a new scene from the current one and the previous scene will close.

Open Recent Displays a list of the most recently opened scenes.

Clear Clears the list of recently opened scenes.

Close Closes the currently opened scene, but does not close the Harmony application.

Save Saves all changes made to the opened scene, drawings, palettes, and palette lists.

Advanced Save

Lets you do the following:

 l Save the scene as the current version.

 l Save different versions representing different stages of the production of 
your scene.

 l Save different versions representing different scene setups.

 l Choose specific assets that you want to save, such as drawings or palettes. 

Rights to Modify Scene 
Version

Allows you to modify the selected version of the scene as well as to manage and 
overwrite other versions. Other users will not be able to open a different version of 
the scene until you close the scene.

Rights to Modify Scene

Allows you to modify the currently selected scene version only. Unless the Get 
rights to modify the scene option is also checked, you will not be able to change 
other versions of the scene. This allows other users to modify different versions of 
the scene while you are working on the selected version.
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Read Changed Drawings

Determines which drawing files have been modified on disk since you loaded them. 
All updated drawings will be reloaded. 

NOTE 

Reloading a locked drawing will discard unsaved changes.

Manage Versions Allows you to manage all the versions of the current scene.

Manage Local Cache
Opens the Manage Local Cache dialog, in which you can see all the Harmony 
Server database scenes that were cached locally, delete unused caches and check 
if the data in a scene's cache matches the data on the database server. 

Save As

Saves the current file with a different name and at a different location.

Saves the current state of a scene as another scene. The Save As window prompts 
you for a new name and a different location for this scene before saving it. This will 
create a complete scene directory for the new scene.

NOTE 

The scene name cannot exceed 23 characters.

Save as New Version
Saves the current scene as another version. The Save Version dialog box prompts 
you to give a name for this new version. This will create a new .xstage file in your 
current project directory.

Back Up Scene Backs up the current scene to a location you choose.

Update Database Scene
Updates your database with only the changes you made to the scene. To do this, 
you must enter your host name and host port in the Preferences dialog box, 
General tab.

Download Database 
Changes

If any changes were made to the scene you downloaded, you can perform an 
update by downloading these changes, which will be integrated into your scene.

Remove Unused Files Removes the unused palettes from the scene list.

Import

From Scanner Imports drawings from a TWAIN scanner.
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Images Imports bitmap images which you can choose to vectorize.

Movie Lets you convert a QuickTime movie to an image sequence and audio file.

Sound Lets you import sound files into your project.

Colour Model
Lets you import TVG drawing file into your project. Once imported, it is display in 
the Model view for use as a colour model which you can load into any Harmony 
scene.

SWF, Illustrator 
Files to Library

Lets you import SWF files into your project.

Vector File
Opens the Import PDF dialog where you may import Adobe Illustrator (.ai) and 
Portable Document Files (.pdf).

Export

Images
Exports a scene as a bitmap image sequence. If there is sound in your scene, it will 
not be exported with the images.

Movie Exports animation as a QuickTime movie.

SWF

Exports a Flash movie file. 

Harmony supports exporting Flash movie files with a limited subset of vector and 
bitmap effects, the latter which can be previewed in Render View  mode.

OpenGL Frames
Exports OpenGL frames (fast display mode) for a quick screen renders of a scene 
that contain no transparency channel. Heavier scenes containing 3D, multiple 
effects and camera moves can be fairly long to export.

Print

Xsheet
Prints the exposure sheet so you can take it to your animation table,  provide a copy 
to the animator, or create your Xsheet skeleton directly in Harmony.

Quit Closes the application.
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Help Menu

The Help menu lets you display the Harmony documentation, Welcome screen and end user license 
agreement, as well as access the Toon Boom website, and identify the product name and version number.

How to access the Help menu

 l At the top of the interface, select Help.

Command Description

Online Help
Opens the Harmony Help system, complete with instructions on how 
to use the system. This requires an internet connection.

Getting Started
Opens the Harmony Getting Started Guide (in PDF format) in a 
browser window. Requires Acrobat Reader.

Scripting Interface Documentation Opens the Harmony Scripting Interface Documentation. 

Extended Scripting Interface 
Documentation

Opens the Harmony Extended Scripting Interface Documentation. 

Script Node Documentation Opens the Harmony Script Node Documentation. 

Python Interface Documentation Opens the Harmony Python Scripting Documentation. See

Toon Boom on the Web
Opens the Toon Boom website, which features a Support and 
Community > Forum section.

Customer Experience Improvement 
Program

The Customer Experience Improvement Program allows Toon Boom 
to collect usage information. The data does not contain any personally 
identifiable information and cannot be used to identify you. The data 
will consist of a basic hardware description, a project summary and 
usage information. The information is used only for software 
improvement purposes, as well as for sharing with third parties for the 
same reason.

This program is enabled by default but is voluntary. If you prefer not to 
participate, you can opt out when you first launch the software, by 
using a global preference, or by a command line argument.
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About Identifies the product name and version number. 

Show Welcome Screen Displays the Harmony Welcome screen.

Show End User License Agreement Displays the End User License Agreement.

Debug Mode

When enabled, information is logged in the Message Log view about 
the preview generated in the Camera view, each time the preview is 
refreshed. In OpenGL preview mode, summary information is logged 
about the amount of layers to process and the time it takes to generate 
the preview. In Render Preview mode, detailed information about each 
composite and effect that is processed is logged.
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Insert Menu

The Insert menu lets you create empty symbols in the Library view, different types of layers in the Timeline 
view, keyframes and control points.

How to access the Insert menu

 l At the top of the interface, select Insert.

Command Description

Create Empty Symbol in Library
Creates an empty symbol in the Library view to which you can edit 
(add content).

Bone Adds a new Bone layer to the Timeline view.

Camera Adds a new Camera layer to the Timeline view.

Colour-Card Adds a new Colour-Card layer to the Timeline view.

Drawing
Adds a new Drawing layer to the Timeline view and a column in the 
Xsheet view.

Game Bone Adds a new Game Bone layer to the Timeline view.

Kinematic Output Adds dd a new Kinematic Output layer to the Timeline view.

Peg Adds a new Peg layer to the Timeline view.

Quadmap Adds a new Quadmap layer to the Timeline view.

Effects
Adds a new layer in the Timeline view with the effect you select: 
Blending, Blur, Blur-Gaussian, Brightness-Contrast, Colour-Override, 
Colour-Scale, Cutter, Glow, Highlight, Shadow, Tone, or Transparency.

Keyframe Adds a keyframe to the selected cell in the Timeline view.

Keyframe and Duplicate Drawing
Adds a keyframe to the selected drawing layer cell in the Timeline 
view and creates a duplicate of the drawing, which sits on top of the 
original drawing.
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Position Keyframe
Adds a position keyframe whereby keyframes will only be added on 
the X, Y and Z parameters of the selected layer. Keyframes are not 
added on the Angle, Scale and Skew parameters.

Control Point

Adds a control point to the trajectory of the selected element or peg in 
the Camera view when the element or peg is in a 3D path. Note that 
you must have a 3D path in the peg portion in order to add a control 
point.
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Play Menu

The Play menu lets you play back animation and sound. Use it to scrub the sound to create your lip-sync, loop 
the playback, navigate through frames, and change the playback range and speed.

How to access the Play menu

 l At the top of the interface, select Play.

Command Description

Play Plays the scene in the Camera or Drawing view. 

Render and Play

Renders your scene's frames, then opens the rendered frames in Play 
for playback. 

This allows you to preview your scene's animation in real time, with 
the effects rendered and with no risk of slowdown. 

Record and Play

Exports your scene as it appears in the Camera view into a movie file, 
then opens it in your workstation's default video player. 

This allows you to preview your animation without any risk of 
slowdown, but it does not preview the effects in your scene. However, 
it is much faster than Render and Play. 

This button automates the usage of the Export OpenGL Frames dialog 
see 

Test SWF Movie
Quickly exports your scene as a Flash Movie (.swf), then opens it in 
your workstation's default web browser.

Stop Stops playback.

Mini Playback

Open the Mini Playback dialog. This dialog allows you to set the 
amount of frames before and after the current frame to playback when 
using Mini Playback, to set the speed of Mini Playback and to start Mini 
Playback.

Start Mini Playback
Begins Mini Playback using the last settings entered in the Mini 
Playback dialog. By default, Mini Playback will play 5 frames before 
and after the current frame, at the scene's frame rate. 
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Playback Speed
Opens the Set New Frame Rate dialog box where you can set the 
frame rate at which the playback plays.

Loop
If pressed, your scene will repeat indefinitely when playing. 
Otherwise, it will stop when the end is reached.

Enable Sound Turns on sound during playback.

Enable Sound Scrubbing Turns on sound scrubbing during playback.

Start Frame
Opens the Set Playback Start Frame dialog box , in which you can 
enter the frame number from which to start playback.

Stop Frame
Opens the Set Playback Stop Frame dialog box, in which you can set 
the frame number at which to stop playback.

First Frame Moves the red playhead to the first frame.

Previous Frame Moves the red playhead to the previous frame.

Next Frame Moves the red playhead to the next frame.

Last Frame Moves the red playhead to the last frame.

Go to Frame
Opens the Go to Frame dialog box where you can enter the frame 
number on which the red playhead to be positioned in the Timeline 
view.

Enable Playback

Top View Plays back your animation in the Top view.

Side View Plays back your animation in the Side view.

Perspective View Plays back your animation in the Perspective view.
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Scene Menu

The Scene menu lets you set the scene length, add frames to the scene, view different displays of the scene, 
set render options, access the Scene Settings dialog box and Elements Manager window, and verify the 
drawing and palette files in your project.

How to access the Scene menu

 l At the top of the interface, select Scene.

Command Description

Scene Length Lets you set the length of the scene in frames.

Frame

Add Frames at Start Adds the number of frames you specify to the beginning of the scene.

Add Frames at End Adds the number of frames you specify to the end of the scene.

Add Frames Before Selection

Adds the number of frames you specify before or after your selection.

Add Frames After Selection

Remove Selected Frames Deletes the selected frames from your scene.

Camera

Default Camera
Lets you select a camera. If you only add one camera to your scene, 
you will only see Default Camera in your list.

Default Display

Display All
Shows the contents of a specific Display node, updating the contents 
of the Camera, Top, Side, Perspective, and Timeline views.

Display

Scene Settings
Opens the Scene Settings dialog box where you can set the resolution, 
alignment, bitmap resolution and many other parameters.
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Render

Auto Render

Automatically recalculates the preview image whenever you modify a 
parameter. If your scene is heavy and you do not want the preview 
rendered automatically, deselect the Auto-Render option and do the 
preview update manually.Note that this will slow down Harmony as it 
takes resources to update every frame.

Auto Render Write

Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this 
command.

Cancel Preview Render Cancels a render that was started.

Element Manager

Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing 
folders that are not linked to a column in your scene, use the Element 
Manager to delete them if needed. See xref Reference > Windows > 
Element Manager. 

Check Files Verifies the integrity of the drawing and palette files in your project. 
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View Menu

The View menu lets you manipulate the view by zooming, panning, or rotating. You can also display the grid 
and change its size, use the onion skin feature to help with drawing, and set the preview resolution. 

How to access the View menu

 l At the top of the interface, select View.

Command Description

Toggle Full Screen

Cycles through the following display modes:

 l Normal Full-Screen: The main application window becomes 
full screen.

 l View Full-Screen: The selected view becomes full screen and 
all other views are collapsed.

 l Normal: The main application window is restored to its original 
size and collapsed views are expanded.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Rotate View CW
Rotates the Camera view 30 degrees clockwise, like an animation 
table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an 
animation table.

Mirror View
Temporarily flips the Camera or Drawing view horizontally, allowing 
you to view and edit your artwork as if it was being mirrored.

Reset Zoom Resets the view’s zoom to its default position.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.
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Next Colour Goes to the next colour in the Colour view.

Previous Colour Goes to the previous colour in the Colour view.

Grid

Show Grid Displays the grid.

Grid Outline Only Displays the outline of the grid only.

Underlay Displays the grid under the drawing elements.

Overlay Displays the grid over the drawing elements.

Square Grid Displays a standard square grid.

12 Field Grid Displays a 12-field size grid.

16 Field Grid Displays a 16-field size grid.

Onion Skin

Show Onion Skin

Lets you preview the previous and next drawings. By default, the 
previous drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Add to Onion Skin Adds a series of selected elements to the onion skin preview.

Remove from Onion Skin Removes a series of selected elements from the onion skin preview.

Remove Unselected from Onion 
Skin

Removes all elements except the ones selected from the onion skin 
preview.

Add All to Onion Skin Adds all of the scene's elements to the onion skin preview.

Remove All from Onion Skin Removes all of the scene's elements from the onion skin preview. 
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Onion Skinning by Frames

Selects the drawings to display in the Onion Skin by their frame 
number relative to the current frame. For example, if the Onion Skin is 
set to include 2 drawings before and after the current frame, it will 
include the drawings up to two frames before and up to two frames 
after the current frame, even if those drawings are the same as the one 
in the current frame. This is more useful for cut-out animation as it 
allows you to position a drawing relative to its position in adjacent 
frames.

NOTE 

This option only works in the Camera view. 

Onion Skinning by Drawings

Selects the drawings to display in the Onion Skin by the amount of 
different drawings before and after the current frame. For example, if 
the Onion Skin is set to include 2 drawings before and after the current 
frame, this will display the nearest two different drawings before and 
after the drawing in the current frame in the Onion Skin, even if those 
drawings are further than 2 frames away from the current frame. This 
is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust 
the extent of the Onion Skin in the Timeline view are not 
available. 

No Previous Drawing
Removes the previous drawing's onion skin and displays only the next 
drawing.

Previous Drawing Displays the previous drawing.

Previous Two Drawings Displays the previous two drawings.

Previous Three Drawings Displays the previous three drawings.

No Next Drawing Do not show the onion skin for all of the next drawings.

Next Drawing Show the onion skin for the next drawing.

Next Two Drawings Show the onion skin for the next two drawings.
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Next Three Drawings Show the onion skin for the next three drawings.

Reduce One Previous Drawing Reduces the number of previous visible drawings by one.

Add One Previous Drawing Adds one drawing to the number of previous visible drawings.

Reduce One Next Drawing Reduces the number of next visible drawings by one.

Add One Next Drawing Adds one drawing to the number of next visible drawings.

Light Table
Turns on the light table so you can see the previous and subsequent 
active layers in washed-out colours. It is useful for seeing the other 
layers when designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of 
the ink and paint process. Any unpainted zones can be seen as the 
light shows through the unpainted areas of the silhouetted drawing.

Show

Symbol Pivot

Displays a symbol's pivot. The Symbol pivot is similar to the Drawing 
pivot. Each symbol cell can have its own pivot and act the same as the 
Drawing pivot. The Symbol pivot can also be referred to as embedded 
pivot. Inside a symbol, each drawing can have its own pivot. 

Safe Area
Displays the TV safety zone and the centre of the camera frame. The 
safe area adapts to the scene resolution, as well as the safety zone 
and frame’s centre.

Camera Mask

Displays a black mask around the scene’s frame to avoid seeing the 
unnecessary artwork. This option is handy when you're animating and 
setting up the scene. It allows you to see your scene’s composition 
better.

Control Displays the controls of the selected element.

Current Drawing on Top

Displays the selected drawing on top of everything while you draw. By 
enabling this option, each time you select a drawing tool, the selected 
drawing is displayed in front of everything in the Camera view. The 
Timeline view ordering remain unchanged.You only need to enable 

265

Harmony 24 Advanced Reference Guide                          



Chapter 2: Menus

this option once, it is not necessary to do it each time you select a 
drawing tool. 

Outline Locked Drawings
Displays drawing that are locked in the Timeline view (cannot be 
selected in the Camera view) as wireframes.

Show Strokes
Displays the strokes in your drawings so that the invisible lines stand 
out.

Show Strokes with Colour Wash Displays strokes with washed-out colours.

Hide All Controls Hides the controls of the selected element.

Alignment Guides Alignment Guides

Show Alignment Guides

When enabled, alignment guides will be visible in the Camera and 
Drawing views.

This is enabled by default. Disabling this option will hide and disable 
alignment guides, meaning that animation and drawing tools will not 
snap to them, even if the  Snap to Alignment Guides option is 
enabled in the Tool Properties view. 

Lock Alignment Guides

It is possible to reposition alignment guides in the current panel by 
dragging them using the  Transform tool. Enabling this option will 
lock the alignment guides in their current position, allowing you to 
manipulate layers and artwork in your scene without accidentally 
moving alignment guides.

Clear Alignment Guides Removes all the alignment guides from your scene.

New Horizontal Alignment 
Guide

Adds a horizontal alignment guide to the middle of the stage.

TIP 

You can move the alignment guide from its default position 

using the   Transforml  tool or the  Select tool.

New Vertical Alignment Guide Adds a vertical alignment guide to the middle of the stage.
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TIP 

You can move the alignment guide from its default position 

using the  Transforml  tool or the  Select tool.

Particle

Show Particles as Dots in 
OpenGL

Displays the particles as dots in the OpenGL preview mode. This 
makes the playback speed faster for a heavy scene.

Preview Manager
Opens the Preview Manager where you can set options for the quality 
of previews, and clearing and updating the cache.

Preview Resolution

Same as Scene Resolution

Lets you choose a resolution for previewing a scene.

3/4 of Scene Resolution

1/2 of Scene Resolution

1/3 of Scene Resolution

1/4 of Scene Resolution

Custom
Lets you select a resolution from a list of presets or enter X and Y 
values for a  custom preview resolution.

Bitmap File Quality

Let's you increase or decrease the preview quality of raw bitmap 
images. By default, bitmap files imported in Harmony will display in a 
low resolution in the Camera view to avoid hindering performance. 

TIP 

You can change the default resolution in which bitmap files are 
displayed in the Camera view by changing the Small Bitmap 
Resolution preference located in the Camera tab of the 
Preferences dialog.
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NOTE 

This only affects the way bitmap images display in the OpenGL 
preview of the scene in the Camera view. The preview quality of 
bitmap images does not affect the final render. 
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Windows Menu

The Windows menu lets you customize your workspace to suit your working style, save it as a new 
workspace, and load it from the Workspace toolbar. You can also show or hide the different toolbars and 
views in Harmony.

How to access the Windows menu

 l From the top menu, select Windows.

Command Description

Restore Default Workspace
Returns modified workspaces to their original default layout if you do 
not like the current modifications or inadvertently closed some 
windows.

Workspace

Workspace Manager
Opens the Workspace Manager where you can modify, create, delete, 
rename and reorder your workspaces.

Save Workspace Saves the current workspace along with any modifications you made.

Save Workspace As...
Saves the workspace as a new version to avoid overwriting the current 
one.

Workspace
Lets you open workspaces designed specifically for animating, 
compositing, hand drawing, scripting and the default workspace.

Toolbars

Allows you to add or remove toolbars from your workspace. 

NOTE 

For information on the different toolbars in Harmony, see 
Toolbars.

Camera Shows or hides the Camera view.

Colour Shows or hides the Colour view.
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Drawing Shows or hides the  Drawing view.

Function Shows or hides the Function view.

Layer Properties Shows or hides the Layer Properties view.

Library Shows or hides the Library view.

Message Log Shows or hides the Message Log view.

Reference View Shows or hides the Model view.

Perspective Shows or hides the Perspective view.

Side Shows or hides the Side view.

Timeline Shows or hides the Timeline view.

Tool Properties Shows or hides the Tool Properties view.

Top Shows or hides the  Top view.

Xsheet Shows or hides the Xsheet view.

Integrated Help Shows or hides the Integrated Help view.

Metadata Editor Shows or Hides the Metadata Editor view.

Script Editor Shows or hides the Script Editor view.
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View Menus
A view menu contains commands specifically related to that view.

How to access a  view menu 

 1. In the top-left corner of a view, click the Menu  button.

Camera View Menu 272

Colour View Menu 289

Drawing View Menu 292

Function View Menu 305

Library View Menu 307

Reference View Menu 309

Onion Skin View Menu 311

Perspective View Menu 313

Script Editor View Menu 319

Side View Menu 324

Timeline View Menu 329

Top View Menu 334

Xsheet View Menu 339
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Camera View Menu

The Camera View menu lets you do many things in the Camera view, including selecting and editing objects in 
different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Camera menu

 l In the upper-left corner of the Camera view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Drawing Object Places an object you cut or copied into the location you select in a view.

Paste Drawing Object 
in Place

Pastes the copied object in the same place as the original.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Strokes With 
Current Colour

Selects all the strokes that are filled with the colour or texture that’s currently 
selected in the Colour view.

Select Strokes With 
Current Pencil 
Texture

Selects all the pencil lines that use the pencil line texture that’s currently 
selected in the Colour view. 

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
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deselect them and select any other lines in the drawing that were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child 
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent 
Skipping Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Group

Group: Groups selected drawing objects in the Camera or Drawing view.

Ungroup: Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

View

Navigation

Zoom In: Zooms in the view.

Zoom Out: Zooms out the view.

Rotate View CW: Rotates the Camera view 30 degrees clockwise, like an 
animation table.

Rotate View CCW: Rotates the Camera view 30 degrees counter-clockwise, like 
an animation table.

Reset Zoom: Resets the view’s zoom to its default position.
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Reset Rotation: Resets the view’s rotation to its default position.

Reset Pan: Resets the view’s pan to its default position.

Reset View:  Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line 
Art and Colour 
Art

Displays all Art layers.

Open GL View

Switches the Camera view to fast display, letting you see your animation play in 
real time. The OpenGL display requires less memory. The final look of your 
effects is not shown in the OpenGL View Mode. You must switch to the Render 
View Mode to see your effects.

Render View

Switches the Camera view to a fully rendered display showing the final image of 
the current frame. If a modification is done to your current frame or if you move to 
a different frame, click the Update Preview button to update the display if your 
preview does not update automatically.The Render View Mode display lets you 
see the final look of your frames including effects and antialiasing. You cannot 
play back your scene in Render View Mode. To see your scene fully rendered and 
to play it back, you must press the Render and Play  button in the Playback 
toolbar.

Matte View

Switches the Camera view to a matte display showing the alpha channel of the 
elements in your scene. The transparency level ranges from 0 to 100 percent. 
Zero percent is completely transparent and represented by black and 100 
percent is completely opaque and represented by white. Everything in between 
these extremes has a transparency level somewhere between 1 and 99 percent 
and is represented in various shades of grey. 

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.
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Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings 
are displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Add to Onion Skin: Adds Adds a series of selected elements to the onion skin 
preview.

Remove from Onion Skin: Removes Removes a series of selected elements from 
the onion skin preview.

Remove Unselected from Onion Skin: Removes Removes all elements except 
the ones selected from the onion skin preview.

Add All to Onion Skin: Adds Adds all of the scene's elements to the onion skin 
preview.

Remove All from Onion Skin: Removes Removes all of the scene's elements 
from the onion skin preview. 

Onion Skinning by Drawing: 

No Previous Drawing: 

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.
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Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous visible 
drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see Turns on the light table so you can see the 
previous and subsequent active layers in washed-out colours. It is useful for 
seeing the other layers when designing, animating or cleaning up your animation. 

Backlight

Produces Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.

Show

Symbol Pivot: Displays a symbol's pivot. The Symbol pivot is similar to the 
Drawing pivot. Each symbol cell can have its own pivot and act the same as the 
Drawing pivot. The Symbol pivot can also be referred to as embedded pivot. 
Inside a symbol, each drawing can have its own pivot. 

Safe Area: Displays Displays the TV safety zone and the centre of the camera 
frame. The safe area adapts to the scene resolution, as well as the safety zone 
and frame’s centre.

Camera Mask: Displays Displays a black mask around the scene’s frame to avoid 
seeing the unnecessary artwork. This option is handy when you're animating and 
setting up the scene. It allows you to see your scene’s composition better.

Control: Displays the controls of the selected element.

BBox Selection Style: Lets you change the display style of selected elements to 
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a bounding box style. This removes the default overlay highlight and leaves only 
the bounding box around the selected element.

Outline Locked Drawings: Drawings that are locked in the Timeline view (cannot 
be selected in the Camera view) are displayed as wireframes.

Show Current Drawing on Top: Displays Displays the selected drawing on top 
of everything while you draw. By enabling this option, each time you select a 
drawing tool, the selected drawing is displayed in front of everything in the 
Camera view. The Timeline view ordering remain unchanged.You only need to 
enable this option once, it is not necessary to do it each time you select a drawing 
tool.

Show Strokes: Displays the strokes in your drawings so that the invisible lines 
stand out.

Show Strokes with Colour Wash: Displays strokes with washed-out colours.

Highlight Selected Colour: 

Show Scan Information: Displays a status bar showing the scanning information 
at the bottom of the Drawing and Camera view.

Hide All Controls Hides the controls of the selected element.

Render Current Frame Renders only the current frame.

Auto Render

Automatically recalculates the preview image whenever you modify a parameter. 
If your scene is heavy and you do not want the preview rendered automatically, 
deselect the Auto-Render option and do the preview update manually.Note that 
this will slow down Harmony as it takes resources to update every frame.

Layer Properties Displays the Layer Properties window of the selected layer in the Timeline view.

Preview Manager
Opens the Preview Manager where you can set options for the quality of 
previews, and clearing and updating the cache.

Bitmap File Quality
Let's you increase or decrease the preview quality of raw bitmap images. By 
default, bitmap files imported in Harmony will display in a low resolution in the 
Camera view to avoid hindering performance. 
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TIP 

You can change the default resolution in which bitmap files are displayed in 
the Camera view by changing the Small Bitmap Resolution preference 
located in the Camera tab of the Preferences dialog.

NOTE 

This only affects the way bitmap images display in the OpenGL preview of 
the scene in the Camera view. The preview quality of bitmap images does 
not affect the final render. 

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not need to trace 
directly over the gap. You can draw it a few millimeters away. The two closest 
points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a selection. It is 
recommended that you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside all 
drawings selected with the Permanent Selection  option in the Select tool.
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Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a selection 
on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If no 
selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a selection 
on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all the 
drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no selection 
has been drawn using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a selection 
on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil strokes 
into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into centreline 
pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. If 
you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 
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Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes: Removes strokes inside painted area. This option only 
works after the painted drawing is flattened.

Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that 
lies unseen beneath the vector contour of a textured line. This often occurs when 
you cut and paste textured lines from one drawing into another. If you cut a 
portion from a textured line and paste it into a different drawing, Harmony pastes 
the entire unseen texture bitmap from the source drawing into the new one, even 
if you only took a small portion of the source drawing. Using the Crop Brush 
Texture command will crop away extraneous texture that does not touch the 
vector area. If there are many textured lines in your scene, this will greatly reduce 
the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).
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Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art 
From Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will be 
created.
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Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent. This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the background) for 
tracing to create a matte directly in Harmony.By default, Harmony creates small 
thumbnail images when imported as bitmap in order to increase performance by 
using a small thumbnail image instead of using the original large size bitmap for 
animation work in Harmony. This will make difficult to view details or trace due 
to the low resolution (blurry). This option temporary increases the resolution of 
bitmaps up to their original bitmap resolution to make tracing easier.

Previous Drawing

Once a cell is selected in the Timeline view, you can navigate between the 
drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour swatch 
to avoid repainting or unpainting the zones linked to that swatch. If you using the 
Paint tool and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Drawing Tools

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil 
lines, shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes in 
your artwork. You can add, remove, tweak and move vector points, move the 
Bezier handles of the vector points as well as  deform vector outlines. 
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Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate and skew 
it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making 
them easier to edit. 

Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope
Allows you to deform and warp artwork by moving points and tweaking lines in a 
grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want 
its location to be.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central 
vector lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing Allows you to create and configure a morphing sequence, which will 
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automatically generate the in-betweens between two drawings in the current 
layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking 
to create each point in the sequence of line segments. 

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush
Lets you repaint existing brush strokes. The new brush strokes will be cropped to 
fit in existing artwork. 

Close Gap
Allows you to close open shapes so that they can be filled with the Paint tool. By 
drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.

Stroke
Allows you to create invisible lines that can serve as colour zones that can be 
filled, or close the gaps in existing colour zones.

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and textures in a 
colour zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like with a real animation 
disc.

Animation
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Insert Keyframe Adds a keyframe on the selected cell in the Timeline view. 

Insert Control Point Adds a control point to a 3D path function.

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to 
the value of the next keyframe. 

Flip Flips the position of an element on its axis.

Set Ease for Multiple 
Parameters

Lets you set the ease in and ease out on multiple functions and keyframes. This 
opens the Set Ease For Multiple Parameters where you can modify the Bezier or 
Ease curve. You can apply easing parameters to a certain type of function only, 
such as rotation or scale.

Linear Motion Transforms a curved path to a linear path removing tension, bias, and continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Select Previous 
Keyframe/Point

Select the previous keyframe/point.

Select Next 
Keyframe/Point
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Lock Locks a layer so it cannot be selected in the Camera view.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. This 
is useful when doing cut-out animation. Cut-out puppets often have a particular 
Z ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object up 
to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move them 
towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, 
it will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to be 
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at a different location to represent the group's motion better.

Inverse Kinematic 
Tool

Allows you to pose a character model by pulling on its extremities, such as hands 
and feet, and have the other connected limbs follow. Can be used on any piece 
connected in a hierarchy. 

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold 
Orientation

Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Set IK Min Angle
Sets limitations on the angle parameter to prevent the puppet from bending too 
far.

Set IK Max Angle

Remove All 
Constraints

Removes all nails except the minimum and maximum angles.

Morphing

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and contour 
position. Also, if a contour is not animated correctly, you can use hints to correct 
the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint The Zone Hint  point is used on a colour zone to control the proximity rule. The 
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Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone is 
not associated with the corresponding one by default. For example, in a splash 
animation there are many water droplets that are the same colour. Harmony 
automatically morphs the droplet to the nearest one. This is not always the one 
you may have predicted. A Zone Hint will force a colour zone to morph with 
another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. It 
can be used on drawings that were done using the Pencil, Polyline, Ellipse, Line 
and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the central 
vector. Make sure to place it far enough away from the line so you will see it snap 
when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding shape 
in the destination drawing. If you do not place a Vanishing Point Hint to control 
the point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. 
A shape will appear in the destination drawing when there is no corresponding 
shape in the source drawing. If you do not place an Appearing Point Hint to 
control the point of appearance, the shape will appear from its centre and expand 
outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. This 
option is useful while setting hints. You can use the default keyboard shortcut F4 
to toggle between your drawings.

Suggest HInts
Automatically sets Automatically sets hint points on key drawings as a help tool. 
If you're not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Colour View Menu

The Colour View menu lets you access commands related to the Colour view such as creating new palettes, 
adding new colour swatches, and displaying the Tint panel.

How to access the Colour menu

 l In the upper-left corner of the Colour view, click the menu button.

Command Description

Palettes

New

Creates a new colour palette.

By default, Toon Boom Harmony Advanced is set to the Basic mode. For simple 
productions, it is recommended to use the Basic mode.  This setting stores the 
palettes automatically for you and saves them at the Scene level. When you use 
the Advanced Palette Lists mode, you can decide at which level you want to store 
your palettes: Environment, Job, Scene, or Element.

Link Lets you access other palettes created in the project and link them to your scene.

Import Imports a colour palette located on your hard drive.

Remove Removes the selected palette from the palette list.

Remove and Delete 
on Disk

Removes the selected palette from the palette list and deletes the palette file 
from the disk.

Rename Lets you five the selected colour palette a new name.

Duplicate
Creates a copy of the original palette, using the same names and colour values, 
but has a different ID and is independent from the original palette. This ensures 
that both the duplicate and original palettes are completely independent.

Clone
Creates a copy of the master palette. The colours in each palette have the same 
properties. The colours have the same identification number pointing to the same 
colour zones, but they can have different names and RGBA values.

Pencil Texture Displays the colour palette containing the pencil line textures.
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Palette

Move Up Moves the selected colour palette up one level.

Move Down Moves the selected colour palette down one level.

Colour Editor Opens the Colour Editor where you can pick and edit colour swatches.

Tint Panel
Opens the Tint panel where you can modify a series of colours to blend a tint in 
them or offset their RGBA values. 

Current Palette 
Overrides

When clone palettes are present in the palette list, by default, priority is given to 
the palette that is the highest in the palette list to decide which colours to apply 
to drawings. With this option enabled, priority is given to the currently selected 
palette. Selecting any of the clone palettes will make drawings use colours from 
the selected palette instead. 

Display Colour 
Values

Display the colour values beside their colour swatches in the palette list.

Colours

Cut Cuts the selected colour swatch from the palette.

Copy Copies the selected colour swatch which you can paste in a different palette.

Copy Colour ID
Copies a colour swatch's colour ID so you can keep a reference file of colour IDs 
or use them with custom plug-ins. Example of a colour ID: 075cf5b552401130.

Paste Colour Values Pastes the colour value of the copied swatch over an existing colour swatch.

Paste As New 
Colours

Creates a new colour swatch from the colour value of the copied swatch.

Paste As Clones
Pastes a copied colour to a new palette as a clone of the original one. Both colour 
use the same colour ID. They have to be in different palettes.

New Creates a new colour swatch from the colour swatch that was last selected.
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Edit
Opens the Colour Picker window in which you can edit the selected colour 
swatch.

Delete Deletes the selected colour swatch from the palette.

New Texture
Lets you add a bitmap colour swatch to your palette. You can load photos and 
textures and paint your drawings with it. The bitmap image must be a .tga or .psd 
file format.

Edit Texture
Opens the browser to replace the texture used in a textured colour swatch. All 
zones using the swatch will be updated with the new texture.

Scale Down Texture Lets you set a new maximum texture size or scaling factor.

New Default Colour Creates a new colour using the default colour set in the preferences.

Protect Colour
Locks a selected colour, so if you ever paint over it accidentally, the work already 
done will not be affected. You can also block the filling colours if you painted all 
of the animation in Line Art and plan to repaint the lines.

Swatch Mode
Displays the colour swatches with its corresponding name inside the swatch. 
When this option is not selected, the names of the colour swatches are displayed 
beside the swatch.

Independent Bitmap 
Colour

Bitmap colour selection is independent from the vector colour selection.

Bitmap Colour Sliders

RGB Displays the colour picking sliders as RGB (red, green, blue).

HSV Displays the colour picking sliders as HSV (hue, saturation, value).
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Drawing View Menu

The Drawing View menu lets you access tools, set morphing  parameters, lock or unlock layers, and select 
elements in the Drawing view.

How to access the Drawing menu

 l In the upper-left corner of the Drawing view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Drawing Object Places an object you cut or copied into the location you select in a view.

Paste Drawing Object 
in Place

Pastes the copied object in the same place as the original.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Selects all the strokes that are filled with the colour or texture that’s currently 
selected in the Colour view.

Select Strokes With 
Current Pencil 
Texture

Selects all the pencil lines that use the pencil line texture that’s currently 
selected in the Colour view. 

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
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deselect them and select any other lines in the drawing that were not selected.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW Rotates the Camera view 30 degrees counter-clockwise, like an animation table.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line 
Art and Colour 
Art

Displays all Art layers.

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

293

Harmony 24 Advanced Reference Guide                          



Chapter 2: Menus

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings 
are displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Show Centre Line: 

No Previous Drawing: Displays no previous drawing.

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous visible 
drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see Turns on the light table so you can see the 
previous and subsequent active layers in washed-out colours. It is useful for 
seeing the other layers when designing, animating or cleaning up your animation. 
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Backlight

Produces Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.

Show

Show Strokes Displays the strokes in your drawings so that the invisible lines stand out.

Show Strokes with 
Colour Wash

Displays strokes with washed-out colours.

Highlight Selected 
Colour

Identify a selected colour swatch used in a drawing.

Show Morphing Key 
Drawing Thumbnail

When using the Morphing tools, this displays the source or destination drawing 
as a reference in the bottom corner of the Drawing view.

Show Scan 
Information

Displays a status bar showing the scanning information at the bottom of the 
Drawing and Camera view.

Desk

No Thumbnail

Changes the size of the drawing desk thumbnails.

Small Thumbnail

Medium Thumbnail

Large Thumbnail

Remove Selected 
Drawing

Clears selected drawing from drawing desk.

Remove All Drawings Clears all drawing from drawing desk.

Drawing

Clean Up Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
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number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not need to trace 
directly over the gap. You can draw it a few millimeters away. The two closest 
points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a selection. It is 
recommended that you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside all 
drawings selected with the Permanent Selection  option in the Select tool.

Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a selection 
on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If no 
selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a selection 
on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.
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Repaint Selection on All Drawings: Repaints any art inside a selection on all the 
drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no selection 
has been drawn using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a selection 
on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil strokes 
into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into centreline 
pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. If 
you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes: Removes strokes inside painted area. This option only 
works after the painted drawing is flattened.
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Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that 
lies unseen beneath the vector contour of a textured line. This often occurs when 
you cut and paste textured lines from one drawing into another. If you cut a 
portion from a textured line and paste it into a different drawing, Harmony pastes 
the entire unseen texture bitmap from the source drawing into the new one, even 
if you only took a small portion of the source drawing. Using the Crop Brush 
Texture command will crop away extraneous texture that does not touch the 
vector area. If there are many textured lines in your scene, this will greatly reduce 
the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 
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Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art 
From Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will be 
created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent. This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the background) for 
tracing to create a matte directly in Harmony.By default, Harmony creates small 
thumbnail images when imported as bitmap in order to increase performance by 
using a small thumbnail image instead of using the original large size bitmap for 
animation work in Harmony. This will make difficult to view details or trace due 
to the low resolution (blurry). This option temporary increases the resolution of 
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bitmaps up to their original bitmap resolution to make tracing easier.

Previous Drawing

Once a cell is selected in the Timeline view, you can navigate between the 
drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour swatch 
to avoid repainting or unpainting the zones linked to that swatch. If you using the 
Paint tool and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Drawing Tools

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil 
lines, shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes in 
your artwork. You can add, remove, tweak and move vector points, move the 
Bezier handles of the vector points as well as  deform vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate and skew 
it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making 
them easier to edit. 
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Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope
Allows you to deform and warp artwork by moving points and tweaking lines in a 
grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want 
its location to be.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central 
vector lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking 
to create each point in the sequence of line segments. 
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Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush
Lets you repaint existing brush strokes. The new brush strokes will be cropped to 
fit in existing artwork. 

Close Gap
Allows you to close open shapes so that they can be filled with the Paint tool. By 
drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.

Stroke
Allows you to create invisible lines that can serve as colour zones that can be 
filled, or close the gaps in existing colour zones.

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and textures in a 
colour zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like with a real animation 
disc.

Morphing

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and contour 
position. Also, if a contour is not animated correctly, you can use hints to correct 
the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint The Zone Hint  point is used on a colour zone to control the proximity rule. The 
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Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone is 
not associated with the corresponding one by default. For example, in a splash 
animation there are many water droplets that are the same colour. Harmony 
automatically morphs the droplet to the nearest one. This is not always the one 
you may have predicted. A Zone Hint will force a colour zone to morph with 
another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. It 
can be used on drawings that were done using the Pencil, Polyline, Ellipse, Line 
and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the central 
vector. Make sure to place it far enough away from the line so you will see it snap 
when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding shape 
in the destination drawing. If you do not place a Vanishing Point Hint to control 
the point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. 
A shape will appear in the destination drawing when there is no corresponding 
shape in the source drawing. If you do not place an Appearing Point Hint to 
control the point of appearance, the shape will appear from its centre and expand 
outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. This 
option is useful while setting hints. You can use the default keyboard shortcut F4 
to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame Goes to the previous frame of the selected frame in the morphing sequence.

Go to Next Frame Goes to the next frame of the selected frame in the morphing sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest HInts Automatically sets Automatically sets hint points on key drawings as a help tool. 
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If you're not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Function View Menu

The Functions View menu lets you do many things in the Camera view, including selecting and editing objects 
in different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Function menu

 l In the upper-left corner of the Function view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select Next Keyframe Selects the next keyframe.

Select Previous 
Keyframe

Selects the previous keyframe.

Select Left Handle Selects the left handle of the selected keyframe.

Select Right Handle Selects the right handle of the selected keyframe.

Select All
Selects all objects in the Function view. This helps you manage multiple objects 
as one.

Deselect All Deselects all selected objects in the Function view.

View
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Show Current Frame Displays the current frame 

Toggle Grid Enables the display of the grid.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Function List

Auto Load Selection
Sets the Function view to automatically load the functions of layers when the 
node is selected in the Node View.

Clear Will clear all functions in the Function view.

Load Selection Loads the functions of the current node selection.

Add Selection Adds the functions of the currently selected node.

Remove Selection Will remove the function of the currently selected node from the Function view.

Show

Show Motion: Displays the function for Motion (the Pos_x and Pos_y).

Show Rotation: Displays the function for Rotation (Angle_z).

Show Scale: Displays the function for Scaling (Scale_x and Scale_y).

Show Skew: Displays the function for Skew.
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Library View Menu

The Library View menu lets you access commands specific to the Library view, such as opening a Library or 
getting the rights to modify a library folder.

How to access the Library menu

 l In the upper-left corner of the Library view, click the menu button.

Command Description

View

List Displays the contents of the selected folder as a list.

Thumbnails Displays the contents of the selected folder as a thumbnails.

Details Displays the details of the selected file.

Generate Thumbnails Creates a thumbnail to display in the preview window.

Edit

New Symbol

Creates a new symbol from a drawing or part of a drawing in the Drawing or 
Camera view, or a layer in the Timeline view. 

If your selection is in the Timeline , the new symbol appears in the  Symbol folder. 
The current selection is not replaced by the new symbol. The new symbol only 
appears in the library. You must drag it into your scene to use it.

If your selection is in the Drawing or Camera view, the new symbol appears in the 
Symbol folder and in the Timeline view as a new layer.

Cut Cuts the selected file in the Library view.

Copy Copies the selected file in the Library view.

Paste Pastes the selected file in the Library view.

Delete Deletes the selected file in the Library view.
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Delete Thumbnails Deletes any thumbnails that were generated for display in the preview window.

Edit Symbol

Places you inside the symbol where you can edit it. 

To return to the project's timeline, click the Top  button in the Camera view's 
top-left corner, press  Ctrl + Shift + E (Windows/Linux) or ⌘  + Shift + E (macOS). 

Remove Unused Files Removes any files not in use in the selected template.

Rename Template Lets you rename a selected template.

Import Files
Imports vector files such as AI, PDF, and SWF. You requires the right to modify 
the library in which you want to import the files.

Folders

New Folder
Creates a new folder in the Library view. Before you can create a new folder, you 
must have the right to modify the folder in which you are creating the new folder.

Refresh Updates the view and its contents.

Open Library Lets you open a library on your computer.

Close Library Unlinks a library folder from your library list.
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Reference View Menu

The Reference View menu lets you load models and view them in different ways, as well as access some 
drawing tools.

How to access the Reference menu

 l In the upper-left corner of the Reference view, click the menu button.

Icon Tool/Command Description

View Menu  

Previous
Shows the previous model loaded in the 
Reference view.

Next
Shows the next model loaded in the Reference 
view.

Import References
Imports a TVG drawing as a model in the 
Reference view.

 
Use Current Drawing as 
Reference

Loads the currently selected drawing in the 
scene as a model in the Reference view.

  Load Default References
Loads TVG drawings placed in a custom 
models folder located in the scene folder.

  Unload Current Unloads the image from the Reference View.

  Delete Current Deletes the image in the Reference view.

  Zoom In Zooms in the view.

  Zoom Out Zooms out the view.

  Reset Zoom Resets the view’s zoom to its default position.

  Reset Pan Resets the view’s pan to its default position.
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  Reset View Resets the view to its default position.

  Rotate View CW
Rotates the Camera view 30 degrees 
clockwise, like an animation table.

  Rotate View CCW
Rotates the Camera view 30 degrees counter-
clockwise, like an animation table.

  Reset Rotation
Resets the view’s rotation to its default 
position.

Select
Activates the Select tool. This tools is also 
available on the Tools toolbar.

Cutter Selection
Allows to cut a section of the model to paste it 
in your scene.

Colour Eyedropper
Activates the Colour Eyedropper tool. This 
tools is also available on the Tools toolbar.

Zoom
Activates the Zoom tool. This tools is also 
available on the Tools toolbar.
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Onion Skin View Menu

The Onion Skin view menu contains extra options for controlling the Advanced Onion Skin. It is accessible via 
the Onion Skin view—see Onion Skin View on page 703.

How to access the Onion Skin view menu

 1. In the top-left corner of the Onion Skin view, click on the  View Menu button.

Command Description

Advanced 
Onion Skin

Enables Advanced Onion Skin. Advanced Onion Skin allows you to select, on the fly, which 
drawings to include in your Onion Skin, even if those drawings are not consecutive drawings, as 
well as the opacity scales for the drawings before and after the current frame. 

The controls for selecting which drawings to display in the Onion Skin as well as their opacity 
sliders are only accessible when Advanced Onion Skin is enabled. Otherwise, when using 
regular Onion Skin, the opacity of drawings in the Onion Skin is determined by the Onion Skin 
settings in the Preferences dialog. The amount of drawings to include in the Onion Skin is set 
using the Onion Skin Add / Reduce One Previous Drawng and Onion Skin Add / Reduce One 
Next Drawing commands, available in the Camera and Drawing toolbars as well as in View > 
Onion Skin in the top menu. 

Original Colors Displays the onion skin using the actual colours of the drawings. 

Coloured
Displays the onion skin using the colours selected for the previous and next drawings in the 
Onion Skin view. 

Coloured 
Outlines

Displays the onion skin using the colours selected for the previous and next drawings, but only 
as outlines instead of filled shapes. 

Onion Skin by 
Frames

Selects the drawings to display in the Onion Skin by the amount of different drawings before 
and after the current frame. For example, if the Onion Skin is set to include 2 drawings before 
and after the current frame, this will display the nearest two different drawings before and 
after the drawing in the current frame in the Onion Skin, even if those drawings are further than 
2 frames away from the current frame. This is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust the extent of the Onion 
Skin in the Timeline view are not available. 

Onion Skin by Selects the drawings to display in the Onion Skin by the amount of different drawings before 
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Command Description

Drawings

and after the current frame. For example, if the Onion Skin is set to include 2 drawings before 
and after the current frame, this will display the nearest two different drawings before and 
after the drawing in the current frame in the Onion Skin, even if those drawings are further than 
2 frames away from the current frame. This is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust the extent of the Onion 
Skin in the Timeline view are not available. 

Apply Colour 
Wash

Displays onion skins with a lighter, less saturated colour. The further away the drawing is from 
the current frame, the more washed its colour appears. 

NOTE 

The minimum and maximum colour wash values for Onion Skin can be customized in the 
Drawing tab of the Preferences dialog.

Enable Onion 
Skin for Other 
Elements

In the Drawing View, when the Light Table is enabled, making other layers visible alongside 
the current layer, this will make the Onion Skin for other visible layers appear alongside the 
Onion Skin for the current layer. Drawings for elements above the current layer will appear in 
blue, and drawings for elements below will appear in yellow. 

NOTE 

The drawings from other elements that get displayed in the Onion Skin are the drawings 
that are exposed at the same time as the drawings displayed in the current layer's Onion 
Skin. 

Link Sliders

When enabled, the opacity sliders in the Onion Skin view will move simultaneously as you 
adjust one of them, so that the opacity levels for previous and next drawings progresses from 
the opacity level of the first drawing to the opacity level of the last drawing.

When this mode is enabled, you can adjust the first and last sliders for previous or next 
drawings, then, optionally, adjust a single one of the sliders in-between to create a segmented 
progression. 

However, if you want to make the opacity of Onion Skin drawings to vary in any way that is 
more complex, you must disable this option.
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Perspective View Menu

The Perspective View menu lets you select and edit elements, manipulate the view during scene setup, set 
parameters for animation and access animation tools.

How to access the Perspective menu

 l In the upper-left corner of the Perspective view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste in Place Pastes the copied object in the same place as the original.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.
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Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms into the view, towards the view's pivot point, up to 80,000%.

Zoom Out Zooms out of the view, away from the view's pivot point, up to 1%.

Move Forward
Moves infinitely forward into the view, using the direction set by the current 
position and angle of rotation.

Move Backward
Moves infinitely backwards out of the view, using the direction set by the 
current position and angle of rotation.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Light Table

Turns on the light table so you can see Turns on the light table so you can see 
the previous and subsequent active layers in washed-out colours. It is useful 
for seeing the other layers when designing, animating or cleaning up your 
animation. 

Camera Cone Displays the camera cone.
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Clipping Planes

Allows you to change the near and far clipping distances. The far clipping 
distance value specifies how far the camera can see. The near clipping 
distance value specifies how close the camera can see. By default, the near 
clipping distance is 1 and the far clipping distance is set to 1000. 

NOTE 

The maximum value for far clipping distance is 100,000.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate Animate

Animate 
Current 
Frame

When this option is selected, every time you use the  Transform or 
 Advanced Animation tools to manipulate an element in your scene, 

the position of the element will be stored in a keyframe at the current frame. 
This allows you to animate elements in your scene without creating keyframes 
manually.

Animate Onion 
Skin Range

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformations to an element in your 
scene, the transformations will be stored as keyframes at the beginning and at 
the end of the current Onion Skin range, as well as on every existing keyframe 
in-between. This can be useful if you want to reposition an element that you 
have already animated, but only during a specific range of frames, which you 
can define by enabling Onion Skin and setting the Onion Skin range to cover 
that range of frames.

Animate Off

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformation to an element in your 
scene, the transformations will affect the element throughout the whole 
scene. This can be useful if you want to reposition an element after you have 
already animated it. 

Insert Keyframe Adds a keyframe to the currently selected frame in the Timeline view.
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Insert Control Point
Adds a control point to the motion path at the currently selected frame. This 
control point does not appear in the Timeline, but can be used to reshape the 
motion path. In order for this command to work,  layers must be set to 3D Path. 

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion 
keyframes, Harmony generates the interpolation between the motion 
keyframe and the next keyframe. This means that a value for each frame 
between the keyframes is calculated by Harmony to progress from the value 
of the previous keyframe to the value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis of 
the layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.

Linear Motion Straightens out the motion path on either sides of the selected control point.

Lock in Time
Indicates whether the point is locked to a specific frame (keyframe) or only 
locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Locks the Z value when you're animating in 3D space. This means you can 
only reposition your object along the x and y axes. 

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next 
drawing.
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Substitute Drawing Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. 
All transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 
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Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Skew Slants the selected element.

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your drawing. 
Also, if you have several elements attached to one trajectory, you might want 
your trajectory to be at a different location to represent the group's motion 
better.
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Script Editor View Menu

The Script Editor view menu gives you access to all of the commands needed for editing and testing scripts in 
the Script Editor view—see Script Editor View on page 714.

How to access the Script Editor view menu

 1. Add the Script Editor view to your workspace by doing one of the following:

 l In the top-right corner of an existing view, click on the  Add View button and select Script 
Editor.

 l In the top menu, select Windows > Script Editor.

 2. In the top-left corner of the Script Editor view, click on the  Menu button.

Button Description

File

New Script

Creates a new script. When you click on this button, you are first prompted to type 
in a name for the script. Then, you will be prompted to select which location to 
save the script in:

 l User: Saves the script to a directory in your user preferences directory. You 
will be able to run and edit the script from any scene as long as you are 
logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using 
Harmony Server, the script will be saved to the preferences for your 
Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the 
script to the Harmony database's global script directory. Anyone who is 
logged in to the database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save 
the script to the current scene's environment. Anyone will be able to edit 
and run the script as long as they are working on a scene inside this 
environment.

 l Job: If you are using Harmony Server, select this option to save the script to 
the current scene's job. Anyone will be able to edit and run the script as 
long as they are working on a scene inside this job.
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Button Description

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be 
able to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_
GLOBAL_SCRIPT_LOCATION environment variable. This option is only 
available if this environment variable is set.

NOTE 

For more information on script locations, see Script list on page 714.

Import Script

Allows you to import a script from your machine into Harmony. When you click on 
this button, you are prompted to browse for and select a script on your file system. 
Then, you are prompted to select which location to import the script in:

 l User: Saves the script to a directory in your user preferences directory. You 
will be able to run and edit the script from any scene as long as you are 
logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using 
Harmony Server, the script will be saved to the preferences for your 
Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the 
script to the Harmony database's global script directory. Anyone who is 
logged in to the database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save 
the script to the current scene's environment. Anyone will be able to edit 
and run the script as long as they are working on a scene inside this 
environment.

 l Job: If you are using Harmony Server, select this option to save the script to 
the current scene's job. Anyone will be able to edit and run the script as 
long as they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be 
able to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_
GLOBAL_SCRIPT_LOCATION environment variable. This option is only 
available if this environment variable is set.
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Button Description

NOTES 
 l When you import a script, any user interface (.ui) or icon (.png) file that 

is in the same directory and has the same filename as the script will also 
be imported.

 l For more information on script locations, see Script Editor View on page 
714.

Delete Script

Deletes the selected script. 

NOTES 
 l You cannot delete a script if it is in the Application Resources location, as 

those are scripts that are installed with Harmony.

 l If you delete a script that was originally in Application Resources but 
which you copied to another location so you could make changes to it, the 
original version of the script in the Application Resources folder will be 
restored to the list. 

Refresh Script File 
List

Refresh the list of scripts in the Script Editor. If there are new scripts in your user 
preferences or your scene's scripts sub-folder, click on this button to be able to 
open them in the Script Editor. 

Editor

Set External Editor

Allows you to type in the path and name for your preferred text editing software.

NOTES 
 l On macOS, only typing the name of your preferred text editing software 

is enough if that application supports the AppleScript Open Document 
protocol. 

 l On Windows and GNU/Linux, unless your text editor is in your system's 
PATH environment variable, you will have to type in the full path to the 
editor. 

External Editor Opens the selected script in the chosen external text editing software. 

Play/Debug

321

Harmony 24 Advanced Reference Guide                          



Chapter 2: Menus

Button Description

Set Target

Prompts you to select which script and which function to use with the Run and 
Debug commands.

NOTES 
 l You can set the entire script as the target by selecting the <Nothing> 

function from the functions list.

 l You cannot link an entire script to a toolbar button. Only functions within 
scripts can be added as toolbar buttons. Therefore, running or debugging 
an entire script rather than one of its functions should be done for testing 
purposes only.

Run

Runs the target script and function. 

NOTES 
 l If you have not set a target script and function, you will be prompted to 

set one when you select this command.

 l You can set or change the target script and function by selecting Set 
Target from this menu.

 l If you are editing <<<Sandbox>>>, this button will simply run what you 
typed into the sandbox, regardless of whether another target is set.

Debug

Open the target script and function in the Qt Script Debugger, in which you can test 
and debug the function.

NOTES 
 l If you have not set a target script and function, you will be prompted to 

set one when you select this command.

 l You can set or change the target script and function by selecting Set 
Target from this menu.

 l If you are editing <<<Sandbox>>>, this button will simply debug what 
you typed into the sandbox, regardless of whether another target is set.

Stop If a script is currently running, this interrupts its execution.

Help

Scripting Interface 
Documentation

Opens the reference documentation for the Harmony scripting interface in a web 
browser. 
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Button Description

NOTE 

This documentation is installed with Harmony and does not require Internet 
access. 
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Side View Menu

The Side View menu lets you position elements in 3D space, set parameters for animation and access 
animation tools—see Side View on page 719.

How to access the Side menu

 l In the upper-left corner of the Side view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children Lets you select all elements parented to the selected peg element in the 
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Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate
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Animate 
Current 
Frame

When this option is selected, every time you use the  Transform or 
 Advanced Animation tools to manipulate an element in your scene, 

the position of the element will be stored in a keyframe at the current frame. 
This allows you to animate elements in your scene without creating keyframes 
manually.

Animate Onion 
Skin Range

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformations to an element in your 
scene, the transformations will be stored as keyframes at the beginning and at 
the end of the current Onion Skin range, as well as on every existing keyframe 
in-between. This can be useful if you want to reposition an element that you 
have already animated, but only during a specific range of frames, which you 
can define by enabling Onion Skin and setting the Onion Skin range to cover 
that range of frames.

Animate Off

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformation to an element in your 
scene, the transformations will affect the element throughout the whole 
scene. This can be useful if you want to reposition an element after you have 
already animated it. 

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion 
keyframes, Harmony generates the interpolation between the motion 
keyframe and the next keyframe. This means that a value for each frame 
between the keyframes is calculated by Harmony to progress from the value 
of the previous keyframe to the value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis of 
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the layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.

Linear Motion
Transforms a curved path to a linear path removing tension, bias, and 
continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) 
or only locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the next 

drawing.

Substitute Drawing Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.
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Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. 
All transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your drawing. 
Also, if you have several elements attached to one trajectory, you might want 
your trajectory to be at a different location to represent the group's motion 
better.
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Timeline View Menu

The Timeline View menu lets you modify layers, keyframe and timing.

How to access the Timeline menu

 l In the upper-left corner of the Timeline view, click the menu  button.

Parameter Description

Import

From Scanner Imports drawings from a TWAIN scanner.

Images Imports bitmap images which you can choose to vectorize.

Sounds Lets you import sound files into your project.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from 
Xsheet

Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse and 
Reverse-Forward.

Paste Reverse Reverses the timing of drawings or keyframes in range of selection after copying.
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Delete Removes selected objects.

Modify Paste Presets
Lets you modify existing presets when pasting keyframes and exposures. There 
are three presets you can modify: the default presets for both key frames and 
exposures, key frames only and exposures only. 

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Synced Layers
Selects all the layers synced to the selected layer. The selected layer must be a 
synced in order for this option to be enabled.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent 
Skipping Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Lock Lock: Locks Locks one or a multiple selection of layers. 
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Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Tag

Timeline Tag: You can tag elements in the Timeline or Node views to view only 
those elements. When you tag elements, an asterisk appears beside the item in 
the Timeline view. Once your elements are tagged and you have switched over to 
View Tagged Layers mode, the Timeline view will display only tagged elements. 
The red bar on the left of the layers indicates you are in this view mode.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Scene Markers

Mark Current Frame: Places a scene marker on the current frame on which the 
playhead is parked. The marker appears in the frame counter area of the Timeline 
view. You can customize the colour of the scene marker and add text to display as 
a tooltip when you hover over the marker—see .

Create Scene Marker: Creates a scene marker from a selected frame range in the 
frame counter area of the Timeline view.

Edit Scene Marker: Lets you edit an existing scene marker. 

NOTE: It's important to select the entire length of the scene marker, otherwise 
the Timeline Scene Marker dialog box will not open for editing.

Delete Scene Marker: Removes an existing scene marker.

Share Functions
Lets you share an existing function curve. By default, all function curves can only 
be used and modified using their original parameter. If you want another layer or 
parameter to use the same function curve, you must share it.

View
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Cycle to Next View 
Mode

Displays the new view mode.

Normal View Mode

Displays the Normal view mode, the default in the Timeline view. It shows 
everything connected to the chosen display. In this mode, anything not connected 
to the currently set default display will not be shown in the Timeline view. This 
also means that you cannot add certain elements to the Timeline view, as by 
default, when added they are not connected to any display or composite node. 
An example of such an element is a peg.

Selection Only Mode
Displays only elements currently selected in the Camera or Node view. This 
makes it easier to concentrate on one or a few elements at a time.

View Tagged Layers

Lets you see only elements which have been assigned a Tagged status. An item 
that has been tagged will appear in the Timeline view with a small asterisk 
beside its name. 

Once your elements are tagged and you have switched over to View Tagged 
Layers mode, the Timeline view will display only tagged elements. The red bar 
on the left of the layers indicates you are in this view mode. While in this mode, 
the asterisks are not displayed beside the tagged elements.

Show Functions  

Centre on Selection
Scrolls the layers list to the currently selected layer. This is useful if you want to 
select a layer in the Camera view, then manipulate its timing Timeline view. 

Change Track Colour Opens the colour picker window to modify the colour of the selected layer.

Default Track Colour Resets the layer colour.

Collapse/Expand
Toggles between expanding and collapsing all parent layers in the Timeline 
view.

Collapse All Collapses all parented layers in the Timeline view.

Expand All Expands all parented layers in the Timeline view.

Set Tempo Marker

Lets you set a marker that synchronizes your animation with a musical score. This 
lets you reproduce the FPB (Frames Per Beat) and use the tempo signature as 
tempo markers. The Xsheet view lets you pace your animation according to the 
tempo or beat of the soundtrack music or to any rhythmic sound, such as the 
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ticking of a clock or water leaking from a spout. See .

Layers

Add Synced Drawing Layer
Creates a new drawing layer whose timing is synced immediately with the 
currently selected drawing layer.

Sync Layer With
Opens the Convert to Synced Drawing Layer dialog box. In this dialog box, every 
other drawing layer in the project can be selected, parented and have its timing 
synced to the currently selected layer.

Unsync Layer Unsyncs the parent layer of a synced pairing, when the child layer is selected.
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Top View Menu

The Top View menu lets you position elements in 3D space, set parameters for animation and access 
animation tools—see Top View on page 732.

How to access the Top menu

 l In the upper-left corner of the Top view, click the menu button.

Command Description

Edit  

Cut Drawing Object
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Drawing Object Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Drawing Object Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Lets you select the parent of the selected element in the Timeline view.
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Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Animate 
Current 
Frame

When this option is selected, every time you use the  Transform or 
 Advanced Animation tools to manipulate an element in your scene, 

the position of the element will be stored in a keyframe at the current frame. 
This allows you to animate elements in your scene without creating keyframes 
manually.

Animate Onion 
Skin Range

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformations to an element in your 
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scene, the transformations will be stored as keyframes at the beginning and at 
the end of the current Onion Skin range, as well as on every existing keyframe 
in-between. This can be useful if you want to reposition an element that you 
have already animated, but only during a specific range of frames, which you 
can define by enabling Onion Skin and setting the Onion Skin range to cover 
that range of frames.

Animate Off

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformation to an element in your 
scene, the transformations will affect the element throughout the whole 
scene. This can be useful if you want to reposition an element after you have 
already animated it. 

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion 
keyframes, Harmony generates the interpolation between the motion 
keyframe and the next keyframe. This means that a value for each frame 
between the keyframes is calculated by Harmony to progress from the value 
of the previous keyframe to the value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis of 
the layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.
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Linear Motion

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) 
or only locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the next 

drawing.

Substitute Drawing Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. 
All transformations are reset regardless of the tool you're using.

Reset All Except Z
Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
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particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your drawing. 
Also, if you have several elements attached to one trajectory, you might want 
your trajectory to be at a different location to represent the group's motion 
better.
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Xsheet View Menu

The Xsheet View  menu lets you modify columns, keyframe and timing.

How to access the Xsheet menu

 l In the upper-left corner of the Xsheet view, click the menu button.

Parameter Description

File

Import

Images: Imports bitmap images which you can choose to vectorize.

From Scanner: Imports drawings from a TWAIN scanner.

Sounds: Lets you import sound files into your project.

Print
Prints the exposure sheet so you can take it to your animation table,  provide a 
copy to the animator, or create your Xsheet skeleton directly in Harmony.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from 
Xsheet

Copies selected objects and properties.

Paste Cells in Xsheet Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse and 
Reverse-Forward.
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Paste Reverse Reverses the timing of drawings or keyframes in range of selection after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Insert Mode

Adds a new value or a new value sequence over existing ones, the new values 
are inserted between the old ones. The existing timing sequence is pushed down 
the column. The Insert mode opposite of the Overwrite mode, which is the Xsheet 
default mode.

Gestural Drag Mode

Lets you drag a cell to any other frame in the same column or into another 
column.

This feature does not apply to Annotation columns.

Send to Function 
View

Sends selected objects to the Function view where you can edit and adjust its 
function curve and parameters.

View

Zoom In Xsheet Zooms in the view.

Zoom Out Xsheet Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Set Tempo Marker  

Expand/Collapse

Collapse Selection: 

Expand Selection: 
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Collapse All: 

Expand All: 

Column Properties

Lets you rename a column, and enable or disable a column. To view additional 
properties, select Edit > Preferences from the top menu. In the Preferences 
dialog box, select the Advanced tab, then select the Advanced Element Mode 
option.

Show Column List  

Column Types 
Manager

Lets you add advanced column types to create particular animation paths. When 
you create these columns, they are not linked automatically to any particular 
drawing layer. You can create a motion path using these columns and then link or 
unlink several drawing or peg layers to it. 

Show Thumbnails
Displays column thumbnails making it easier to identify a particular column. This 
option displays a small thumbnail picture of the current frame below the column 
header.

Show Selection  

Set Columns Width Lets you change the column width (in pixels) and set it as the default.

All Columns to 
Default Width

Returns all columns to their default width of 100 pixels.

Change Columns 
Colour

Lets you customize the colour of the column by selecting one from the Select 
Colour dialog box. The colour you select is also reflected in the correspondng 
layer in the Timeline view.

Default Column 
Colour

Removes the colour you assigned to a column (if any).

Hide Selected 
Columns

Hides selected columns.

Unhide All Columns Displays all columns.

Show Hidden 
Columns

Displays columns that were previously hidden.
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Enable Playback Plays back your animation in the Perspective view.

Columns

Add Columns
Lets you add a column. You can specify the column name, type, and set drawing 
layer options in the Add Column dialog box that opens.

Delete Columns
Removes the selected column. You have the option to delete the associated 
drawing files and element folders.

Clone Selected 
Columns: Drawings 
Only

Creates a copy of the selected column that is linked to the original. If a drawing is 
modified in the original or cloned column, both will be updated. However, cloned 
columns can have different timings. 

You can clone the drawings only or both the drawings and timing.
Clone Selected 
Columns: Drawings 
and Timing

Duplicate Selected 
Columns

Creates an independent copy of the selected column.  This useful when you need 
to modify the element independently, including the timing (exposure). Changes 
to the original element do not propagate to the duplicate.

Merge Selected 
Columns

There are two methods of merging drawings. 

 l You can merge selected drawings in adjacent elements. The columns and 
layers will be left intact, and each new merged drawing will reside in the 
frames of the left-most column or lower layer.

 l You can merge elements. All drawings will be merged. Unused columns 
and layers will be deleted, but the original drawing files are still 
accessible.

Frames  

Add Frames At Start

Adds the number of frames you specify to the end of the scene.

Add Frames At End

Add Frames Before 
Selection

Adds the number of frames you specify before or after your selection.

Add Frames After 
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Selection

Remove Selected 
Frames

Deletes the selected frames from your scene.

Drawings

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Rename Drawing Lets you give a selected drawing a new name.

Mark Drawing As

Marks selected drawings as one of the following: Key, Breakdown, In-between, 
RetakeKey, RetakeBD or RetakeIB.

This helps to keep the Xsheet well organized while animating.

When working with several animators, directors or even other studios, the 
necessity for retakes will often arise. Harmony gives you the possibility to mark 
new drawings as either Retake Key, Retake Breakdown, or Retake In-betweens.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Exposure

Increase
Adds Adds one more exposure to a selected cell; repeating this action adds an 
extra cell each time. This is an efficient way to extend a drawing's exposure and 
is always set in Insert mode. Increasing an exposure pushes the existing 
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exposure forward.

Decrease
Decreases exposure of a selected cell by one; repeating this action decreases one 
exposure adds an extra cell each time. This is an efficient way to shorten a 
drawing's exposure. Decreasing an exposure pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure Lets you extend the length of a selected cell.

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure Removes key exposures from the selected cells.

Remove Duplicate 
Key Exposure

When working with drawings to adjust the timing of a mouth in a lipsync, for 
example, and forcing the use of specific key exposures, unnecessary key 
exposures will be created. You can delete these duplicates without affecting the 
rest of the drawing. The first drawing of the selection will be used for the range.

NOTE 

Duplicate key exposures may occur when pasting with the Enforce Key 
Exposure option selected.

Fill Empty Cells

Lets you Fills the empty frames in the selection with the exposure just before. For 
example, if you select a range of frame that starts with an exposed drawing and 
then ends with empty cells, all of the empty cells in the selection will be filled 
with the exposed drawing just before the empty cells. 

Insert Blank Cell Adds Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Fill Selection

Lets you Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many columns, an 
entire column, or many columns. You can use numbers, words, letters, or any 
alphanumeric value.
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Sequence Fill

Lets you Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a cycle, and so 
on. The selection can be over one cell or a cell range in one column or more or an 
entire column or many entire columns.

Fill Cells Randomly

Lets you Lets you fill in random values over a selection. You can give a maximum 
and a minimum value and create a range for Harmony to choose the random 
values from. The selection can be over one cell or a cell range in one column or 
more or an entire column or many entire columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Motion

Insert Keyframe

Insert Keyframe and 
Duplicate Drawing

 

Delete Keyframes Deletes the selected keyframes.

Go to Previous 
Keyframe

 

Go to Next Keyframe  

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to 
the value of the next keyframe. 

Morphing

Create Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 
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Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire sequence 
between the two keyframes.

Insert Morphing Key 
Drawing

Creates a morphing keyframe from a selected morphing frame.

Convert Morphing to 
Drawing

Lets Lets you convert your morphing inbetweens to real drawings you can edit. 
This is useful when manually editing a morphing sequence or if you prefer to 
have animation timing in double frame (on twos) instead of single frame (on 
ones). 

Lip-Sync

Change Mouth Shape 
to

Lets you change the mouth shape to one of the following: A, B, C, D, E, F, G, X.

Auto Lip-Sync 
Detection

Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps Automatically maps drawings in an element to the mouth 
chart you have generated for a sound. This can save time when you are lip-
synching a voice track.

Sound Display

Sound Name
Shows the name of the sound file, as well as the file format. The line running 
vertically through the column frames between the same file name indicates a 
continuity of the same sound file in these frames.

Mouth Shapes

Shows the letter (or name depending on the way you named your character's 
different mouth positions) in the column's frames. There is only one mouth 
position allotted per frame and this position should correspond to the sound file 
after performing a lip-sync.

Waveform

Shows a vertical display of the sound file's actual waveform. In the column 
header, in the field under the column name, you can type in a percentage to zoom 
in or zoom out on the waveform, or pass the scroll cursor  over the Zoom 
Waveform  icon.

Sound Edit
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Insert Blank Cell Places an empty cell between other cells. 

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Annotation

Import File Lets you import an image file in an Annotation column.

Change Pen Colour
Lets you change the pen colour by selecting one from the Select Colour dialog 
box.

Pen Width Lets you select a pen preset or change the pen width (in pixels).

Eraser Width Lets you modify the width of the Eraser tool.

Erase All
Removes all text and drawn annotations. Annotations that you type in cannot be 
erased using this method.

Erase Selected 
Images

Removes images you select in the Annotation column.

Erase Selected Texts Removes text you select in the Annotation column.

Enable Drawing Lets you draw in the Annotation column using your mouse or pen tablet.
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Chapter 3: Layers
In Harmony, everything that constitutes the different elements of a scene, including drawing layers, sound 
effects, visual effects and pegs is represented by a layer in the Timeline view.

At the core of the rendered picture is the drawing layer, which is used to display drawings. Those layers are 
rendered from bottom to top, with the bottommost layer appearing in the background, and the topmost layer 
appearing in the foreground.

Some layers, such as Peg, Bone or Quadmap layers, are made to offset drawing layers. They must be created 
as the parent of a drawing layer, or of a hierarchy of drawing layers, in order to transform the layers in the 
rendered image.

Other layers, such as Blur and Transparency layers, are made to transform the picture output by drawing 
layers. They must be created as children of drawing layers, or groups of drawing layers, in order to transform 
the drawings. 

Deformation Layers 350

Bone Layers 351

Deformation Composite Layer 353

Game Bone Layer 354

Kinematic Output Layer 356

Effect Layers 357

Blending Layer 358

Blur Layer 363

Blur-Gaussian Layer 365

Colour-Override Layer 367

Colour-Scale Layer 371

Cutter Layer 373

Glow Layer 375

Highlight Layer 378

Shadow Layer 382

Tone Layer 385

Transparency Layer 389

Image Layers 391

Colour-Card Layer 392

Drawing Layer 394
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Move Layers 408

Camera Layer 409

Peg Layer 410

Quadmap Layer 412

Sound Layer 415
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Deformation Layers
Deformation layers are layers that make deformers. In Harmony, deformers are made of chains of deformation 
layers laid out in a hierachy. Each deformation layer represents a point in the deformation chain.

Bone Layers 351

Deformation Composite Layer 353

Game Bone Layer 354

Kinematic Output Layer 356

350



Bone Layers

The Bone node is one of the main nodes used to build a deformation rig. Each Bone node consists of a bone 
and an articulation. You can chain Bone nodes to create a skeleton chain for your character. The Rigging tool 
can be used to create and connect those nodes automatically. 

Properties

Parameter Descriptions

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Resting Parameters Rest Offset

(x) Axis This is the bone x-axis (horizontal) coordinates for the resting position.

(y) Axis This is the bone y-axis (vertical) coordinates for the resting position.

351

Harmony 24 Advanced Reference Guide                          



Chapter 3: Layers

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Bias This is the articulation's bias (roundness and smoothness) for the resting position.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y-axis parameters are controlled by the 
same 2D path function.

Separate
When this option is enabled, the X and Y-axis parameters are individual one from 
another.

Path When using a 2D Path, this field displays the name of the function.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

(y) Axis
This is the bone y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation position. 
This parameter can be linked to a function to be animated over time.

Orientation
This is the bone's orientation angle for the animation position. This parameter can 
be linked to a function to be animated over time.

Bias
This is the articulation's bias (roundness and smoothness) for the animation 
position. This parameter can be linked to a function to be animated over time.

Length
This is the bone's length for the animation position. This parameter can be linked 
to a function to be animated over time.
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Deformation Composite Layer

The Deformation-Composite node is automatically added to a rig when creating a split deformation chain. It is 
used to link the different nodes of a split deformation chain together before deforming the drawing it is linked 
to.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has 
no visible effect on the rendered image, nor on the preview in the 
Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name Use this field to rename the node.
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Game Bone Layer

The Bone node is one of the main node used to build a deformation rig. Each Bone node consists of a bone and 
an articulation. Chaining Bone nodes will create a skeleton chain for your character. The Rigging tool can be 
used to create and connect those nodes automatically.

Parameter Descriptions

Resting Parameters Rest Offset

(x) Axis This is the bone X-axis (horizontal) coordinates for the resting position.

(y) Axis This is the bone Y-axis (vertical) coordinates for the resting position.

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y axis parameters are controlled by the 
same 2D path function.
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Separate
When this option is enabled, the X and Y axis parameters are individual from each 
other.

Path When using a 2D Path, this field displays the name of the function curve.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

(y) Axis
This is the bone Y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation position. 
This parameter can be linked to a function curve to be animated over time.

Orientation
This is the bone's orientation angle for the animation position. This parameter can 
be linked to a function curve to be animated over time.

Length
This is the bone's length for the animation position. This parameter can be linked 
to a function curve to be animated over time.
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Kinematic Output Layer

The Kinematic Output node lets you hook a separate element that you want to be linked to the deformation 
chain but not be part of the deformation, such as a hand to an arm or an arm to the body. These elements will 
follow the movement of the chain just like a regular cut-out character hierarchy piece without being influenced 
by the deformation of the arm. If you don't use the Kinematic Output, the piece's pivot will not follow the 
deformation.

Connect a Kinematic Output node below the deformation node you want your drawing to follow.
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Effect Layers
Effect layers can be connected under a layer or under a group to transform the image. 

Should you need to apply the same effect to several layers combined, you must group them together so that 
Harmony composes those layers into a single image before applying the effect. 

Blending Layer 358

Blur Layer 363

Blur-Gaussian Layer 365

Colour-Override Layer 367

Colour-Scale Layer 371

Cutter Layer 373

Glow Layer 375

Highlight Layer 378

Shadow Layer 382

Tone Layer 385

Transparency Layer 389
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Blending Layer

T-COMP2-005-001

By default, layers are composited onto each other directly. This means that opaque pixels in front-most layers 
hide pixels in layers further back, and semi-transparent pixels on front-most layers are blended with pixels 
further back proportionally to their alpha ratio. This does the job for solid objects. However, some types of 
layers and effects may look better when composited into the scene using more advanced approaches. The 
Blending node can be used to composite an element, effect or group using one of many different algorithms 
that may make it look much better in the final render.

NOTE 

The effect of the Blending node is only visible when the Camera view is in Render Preview  
mode.

Connection

A Blending layer can be connected under a layer, an effect or a group to affect the way it will be composited 
into the scene.

Properties

Parameter Description
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Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name Allows you to change the name given to the node.

Blend Mode

Choose the blending effect mode you wish to apply to your layer. 

NOTE 

Some of the available blending modes have a BETA or Legacy variant to them.                         

 l A BETA blending mode is one that has been recently added in Harmony 
and which was made to more closely resemble results obtained in 
professional photo editing software such as Adobe Photoshop.

 l A Legacy blending mode is a blending mode that was present in older 
versions of Harmony. Starting from Harmony 10, these blending modes 
were enhanced by de-multiplying colours before compositing the image 
then re-multiplying them. Their legacy version remain available to ensure 
scenes created in older versions of Harmony do not render differently. 

 l Normal: Composites the image without any specific blending effect.

 l Erase:Subtracts the overlay pixel's alpha from the underlay pixel, "cutting 
out" the overlay from the underlay. The overlay pixel's colour information is 
ignored. 

 l Invert:Inverts the underlay pixel proportionally to the alpha value of the 
overlay pixel. The overlay image hence acts as a "matte" for an invert effect. 

 l Replace:Ignores the underlay pixel completely, outputting the overlay pixel 
as if nothing existed behind it. This applies to all overlay pixels that have an 
alpha value of at least 1, so the negative space of the overlay image will not 
hide the underlay image. If the overlay pixel is not fully opaque, it will be 
mixed with black. 

 l Colour Burn: Darkens each channel in the underlay pixel with the darkness 
value of the corresponding channel in the overlay pixel, by increasing the 
contrast of the underlay pixel. 

 l Darken: For each channel, uses the value that is the darkest between the 
underlay pixel and the overlay pixel. 

 l Linear Burn: Darkens each channel in the underlay pixel with the darkness 
value of the corresponding channel in the overlay pixel, by reducing the 
brightness of the underlay pixel. 

 l Multiply: Multiplies the value of each channel in the underlay pixel with the 
value of each channel in the overlay pixel, treating those values as ratios. 
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Multiplying anything with black will result in black, and multiplying anything 
with white will leave the colour unchanged.

 l Colour Dodge: Lightens each channel in the underlay pixel with the 
brightness value of the corresponding channel in the overlay pixel, by 
decreasing the contrast of the underlay pixel. 

 l Lighten: For each channel, uses the value that is the brightest between the 
underlay pixel and the overlay pixel.

 l Linear Dodge: Lightens each channel in the underlay pixel with the 
brightness value of the corresponding channel in the overlay pixel, by 
increasing the brightness of the underlay pixel. 

 l Screen: The reverse of multiply. Multiplies the reverse value of each channel 
in the underlay and overlay pixel, treating those values as ratios. Multiplying 
anything with white will result in white, and multiplying anything with black 
will leave the colour unchanged. 

 l Vividlight: This colour dodges overlay pixels with a value above 50% onto 
underlay pixels, and colour burns overlay pixels with a value below 50% 
onto underlay pixels. The brighter the overlay pixel is, the more intense the 
colour dodging effect will be. The darker the overlay pixel is, the more 
intense the colour burning effect will be. 

 l Hardlight: This screens overlay pixels with a value above 50% onto underlay 
pixels, and multiplies overlay pixels with a value below 50% onto underlay 
pixels. The brighter the overlay pixel is, the more intense the screen effect 
will be. The darker the overlay pixel is, the more intense the multiplying 
effect will be. Blending any colour with white or black will result in white or 
black, and blending a colour with plain grey will leave the colour unchanged. 

 l Linearlight: This linear dodges overlay pixels with a value above 50% onto 
underlay pixels, and linear burns overlay pixels with a value below 50% onto 
underlay pixels. The brighter the overlay pixel is, the more intense the linear 
dodging effect will be. The darker the overlay pixel is, the more intense the 
linear burning effect will be. 

 l Overlay: Like hardlight, exept it screens or multiplies the underlay pixel over 
the overlay pixel, based on the value of the underlay pixel.

 l Pin Light: For each channel, if the overlay pixel's value is above 50%, use the 
lightest pixel between the underlay and overlay pixels. If the overlay pixel's 
value is below 50%, use the darkest pixel between the underlay and overlay 
pixels.

 l Softlight: Each channel of the overlay pixel lightens or darkens the 
corresponding channel of the underlay pixel on a softer  scale. The effect is 
proportional to how dark or bright the overlay pixel is, but inversely 
proportional to how dark or bright the underlay pixel is. 

 l Difference: For each channel, this takes the darkest pixel among the overlay 
and underlay pixels, subtract it from the lightest pixel, and outputs the result. 
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 l Divide: For each channel, this divides the value of the underlay pixel by the 
value overlay pixel. Both values are treated as ratios, so the resulting colour 
is brighter. A white overlay pixel will leave the underlay colour unaffected, 
and a black overlay pixel will always result in white. 

 l Exclusion: Adds the overlay and underlay pixel, then subtracts the multiplied 
value of both pixels twice. This results in an effect similar to Difference, 
except that while the Difference mode produces consistently high contrast 
pixels, the contrast of the resulting pixels with the Exclusion mode is 
proportional to how dark or bright the overlay pixels are. 

 l Subtract: For each channel, subtracts the value of the overlay pxiel from the 
value of the underlay pxiel. For example, if the underlay pixel is white, and 
the overlay pixel is dark gray, the resulting pixel will be light gray. Likewise, 
if the underlay pixel is yellow, and the overlay pixel is red, the resulting pixel 
will be green, as yellow is a mix of green and red. 

 l Colour: Outputs a colour with the hue and saturation of the overlay pixel, 
and the luminosity of the underlay pixel. The overlay layer can hence be used 
to "colourize" the underlay layer.

 l Hue: Outputs a colour with the luminosity and saturation of the underlay 
pixel and the hue of the overlay pixel.

 l Saturation: Outputs a colour with the luminosity and hue of the underlying 
colour, and the saturation of the source colour.

 l Luminosity:Outputs a colour with the hue and saturation of the underlay 
pixel and the luminosity of the overlay pixel. This is the reverse of the Colour 
blending mode. 

Clamping Mode

 l Apply ClampingWill clamp the colour values to the maximum and minimum 
if they are outside this range. If 16-bit is selected as the Processing Bit Depth 
in Colour Space, the maximum value will be clamped to 32767. If 32-bit is 
selected as the Processing Bit Depth, the maximum value will be clamped to 
1.

 l No Clamping (32-bit float)No clamping is applied. This option is only 
effective when Processing Bit Depth of the Colour Space is set to 32-bits per 
channel (float) and you do not want values to be clamped to 0 and 1. This 
option has no effect if the Processing Bit Depth is 16-bits per channel.

SWF Blend Mode

If you intend to export your scene in SWF format, you can use this option to choose 
which blend mode to use for this effect in the exported Flash movie. Since Flash 
does not support all the blending modes supported by Harmony, this is left as a 
separate option. You can ignore this option if you don't intend to export your scene in 
SWF format. 

 l Normal: Composites the image without any specific blending effect.

 l Multiply: Multiplies the value of each channel in the underlay pixel with the 
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value of each channel in the overlay pixel, treating those values as ratios. 
Multiplying anything with black will result in black, and multiplying anything 
with white will leave the colour unchanged.

 l Screen: The reverse of multiply. Multiplies the reverse value of each channel 
in the underlay and overlay pixel, treating those values as ratios. Multiplying 
anything with white will result in white, and multiplying anything with black 
will leave the colour unchanged. 

 l Lighten: For each channel, uses the value that is the brightest between the 
underlay pixel and the overlay pixel.

 l Darken: For each channel, uses the value that is the darkest between the 
underlay pixel and the overlay pixel. 

 l Difference: For each channel, this takes the darkest pixel among the overlay 
and underlay pixels, subtract it from the lightest pixel, and outputs the result. 

 l Add: Adds the colour values of each channel in the overlay pixel and the 
underlay pixel. For example, adding two dark grey pixels with a value of 100 
in each channel will result in a light grey pixel with a value of 200 in each 
channel. Likewise, if one of the pixels is red and the other is green, the 
resulting pixel will be yellow. 

 l Subtract: For each channel, subtracts the value of the overlay pxiel from the 
value of the underlay pxiel. For example, if the underlay pixel is white, and 
the overlay pixel is dark gray, the resulting pixel will be light gray. Likewise, 
if the underlay pixel is yellow, and the overlay pixel is red, the resulting pixel 
will be green, as yellow is a mix of green and red. 

 l Invert: Inverts the underlay pixel proportionally to the alpha value of the 
overlay pixel. The overlay image hence acts as a "matte" for an invert effect. 

 l Overlay:Like hardlight, exept it screens or multiplies the underlay pixel over 
the overlay pixel, based on the value of the underlay pixel.

 l Hardlight: This screens overlay pixels with a value above 50% onto underlay 
pixels, and multiplies overlay pixels with a value below 50% onto underlay 
pixels. The brighter the overlay pixel is, the more intense the screen effect 
will be. The darker the overlay pixel is, the more intense the multiplying 
effect will be. Blending any colour with white or black will result in white or 
black, and blending a colour with plain grey will leave the colour unchanged. 
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Blur Layer

T-HFND-010-007

The Blur effect creates an effect that softens, fogs or obscures the image evenly in all directions. This effect is 
useful when you want to make cloudy images not realistically seen in detail, such as a drawing object that is 
farther back or in the background of your scene, usually blurry due to the laws of atmospheric perspective. 
Other uses include the general softening of objects such as snow, stars and shadows that do not naturally 
have a hard outline.

Refer to the following example to connect this effect:

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
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Parameter Description

effect.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.

Quality
Select High for a slow and accurate operation or Low for a faster operation with a 
more raw look.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Blur-Gaussian Layer

T-COMP2-003-002

The Blur-Gaussian effect softens the image, reducing the amount of noise and detail. The look of the Gaussian 
blur is smooth, but does take some rendering time. This effect is useful when rendering time is less important, 
and quality is more important. Also, you can use a matte with this effect to isolate areas of the image.

For a detailed video tutorial by Adam Phillips, see

https://www.youtube.com/watch?v=mHAnqqM2PyE

Refer to the following example to connect this effect:

Properties 
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Repeat Edge Pixels
Makes the blur algorithm operate as if the pixel values beyond the edge of the 
layer are the same as the values of the edge pixels. This keeps edges sharp, 
preventing them from darkening and becoming more transparent.

Blurriness

Directional
Blurs according to the length, width, and angle you specify. For example, if a 
character is walking east, the blur may fall to the west.

Blurriness Amount of blur applied to the layer.

Horizontal Blurriness Length of the blur.

Vertical Blurriness Thickness of the blur.

Angle
The direction in which the blur is applied: sideways, up, down,  90 degrees, 45 
degrees, and so on.

Bidirectional Blurs in both horizontal and vertical directions.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

Precision
Blurs the image the number of times the precision indicates at different radius 
(between 0 and the specified radius).
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Colour-Override Layer

The Colour-Override effects processes the colours in a drawing layer. Using this effect, you can change 
colours from the palette without affecting the actual palette, swap clone palettes, or even replace a specific 
colour zone.  The drawings in this layer must be .tvg files as the Colour-Override uses the colour palettes 
linked to them.

The Colour-Override effect lets you:

 l Change colour values in drawings during the compositing process.

 l Use colour values from a specific colour palette in the palette list.

 l Establish the priority of override palettes in the palette list. For example, you may have different clones 
of the same palette, such as a daytime and nighttime version.

 l Isolate specific areas of a drawing by selecting certain colours. For example, using specific colours to 
generate a matte for a glow effect.

 l Hide certain colours.

Refer to the following example to connect this effect:
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Interface

Palettes

The Palettes section displays the palettes in the palette list of the selected layer. You can move these palettes 
into the Whole Palette Overrides section to reorder them. If you have cloned palettes, the higher one in the list 
will override the others. This is useful for overriding the clone palette ordering set in the scene through the 
Colour view. 

You can load additional palettes in the palette list from either your project, by clicking on The Palette  
button, or your computer by clicking on the Browse  button.

 l The Palette  button allows you to load a palette contained within the project hierarchy (Environment, 
Job, Scene and Elements).

 l The Browse  button allows you to load a palette located outside the project hierarchy, anywhere on 
your system or server. If you link to a palette outside of your project, you will be prompted with the 
following warning message:

You can hover your mouse over the palette name in any of the override sections to display the path to the 
palette.
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Colours

The Colours section displays the colour swatches of the selected palette. Move a swatch into the Colour-
Overrides section to change its value.

Whole Palette Overrides

The Whole Palette Overrides section forces the use of a particular palette (clone palette) or palette list 
ordering during the compositing process. You must drag palettes from the Palettes section to change their 
order. Harmony uses the palettes in the order they appear in the palette list to find the colour values 
associated with the colour IDs of each colour zone. To apply a different version of a colour palette to, for 
example, switch from a day to a night palette, use the Override section to change the order of the colour 
palettes (you must be working with cloned palettes).

Individual Colour Overrides

When you drag a swatch from the Colours section to this section, you can override its value. The default 
override mode is set to New RGBA so you can override the RGB value as well as the transparency value.
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The Current column always displays the colours from the currently active palette.  Selecting a clone palette in 
the Palettes area will not change the colours if you haven't changed the active palette in the Whole Palette 
Overrides section. The update will be done once you close and reopen the Colour Override Layer Properties 
window.
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Colour-Scale Layer

The Colour-Scale effect offsets an image's colours. This effect is useful in creating ambient transitions, such as 
from daytime to nighttime.

Refer to the following example to connect this effect:

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Red The factor by which to multiply red values in the image.
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Parameter Description

Green The factor by which to multiply green values in the image.

Blue The factor by which to multiply blue values in the image.

Alpha The factor by which to multiply alpha values in the image.

Hue The colour or hue to offset the image.

Saturation The amount of colour to offset the image.

Value

Enter the value for the colour to offset the image. The actual colour values of the 
image are not changed; instead, the channels are multiplied by a selected 
amount. For example:

 l A value of 1 does not change the colour values.

 l A value greater than 1 brings the colour channel value closer to 255 (or 
white).

 l A value less than 1 brings the colour channel value closer to zero (0 or 
black).

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Cutter Layer

T-HFND-010-009

The Cutter effect cuts out a portion of an image. To do this, it needs to be connected to the drawing it is 
intended to cut as well as to a matte  layer. The cutter will take the shape of the drawing in the matte layer and 
cut this shape out of the drawing layer. This is especially useful if you want to make a character disappear 
between a background element, or if you want to cut out a hole in the middle of a character. 

Like all effects that use a matte, the Cutter's effect has an Inverted parameter, which is disabled by default. 
When enabled, the Cutter will have the reverse effect: Instead of cutting the matte's shape out of the drawing, 
it will cut everything outside of the matte's shape out of the drawing, leaving only the parts of the drawing 
that are covered by the matte. 

The Cutter effect can be used with 2D-3D integration. Rendered 2D drawings, integrated with 3D models, 
display soft, anti-aliased edges, even where the Cutter effect is applied.

Refer to the following example to connect this effect:

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
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Parameter Description

and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name Allows you to enter a name for the node.

Inverted
When this option is enabled, the Cutter node will invert the matte shape to cut 
the drawing. Instead of cutting the image intersecting with the matte, it will cut 
any artwork outside of the matte shape.

374



Glow Layer

T-HFND-010-009B

The Glow effect turns your image into a glow area with a bright soft-edged light or diffuse light region around 
an image. The Glow effect is useful for creating a shining rim around objects, such as the sun or stars. Clone 
your layer to display the original image on top of the glow.

Refer to the following example to connect this effect:

Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that 
make up the edge of the matte.

 l Directional: The matte is blurred in the direction configured with the 
Directional Angle and Directional Falloff Rate parameters.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value 
goes from 0 to 360, with 0 meaning west, and angles going counterclockwise. For 
example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal 
value between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the 
edge of the character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge 
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Parameter Description

of the image.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
opaque areas of the drawing. When this option is enabled, the effect is applied to 
transparent or empty areas of the drawing. 

Use Source Colour

Instead of using the colour in the Colour parameters, this uses the colours in the 
source drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 

Multiplicative
Multiplies the colours of the effect with the colours of the background. This 
intensifies the effect. 

Colour

Red The amount of red to add to the colour in the background image.

Green The amount of green to add to the colour in the background image.

Blue The amount of blue to add to the colour in the background image.

Alpha The alpha value of the effect. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This 
parameter can take a decimal value between 0 and 1. At 1, the effect is fully 
applied. At 0, the effect is not visible. 
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Highlight Layer

T-HFND-010-009C

The Highlight node allows you to brighten an image's area to simulate a light source. For this effect, you will 
need to create a matte to determine the shape and position of the highlight on a separate element, so that you 
can blur the edges to create a softer effect. By adjusting the Highlight properties, you can control the type and 
amount of blur, as well as the colour of the Highlight effect.

Connection

The Highlight effect layer must be connected as a child of the drawing layer or group which you want it to 
affect, and must have a matte drawing layer or group added to its Matte attribute. The part of its parent image 
that are covered by the matte drawing will have a highlight applied to it. 
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Layer Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible effect on 
the rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node 
must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change 
of depth or scale. When disabled, the effect's values will remain unchanged regardless of 
depth or scale changes. It is recommended that this option be disabled when multiple 
drawings are composited and attached this effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make up the 
edge of the matte.

 l Directional: The matte is blurred in the direction configured with the Directional 
Angle and Directional Falloff Rate parameters.
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Parameter Description

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur effect. The 
blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value goes from 0 
to 360, with 0 meaning west, and angles going counterclockwise. For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff 
Rate

The distance where the blur fades from the edge of the image. Select a decimal value 
between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the 
image.

Multiplicative

Multiplies the RGB values contained in the underlying image by the RGB values contained 
in the effect that is linked to the matte port of the underlying image. 

The values being multiplied can be positive (highlight) or negative (tone).

TIP 
 l A positive value will react visually as a divide blend mode.

 l A negative value will react visually as a multiply blend mode.

Colour

Red The amount of red to add to the colour of the source image.

Green The amount of green to add to the colour of the source image. 

Blue The amount of blue to add to the colour of the source image. 

Alpha The alpha value of the effect. 
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Parameter Description

Colour Swatch Opens the Colour Picker dialog, in which you can visually select a colour for the effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This parameter 
can take a decimal value between 0 and 1. At 1, the effect is fully applied. At 0, the effect 
is not visible. 

Matte

Invert Matte

Inverts the matte used to generate the effect. By default, the affect is applied to opaque 
areas of the matte and transparent areas of the matte are ignored. When this option is 
enabled, the effect is applied to transparent areas of the matte and opaque areas of the 
matte are ignored. 

Use Matte Colour

Instead of using the colour in the Colour parameters, this uses the colours in the matte 
drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 
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Shadow Layer

With the Shadow effect, you can turn a drawing into a shadow. It doesn't matter if the drawing layer is a fully 
coloured character. The Shadow effect will render it into a grey, semitransparent, slightly blurry silhouette. 
You must clone your layer to see the original image displayed on top of the shadow.

Refer to the following example to connect this effect:

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type Allows you to choose between the following blur types for the effect:
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Parameter Description

 l Radial: The edges of the matte are blurred evenly around points that 
make up the edge of the matte.

 l Directional: The matte is blurred in the direction configured with the 
Directional Angle and Directional Falloff Rate parameters.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value 
goes from 0 to 360, with 0 meaning west, and angles going counterclockwise. For 
example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal 
value between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the 
edge of the character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge 
of the image.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
opaque areas of the drawing. When this option is enabled, the effect is applied to 
transparent or empty areas of the drawing. 

Use Source Colour

Instead of using the colour in the Colour parameters, this uses the colours in the 
source drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 

Multiplicative
Multiplies the colours of the effect with the colours of the background. This 
intensifies the effect. 
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Parameter Description

Colour

Red
The amount of red to subtract from the colour in the background image. To obtain 
a shadow effect, this value must be negative.

Green
The amount of green to subtract from the colour in the background image. To 
obtain a shadow effect, this value must be negative.

Blue
The amount of blue to subtract from the colour in the background image. To 
obtain a shadow effect, this value must be negative.

Alpha The alpha value of the effect. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This 
parameter can take a decimal value between 0 and 1. At 1, the effect is fully 
applied. At 0, the effect is not visible. 
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Tone Layer

T-COMP2-004-004

The Tone effect allows you to add a dark-coloured region to your drawing and simulate the shaded area away 
from a light source. To produce the tone effect, create a drawing to control where the tone will appear. The 
Tone effect uses a matte to determine the shape and position of the tone on your drawing and can be blurred 
at the edges to create a softer effect. 

Connection

The Tone effect layer must be connected as a child of the drawing layer or group which you want it to affect, 
and must have a matte drawing layer or group added to its Matte attribute. The part of its parent image that 
are covered by the matte drawing will have a tone applied to it. 
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Layer Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible effect on 
the rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node 
must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change 
of depth or scale. When disabled, the effect's values will remain unchanged regardless of 
depth or scale changes. It is recommended that this option be disabled when multiple 
drawings are composited and attached this effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make up the 
edge of the matte.

 l Directional: The matte is blurred in the direction configured with the Directional 
Angle and Directional Falloff Rate parameters.
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Parameter Description

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur effect. The 
blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value goes from 0 
to 360, with 0 meaning west, and angles going counterclockwise. For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff 
Rate

The distance where the blur fades from the edge of the image. Select a decimal value 
between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the 
image.

Multiplicative

Multiplies the RGB values contained in the underlying image by the RGB values contained 
in the effect that is linked to the matte port of the underlying image. 

The values being multiplied can be positive (highlight) or negative (tone).

TIP 
 l A positive value will react visually as a divide blend mode.

 l A negative value will react visually as a multiply blend mode.

Colour

Red
The amount of red to add to the colour of the source image. To obtain a shadow effect, the 
value added will be negative.

Green
The amount of green to add to the colour of the source image.  To obtain a shadow effect, 
the value added will be negative.

Blue
The amount of blue to add to the colour of the source image.  To obtain a shadow effect, 
the value added will be negative.
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Parameter Description

Alpha The alpha value of the effect. 

Colour Swatch Opens the Colour Picker dialog, in which you can visually select a colour for the effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This parameter 
can take a decimal value between 0 and 1. At 1, the effect is fully applied. At 0, the effect 
is not visible. 

Matte

Invert Matte

Inverts the matte used to generate the effect. By default, the affect is applied to opaque 
areas of the matte and transparent areas of the matte are ignored. When this option is 
enabled, the effect is applied to transparent areas of the matte and opaque areas of the 
matte are ignored. 

Use Matte Colour

Instead of using the colour in the Colour parameters, this uses the colours in the matte 
drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 
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Transparency Layer

T-HFND-010-008

The Transparency effect is used to make an image partially transparent. The Transparency effect is useful 
when fading images in and out, such as a phantom or to make something partially see-through, such as a 
window.

Refer to the following example to connect this effect:

You can enter a value in the Transparency field or change the transparency value over time by linking it to a 
function curve. Entering a value of 100 in the Transparency field will make the element 100% transparent, in 
other words, invisible. Entering a value of 0 will render the element completely opaque.

It is also possible to adjust a drawing layer's transparency directly in the Layer Properties window without 
using the Transparency layer. In the layer's properties, go to the Drawing tab and adjust the Opacity 
parameter. This parameter is visible in OpenGL mode.
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Properties

Parameter Description

Name Allows you to enter a name for the node.

Transparency
Lets you set the opacity of an element.  Values range from 0 to 100. A value of 
100 will make the element 100% transparent and a value of 0 will render the 
element completely opaque.

390



Image Layers
Image layers generate an image that display in your scene's render. The drawing layer, which is the main type 
of layer used in Harmony, generates an image based on the drawings in its element which are exposed at the 
current frame. The Colour-Card simply fills the render area with a solid colour. 

Colour-Card Layer 392

Drawing Layer 394
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Colour-Card Layer

T-ANIMPA-012-001

The Colour Card allows you to fill the scene's background with a solid colour when there is no background 
image. If no drawing or colour-card is present to cover the scene's background, the scene will be rendered on a 
pitch black canvas.

NOTE 

By default, the Colour Card has a Z ordering value of 12 Backward. This puts the Colour card 
behind all elements that have a value lower than 12 Backward. Most of the time, the Colour card 
will appear automatically behind all the scene elements as they are all set to 0 Backward, unless 
you have changed the Z ordering of the scene components. If so, the Colour Card will be in front of 
the elements that are pushed back to more than 12 fields backward.

Connection

The Colour Card does not need to be connected to anything in your scene. It simply needs to be added to it 
alongside your drawing layers and groups.

Because a Colour Card has a default position on the z-axis of 12 Backward, it will appear behind all the layers 
in your scene regardless of whether or not it has layers underneath it. 
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Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the layer. When disabled, a layer has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Depth
This parameter can be used to determine whether the colour card displays behind 
or in front of elements with the same position on the z-axis. 

Offset Z

The position of the Colour Card on the Z-axis. By default, this is set to 12 B to 
ensure the Colour Card appears behind other elements in the scene. You can set 
this to 0 F to make the Colour Card respect the order of the layers in the Timeline 
view.

Colour

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Invert Matte
If an image is connected to the Colour Card's matte port, by default, the colour is 
only applied on the opaque areas of the matte. If this parameter is enabled, the 
colour is applied to the transparent areas of the matte instead.

393

Harmony 24 Advanced Reference Guide                          



Chapter 3: Layers

Drawing Layer

The Drawing layer is at the core of a scene's structure. A drawing layer is linked to an element, which contains 
a series of drawing, and its Xsheet column, which indicates when and for how long each drawing is exposed. 
The layer is what connects the element and its exposure to the rendered image. It indicates the position of the 
drawings relative to other elements and to the stage, as well as the drawing's connections with pegs, groups 
and effects, if any. 

Although drawing layers can be transformed and animated on their own, it is typical to connect them under a 
parent peg. This allows you to keep the position and animation information of the element in the peg, making 
it easier to manipulate the exposure and the transformations separately. This is especially useful in digital cut-
out animation where manipulating and transforming layers is often the main method of simulating movement, 
and changing drawings is the secondary method. 

You can also connect a drawing layer as a child of another drawing layer. Just like with pegs, any 
transformation done to the parent layer, whether on itself or through one of its parents, will also be applied to 
the child layer. 

Optionally, you can connect a matte drawing to a drawing layer. When a drawing layer has a matte drawing, 
only the parts of the drawings that intersect with the opaque areas of the matte drawing will be rendered. This 
allows you to accomplish the same effect as connecting the drawing layer to a cutter effect.

Layer Properties

The drawing layer's properties are organized in the following tabs:
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 l Transformation Tab

 l Drawing Tab

 l Controls Tab

 l Line Thickness

 l Advanced Tab

Transformation Tab

The Transformation tab contains parameters for adjusting the position, scale, rotation, skew and pivots of an 
element.

Parameter Description

Position

3D Path: Use a 3D path to position the element. A 3D path uses a single function 
to define the position on the X, Y and Z axes. This function is made of control 
points linked by a curvilinear path, making the movement follow a natural curve. 
The pace and ease of the movement is determined by a single velocity function.
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Separate: Positions the element using separate functions for the X, Y and Z axes. 
This allows to control the direction and pace of the movement across all three 
axes separately. Unless ease is applied to the axes, the trajectory of the element 
will follow straight lines going between each keyframe.

Path: If the 3D Path option is selected, this field allows you to create or select the 
3D Path function used to position the element.

Path (x) Axis: The position of the element on the East-West axis, in fields.

Path (y) Axis: The position of the element on the South-North axis, in fields.

Path (z) Axis: The position of the element in the Back-Front axis, in fields. 

Velocity: If the 3D Path option is selected, this function is used to control the pace 
at which the element moves towards each control point in the 3D Path function, 
on all three axes simultaneously.

Scale

Locked: Uses a single scale parameter to scale the element, preserving its 
proportions.

Separate: Uses a separate parameter to scale the element on the X and Y axis, 
allowing to stretch or squash the element. 

 

(x) Axis: The horizontal scale factor. The default value is 1.

(y) Axis: The vertical scale factor. The default value is 1.

Scale in Fields: With this option enabled, the scale factor is based on the amount 
of fields in the scene. For example, to shrink one of the dimensions of an element 
to half its original size, the scale factor would normally bet set to  0.5. If this option 
is enabled and the amount of fields in the scene is 12, then the scale factor to 
shrink the element by half would be 6. 

Ignore Parent Scaling: When this option is enabled, scaling factors applied to a 
parent layer will not be applied to the current layer. This can be handy in cut-out 
rigs when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: The angle at which the element is rotated, based on the 360 degrees 
scale. Values below 0 or above 360 degrees will cause the rotation to cycle. 

Skew
Skew: The angle at which the element is skewed. This value can range from -90 
to 90 degrees. 

Pivot

(x) Axis: The horizontal position of the pivot point of the element relative to the 
pivot point of the drawing, in fields.

(y) Axis: The vertical position of the pivot point of the element relative to the pivot 
point of the drawing, in fields. 
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NOTE 

These parameters can be changed visually by clicking and dragging the 
pivot point when using on of the tools in the Advanced Animation toolbar. 

Drawing Pivot

An element layer has two pivots:

 l The pivot of the element, which is set by the Pivot parameters above.

 l The pivot of the currently exposed drawing, which is set using the 
Drawing Pivot  tool. 

This preference is used to determine what to do with the pivot point of the 
currently exposed drawing:

 l Don't Use Embedded Pivot: Ignores the pivot point of the exposed 
drawing. The pivot point of the element is positioned using the Pivot 
parameters above, relative to the centre of the drawing. 

 l Apply Embedded Pivot on Parent Peg: Use the pivot point of the 
exposed drawing to determine the position of the pivot point of the parent 
peg of the drawing layer. This is useful when making a character rig where 
each element has a parent peg, and those parent pegs are intended to be 
used for animation. The pivot point of these parent pegs will be based on 
the pivot point set for the exposed drawing.

 l Apply Embedded Pivot on Drawing Layer: Use the pivot point of the 
drawing to determine the pivot point of the element. This means the pivot 
point is positioned using the Pivot parameters above, but relative to the 
pivot point of the drawing. 
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TIP 

The two latter options are useful when making a character rig where a layer 
can represent a body part from different angles. Since each angle is 
represented by a drawing, and each angle is liable to have a different pivot 
point, you can set the pivot point of each angle by using the Drawing Pivot 

 tool on each drawing. Then, if you want to animate the drawing layers 
directly, you can set this parameter to the Apply Embedded Pivot on 
Drawing Layer option, and if you want to animate using the parent pegs of 
the drawing layers, you can set this parameter to the Apply Embedded 
Pivot on Parent Peg option, so that these pivots are used when animating 
the different parts of the rigs. 

Drawing Tab

The Drawing tab contains parameters for the art layers, bitmap images and the element's matte drawing.
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Parameter Description

Element Columns Drawing Path: Displays the full path to the current drawing.

Art Layers

These parameters allow you to set whether each art layer in the drawing layer is 
enabled, and whether they should contain vector or bitmap artwork. By default, 
options for the Line Art and Colour Art layers will be available. If the Enable 
Overlay and Underlay Arts preference is enabled, options for the Overlay Art and 
Underlay Art layers will also be available. 

Enabled: Determines whether the art layer is displayed.

Vector: Makes the art layer enabled for vector artwork, Vector drawing tools will 
be used to draw in this art layer, and vector artwork information will be 
preserved.

Bitmap: Makes the art layer enabled for bitmap artwork. Only bitmap-compatible 
drawing tools will be enabled when drawing on this layer, and all artwork will be 
rasterized into a bitmap image. 

Bitmap File Options

Colour: Determines whether or not the colours in the image is  processed. If 
unchecked, the image will be solid black. 

Transparency: Determines whether or not the transparency in the image is 
processed. If unchecked, the image will be fully opaque.

Transparency Type: If the layer contains bitmap images with a transparency 
channel, there are several approaches to rendering the image's transparency. You 
may need to select the proper transparency type to make sure Harmony renders 
the image as intended.  

 l Premultiplied with Black: Semi-transparent pixels in the original image 
are blended with black. 

 l Premultiplied with White: Semi-transparent pixels in the original image 
are blended with white. 

 l Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

 l Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so 
that a color value never exceed the alpha value for a given pixel. When 
the RGB values are multiplied with the alpha value, that is to say, if you 
have a pixel of value R=247, G=188, B=29 and the alpha is 50% or the 
image has a 50% transparency, then the actual RGB values output would 
be half of the amounts listed above.

Tile Horizontally: Repeats the bitmap image infinitely to the left and to the right 
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of the layer. This can be useful for making looping backgrounds. 

Tile Vertically: Repeats the bitmap image infinitely to over and underneath the 
layer. This can be useful for making looping backgrounds.

NOTE 

When both the Tile Horizontally and Tile Vertically options are used 
together, the bitmap image is tiled all over the scene. 

Matte

Invert Matte:If a drawing, group or effect is added to the drawing's Matte 
attribute, the part of the drawing that intersect with the matte's opaque areas will 
be cut out by default. If this parameter is enabled, the part of the drawing that 
intersect with the matte's transparent areas will be cut out instead. 

Colour Space

Colour Space: The colour space in which the element’s colours should be 
interpreted. If the element’s colour space is different from the project colour 
space, then the element’s colours will be converted from the element’s colour 
space to the project’s colour space as they are processed, before being 
composited together with the scene’s special effects.

 l Undefined Colour Space: No colour space is defined for the drawing. The 
drawing’s colours will be interpreted as if they were the same colour 
space the one selected in the Colour Space tab of the Scene Settings 
dialog. 

 l ACES2065-1: An ACES linear colour space that uses the AP0 colour 
primaries and is intended for image file interchange.

 l ACEScg: An ACES linear colour space that uses the AP1 colour primaries 
and is intended for CGI rendering and compositing.

 l Linear Rec.709 (sRGB): The colour space that uses the same primaries 
and white point as sRGB and Rec. 709, but with no gamma transfer curve 
applied to the colour values. 

 l Linear Rec. 2020:  A colour space used for Ultra High Definition TV 
(UHDTV). It has a complex gamma transfer curve and primaries that cover 
more of the human-perceivable colour space than other colour spaces, 
especially in the area of human-perceivable greens. 

 l Linear P3-D65: The same as Display P3, except with no gamma transfer 
curve. This colour space is useful for compositing intermediary images 
that are meant to be rendered in Display P3.

 l Display P3: A colour space commonly used for digital projection. It has 
the same primaries as DCI-P3, the same white point as sRGB and the 
same gamma transfer curve as sRGB.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and 
white point as sRGB, but has a different gamma transfer curve.
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 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a 
gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
of the standard gamma curve for Rec. 709.

 l Rec. 2020:A colour space used for Ultra High Definition TV (UHDTV). It 
has a complex gamma transfer curve and primaries that cover more of the 
human-perceivable colour space than other colour spaces, especially in 
the area of human-perceivable greens.

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple 
gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
of the standard gamma curve for Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It 
has the same primaries and white point as Rec. 709, but has a different 
gamma transfer curve.

NOTE 

In the  OpenGL View mode of the Camera view, the colour space of 
drawing layers is ignored and only the colour space of original bitmap files 
is taken in account. To test the colours of your drawing in their selected 

colour space, you must activate  Render View mode. 

Controls Tab

The Controls tab contains animation control options.

Parameter Description

Animation

Animate Using Animation Tools: By default, a drawing layer can be animated 
directly, as if it was its own peg. If you disable this option, it will only be possible 
to animate the layer using its parent peg. If the layer has no parent peg, it will be 
immutable. 
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This can be useful if you want to create cut-out character rigs that should only be 
animated using pegs, which can help separate the drawing exposure from the 
transformations on the drawings. If every drawing layer in a character rig has this 
option disabled, only layers that have a parent peg will be animatable, and the 
animator will only be able to animate on the pegs. This also rules out the 
possibility of accidentally animating an element directly and using its parent peg 
concurrently. 

When this option is disabled, clicking on the drawing layer in the Camera view 
with the Transform tool will automatically select the layer's parent peg. 

Spline Offset

If the layer's controls are displayed, you can see its animation trajectory in the 
Camera view. This is referred to as the spline. By default, the position of each 
point in the spline is based on the element's pivot point. However, you can use the 
spline offset to give it a more fitting position if desired. You can do this by using 
the Spline Offset tool of the Advanced Animation toolbar, or by manually 
entering the offset values in the Spline Offset fields.

(x) Axis: The horizontal offset of the spline, in fields.

(y) Axis: The vertical offset of the spline, in fields.

(z) Axis: The depth offset of the spline, in fields.

TIP 

To display the animation trajectory of the layer in the Camera view, select 
the layer, then do one of the following:        

 l In the Camera toolbar, click on Show Control .

 l From the top menu, select View > Show > Control. 

 l Press Shift + F11 (Windows/Linux) or ⌘  + F11 (macOS).

Line Thickness

The Line Thickness tab contains options regarding the way pencil lines in the element are rendered. These 
options can be very useful to enhance the quality of line art without having to work on it. 
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Parameter Description

Line Thickness

Adjust Pencil Lines Thickness: Enables the options below to adjust the line 
thickness in the rendered image. 

Normal Thickness:  This setting makes the line thickness adjustments take one of 
two very different behaviors:

 l Enabled: The line thickness settings are applied to pencil lines in all art 
layers in the element. This setting should be used if you want to adjust the 
line thickness of pencil lines. 

 l Disabled: The line thickness settings are applied to all art, whether brush 
strokes or pencil lines, in the line art layer, so that it fits the desired 
thickness pattern around art in the colour art layer. This setting should be 
used for drawings that have their line art on the line art layer and their 
colour art on the colour art layer, which is typical of traditional and 
paperless animation productions. 

NOTE 

When this option is disabled, all artwork in the line art layer that 
does not surround artwork in the colour art layer will be cropped 
out.

Scale Independent:

 l Scale Dependent: The line thickness will vary based on the scale of 
drawing elements as well as the camera position.

 l Scale Independent: Line thickness will not be effected by the scale of the 
drawing element or the position of the camera
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 l Scale Independent (Legacy): The line thickness will not be effected by 
the scale of the drawing elements or the position of the camera. Changing 
resolution changes the visual thickness when rendering

Proportional: The factor by which to adjust line thickness. The original line 
thickness in the drawing will be multiplied by this value. A value between 0 and 1 
can be used to make pencil lines thinner. 

Constant:  The offset by which to adjust line thickness. This value will be added 
to the original line thickness in the drawing. A negative number can be entered to 
make pencil lines thinner. 

Minimum: The minimum pencil line thickness allowed. Line thickness will not go 
below this value.

Maximum: The maximum pencil line thickness allowed. Line thickness will not go 
above this value. Set it to 0 to disable maximum line thickness.

Deformation

Pencil Lines Quality: The quality of the rendered pencil lines when deformed by 
deformation chains. Increasing this parameter is unlikely to wield noticeable 
result unless rendering in very high resolutions. 

Preserve Line Thickness: If this option is checked, the thickness of pencil lines 
will not be affected by deformations. Only their directions will be affected. Also, if 
a pencil line is textured, it will not be stretched or squashed by deformations. 

NOTE 

This setting must be enabled for the Pencil Lines Smoothing and Fit Error 
parameters to be available.

Pencil Lines Smoothing: The smoothing factor applied to pencil lines when 
rendering. This value can range from 0 to 10. The higher it is, the more corners 
and points will appear smoothed out.

Fit Error: When this parameter is increased, pencil lines in the rendered image 
will have less vector points and the curves between the remaining vector points 
will be adjusted to fit the original shape. This setting can be increased if the 
amount of details and points in the pencil lines creates problems around 
deformation articulations and corners. Its value can range from 1 to 100. 

NOTE 

The Fit Error parameter will have no effect if the Pencil Lines Smoothing 
parameter is set to 0.
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Advanced Tab 

The Advanced tab contains options for setting the alignment of drawings, line thickness, vector render 
options, and more.

Parameter Description

Alignment

Alignment Rule: The alignment rule selections are intended to deal with 
drawings that were created on paper of a different size or orientation from the 
default alignment rule (set up in the Scene Settings dialog box) or imported 
bitmap images. The drawings are then scaled to match the Harmony alignment 
rectangle. Note that alignment rules are not based on the camera frame, but on 
the scene frame. Refer to the Fundamentals Guide to learn more about scene 
alignment and scene settings.

 l Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

 l Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

 l Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

 l Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.

 l Centre Fit: Centers the drawings.

 l Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.
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 l Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the 
height of the alignment rectangle of the scene.

 l Centre TB: Aligns the drawings in the top-bottom centre of the alignment 
rectangle. Harmony scales the drawings to match their widths to the 
width of the alignment rectangle of the scene.

 l Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear 
on the corners of the image, making it difficult to manipulate the 
quadmap. In this case, you would set the drawing layer of the quadmap 
images to Stretch to make the handles appear on the corner of the image. 
This can have the effect of distorting the images, but it is not an issue with 
images that will be distorted through the Quadmap node anyways.

 l As Is: Leaves the drawings aligned as they are. 

 l Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on 
paper of a different size or orientation than the other paper in the scene, and 
requires alignment  so they are treated accurately.

Flip Horizontal: Flips the drawing on the horizontal axis.

Flip Vertical: Flips the drawing on the vertical axis.

Vector Render Options

Antialiasing Quality: The smoothness (antialiasing) setting used to make the 
crisp vector contours appear smooth. 

 l None - No Transparency: Dsables antialiasing, renders semi-transparent 
pixels either fully opaque or fully transparent, and fills single-pixel gaps 
with an opaque pixel to avoid generating out-of-place gaps when lines 
intersect each other.

 l Low: Disables antialiasing, but renders transparency. 

 l Medium Low: Renders vector artwork with basic antialiasing.

 l Medium: Renders vector shapes with improved antialiasing. Bitmap 
texture fills will appear blurred.
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 l High: Renders vector shapes with improved antialiasing, without blurring 
bitmap texture fills.

TIP 

It is recommended to leave this setting to High unless you are working on a 
pencil test, or another type of scene where rendering speed is more 
important than rendering quality.

TIP 

If the production requires exporting line art without antialiasing to colour 
them in a third-party software, it is recommended to use the None - No 
Transparency setting. This setting automatically fills one-pixel gaps 
created by crisp lines intersecting each other, which would otherwise need 
to be filled manually in the third-party software.

Antialiasing Exponent: Determines how much the artwork is scaled up to apply 
antialiasing onto it. A higher value will results in sharper edges, and a lower value 
will result in softer edges. Typical values range between 0 and 3. Higher values 
may be attempted but may result in overly crisp outlines. Negative values will 
cause the outlines to appear blurry.

Texture Filter: This setting determines how textures in the element are 
resampled when rendering:

 l Bilinear: This option takes the four pixels around each point and makes a 
bilinear interpolation between them, which may make them look blurry. 

 l Nearest: When sampling the texture up, this option generates extra pixels 
by using the colour of the nearest defined pixel. When sampling the 
texture down, this option simply removes pixels from the texture. 

 l Nearest (Filtered): This option is similar to Nearest, but it adds an extra 
layer of resampling to make all pixels look like they are the same size. 

Miscellaneous
Opacity: Lets you quickly change the transparency of the selected element. 
Opacity settings here will be reflected in both OpenGL preview, and full render.
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Move Layers
Move layers are used to animate layers as well as camera motions.

Camera Layer 409

Peg Layer 410

Quadmap Layer 412
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Camera Layer

You can setup the camera position by entering coordinates and values in the Layer Properties view.

Parameter Description

Enable/Disable Turns the camera layer on or off.

Change Track Colour

The Change Track Colour  button lets you change the colour of the exposed 
frames; this helps you to quickly locate a layer in the Timeline view. Click the 
Change Track Colour  button to open the Select Colour window and choose a new 
colour. You can modify the colour for any type of layer, such as group, peg, 
drawing, and effects.

Name
Displays the current layer name. You can rename the layer by typing in a new 
layer name.

Position

Displays the current position of the camera layer using X-axis (East/West), Y-axis 
(North/South) and Z-axis (Forward/Backward) coordinates. To reposition your 
camera frame, type in the new values corresponding to the desired position 
coordinates. You can also use the up and down arrows to set the value of each 
field.

Angle
Displays the current rotation value. To set a new rotation position, type in a new 
angle value. You can also use the up and down arrows to set the new angle 
value.

Pivot

Displays the current position of the rotation pivot of the camera layer. The camera 
will perform a rotation taking the position of the pivot as its angle centre. By 
default, the pivot is set at the centre of the camera frame. To reposition the pivot 
point, enter new X and Y coordinates values in the appropriate field. To see the 
pivot's position, the Rotate tool must be selected.
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Peg Layer

Find below a description of all the Peg node parameters.

Transformation Tab

Parameter Description

Position

3D Path: Use a 3D path to position the element. A 3D path uses a single function 
to define the position on the X, Y and Z axes. This function is made of control 
points linked by a curvilinear path, making the movement follow a natural curve. 
The pace and ease of the movement is determined by a single velocity function.

Separate: Positions the element using separate functions for the X, Y and Z axes. 
This allows to control the direction and pace of the movement across all three 
axes separately. Unless ease is applied to the axes, the trajectory of the element 
will follow straight lines going between each keyframe.

Path: If the 3D Path option is selected, this field allows you to create or select the 
3D Path function used to position the element.

Path (x) Axis: The position of the element on the East-West axis, in fields.

Path (y) Axis: The position of the element on the South-North axis, in fields.

Path (z) Axis: The position of the element in the Back-Front axis, in fields. 

Velocity: If the 3D Path option is selected, this function is used to control the pace 
at which the element moves towards each control point in the 3D Path function, 
on all three axes simultaneously.

Scale

Locked: Uses a single scale parameter to scale the element, preserving its 
proportions.

Separate: Uses a separate parameter to scale the element on the X and Y axis, 
allowing to stretch or squash the element. 

(x) Axis: The horizontal scale factor. The default value is 1.

(y) Axis: The vertical scale factor. The default value is 1.

Scale in Fields: With this option enabled, the scale factor is based on the amount 
of fields in the scene. For example, to shrink one of the dimensions of an element 
to half its original size, the scale factor would normally bet set to  0.5. If this option 
is enabled and the amount of fields in the scene is 12, then the scale factor to 
shrink the element by half would be 6. 

Ignore Parent Scaling: When this option is enabled, any scaling value applied to 
a parent layer is ignored in the current layer. This can be handy in cut-out rigs 
when you need to scale an arm without affecting the forearm. 

Rotation Angle z: Lets you  type in a degree value for the rotation angle. Note that you can 
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enter values greater than 360 and -360 degrees. If you enter 720, the object will 
rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: The horizontal position of the pivot point of the element relative to the 
pivot point of the drawing, in fields.

(y) Axis: The vertical position of the pivot point of the element relative to the pivot 
point of the drawing, in fields. 
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Quadmap Layer

T-COMP2-010-001

The Quadmap transformation layer lets you deform the shape of an element. For example, you can use it to 
create a drop-shadow effect on an element.

You can edit the Quadmap visually in the Camera view.

How to edit the Quadmap in the Camera view

 1. In the Timeline view, click the Add Layer  button and select Quadmap.

 2. Connect the drawing you want to deformto the Quadmap.

 3. In the Tools toolbar, disable the Animate mode to change the value for the Quadmap over the 
entire duration of the element.

 4. In the Timeline view, click on the Quadmap layer to select it.

 5. From the top menu, select View > Show > Control or pressShift + F11.

The quadmap handles appear around the element in the window. There is also a pivot point at the 
centre of the quadmap frame that you can reposition.

 6. In the Camera view window, use the Transform tool to move the points on the quadmap. Shift + 
click to select multiple points.
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TIP 

The position of the points can be animated. To do this, open the Quadmap layer layer properties 
and create functions for each of the coordinates.

Properties

Parameter Description

Name Allows you to change the name given to the node.

2D Path
Changes the X and Y values simultaneously and control the velocity of the 
change.
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Separate
Changes the X and Y values separately. Each one can be attached to separate 
function curves.
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Sound Layer
When you select a sound layer in the Timeline view, the options related to that layer appear in the Layer 
Properties view.

If you double-click on a sound layer in the Timeline view, or in a sound column in the Xsheet view, the Sound 
Element Editor dialog will open. This dialog allows you to fine-tune the sound track's lip sync, start time, stop 
time and volume.
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Chapter 4: Tools Properties
Harmony has a wide variety of drawing and manipulation tools and each one of them has a series of options 
and modes available in the Tool Properties view. This section covers these options.  

Brush Tool Properties 418

Centerline Editor Tool Properties 444

Close Gap Tool Properties 446

Colour Eyedropper Tool Properties 447

Contour Editor Tool Properties 448

Cutter Tool Properties 453

Drawing Pivot Tool Properties 458

Edit Gradient/Texture Tool Properties 461

Ellipse Tool Properties 462

Envelope Tool Properties 473

Eraser Tool Properties 476

Ink Tool Properties 498

Line Tool Properties 500

Morphing Tool Properties 514

Paint Tool Properties 518

Pencil Tool Properties 525

Pencil Editor Tool Properties 538

Perspective Tool Properties 543

Polyline Tool Properties 546

416



Rectangle Tool Properties 556

Reposition All Drawings Tool Properties 567

Rigging Tool Properties 569

Select Tool Properties 571

Shift and Trace Tool Properties 584

Smooth Editor Tool Properties 587

Stamp Tool Properties 589

Stroke Tool Properties 598

Text Tool Properties 600

Transform Tool Properties 603

Zoom Tool Properties 607
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Brush Tool Properties
The Brush tool allows you to draw by creating shapes based on your drawing strokes and filling them with 
colour or textures. When used with a tablet, it is pressure sensitive, just like a real life brush.

How to access the Brush tool properties

 1. In the Tools toolbar, select the Brush  tool.

The tool's properties are displayed in the Tool Properties view.

Brush Properties

The following properties affect the brush's size, smoothing and other properties for the drawing style of your 
brush. Those properties can be saved into brush presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Brush Properties Dialog The arrow button right of the preview area opens the Brush Properties dialog. 
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Property Description

While the Tool Properties view only gives you access to a few of the brush 
properties, a list of brush presets and other drawing options, the Brush Properties 
dialog gives you access to all the available options for your brush's tip and texture. 
For more information on the Brush Properties dialog, see the Brush Properties Dialog 
section below.

Maximum Size

Defines the maximum width of brush strokes.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will 
vary between its maximum size and minimum size depending on the amount of 
pressure used. If used with a mouse, the width of the stroke will always be its 
maximum size. 

Flow

Allows you to set the opacity for each instance of the brush tip that gets printed into 
your canvas. Contrary to the Opacity parameter, the flow parameter has a cumulative 
effect. This means that a lower flow will make your brush strokes more transparent 
towards its extremities and more opaque in its center. Your stroke's flow will also 
accumulate if you draw over it. By default, your brush's flow varies with the amount 
of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your 
whole brush stroke's opacity will not exceed the Opacity parameter. By default, the 
Opacity parameter varies depending on the amount of pressure you put on your 
tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Brush Presets

These options allow you to select, create and manage brush presets.
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Icon Property Description

  Presets list

By default, Harmony has preloaded brush presets. You can also create 
your own brush presets by configuring your brush, then saving its 
properties into a new preset. It is also possible to export and import 
brush presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into 
an .xml file. 

 l Small Thumbnail: Displays presets in a grid of small 
thumbnails with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

420



Drawing Options

These options affect the way your drawing strokes are added to your artwork.

Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Brush Colour swatch. Then, in 
the colour list, select the desired colour swatch for your 
outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 
colour list, select the desired colour swatch for the fill. 

Repaint Brush When enabled, your brush strokes will only repaint existing artwork and 
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will not add colour to empty areas. If you repaint semi-transparent 
artwork, your artwork will not become more opaque than it already is.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

NOTE 

This option is only available when drawing on a vector layer.

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 
as a separate drawing object, which can be edited independently from 
other parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 

NOTE 

This option is only available when drawing on a vector layer. 
When drawing on a bitmap layer, artwork is always flattened. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool 
will snap against nearby alignment guides.
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Respect Protected 
Colour

In the Colour view, it is possible to make some of the colours in your 
palettes protected from change. When enabled, the Respect Protected 
Colour option will prevent the brush tool from drawing over areas filled 
with a protected colour.

NOTE 

This option is only available when drawing on a vector layer. 
When drawing on a bitmap layer, colour is not linked to your 
palettes and cannot be protected.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with 
a gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a 
gradient by selecting a zone painted with a gradient with the Select tool, 
then clicking on Store Colour Gradient  in the Tool Properties view.

NOTE 

This option is only available when drawing on a vector layer.

Brush Properties Dialog

Brushes have an extensive set of options and properties that are not displayed in the Tool Properties view, but 
rather, in a dialog you can access from it. To open the Brush Properties dialog, click on the arrow button right 
of the stroke display area. 

The Brush Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 
layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 423

 l Smoothing Tab    on page 433

 l Transparency Tab on page 434

 l Dual Tip Tab on page 437

 l Paper Texture Tab on page 441

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your brush tip.
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NOTE 

The "Size Proportional to Camera" option has been moved to the new Size Properties window.

424



Property Description
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Brush Type

Allows you to select between one of the following brush types:

 l Solid Vector Brush: Creates vector shapes filled with a solid colour. 
Makes artwork lightweight, scalable and easy to tweak. Since this kind of 
brush can only create solid colour shapes, solid vector brushes have a 
limited set of options including size, roundness, angle, centerline 
smoothing and contour smoothing.

 l Textured Vector Brush: Creates vector shapes filled with a texture. This 
gives you access to bitmap brush tips, paper textures, transparency and 
several other options.

NOTE 

This option is not available when working on a bitmap layer. With bitmap 
layers, brushes are always textured, and textured brush options are always 
available.

Brush Tip Library

This is where you select the shape of the brush tip. By default it is round. Note 
that some tips are designed to have semitransparent areas, even when the 
maximum brush opacity is set to 100%.

To create a custom brush tip, you must prepare the file ahead of time, either in 
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 
supported and transparency is not supported in the traditional sense. Black 
appears as 100% opaque, white appears as 100% transparent and all the 
shades of grey in between appear as varying degrees of semitransparency. A 
range of file formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. 
Alpha channels are disregarded on import. It is recommended that your file be 
between 100 x 100 pixels and 400 x 400 pixels. 

You can also import brush tips that you exported from Harmony, so you can 
share them with colleagues.

Minimum and Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and 
thin effect on your stroke. This works with the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  width of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to 
and as a percentage of the maximum size.
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You can control the size properties by clicking on the arrow button on right and 
the dialog box will appear as shown below.

 l Pressure: Allows you to apply more pressure and increases the size of 
the brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast 
speed.  You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the 
end of each stroke. The value can be expressed using two options: 
Distance and Percentage. Distance is selected by default. For example: 
A taper of 200 will be the same length as the width (diameter) of a stroke 
that has its size set at 200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of 
start taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  
the effect of end taper can be visualized once the stroke is complete and 
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vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.

 l Size Proportional to Camera: If you check this option, the size of the  will 
be adjusted to the position of the camera on the z-axis. This means that if 
the camera is zoomed in on the scene, the  will be proportionally smaller 
so that it appears the same size in the rendered image. Likewise, if the 
camera is zoomed out, the  will be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of 
creating width variation on your stroke. In other words, you would be 
forcing a uniform line width using the Maximum Size value.

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and 
orientation of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 
squashes the tip vertically, allowing you to turn round or square tips into 
flat tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the 
squashing will still be done relative to the tip's original orientation.

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set 
whether your brush takes your pen's tilt angle into account, and how much. 

When your pen is fully tilted, your brush tip will be stretched by the percentage 
you set in this parameter, in the angle in which you tilt it. For example, if you set 
the Pen Tilt Sensitivity to 50%, and you tilt your pen all the way up or down, your 
brush tip will be stretched vertically by 50%. With the same setting, if you tilt 
your pen all the way left or right, your brush tip will be stretched horizontally by 
50%.
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Angle Function

If enabled, your brush tip will rotate with the angle of your pen tip. You can select 
one of the following options:

 l Constant: The static orientation of the brush tip expressed in degrees.

 l Heading: The orientation of the brush tip is determined by the direction in 
which the stroke is drawn. It changes dynamically as the stroke is drawn.

 l Azimuth: When the pen is tilted, it uses the direction in which the pen 
eraser is facing.

 l Twist (if supported by pen): It uses the twist angle of the stylus and is 
only available with Wacom Art Pen.

Hardness

The hardness value corresponds to the softness of the brush tip's edges. The 
lower the value, the softer the tip edge. The higher the value, the sharper the tip 
edge. Be aware that some brush tips are not 100% opaque, so they will always 
appear somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the brush. A value of 100% 
sets the stamp marks edge to edge, if there is no white space around the shape. 
The larger the value, the greater the space between marks. A really large value 
can make the brush stroke appear as a string of individual marks. Conversely, a 
small spacing value will give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 
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Count

Defines the number of stamps for each space in the brush stroke. This will create 
the appearance of thicker stamps in the brush stroke.

Random Size

You can create variation between the thick and thin of your brush stroke just by 
setting the Maximum and Minimum Size values. If you add randomness to the 
mix, pressure sensitivity from your drawing tablet will still be applied. Light 
pressure will create random values around the minimum, while heavy pressure 
will create random values closer to the maximum. The larger the percentage, the 
larger the range of random variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating 
width variation on your stroke, whether you are applying randomness or 
not. Therefore, you would be forcing a uniform line width using the 
Maximum Size value.

430



Random Angle

Sets the range for random rotation around the set Angle value. For example, if 
the Angle is set to 45° and the Random Angle set to 10°, the software will 
choose values between 40°–50° (plus or minus 5 degrees, equaling a total of 10 
degrees).

Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if 
the Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony 
will choose values between 45%–55% (plus or minus 5 percent, equaling a total 
of 10 percent).

Random Count

Sets a varying number of stamps at each step in the textured brush stroke. 

The randomization is based on an entered percentage. The range in number of 
stamps depends on what is entered in Count. 

For example, if 4 is entered, and the Random Count percentage is set to 50%, 
then the range will be from 50% less than 4 to 50% more than four (2 to 6). The 
range will be 2 (50% less than 4) to 6 (50% more than 4). 
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If 4 is entered, and the Random Count percentage is set to 100%, then the range 
will be from 100% less than 4 to 100% more than four (0 to 8). The range will be 
0 (100% less than 4) to 8 (100% more than 4). 

 

Random Offset X

Sets a randomized variation in horizontal distance between the applied stamp 
and the previous stamp in the brush stroke.

You may enter between the percentage values of 0% and 300%.

Random Offset Y

Sets a stamp to be applied with a randomized vertical placement. As a result, the 
brush stroke will have the appearance of being thicker.

You may enter between the percentage values of 0% and 300%.
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Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your brush 
strokes as you paint. 

NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 
support smoothing.

Property Description

Centerline Smoothing
Defines the amount of smoothing Harmony should perform on the central line of the 
brush stroke. A higher setting will prevent your line from being shaky, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing
Defines the amount of smoothing Harmony should perform on the outer contour of 
the brush stroke. A higher setting will round sharp corners and reduce the amount of 
control points for the resulting vector shape. 
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Transparency Tab

The Transparency tab allows you to decide if your brush has antialiasing as well as to set its flow and opacity 
settings. 

NOTE 

The Transparency tab's options are only available on vector layers if the Brush Type option of the 
Tip tab is set to Textured Vector Brush. On bitmap layers, those options are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the brush strokes to blend with 
the surrounding colours, to create an illusion of smoothness otherwise not possible 
due to the picture resolution.

If antialiasing is disabled, the brush's texture will only render fully transparent or fully 
opaque pixels. Disabling this option can be useful if you need your outlines to be very 
crisp, if you want to make pixel art or if you need your brush strokes to render in solid 
colors with no variation, which makes them easier to repaint or process in third party 
software.

NOTE 

When disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum 
Flow

The Maximum and Minimum Flow parameters let you set the range for the rate at 
which paint flows from your brush. The analogy works better with a pen. The greater 
the flow, the more ink comes out, hence the more consistent the colour and texture of 
the line. If the flow is light,  then the colour and texture of the line may look spotty. This 
feature works with the pressure sensitivity of a pen tablet.
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 l Maximum Flow: Sets the maximum rate at which colour and texture are 
applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are applied 
as you create a fluid stroke. It is defined as a percentage of the Maximum Flow 
value. If the Minimum Flow value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The flow will be set to the constant rate 
of the Maximum Flow value.

You can control the flow properties by clicking on the arrow button on right and the 
dialog box will appear same as shown for size properties above. Minimum and 
Maximum Size on page 426.

Maximum Opacity and 
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a brush mark. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the brush mark when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the brush mark when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and the 
dialog box will appear same as shown for size properties above. Please refer Minimum 
and Maximum Size on page 426
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Randomness
Th Randomness parameter lets you set the range for the randomness of the flow and 
opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your brush stroke just by setting the Maximum 
and Minimum Flow values. If you add randomness to the mix, pressure sensitivity from 
your drawing tablet will still be applied. Light pressure will create random values 
around the minimum, while heavy pressure will create random values closer to the 
maximum. The larger the percentage, the larger the range of random variation. 

NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of creating 
flow variation on your stroke, whether you are applying randomness or not. That 
is, you would be forcing a uniform flow using the Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the 
Maximum and Minimum Opacity values. If you add randomness to the mix, pressure 
sensitivity from your drawing tablet will still be applied. Light pressure will create 
random values around the minimum, while heavy pressure will create random values 
closer to the maximum. The larger the percentage, the larger the range of random 
variation.
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NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of creating 
opacity variation on your stroke, whether you are applying randomness or not. 
That is, you would be forcing a uniform opacity using the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and 
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 
Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab must be set 
to Textured Vector Brush. 

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your brush uses a 
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be 
disabled. 
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Property Description

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. When the two brush tips are combined in this mode, 
they essentially cut each other out in overlapping areas, where one or both tips have 
an area of 100% transparency. The less opaque the brush tips are, the lighter their 
combination. 

Colour Dodge
In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes 
overlap, within the boundaries of the primary shape, the colour and opacity appear 
darker.
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Property Description

Combine
This mode treats the two tips as two different and separate brushes that have the 
same colour and follow the same path.
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Property Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your brush. You can also add textures by 
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 
Texture tab. Additionally, if you are working on a vector layer, the Brush Type option of the Tip 
tab must be set to Textured Vector Brush. 

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your brush uses a 
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will 
be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive
This option layers the texture on top of itself as you scribble overlapping lines in one 
continuous stroke.  If this option is turned off, areas of overlapping lines from a single, 
continuous stroke will appear the same, in terms of darkness and texture, as non-

442



Property Description

overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 
enabled, the paper texture's position does not change with each sweep of the brush. 
If this option is disabled, each sweep of the brush produces a different texture 
position. The texture orientation always stays the same.
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Centerline Editor Tool Properties
The Centerline Editor tool allows you to edit brush strokes by their centreline rather than by their contour.  This 
makes it easier to tweak the tips, curves and corners of brush strokes. The purpose of this tool is to make it as 
easy to edit brush strokes as it is to edit pencil lines with the Contour Editor tool.

How to access the Centerline Editor tool properties 

 1. In the Tools toolbar, select the Centerline Editor  tool.

 2. The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 
elements:

 l Lasso: Allows you to select multiple elements by 
drawing an irregular closed shape around them with 
your mouse.

 l Marquee: Allows you to select multiple elements 
by drawing a rectangle around them. This is faster, as 
you only need to drag your mouse from one corner of 
the rectangle to its opposite corner, but it may not be as 
precise as you want.

TIP 

You can press and hold the Alt key to temporarily use 
the other selection mode.

Show Centerline Editor Controls
When enabled, selecting several control points will make a 
manipulator bounding box appear. You can use this 
manipulator to scale and rotate the selection of points.
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Icon Property Description

Apply to Line and Colour Art

Allows you to perform drawing operations on both the Line Art 
and Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, 
they will also be affected when this option is enabled.

  Centerline Smoothness

Allows you to adjust the amount of control points on the 
centreline that is generated from the selected stroke. A lower 
value will create a centreline with less points, which makes it 
easier to manipulate large lengths of the stroke, and a higher 
value will generate a centreline with more points, allowing you 
to tweak details. 
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Close Gap Tool Properties
The paint tool requires the area you attempt to fill to be closed in order to know exactly what area of your 
artwork must be filled. However, it is common for artists to accidentally leave small gaps in their artwork. 

The Close Gap tool allows you to quickly close small gaps in a shape by creating an invisible stroke connecting 
two extremities of the gap. You can then fill the area using the Paint tool, as this invisible stroke will be taken 
in account to determine the outline of the shape to fill. 

TIP 

You do not need to use the Close Gap tool with precision. If you draw a crude stroke near the gap 
you want to close, the tool will automatically detect the two closest line extremities and will draw 
an invisible straight line connecting them. closing the gap between them. 

How to access the Close Gap tool properties

 1. In the Tools toolbar, select the Close Gap  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Auto Flatten

The Close Gap tool creates an invisible drawing stroke to close the shape. 
Enabling this option will merge the stroke into the artwork instead of adding the 
stroke on top of it.

NOTE 

The area you close with the Close Gap tool will be fillable regardless of 
whether or not this option is enabled.
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Colour Eyedropper Tool Properties
The Colour Eyedropper tool allows you to pick a colour from your drawing without going to the Colour view. 

NOTE 

The following options will only have an effect when picking colours from a bitmap layer, as they 
affect the colour that gets picked. When working on a vector layer, you can only pick colours that 
are available in one of the palettes in your scene. Therefore, the colour you pick will always be 
exactly the colour that was used to fill the shape or stroke you clicked on.

How to access the Colour Eyedropper tool properties

 1. In the Tools toolbar, select the Colour Eyedropper  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

Sample All Layers

By default, the Colour Eyedropper tool picks the colour from the active 
drawing layer only. This means that if the colour is semi-transparent, it will 
still only take the colour from the active layer, along with its transparency, 
and ignore the colours from layers behind it. 

With this option enabled, the Colour Eyedropper tool will pick the colour as 
it appears on the screen instead, allowing you to pick colours that are the 
result of several layers composited together.

Do Not Pick 
Transparency

By default, the Colour Eyedroppertool picks the colour's alpha value as well 
as its colour values. When enabled, the colour picked will always have an 
alpha value of 255.
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Contour Editor Tool Properties
The Contour Editor lets you reshape vector shapes, brush strokes and lines in your drawings. 

Artwork in Harmony is made of vector shapes. Vector shapes are defined by points, the lines joining the points 
together (contours) and the curve vectors, represented by Bezier handles, which make the curve of said lines.

The Contour Editor tool allows you to select a contour or point, and change the position of points, add and 
remove points from the shape, rotate, lengthen and shorten curve handles to influence the curve of contours 
between those points, or drag contours between points to change their curve directly. 

How to access the Contour Editor tool properties

 1. In the Tools toolbar, select the Contour Editor  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Modes

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 
elements:

 l Lasso: Allows you to select multiple elements by 
drawing an irregular closed shape around them with your 
mouse.

 l Marquee: Allows you to select multiple elements by 
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Icon Property Description

drawing a rectangle around them. This is faster, as you only 
need to drag your mouse from one corner of the rectangle to 
its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the 
other selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to 
select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can 
also click on this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on to re-enable 
the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, moving the control point 
in a contour near another contour will snap that control 
point against that contour. This will lock the point and the 
contour together, and moving the control point will deform 
the contour. 

This option can be especially useful if you need to makes the 
edges of two shapes snap together, like so:

You can also use this option to make a control point snap 
against another control point, allowing you to join lines 
together.
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Icon Property Description

NOTE 

When a control point is snapped against a contour 
or another control point in your drawing, the Contour 
Editor will manipulate them together. However, 
even if you make a point in one drawing stroke snap 
against another drawing stroke, they will remain 
separate drawing strokes unless they are flattened 
together, and you will still be able to manipulate 

them individually with the Select tool. 

 l Snap to Alignment Guides: While moving the selection or 
one of its control points, it will snap against nearby 
alignment guides.

 l Snap and Align: Snaps the selected anchor point to any 
existing line while displaying temporary rulers as a guide 
that you can also snap your anchor point to. 

 l Snap to Grid: While moving the selection, the mouse cursor 
will snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

Show Contour Editor 
Controls

When enabled, selecting several control points will make a 
manipulator bounding box appear. You can use this manipulator to 
scale and rotate the selection of points.

Tip Style
If you select and remove part of a pencil line, this option allows you 
to choose which kind of line tip the removed segment should leave 
behind:
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Icon Property Description

 l  Tip Style: Round: Leaves rounded tips at the extremities 
of the deleted line segment.

 l  Tip Style: Flat: Leaves flat tips at the extremities of the 
deleted line segment.

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they 
will also be affected when this option is enabled.

Operations

Icon Property Description

Smooth Selection

The Smooth operation lets you smooth out selected drawing 
strokes and remove extra points.

TIP 

You can also smooth the selection by selecting Drawing> 
Optimize > Smooth from the top menu or by pressing Alt + 
Shift + S.             
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Split Pencil Line 

Join Pencil Lines

When drawing with the Polyline tool, your drawing has an even line 
thickness. You can use the Pencil Editor to adjust the thickness point 
by point, but if you want to adjust it quicker, you can use the Split 
Pencil Line and Point Pencil Lines options to create segments and 
apply a pencil stencil to your drawing. Note that if you did not join 
the pencil lines on your polyline stroke, the segments between the 
points will act as separated segments.
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Cutter Tool Properties
The Cutter tool lets you cut out part of a drawing so that you can transform it, copy it or delete it. It also allows 
you to trim overshot lines.

How to access the Cutter tool properties

 1. In the Tools toolbar, click and hold on the Select  tool to display the menu beneath and select 
the Cutter  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 
rectangle around them. This is faster, as you only need to drag your 
mouse from one corner of the rectangle to its opposite corner, but it 
may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Easy Drag
When enabled, you can drag the selection by clicking anywhere inside its 
bounding box. By default, you must click on the artwork in the selection to be 
able to drag it. 
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Use Mouse 
Gesture 

When this option is enabled along with the Lasso  selection type, quickly 
drawing a line with the Cutter tool over a line segment in your artwork will 
instantly delete it. This can be useful if you want to use the Cutter tool to 
quickly clean up your artwork. 

It allows you to cut in two modes as follows:

 l Single Line Cutting Gesture: It deletes first line segment over which 
a straight gesture is drawn with the cutter.

 l Multiple Lines Cutting Gesture: It deletes all line segments over 
which a straight gesture is drawn with the cutter.

NOTE 

This option will only work when using the Cutter tool on separate 
brush or pencil strokes. Hence, it is important not to flatten your 
artwork if you intend to use this option to clean up your drawings. This 
option has no effect on bitmap layers as the artwork in bitmap layers is 
always flattened.

Use Mouse 
Gesture Breaker 
Mode

When using the Lasso  selection type, the Use Mouse Gesture Breaker Mode  
option lets you draw an invisible stroke on a pencil line to cut it in two 
individual objects. Once a pencil line is cut with this option, you will be able 
to select the two portions independently with either the Cutter tool, Pencil 
Editor tool or Select tool.
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NOTE 

This option only works with pencil lines.

Tip Style

When cutting through pencil lines, this option decides what kind of pencil 
line tips to put at the extremities of the remaining pencil line segments, 
where they were cut. 

By default, this is set to Bevel , which will leave the tip of the pencil line 
cut at the same angle as your cutter stroke. If you prefer, you can make pencil 
lines that you split with the Cutter tool have Flat  or Round  tips 
instead. 

Antialiasing

When working on bitmap artwork, enabling this will smooth the edges of the 
artwork you cut out, so that they do not appear pixelated. 

NOTE 

This option is only available with bitmap layers.

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can be 
toggled on or off. When toggled on, it has two different modes. You can 
select a mode by clicking and holding on the button.
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Icon Property Description

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool will 
work on all these layers simultaneously. 

 l On When this button is toggled on, the tool will work on all the 
visible layers.

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer 
is synced with another layer, the tool will work on both the current 
layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All 
Frames

This option allows you to determine which drawings in the current layer the 
tool should affect. It can be toggled on or off. When toggled on, it has two 
different modes. You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
drawing in the current frame.

 l Apply to All Frames: The tool will work on every exposed 
drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every drawing 
displayed in the Onion Skin. Onion Skin must be enabled for this 
option to work. 

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and Colour 
Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also be 
affected when this option is enabled.

Operations

Icon Property Description
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Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees 
CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees 
CCW

Rotates the current selection 90 degrees counter-clockwise.
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Drawing Pivot Tool Properties
The Drawing Pivot  tool lets you set the pivots on your character. You can set the drawing pivots on drawings 
and symbols.

Tool Options

Icon Property Description

Setting the Drawing Pivot for Symbols on 
All Frames

The Set the Pivot for Symbol on All Frames  option 
is enabled by default. When you set a drawing 
pivot on a symbol, all of its cells use the same 
drawing pivot. This means you do not have to set a 
drawing pivot on all frames. Once you set it, it is 
done.

If you prefer to set a different drawing pivot for a 
series of cells, you can deselect the option and set 
your pivots on each cell or cell range.

NOTE 

If you have already set several different 
pivots on your symbol's cells and selected 
the Set the Pivot for Symbol on All 
Frames option, once you set a new pivot 
on the same symbol, all of its pivots will 
be reset and will use your new pivot.

Snapping

Allows you to enable or disable snapping for this 
tool and all other animation and drawing tools that 
support snapping, as well as to select which types 
of snapping are enabled. 

If you double-click or long-click on this button, it 
will open a pop-up menu in which you can toggle 
different snapping modes. You can also click on 
this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it 
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on to re-enable the snapping modes which were 
previously enabled. 

This tool supports the following snapping modes :

 l Snap to Contour: When moving the pivot, 
it will snap against the nearby points and 
contours of your artwork.

 l Snap to Alignment Guides: When moving 
the pivot, it will snap against nearby 
alignment guides.

 l Snap and Align: When moving the pivot, it 
will align with the edges of elements in the 
drawing.

 l Snap to Grid: When moving the pivot, it 
will snap against the intersecting points of 
the grid. 

TIP 

To display the grid, select View > 
Grid > Show Grid from the top 
menu or press Ctrl + '.

Reset Pivot
When you click the Reset Pivot  option, the drawing 
pivot of the selected drawing or symbol is reset to 
the centre of the Camera view.

Copying Pivot on Parent Symbol

When you import new extra drawings, such as 
hands and mouths, you can use the drawing pivot 
that was set on your drawings and report them to 
the symbol's cells. Use the Copy Pivot to Parent 
Symbol   command for this.
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Icon Property Description

NOTE 

When you copy drawing pivots to the 
parent symbol, there is no link between 
the drawings' pivots and the symbol's 
pivots. If you modify the drawing pivot 
later, it will not link to the symbol. You 
would need to perform the operation 
again. If you need to modify the symbol's 
pivots, you can do it directly on the 
symbol's cells.
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Edit Gradient/Texture Tool Properties
The Edit/Gradient Texture tool allows you to move, rotate and scale a gradient or texture fill within the shape 
it fills, without modifying the shape itself. 

How to access the Edit Gradient/Texture tool properties

 1. In the Tools toolbar, select the Edit Gradient/Texture  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can be 
toggled on or off. When toggled on, it has two different modes. You can 
select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool will 
work on all these layers simultaneously. 

 l On When this button is toggled on, the tool will work on all the 
visible layers.

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer 
is synced with another layer, the tool will work on both the current 
layer and its synced layer. 

NOTE 

This option only works in the Camera view. 
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Ellipse Tool Properties
The Ellipse tool allows you to quickly draw an ellipse or a circle.

How to access the Ellipse tool properties

 1. In the Tools toolbar, select the Ellipse  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.
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Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 
access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 
467 section below.

Size Defines the width of the pencil line used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can choose 
between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your shape is added to your artwork.
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Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, the shape you draw is automatically filled with the 
selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 
the colour list, select the desired colour swatch for your 
outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 
colour list, select the desired colour swatch for the fill. 

Snapping
Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 
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If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the 
mouse cursor will snap to the nearby contours of the artwork in 
your drawing. 

 l Snap to Alignment Guides: While drawing, the drawing tool 
will snap against nearby alignment guides.

 l Snap and Align: When enabled, while you're drawing, the 
mouse cursor will automatically align to the rectangular 
bounding boxes of other strokes and shapes in your drawing.

 l Snap to Grid: While moving the selection, the mouse cursor will 
snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid from 
the top menu or press Ctrl + '.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 
as a separate drawing object, which can be edited independently from 
other parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with 
a gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a 
gradient by selecting a zone painted with a gradient with the Select tool, 
then clicking on Store Colour Gradient  in the Tool Properties view.

Draw Circle

When enabled, the ellipsis tool will always draw an ellipsis of equal 
width and height, making it a perfect circle.

TIP 

You can also draw a perfect circle by holding the Shift key while 
drawing.

Pencil Properties Dialog

The Ellipse tool draws the same type of line as the Pencil tool. Hence, you can configure the Ellipse tool's lines 
using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 
display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will reduce 
the amount of control points it has, making it easier to tweak, but is liable to reduce 
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 
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However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Maximum and Minimum 
Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a pencil line. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the pencil line when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the pencil line when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Please refer 
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Ellipse Tool Properties on page 462

Pressure: Allows you to apply more pressure and increases the size of the 
pencil. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
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effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.
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Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 
the current pencil texture palette. The pencil texture's effect on your 
pencil line will be based on the image's transparency channel, and will 
follow your pencil lines on its horizontal axis. This option is also 
available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 
texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it 
in the Colour view.
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Envelope Tool Properties
Selecting the Envelope tool displays its properties and options in the Tool Properties view. 

Icon Tool Name Description

 
Width and 
Height

Increase the width and height values to add more columns and rows to the 
deformation grids.

Lasso

Sets the selection mode to Lasso, which allows you to select multiple items by 
drawing a lasso around them.

TIP 

When this option is enabled, you can press and hold the Alt key to 
temporarily use Marquee mode.

Marquee
Sets the selection mode to Marquee, which allows you to select multiple items 
by drawing a rectangle around them. 
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TIP 

When this option is enabled, you can press and hold the Alt key to 
temporarily use Lasso mode.

Snapping

Allows you to enable or disable snapping for this tool and all other animation 
and drawing tools that support snapping, as well as to select which types of 
snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up menu in 
which you can toggle different snapping modes. You can also click on this 
button to toggle it off, which will disable all snapping modes, and click on it 
again and toggle it on to re-enable the snapping modes which were previously 
enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its control 
points, it will snap against the nearby points and contours of your 
artwork, allowing you to snap parts of your artwork together. 

 l Snap to Alignment Guides: While moving the selection or one of its 
control points, it will snap against nearby alignment guides.

 l Snap and Align: When enabled, while moving a selection, the 
rectangular bounding box of the selection will snap to the rectangular 
bounding box of any other drawing stroke in the drawing, allowing you 
to align drawing strokes laterally.

 l Snap to Grid: While moving the selection, the mouse cursor will snap 
against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid from the top 
menu or press Ctrl + '.

 l Allow Snapping on all Drawing Layers: If toggled on, the selections 
can be snapped to all bounding boxes, nearby points, and contours of 
artwork on any layer.

Show Advanced 
Controls

To display more controls,you can click on the Show Advanced Controls  button.
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Apply to Line 
and Colour Art

Allows you to perform drawing operations on both the Line Art and Colour Art 
layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also be 
affected when this option is enabled.

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 
Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 
Degrees CCW

Rotates the current selection 90 degrees counter-clockwise.

Smooth

You can modify the central line smoothness  of your line using this option. This 
parameter smooths the deformed lines. Increasing the value will result in a 
smoother line with fewer control points. The more you increase the value, the 
less details and curves you will get. Use the left and right arrows to increment 
the value by one full unit. Use the Up - Down slider to quickly increment the 
value.
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Eraser Tool Properties
The Eraser tool allows you to erase artwork by drawing eraser strokes over it. When using the Eraser tool with 
a tablet, it is pressure sensitive, like with the Brush and Pencil tool. 

How to access the Eraser tool properties

 1. In the Tools toolbar, select the Eraser  tool.

The tool's properties are displayed in the Tool Properties view.

Eraser Properties

The way the Eraser tool is configured is almost identical to the way the Brush tool is configured.

Property Description

Stroke Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Eraser Properties 
Dialog

The arrow button right of the display area opens the Eraser Properties dialog, which 
gives you access to all the parameters and options for your eraser. The Tool Properties 
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view only gives you access to a few of the eraser properties, a list of eraser presets and 
options for the Eraser tool that are  not related to the eraser properties. For more 
information on the Eraser Properties dialog, see the Eraser Properties Dialog section 
below.

Maximum Size

Defines the maximum size of the eraser. 

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary 
between its maximum size and minimum size depending on the amount of pressure 
used. If used with a mouse, the width of the stroke will always be its maximum size. 

Flow

Lets you set the opacity for each instance of the eraser tip that gets erased from your 
artwork. Contrary to the Opacity parameter, the flow parameter has a cumulative effect. 
This means that a lower flow will make your eraser strokes less effective towards its 
extremities and more effective in its center. Your stroke's flow will also accumulate if 
you draw over it. By default, your eraser's flow varies with the amount of pressure you 
put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your whole 
brush stroke's opacity will not exceed the Opacity parameter. By default, the Opacity 
parameter varies depending on the amount of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Eraser Presets

These options allow you to select, create and manage eraser presets.
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Icon Property Description

  Presets list

By default, Harmony has preloaded eraser presets. You can also 
create your own eraser presets by configuring your eraser, then 
saving its properties into a new preset. It is also possible to export 
and import eraser presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail
Displays presets in a grid of small thumbnails with a preview of their 
tip.

  Large Thumbnail
Displays presets in a grid of big thumbnails, with their name and a 
preview of their tip.

  Stroke View
Displays presets in a list, with their name and a preview of a stroke 
done with each preset. 

Erasing Options

These options affect the way your eraser strokes are applied to your artwork.

Icon Property Description

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will 
also be affected when this option is enabled.
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Icon Property Description

Tip Style

When you erase part of a pencil line, this option determines the shape of 
the extremity of the pencil line where you erased:

 l  Round:  Leaves a round tip at the extremities of the pencil 
line you erased.

 l  Flat: Leaves a flat tip at the extremities of the pencil line you 
erased. A flat tip is always perpendicular to the angle of the 
centreline of the pencil line, so it may not match the angle of your 
eraser stroke. 

 l  Bevel: Leaves a bevel tip at the extremities of the pencil line 
you erased. A bevel tip is flat, but its angle matches the angle of 
your eraser stroke.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While erasing, the eraser will snap 

479

Harmony 24 Advanced Reference Guide                          



Chapter 4: Tools Properties

Icon Property Description

against nearby alignment guides.

Apply to Synced 
Drawing Layers

If the currently selected layer is synced with another layer, the tool will 
work on both the current layer and its synced layer. 

Eraser Properties Dialog

Erasers have an extensive set of options and properties that are not displayed in the Tool Properties view, but 
rather, in a dialog you can access from it. To open the Eraser Properties dialog, click on the arrow button right 
of the stroke display area. 

The Eraser Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 
layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 480

 l Smoothing Tab    on page 487

 l Transparency Tab on page 488

 l Dual Tip Tab on page 491

 l Paper Texture Tab on page 495

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your eraser tip.
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Property Description

Eraser Type

Allows you to select between one of the following eraser types:

 l Solid Vector: Simply cuts out the eraser stroke's shape from the vector artwork. 
A solid vector eraser always completely erase the artworks leaving hard seams. 

 l Textured  Eraser: Allows to configure the eraser with the same options as with 
a textured brush. A textured eraser will decrease the opacity of bitmap textures 
in textured brush strokes if it doesn't completely erase it. If it completely erases 
a brush stroke, it will cut out the erased part from the vector artwork.

 l Textured, Preserve Vector: Like a Textured Eraser, except that it will not cut 
out from the vector shapes, even if it fully erases pixels in a textured brush 
stroke's texture.

NOTE 

Textured erasers only work as expected on textured brush strokes. Using a 
Textured eraser on a solid vector brush stroke or on a pencil line will only cut the 
eraser stroke's shape out of it. If you use a Textured, Preserve Vector type eraser 
on a solid vector shape or on a pencil line, the eraser will not erase anything.
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Property Description

NOTE 

This option is not available when working on a bitmap layer. With bitmap layers, 
erasers are always textured, and textured eraser options are always available.

Eraser Tip Library

This is where you select the shape of the eraser tip. By default, it is round. Note that 
some tips are designed to have semitransparent areas, even when the maximum eraser 
opacity is set to 100%.

To create a custom eraser tip, you must prepare the file ahead of time, either in 
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 
supported and transparency is not supported in the traditional sense. Black appears as 
100% opaque, white appears as 100% transparent and all the shades of grey in 
between appear as varying degrees of semitransparency. A range of file formats are 
supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels are disregarded 
on import. It is recommended that your file be between 100 x 100 pixels and 400 x 400 
pixels. 

You can also import eraser tips that you exported from Harmony, so you can share 
them with colleagues.

Minimum and 
Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and thin 
effect on your stroke. This works with the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  width of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to and as a 
percentage of the maximum size.

You can control the size properties by clicking on the arrow button on right and the 
dialog box will appear as shown below.
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 l Pressure: Allows you to apply more pressure and increases the size of the 
brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can check 
the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
effect of end taper can be visualized once the stroke is complete and vectorized 
as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given distance. 
It uses the same units as the size and is applied as the stroke is drawn.
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Property Description

 l Size Proportional to Camera: If you check this option, the size of the  will be 
adjusted to the position of the camera on the z-axis. This means that if the 
camera is zoomed in on the scene, the  will be proportionally smaller so that it 
appears the same size in the rendered image. Likewise, if the camera is zoomed 
out, the  will be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of creating 
width variation on your stroke. In other words, you would be forcing a uniform line 
width using the Maximum Size value.

Proportional to Camera

If you check this option, the size of the eraser will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
eraser will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the eraser will be proportionally bigger. 

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and orientation 
of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 
squashes the tip vertically, allowing you to turn round or square tips into flat 
tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the squashing will 
still be done relative to the tip's original orientation.

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set whether your 
eraser takes your pen's tilt angle in account, and how much. 

When your pen is fully tilted, your eraser tip will be stretched by the percentage you 
set in this parameter, in the angle in which you tilt it. For example, if you set the Pen Tilt 
Sensitivity to 50%, and you tilt your pen all the way up or down, your eraser tip will be 
stretched vertically by 50%. With the same setting, if you tilt your pen all the way left 
or right, your eraser tip will be stretched horizontally by 50%.
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Use Pen Rotation

If enabled, and if your pen and tablet support tip rotation, your eraser tip will rotate 
with the angle of your pen tip. 

Hardness

The Hardness and Spacing parameters allow you to change the softness and spacing 
of the marks made by the eraser tip. You can preview the hardness and spacing at the 
top of the Eraser Properties window, stroke preview area.

The hardness value corresponds to the softness of the eraser tip's edges. The lower 
the value, the softer the tip edge. The higher the value, the sharper the tip edge. Be 
aware that some eraser tips are not 100% opaque, so they will always appear 
somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the eraser. A value of 100% sets 
the stamp marks edge to edge, if there is no white space around the shape. The larger 
the value, the greater the space between marks. A really large value can make the 
eraser stroke appear as a string of individual marks. Conversely, a small spacing value 
will give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 
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Property Description

Randomness
The Randomness parameters let you create a varied bitmap eraser stroke. Refining 
these options can give your stroke a lovely, non-mechanical look.

Random Size

You can create variation between the thick and thin of your eraser stroke just by setting 
the Maximum and Minimum Size values. If you add randomness to the mix, pressure 
sensitivity from your drawing tablet will still be applied. Light pressure will create 
random values around the minimum, while heavy pressure will create random values 
closer to the maximum. The larger the percentage, the larger the range of random 
variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating width 
variation on your stroke, whether you are applying randomness or not. Therefore, 
you would be forcing a uniform line width using the Maximum Size value.

Random Angle
Sets the range for random rotation around the set Angle value. For example, if the 
Angle is set to 45° and the Random Angle set to 10°, the software will choose values 
between 40°–50° (plus or minus 5 degrees, equaling a total of 10 degrees).
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Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if the 
Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony will 
choose values between 45%–55% (plus or minus 5 percent, equaling a total of 10 
percent).

Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your eraser 
strokes as you paint. 
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NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 
support smoothing.

Property Description

Centerline Smoothing
Defines the amount of smoothing Harmony should perform on your eraser stroke's 
direction, curves and corners. A higher setting will prevent your line from being 
shaky, but is liable to reduce drawing precision and turn sharp angles into curves.

Contour Smoothing
  Defines the amount of smoothing Harmony should perform on outer contour of the 

eraser stroke. A higher setting will round sharp corners and reduce the amount of 
control points for the resulting vector shape. 

Transparency Tab

The Transparency tab allows you to decide if your eraser has antialiasing as well as to set its flow and opacity 
settings. 
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NOTE 

The Transparency tab's options are only available on vector layers if the Eraser Type option of the 
Tip tab is set to Textured Vector or Textured, Preserve Vector.. On bitmap layers, those options 
are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the eraser strokes to 
blend with the surrounding colours, to create an illusion of smoothness 
otherwise not possible due to the picture resolution.

If antialiasing is disabled, the eraser will either fully erase pixels or leave them 
intact.

NOTE 

When disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate 
at which your eraser's effect flows. The greater the flow, the more consistent the 
effect is. If the flow is light,  then the effect may look spotty. This feature works 
with the pressure sensitivity of a pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture are 
applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 
applied as you create a fluid stroke. It is defined as a percentage of the 
Maximum Flow value. If the Minimum Flow value is set to 100%, then 
tablet pressure sensitivity will no longer be applicable. The flow will be 
set to the constant rate of the Maximum Flow value.

Maximum Opacity and 
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity 
range for a eraser mark. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the eraser mark when 
the pressure is heavy. 
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Property Description

 l Minimum Opacity: Sets the transparency limit of the eraser mark when 
the pressure is very light. It is defined as a percentage of the Maximum 
Opacity value. If the Minimum Opacity value is set to 100%, then tablet 
pressure sensitivity will no longer be applicable. The opacity will be set 
to the constant rate of the Maximum Opacity value.

Randomness
Th Randomness parameter lets you set the range for the randomness of the flow 
and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your eraser stroke just by setting the 
Maximum and Minimum Flow values. If you add randomness to the mix, pressure 
sensitivity from your drawing tablet will still be applied. Light pressure will 
create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation. 

NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of 
creating flow variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform flow using the 
Maximum Flow value.
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Property Description

Random Opacity

You can create variation in the opacity of your eraser stroke just by setting the 
Maximum and Minimum Opacity values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light pressure 
will create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation.

NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of 
creating opacity variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform opacity using 
the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip eraser. The primary bitmap eraser tip and 
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 
Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab must be set 
to Textured Vector or Textured, Preserve Vector.

Tool Name Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your eraser uses a 
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be 
disabled. 

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply
This is the default blend mode. When the two eraser tips are combined in this mode, 
they essentially cut each other out in overlapping areas, where one or both tips have 
an area of 100% transparency. The less opaque the eraser tips are, the lighter their 
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Tool Name Description

combination. 

Colour Dodge
In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes 
overlap, within the boundaries of the primary shape, the colour and opacity appear 
darker.
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Tool Name Description

Combine
This mode treats the two tips as two different and separate erasers that have the 
same colour and follow the same path.

494



Tool Name Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your eraser. You can also add textures by 
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 
Texture tab. Additionally, if you are working on a vector layer, the Eraser Type option of the Tip 
tab must be set to Textured Vector or Textured, Preserve Vector.

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your eraser uses a 
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will 
be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive
This option layers the texture on top of itself as you scribble overlapping lines in one 
continuous stroke.  If this option is turned off, areas of overlapping lines from a single, 
continuous stroke will appear the same, in terms of darkness and texture, as non-
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Property Description

overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 
enabled, the paper texture's position does not change with each sweep of the eraser. 
If this option is disabled, each sweep of the eraser produces a different texture 
position. The texture orientation always stays the same.
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Ink Tool Properties
When you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Tool

Lasso

Sets the selection mode to Lasso, which allows 
you to select multiple items by drawing a lasso 
around them.

TIP 

When this option is enabled, you can 
press and hold the Alt key to temporarily 
use Marquee mode.

Marquee

Sets the selection mode to Marquee, which allows 
you to select multiple items by drawing a rectangle 
around them. 

TIP 

When this option is enabled, you can 
press and hold the Alt key to temporarily 
use Lasso mode.

Show Inkable Lines

Highlights all pencil lines (no brush strokes) on the 
selected layer. Pencil line segments that are 
already inked with the selected swatch colour from 
the colour palette are also not highlighted.

Be Smart on Connecting Lines

As you hover and move the cursor across 
intersecting pencil lines, the path that you create 
will be highlighted. When you click on your mouse 
or stylus the highlighted segments are inked.  With 
this option disabled, all the intersecting segments 
that your cursor comes near will be highlighted 
and become part of the selection, even if they were 
not situated in the direction of the chosen path.
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NOTE 

This option only works if the Ink tool is in 
Hover mode.

Select Mode

Use this mode instead of the Hover Mode. In the 
Hover Mode, any potentially inkable pencil line will 
have its central vector line highlighted as the Ink 
tool’s cursor hovers over it. Use Ctrl 
(Windows/Linux) or ⌘  (macOS) to toggle between 
the two modes.

Select Newly Painted, Repainted, 
and Unpainted Contours/Lines

In the Paint   tool properties, this option  keeps a 
selection highlighted around the latest painted 
zone after using the Paint, Repaint, Unpaint, or 
Paint Unpainted tool.

Raise

As you ink the pencil line, the segment will be 
moved on top of the other intersecting strokes. 
Disable this option for the line to be sent behind. 
Hold down the Alt key to perform the opposite 
operation as you ink.

Mitre

As you hover over two perpendicular or nearly 
perpendicular segments, a highlighted path with a 
corner is created. Clicking on these highlighted 
segments inks both segments and makes them 
appear as a single stroke with a corner or bend. 
Options include: As Is, Round, Miter, and Bevel.

Tip Style
Lets you customize the edge of the Ink tool. 
Options include: Round, Flat, and Bevel.
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Line Tool Properties
The Line tool allows you to quickly draw a line segment by dragging the mouse from its starting point to its 
end point.

How to access the Line tool properties

 1. In the Tools toolbar, select the Line  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.

500



Tool Name Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 
access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog section 
below.

Size Defines the width of the pencil line used to draw the line.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can choose 
between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Draw Behind

When enabled, your brush strokes will appear behind the existing artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as you 
draw it, until you release the mouse cursor or tablet pen. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up menu in 
which you can toggle different snapping modes. You can also click on this 
button to toggle it off, which will disable all snapping modes, and click on it 
again and toggle it on to re-enable the snapping modes which were 
previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the mouse 
cursor will automatically snap to the nearby contours of existing 
artwork, allowing you to draw shapes that connect with other parts 
of your drawing. 
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Icon Tool Name Description

NOTE 

If you draw a line with the Line tool and make its tip snap to a 
contour or another control point in your artwork, they will be 
locked together. You can then manipulate both 

simultaneously using the  Contour Editor  tool. You can 
also separate two drawing strokes that have been snapped 

together by selecting one of them with the  Select  tool 
and moving it away.

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.

 l Snap and Align: When enabled, while you're drawing, the mouse 
cursor will automatically align with the edges of strokes and shapes 
in your artwork, allowing you to draw shapes that align with parts of 
your drawing.

 l When enabled, while you're drawing, the mouse cursor will snap 
against the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid from the 
top menu or press Ctrl + '.

Automatically 
Create Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.
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Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option automatically 
merges strokes into existing artwork. 

NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and can 
be treated as individual lines.

Auto-Close Gap

When enabled, small gaps between the pencil lines you draw will be closed 
by an invisible stroke to make sure your shapes are closed and that they can 
be filled with the Paint tool.

When drawing contours with pencil lines, the centreline is used to 
determine whether or not the contour is closed, but the visible tips of the 
pencil line will extend a bit beyond the tips of its centreline, making it 
possible to have shapes that appear closed, but are not really. This can 
prevent the shape from being filled with the Paint tool. Enabling this option 
when drawing with the Pencil or Line tool will prevent you from leaving 
invisible gaps in your contours.

 

Line Building Mode

The Line Building mode is very useful when drawing long lines and curves 
in small increments with pencil lines or the Line tool. As the pencil lines are 
central vector lines, it may be difficult to align the line tips perfectly to 
create a uniform stroke and close all gaps.
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In this mode, you can draw lines in small increments and the tips are merge 
into one single stroke.

NOTE 

This mode only works with pencil lines or the line  tool.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with a 
gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a gradient 
by selecting a zone painted with a gradient with the Select tool, then 
clicking on Store Colour Gradient  in the Tool Properties view.

Straight Line Mode

Draws a straight line. 

In this mode, you can draw curved lines with the following method:

 1. Draw the line by clicking and dragging from the start point to the 
end point of the line, but don’t release the mouse button or pen yet.

 2. While holding the mouse button or pen down, press and hold the 
Ctrl (Windows/Linux) or ⌘  (macOS) and move the mouse or pen to 
define the line’s curve.

 3. Once the line’s curve looks right, release the mouse button or pen.
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Icon Tool Name Description

Curve Line Mode

This mode allows you to draws a simple curved (quadratic Bezier) line in 
two clicks:

 1. Draw the line by clicking and dragging from the start point to the 
end point of the line.

 2. Move the mouse or pen to define the curve of the line and click.

S Curve Line Mode

Draws an S-shaped (cubic Bezier) line. This mode allows you to draw lines 
with finely tuned or even S-shaped curves with three clicks:

 1. Draw the line by clicking and dragging from the start point to the 
end point of the line.

 2. Move the mouse or pen to define the Bezier position of the 
beginning of the line and click.

 3. Move the mouse or pen to define the Bezier position of the end of 
the line and click.
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Icon Tool Name Description

Pencil Properties Dialog

Since the Line tool draws pencil lines, you can use the Pencil Properties dialog to customize the type of lines it 
draws. To open the Pencil Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will reduce 
the amount of control points it has, making it easier to tweak, but is liable to reduce 
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 

509

Harmony 24 Advanced Reference Guide                          



Chapter 4: Tools Properties

Property Description

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Maximum and Minimum 
Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a pencil line. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the pencil line when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the pencil line when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Please refer Line 
Tool Properties on page 500
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Property Description

Pressure: Allows you to apply more pressure and increases the size of the 
pencil. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.
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Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 
the current pencil texture palette. The pencil texture's effect on your 
pencil line will be based on the image's transparency channel, and will 
follow your pencil lines on its horizontal axis. This option is also 
available from the menu button.
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Icon Property Description

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 
texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it 
in the Colour view.
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Morphing Tool Properties
As you create and adjust your morphing sequences, you will often use the Tool Properties view. Using this 
view allows you to do things such as toggle between your key drawings, adjust the easing or select a hint 
type.  

Icon Tool Name Description

Hint Type

The Hint Type drop-down menu allows you to select 
the correct hint to remedy any problem areas in your 
drawing.

You can have more than one hint type in your 
drawings. You can mix all of the hint types in your 
morphing sequence.

Do not Pick Transparency

The Hide Hints  button temporarily Temporarily hides 
the hint points from the key drawings. Use this option 
when you have a series of hint points hiding some 
lines you would like to see.
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Show Morphing in Place

The Show Morphing In Place  option is used with 
morphing layers. Enabling this option prevents the 
currently selected morphing layer from being shown 
on top of the others and maintains the correct layer 
ordering.

Suggest Hints

The Suggest Hints  option is used to automatically set 
Automatically sets hint points on key drawings as a 
help tool. If you're not sure where to set hints, you can 
use this option. It will set the main hints which you can 
then fine tune.

Switch Between 
Drawings

The Switch Between Drawings  button is used to 
toggle Toggles between the two key drawings in your 
morphing sequence. This option is useful while setting 
hints. You can use the default keyboard shortcut F4 to 
toggle between your drawings.

Flatten
The Flatten  option is used when you have to morph a 
sequence with a semi-transparent or transparent 
colour in it.

  Quality

The Quality setting is used to make the lines of the 
morphed drawings smoother. Adjust this parameter 
when you are doing an extreme close up of your 
animation.

  Morphing Layers
The Morphing Layers option is used when working 
with morphing layers. You can add, remove and 
manage your different morphing layers in this space.
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To create new drawings, double-click on the blank 
area under the From section to create the source 
drawing and the To section for the destination 
drawing and type a different value than the ones used 
for the main layer.

Add Layer Adds a new Morphing layer.

Delete Layer Deletes the selected Morphing layer.

Move Up Moves the new layer up in the stack.

Move Down Moves the new lower up in the stack.

  Start

Indicates the start frame of the selected Morphing 
layer. 

  Stop
Indicates the end frame of the selected Morphing 
layer. 

  Ease in and Ease out

The Easing option is used to adjust the starting and 
ending velocity of your morphing sequence so that the 
motion is smooth and not mechanical.

You can adjust the Ease In and Ease Out value by 
dragging your cursor up and down or typing a new 
value. The values go from -1.0 to 1.0.
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Convert Hints

The Convert Hints  option is used to switch the type of 
the selected hint points. This option is useful when 
you position hints and then realize they are not the 
right type. You can select them and convert them to 
the correct type instead of deleting them and setting 
new ones.

Use the Morphing tool to select the hints and then 
convert them by going to the Tool Properties view and 
selecting the new hint type from the Convert Hints 
drop-down menu.

  Time

The Time field is used to set the timing on Appearing 
Point and Vanishing Point hints. These hints are used 
to set the trajectory of appearing and vanishing 
objects, With the Time field, select your Appearing 
Point or Vanishing Point hint and type the frame 
number on which the object will start its appearing or 
vanishing animation.
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Paint Tool Properties
The Paint tool allows you to fill closed areas of your drawing with the selected colour. 

How to access the Paint tool properties

 1. In the Tools toolbar, select the Paint , Paint Unpainted , Repaint  or Unpaint  tool.

The tool's properties are displayed in the Tool Properties view.

Paint Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 
rectangle around them. This is faster, as you only need to drag 
your mouse from one corner of the rectangle to its opposite corner, 
but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.
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Icon Property Description

Paint Mode

The Paint tool has four different modes:

 l Paint:  Paints or repaints selected zones, whether or not they 
are already filled.

 l Paint Unpainted:  Only paints empty zones, and does not 
repaint zones that are already filled with colour. 

 l Repaint:   Only paints zones that are already filled with colour, 
and does not fill empty zones.

 l Unpaint: Removes colour from the selected zone, replacing it 
with transparency.

Paint and Remove 
Textures

The Paint and Remove Texture  option is used when you vectorized images 
as greyscale texture style. An image vectorized as texture is a mix of 
bitmap filling encapsulated in a vector-based frame. Painting a textured 
zones with the Paint tool will change the tint of the textured lines. 
Painting the textured zones using the Paint and Remove Texture option 
transforms the bitmap filling into a 100% vector based zone and fills it 
with a solid colour.

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can 
be toggled on or off. When toggled on, it has two different modes. You 
can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool 
will work on all these layers simultaneously. 

 l On When this button is toggled on, the tool will work on all the 
visible layers.

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 
layer is synced with another layer, the tool will work on both the 
current layer and its synced layer. 
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Icon Property Description

NOTE 

This option only works in the Camera view. 

Apply to All Frames

This option allows you to determine which drawings in the current layer 
the tool should affect. It can be toggled on or off. When toggled on, it has 
two different modes. You can select a mode by clicking and holding on the 
button.

 l Off: When this button is toggled off, the tool only works on the 
drawing in the current frame.

 l Apply to All Frames: The tool will work on every exposed 
drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every 
drawing displayed in the Onion Skin. Onion Skin must be enabled 
for this option to work. 

Respect Protected 
Colour

The Respect Protected Colour option is enabled by default. In your Colour 
view, you can protect some colour swatches to avoid repainting or 
unpainting the zones linked to that swatch. 

If you disable this option the Paint tool will not follow the protect colour 
rule and will repaint or unpaint the protected colours on your drawings 
until you enable the option again.

Use Stored Colour 
Gradient

When you paint a zone with a gradient or textured colour swatch, the 
gradient or texture’s position is set relative to the size of the zone you are 
painting. If you want the Paint tool to use a particular size and position, 
you must first store your desired position and size using the Select  tool 
and then enable the Use Stored Colour Gradient   option in the Paint tool 
properties.
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Icon Property Description

Select Newly 
Painted, Repainted, 
and Unpainted 
Contours/Lines

In the Paint   tool properties, this option  keeps a selection highlighted 
around the latest painted zone after using the Paint, Repaint, Unpaint, or 
Paint Unpainted tool.

Close Gap

By default, if you attempt to fill a shape that has a small gap in its contour, 
the Paint tool will not be able to fill the shape. This option allows you to 
make the Paint tool automatically add a stroke to close the shape when it 
detects a small gap between two strokes in the shape. 

The Close Gap setting can be set to a value between 0 and 10. This 
determines the maximum size of a gap to close, in pixels. You can also use 
one of the following presets:

 l No Close Gap: Sets the Close Gap setting to 0, disabling the 
feature. 

 l Close Small Gap: Sets the Close Gap setting to 2, making the 
Paint tool close gaps that are barely visible. 

 l Close Medium Gap: Sets the Close Gap setting to 4, making 
the Paint tool close gaps that are somewhat visible. 

 l Close Large Gap: Sets the Close Gap setting to 8, making the 
Paint tool close gaps that are easy to notice. 
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Bitmap Options

Since bitmap drawings are made of pixels instead of shapes, and that the outlines of shapes in bitmap 
drawings are often feathered, it can be complicated to figure out exactly the area the Paint tool must fill when 
trying to fill a zone in a bitmap drawing. For example, if the Paint tool only replaces pixels with the exact same 
colour as the one you click on with the selected colour, it will leave a small gap near the outlines of the shape. 

The following settings determine how the Paint tool figures out the area it must fill. When any of these 
settings are increased, the Paint tool's tolerance for colour or alpha differences increases and it will a bigger 
area that it otherwise would. 

Icon Property Description

Source

Allows you to select which art layer to use in order to determine the 
fillable zone. By default, this is set to Current Art , which means the 
layer you are filling will be used to determine the fillable zone. 
However, if you want to keep your colour art on the Colour Art layer 
and the line art on the Line Art layer, you can set the Source to Line Art 

, and then use the Paint tool on the Colour Art layer. The Paint tool 
will use the artwork in the Line Art layer to determine the area to fill 
with colour, but will still add this colour to the Colour Art layer.

This property has the following options:

 l Current Art: Bases the zone to fill on the current art layer.

 l Line Art: Bases the zone to fill on the Line Art layer, 
regardless of which layer you are painting on.

 l Colour Art: Bases the zone to fill on the Colour Art layer, 
regardless of which layer you are painting on.

-- Alpha

The alpha threshold that separates opaque and transparent zones. 
When filling a "transparent" zone, the paint tool will apply the colour 
under semi-transparent pixels, making them opaque. Then filling an 
"opaque" zone, the paint tool will replace the colour of semi-
transparent pixels without affecting their transparency. 

If you want to repaint lineart or shapes that have no outlines, you can 
do so by decreasing this setting completely. This will make it fill any 
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Icon Property Description

pixel that isn't 100% transparent, so it will paint your outlines 
completely. However, if you're using this method to repaint outlines, 
they must not be filled yet for this method to work. 

If you want to paint transparent zones that have dirt or semi-
transparent spots, you can increase this setting to make the Paint tool 
paint behind them instead of around them. 

NOTE 

Raising this setting too high may cause the paint tool to ignore 
outlines that are not 100% opaque, which can cause it to think 
the shape is not closed. Hence, it might fail to find a zone to fill 
and not do anything.

-- Colour Tolerance

The amount of tolerance the paint tool has for changes in colour when 
filling an area. Raising this setting will allow the paint tool to fill over 
areas that have some variations in colour, but may cause it to fill 
beyond the areas you meant to paint.

-- Maximum Overlap

The maximum amount of pixels beyond the fillable zone that the Paint 
tool can fill.

When this setting is set to any value above zero, the paint tool will fill 
the zone until it finds a pixel that is a different colour, value or 
transparency as the one you clicked on. Then, it will start filling pixels 
beyond that point, up until it filled the amount of pixels in the 
Maximum Overlap setting. 

If it lands outside of a fillable zone before it reached the maximum 
overlap, it will stop filling at that point. However, if it lands into 
another fillable zone before reaching its maximum overlap, it will fill 
that zone as well. Therefore, if you're filling shapes inside other 
shapes, you have to set this setting to the approximate width of your 
outlines. Setting it higher will make the colour spill beyond the zone 
you clicked on and fill the zone outside of it, and setting it lower is 
liable to leave a small gap between the fill and the outlines.
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Icon Property Description

NOTE 

When you fill a zone with overlap, Harmony tries to detect and 
preserve the outlines of your shape. This is easy to do when 
filling a transparent shape, or when repainting a shape made of 
solid outlines and a solid fill. However, if you are trying to 
repaint an already painted zone, it may fail to detect your 
outlines and may repaint over them if the colour of your 
outlines or inside the shape isn't consistent. Therefore, it is 
highly recommended to avoid repainting painted zones as much 
as possible when working with bitmap layers. 

Antialiasing

When enabled, the outlines of the fill will be smoothed so that they do 
not look pixelated. 

NOTE 

The effect of this setting will not be visible if you fill all the way 
to the outlines, as the Paint tool will preserve the antialiasing of 
existing outlines when filling up to them. 

524



 Pencil Tool Properties
The Pencil tool allows you to draw simple contour lines that are defined by their centerline and their thickness. 

When you select the Pencil tool, the Tool Properties view displays the different Pencil modes that control how 
the pencil line is drawn.

How to access the Pencil tool properties

 1. In the Tools toolbar, select the Pencil  tool. 

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

The following properties affect the pencil's size, smoothing, shape and other properties for the drawing style 
of your pencil. Those properties can be saved into pencil presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.
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Property Description

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 
access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog section 
below.

Maximum Size

Defines the maximum width of the pencil line.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary 
between its maximum size and minimum size depending on the amount of pressure 
used. If used with a mouse, the width of the stroke will always be its maximum size. 

Centerline Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can choose 
between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 
the colour list, select the desired colour swatch for your 
outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 
colour list, select the desired colour swatch for the fill. 

Trim Extra Lines
When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 
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Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make 
the point where the beginning and end of the stroke meet into a smooth 
curve rather than a hard corner. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto Flatten

By default, when drawing on a vector layer, each new stroke is created 
as a separate drawing object, which can be edited independently from 
other parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 
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Icon Property Description

NOTE 

Using the Select tool, you can select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.                         

Auto-Close Gap

When enabled, small gaps between the pencil lines you draw will be 
closed by an invisible stroke to make sure your shapes are closed and 
that they can be filled with the Paint tool.

When drawing contours with pencil lines, the centreline is used to 
determine whether or not the contour is closed, but the visible tips of the 
pencil line will extend a bit beyond the tips of its centreline, making it 
possible to have shapes that appear closed, but are not really. This can 
prevent the shape from being filled with the Paint tool. Enabling this 
option when drawing with the Pencil or Line tool will prevent you from 
leaving invisible gaps in your contours.

 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool 
will snap against nearby alignment guides.
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Line Building Mode

The Line Building mode is very useful when drawing long lines and 
curves in small increments with pencil lines or the Line tool. As the 
pencil lines are central vector lines, it may be difficult to align the line 
tips perfectly to create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are 
merge into one single stroke.

NOTE 

This mode only works with pencil lines or the line  tool.

Auto Adjust Thickness

The Auto Adjust Thickness  tool is useful when you want to render a 
portion of a line thicker. When tracing a drawing on paper, you will often 
go back to a section of a curve to make it thicker to add dynamism to the 
line. Using the Auto Adjust Thickness tool, you can draw highlight 
strokes over the section to make thicker. Once you release the pen or 
mouse, the line becomes thicker following the shape and curve of the 
original stroke. This way is much faster and smoother than using the 
Pencil Editor tool. You do not have to add extra points and adjust the 
position and Bezier handles.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode
The Line Pushing Mode  option lets you draw highlight strokes over 
existing pencil lines. You can reshape the curves. Depending how you 
draw the pushing stroke over your line, the highlighted section will be 
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Icon Property Description

reshaped in one direction or the other.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

  Colour

You can change the colour of the temporary strokes that appear in the 
drawing space when using the Line Pushing Mode or the Auto Adjust 
Thickness option by clicking on the Colour swatch and selecting a new 
colour in the Colour Picker dialog. 

Pencil Properties Dialog

Pencils have extra parameters which are not accessible from the Tool Properties view. To open the Pencil 
Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will reduce 
the amount of control points it has, making it easier to tweak, but is liable to reduce 
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 
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However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Maximum and Minimum 
Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a pencil line. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the pencil line when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the pencil line when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Please refer  
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Property Description

Pencil Tool Properties on page 525

Pressure: Allows you to apply more pressure and increases the size of the 
pencil. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
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Property Description

effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.
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Icon Property Description

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 
the current pencil texture palette. The pencil texture's effect on your 
pencil line will be based on the image's transparency channel, and will 
follow your pencil lines on its horizontal axis. This option is also 
available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 
texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it 
in the Colour view.
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Pencil Editor Tool Properties
When you select the Pencil Editor  tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing 
an irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by 
drawing a rectangle around them. This is faster, as you only 
need to drag your mouse from one corner of the rectangle to its 
opposite corner, but it may not be as precise as you want.
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TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Apply to Visible Drawing 
Layers

This option allows you to select which layers the tool should affect. It 
can be toggled on or off. When toggled on, it has two different modes. 
You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool 
will work on all these layers simultaneously. 

 l On When this button is toggled on, the tool will work on all the 
visible layers.

 l  Apply to Visible Drawing Layers: The tool will work on all 
the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 
layer is synced with another layer, the tool will work on both 
the current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

  Maximum Size

Defines the maximum width of the pencil line. 

If the pencil line has a constant size, this will define the width of the 
pencil line all over. If the pencil line has a varying size, this will define 
the width of its larger areas. Areas that are in-between the maximum 
and minimum size will be resized proportionally.

  Minimum Size

Defines the minimum width of the pencil line. If the pencil line has a 
varying size, this will define the width of its smaller areas. Areas that 
are in-betwen the maximum and minimum size will be resized 
proportionally.

  Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first 
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tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the 
line curves abruptly. You could also define the Join style as the 
corner style. You can choose between Round, Mitre and Bevel 
style.

  Presets

Harmony provides a variety of pencil presets and thickness stencils 
and also lets you create and save your own. It is a good idea to create 
and save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length 
of the line.  When drawing with a thickness stencil, the pressure 
sensitivity of the tablet is discarded. A thickness stencil can be used 
while drawing, or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Allows to create a new preset from the selected pencil line.

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
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texture palette.

  New Texture Adds a new custom pencil texture to the list.

  Delete Texture Deletes a texture preset from the list.

  Rename Texture Renames the selected texture to keep the list organized.

  Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

  Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use 
the Colour View menu to assign a new palette.

Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes 
and remove extra points.

TIP 

You can also smooth the selection by selecting Drawing> 
Optimize > Smooth from the top menu or by pressing Alt + 
Shift + S.             

Pump Pencil Pressure

The Pump Pencil Pressure  option is used to increase the line thickness 
of a selected area on a pencil line.

Deflate Pencil Pressure
The Deflate Pencil Pressure option is used to decrease the line 
thickness of a selected area on a pencil line.
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Merge Pencil Lines

Because pencil lines are defined by their centre lines, two pencil lines 
that brush against each other may not actually make a closed shape, 
even if they appear closed. If you select several pencil lines that are 
close together, you can use this button to close the small gaps 
between these pencil lines and make them into a single pencil line.

 

Reverse Pencil Thickness

The Reverse Pencil Thickness  option inverts the thick and thin section 
on a selected pencil line. This option will take the thickest size on the 
line and apply it to the thinnest, and it will apply the thinnest to the 
thickest.
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Perspective Tool Properties
The perspective tool allows you to deform artwork by creating a rectangular bounding box around it and 
allowing you to manipulate any of the four corners. The selected artwork will be deformed to fit the shape you 
make by simulating a perspective effect.

How to access the Perspective tool properties

 1. In the Tools toolbar, select the Perspective   tool.

The tool's properties are displayed in the Tool Properties view.

Icon Tool Name Description

Perspective Tool Options

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing 
an irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by 
drawing a rectangle around them. This is faster, as you only 
need to drag your mouse from one corner of the rectangle to 
its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to 
select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
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Icon Tool Name Description

click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its 
control points, it will snap against the nearby points and 
contours of your artwork, allowing you to snap parts of your 
artwork together. 

 l Snap to Alignment Guides: While moving the selection or one 
of its control points, it will snap against nearby alignment 
guides.

 l Snap and Align: When enabled, while moving a selection, the 
rectangular bounding box of the selection will snap to the 
rectangular bounding box of any other drawing stroke in the 
drawing, allowing you to align drawing strokes laterally.

 l Snap to Grid: While moving the selection, the mouse cursor 
will snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will 
also be affected when this option is enabled.

Deformation Mode

Allows you to select between one of the two following deformation 
modes:

 l  Perspective: Deforms the selection by simulating a 
perspective effect. 

 l  Lattice: Deforms the selection by simply making the 
artwork fit the bounding box, without applying a perspective 
effect. 

The difference between both modes becomes easier to understand if 
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Icon Tool Name Description

you apply a transformation to a drawing of a grid to make it look like 
it's laid down on a surface: 

Operations

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Rotate 90 CW Rotates the selection 90° clockwise.

Rotate 90 CCW Rotates the selection 90° counterclockwise.
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Polyline Tool Properties
The Polyline tool allows you to draw complex lines or shapes by defining each point and their Bezier handles 
one by one. 

How to access the Polyline tool properties

 1. In the Tools toolbar, select the Polyline  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.

Icon Property Description

  Preview Area

The Preview area lets you see a preview of the stroke your drawing tool 
will make.
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Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties 
dialog. 

While the Tool Properties view only gives you access to the pencil size, 
a list of pencil presets and other drawing options, the Pencil Properties 
dialog gives you access to all the available options for your pencil's 
shape and texture. For more information on the Pencil Properties dialog, 
see the Polyline Tool Properties section below.

  Size Defines the width of the pencil line used to draw the shape.

Pencil Presets

Icon Property Description

  Presets list

Harmony provides a variety of presets and also lets you create and save 
your own. It is a good idea to create and save pencils with precise sizes 
and parameters when you draw and design for efficiency and 
consistency. 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset 
list.

New Preset Creates a new preset based on the current tool properties. 

Delete Preset Deletes the currently selected preset.

Presets Menu Gives access to more options for managing presets.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail Displays presets in a grid of small thumbnails with a preview of their tip.
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  Large Thumbnail
Displays presets in a grid of big thumbnails, with their name and a 
preview of their tip.

  Stroke View
Displays presets in a list, with their name and a preview of a stroke done 
with each preset. 

Drawing Options

Icon Property Description

Snap to Contour

When this option is enabled, clicking close to a contour in your drawing 
will add the point to that contour. The line you are building will be linked 
to that contour.

If this option is disabled, attempting to click on existing contours will 
always create a point very close to that contour, but not exactly on it. 
Therefore, it is necessary to enable this mode if you want to create lines 
that branch from into existing contours in your drawing.

NOTE 

If you draw a line with the Line tool and make its tip snap to a 
contour or another control point in your artwork, they will be 
locked together. You can then manipulate both simultaneously 

using the  Contour Editor  tool. You can also separate two 
drawing strokes that have been snapped together by selecting 

one of them with the  Select  tool and moving it away.

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 
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TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 
the colour list, select the desired colour swatch for your 
outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 
colour list, select the desired colour swatch for the fill. 

Trim Extra Lines

When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 

Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make 
the point where the beginning and end of the stroke meet into a smooth 
curve rather than a hard corner. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 
as a separate drawing object, which can be edited independently from 
other parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.

Pencil Properties Dialog

The Polyline tool draws the same type of line as the Pencil tool. Hence, you can configure the Polyline tool's 
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 
display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will reduce 
the amount of control points it has, making it easier to tweak, but is liable to reduce 
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
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Property Description

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Maximum and Minimum 
Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a pencil line. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the pencil line when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the pencil line when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Please refer 
Polyline Tool Properties on page 546
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Property Description

Pressure: Allows you to apply more pressure and increases the size of the 
pencil. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.
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Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 
the current pencil texture palette. The pencil texture's effect on your 
pencil line will be based on the image's transparency channel, and will 
follow your pencil lines on its horizontal axis. This option is also 
available from the menu button.
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Icon Property Description

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 
texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it 
in the Colour view.
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Rectangle Tool Properties
The Rectangle tool allows you to quickly draw a rectangle or a square.

How to access the Rectangle tool properties

 1. In the Tools toolbar, select the Rectangle  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 
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Property Description

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 
access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 
561 section below.

Size Defines the width of the pencil line used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can choose 
between Round, Mitre and Bevel style.

Drawing Options

These options affect the way your shape is added to your artwork.

Icon Property Description

Draw Behind
When enabled, your brush strokes will appear behind the existing 
artwork. 
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Icon Property Description

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, the shape you draw is automatically filled with the 
selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 
the colour list, select the desired colour swatch for your 
outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 
colour list, select the desired colour swatch for the fill. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
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modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the 
mouse cursor will snap to the nearby contours of the artwork in 
your drawing. 

 l Snap to Alignment Guides: While drawing, the drawing tool 
will snap against nearby alignment guides.

 l Snap and Align: When enabled, while you're drawing, the 
mouse cursor will automatically align to the rectangular 
bounding boxes of other strokes and shapes in your drawing.

 l When enabled, while you're drawing, the mouse cursor will snap 
against the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid from 
the top menu or press Ctrl + '.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 
as a separate drawing object, which can be edited independently from 
other parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 
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Icon Property Description

NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with 
a gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a 
gradient by selecting a zone painted with a gradient with the Select tool, 
then clicking on Store Colour Gradient  in the Tool Properties view.

Draw Square

When enabled, the rectangle tool will always draw a rectangle of equal 
width and height, making it a perfect square.

TIP 

You can also draw a perfect square by holding the Shift key while 
drawing.

Pencil Presets

These options allow you to select, create and manage pencil presets.

Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.
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New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Pencil Properties Dialog

The Rectangle tool draws the same type of line as the Pencil tool. Hence, you can configure the Rectangle 
tool's lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the 
stroke display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will reduce 
the amount of control points it has, making it easier to tweak, but is liable to reduce 
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 
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However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Maximum and Minimum 
Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity range 
for a pencil line. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the pencil line when the 
pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the pencil line when the 
pressure is very light. It is defined as a percentage of the Maximum Opacity 
value. If the Minimum Opacity value is set to 100%, then tablet pressure 
sensitivity will no longer be applicable. The opacity will be set to the constant 
rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Please refer 
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Property Description

Rectangle Tool Properties on page 556

Pressure: Allows you to apply more pressure and increases the size of the 
pencil. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
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Property Description

effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in 
your user preferences. The default pencil texture palette is added to 
every scene you create in Harmony. The palette is copied in your 
preferences, so it will be added to your new scenes in the exact state it 
is when you make it the default pencil texture palette.
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Icon Property Description

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture 
palette into your scene's palette list, and selects it as the current pencil 
texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 
the current pencil texture palette. The pencil texture's effect on your 
pencil line will be based on the image's transparency channel, and will 
follow your pencil lines on its horizontal axis. This option is also 
available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 
texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it 
in the Colour view.
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Reposition All Drawings Tool Properties
When you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view. 

Tool Options

Icon Option Description

Easy Drag
When enabled, you can drag the selection by clicking anywhere inside its 
bounding box. By default, you must click on the artwork in the selection to be 
able to drag it. 

Apply to 
Synced 
Drawing Layers

If the currently selected layer is synced with another layer, the tool will work on 
both the current layer and its synced layer. 

Operations

Icon Option Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 
Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 
Degrees CCW

Rotates the current selection 90 degrees counter-clockwise.

  Offset X and Y
Use the Offset X and Offset Y operation fields to enter specific values and 
precisely reposition the selected shape.
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Icon Option Description

 1. X: Type a value in this field to reposition your selection along the X-
axis.

 2. Y: Type a value in this field to reposition your selection along the Y-
axis.

 3. Up/Down arrows: Use the up and down arrows to modify the value in 
the X or Y value field.

  Width and Height

Use the Width and Height operation fields to enter specific values to resize 
the selected shape with precision.

 1. Width: Type a value in this field to resize the width of your selection.

 2. Height: Type a value in this field to resize the height of your selection.

 3. Up/Down arrows: Use the up and down arrows to modify the value in 
the Width or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio between the 
Width and Height values.

  Angle

The Angle operation lets you to enter specific values and accurately rotate the 
selected shape.

 1. Angle: Type a degree value in this field to rotate your selection.

 2. Up/Down arrows: Use the up and down arrows to modify the value in 
the Angle value field.
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Rigging Tool Properties
In the Tool Properties view, you can customize not only the behaviour of the tool but also the settings of the 
deformers that you will create.

Mode

Button Name Description

Bone Mode Sets the Rigging tool to create Bone deformations.

Game Bone Mode Sets the Rigging tool to create Game Bone deformations.

Options

Button Parameter Description

Show All Manipulators 
Lets you immediately see the resting position in red (Setup) and the 
animated position in green.
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Operations

Button Name Description

Reset Deform (Reset Current 
Keyframe)

Copies the resting position of the deformation skeleton to the 
current frame.
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Select Tool Properties
The Select tool lets you select strokes and apply basic transformations such as repositioning, rotating, scaling 
or skewing, using the different handles of the bounding box.

If you have text or pencil lines selected with the Select tool, their properties will display in the Tool Properties 
view, allowing you to make changes to your selection.

How to access the Select tool properties

 1. In the Tools toolbar, select either the Select  tool or the Select by Colour  tool. 

The tool's properties are displayed in the Tool Properties view.

NOTE 

Selecting the Select by Colour  tool from the Tools toolbar activates the Select tool, with the 
Select by Colour option enabled. Hence, this topic covers the tool properties for both the Select 
and Select by Colour tools. 

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 
elements:

 l Lasso: Allows you to select multiple elements by 
drawing an irregular closed shape around them with your 
mouse.

 l Marquee: Allows you to select multiple elements by 
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Icon Property Description

drawing a rectangle around them. This is faster, as you only 
need to drag your mouse from one corner of the rectangle to 
its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the 
other selection mode.

Easy Drag
When enabled, you can drag the selection by clicking anywhere 
inside its bounding box. By default, you must click on the artwork in 
the selection to be able to drag it. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to 
select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can 
also click on this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on to re-enable 
the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its 
control points, it will snap against the nearby points and 
contours of your artwork, allowing you to snap parts of your 
artwork together. 

 l Snap to Alignment Guides: While moving the selection or 
one of its control points, it will snap against nearby 
alignment guides.

 l Snap and Align: While moving the selection, the rectangular 
bounding box of the selection will align with the rectangular 
bounding boxes of other strokes and shapes in your artwork. 
If you move one of your selection's control points, it will also 
align with the bounding boxes of other strokes and shapes in 
your artwork.
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 l Snap to Grid: While moving the selection, the mouse cursor 
will snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

 l Allow Snapping on all Drawing Layers: If toggled on, the 
selections can be snapped to all bounding boxes, nearby 
points, and contours of artwork on any layer.

Scale Pencil Line 
Thickness

When enabled, the width of pencil lines will be adjusted when 
scaling them with the Select tool.

TIP 

You can quickly enable this mode by selecting the Scale 

Pencil Line Thickness  tool, in the Select  tool's 
properties dialog.

Select by Colour

When enabled, clicking on a coloured zone in your artwork will 
instantly select all the zones that are filled with the same colour.

Select by Colour can also be accessed from the Tools toolbar.
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Icon Property Description

NOTE 

Only the zones painted with the same colour swatch in your 
palette will be selected. If another zone is coloured with the 
exact same colour, but not the same colour swatch, it will not 
be selected.

Permanent Selection

Allows you maintain a selection while editing multiple drawings. 
Once this option is enabled, the selection zone made using the 
Select tool will remain as you navigate through drawings of the 
same layer and drawings from other drawing layers. 

Apply to Visible Drawing 
Layers

This option allows you to select which layers the tool should affect. 
It can be toggled on or off. When toggled on, it has two different 
modes. You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on 
the currently selected layers. If several layers are selected, 
the tool will work on all these layers simultaneously. 

 l On When this button is toggled on, the tool will work on all 
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the visible layers.

 l  Apply to Visible Drawing Layers: The tool will work on 
all the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently 
selected layer is synced with another layer, the tool will 
work on both the current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All Frames

This option allows you to determine which drawings in the current 
layer the tool should affect. It can be toggled on or off. When 
toggled on, it has two different modes. You can select a mode by 
clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on 
the drawing in the current frame.

 l Apply to All Frames: The tool will work on every 
exposed drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every 
drawing displayed in the Onion Skin. Onion Skin must be 
enabled for this option to work. 
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Icon Property Description

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they 
will also be affected when this option is enabled.

Operations

Icon Property Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

Smooth

Smooth out selected drawing strokes and remove extra points.
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Flatten 

Merges drawing objects and brush strokes into a single layer. If you 
draw new lines to fix a drawing or line with many brush strokes, it 
can be useful to flatten them all into a single shape. By default, lines 
are drawn one on top of each other. If you intend to repaint the lines 
or modify their shape, it will be easier if they are flattened. 

Create Colour Art from 
Line Art

Lets you use the outline you traced on one of the four embedded 
layers (line art, colour art, overlay, underlay) and create invisible 
strokes to paint your drawings on separate layers. This provides 
more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on 
any of the four embedded layers.

Distribute to Layers

The Distribute to Layers  option is used to separate the selected art 
strokes and send them to new drawing layers. In the Camera view, 
once you have drawn your artwork, you can select the strokes you 
want to distribute using the Select  tool and click on the Distribute to 
Layers  button; you can also select Drawing > Distribute to Layers. It 
will automatically take every stroke from the drawing selection made 
in the Camera view and separate them into a different layer for each. 
If an artwork is composed of several strokes, you must group them 
using Edit > Group > Group before using the Distribute to Layers 
option. This option cannot be done from the Drawing view.

Store Colour Gradient 

Use the Store Colour Gradient  operation to record the selected 
gradient’s position. This reuses the stored position of the gradient 
when drawing new brush lines or painting colour zones. Enable the 
Use Stored Colour Gradient  option in the Paint or Brush Tool 
Properties view to do this.

Pencil to Brush
Converts the selected centre line pencil strokes into contour strokes 
brush lines.
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Icon Property Description

Merge Pencil Lines

Because pencil lines are defined by their centre lines, two pencil lines 
that brush against each other may not actually make a closed shape, 
even if they appear closed. If you select several pencil lines that are 
close together, you can use this button to close the small gaps 
between these pencil lines and make them into a single pencil line.

 

NOTE 

Points must be close enough to be merged. If there is a large 
gap between the lines, they will not be merged.

Reverse Pencil Thickness

The Reverse Pencil Thickness  option inverts the thick and thin section 
on a selected pencil line. This option will take the thickest size on the 
line and apply it to the thinnest, and it will apply the thinnest to the 
thickest.
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Offset X Lets you enter a value to reposition the selection along the X-axis.

Offset Y Lets you enter a value to reposition the selection along the Y-axis.

Width Lets you enter a value to resize the width of the selection.

Height Lets you enter a value to resize the height of the selection.

Lock Locks or unlocks the ratio between the Width and Height values.

Angle
Lets you enter specific values to rotate the selection. A positive value 
rotates the selection counter clockwise and a negative value rotates 
the selection clockwise. 

Pencil Selection

If the selection contains pencil lines, the Pencil Selection section appears at the bottom of the Tool Properties 
view, allowing you to adjust the properties of those pencil lines.
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Icon Property Description

  Maximum Size
Adjusts the size of the parts of the pencil lines that are the thickest. 
Parts of the pencil lines that are between the minimum and 
maximum sizes will be adjusted proportionally.

  Minimum Size
Adjusts the size of the parts of the pencil lines that are the thinnest. 
Parts of the pencil lines that are between the minimum and 
maximum sizes will be adjusted proportionally.

  Pencil Line Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the 
first tip you drew. You can choose between Round or Flat 
style.

 l End: Lets you select the style of the end tip, which is the last 
tip you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the 
line curves abruptly. You could also define the Join style as 
the corner style. You can choose between Round, Mitre and 
Bevel style.

  Pencil Stencils

Allows you to apply one of the available line thickness stencils to 
the selected pencil lines. Stencils set the width of a pencil lines all 
along its length. You can use one of the preloaded presets, or create 
your own pencil stencils. 

 
Adding Texture to a 
Pencil Line

Pencil lines support texture. Once a pencil line is drawn, you can 
apply a preset texture or load your own. Textures are independent 
from pencil stencils.
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Text Selection

If your selection include text boxes created with the Text tool, a Text Selection section will appear at the 
bottom of the Tool Properties view, allowing you to adjust the formatting of the whole text box. 

TIP 

You can also adjust the formatting of parts of the text in the text box using the Text tool.

Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic

Makes the selected text italic.

Align Left Aligns the text in the selected text box to the left.
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Icon Property Description

Align Center

Aligns the text in the selected text box to the centre.

Align Right

Aligns the text in the selected text box to the right.

Justify

Makes the text in the selected text box take all the horizontal space by 
adjusting the spacing between each word. Text that use a single line 
and text in the last line of a paragraph is aligned to the left.

  Size

Allows you to set the size of the selected text.
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  Kerning

Allows you to increase or decrease the spacing between each 
character.

  Auto Kern
Sets the kerning automatically based on the font’s predefined 
standard. 

  Indent

Allows you to increase or decrease the indentation of the first line of 
text in each paragraph.

  Line Spacing

Increases or decreases the space between each line of text.
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Shift and Trace Tool Properties
The Shift and Trace tool allows you to temporarily move, rotate and scale drawings, then trace over them in 
other drawings, using Onion Skin to keep the outlines of the shifted drawings in your drawing space.  Contrary 
to Shift and Trace with the Drawing Desk, you can use the Shift and Trace tool in the Camera view. 

How to access the Shift and Trace Tool Properties

 1. Do one of the following:

 l In the Tools toolbar, double-click on the Hand  tool and select Shift and Trace  in the 
pop-up menu.

 l In the top menu, select Drawing > Drawing Tools > Shift and Trace.

The Shift and Trace tool properties appear in the Tool Properties view. 

Icon Tool Name Description

Shift and Trace Tool Options

Enable/Disable Shift 
and Trace

Enabled by default. When disabled, drawings that were repositioned, 
rotated or scaled with the Shift and Trace tool appear in their original 
position.

Display Cross Hair
Enabled by default. When disabled, cross hairs added with the Shift and 
Trace tool are invisible. 

Show manipulators 
for shift and trace

Enabled by default. This displays the manipulator allowing you to rotate 
and scale drawings for Shift and Trace, as well as to re-position their pivot 
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point. When hidden, you can only shift drawings laterally. 

Show the outline of 
the selected shift and 
trace drawing

When enabled, the contours of each brush stroke for the current drawing 
will appear highlighted in cyan.

Show/Hide Pegs

Enabled by default. When using the Shift and Trace tool, peg holes are 
displayed at the bottom of every drawing to help keep track of how offset 
drawings are from their original position and from each other. You can 
also click and drag on the left or right peg hole of a drawing to rotate it 
around the centre peg hole. When disabled, those peg holes are hidden.

Peg Position
Allows you to select on which edge of the drawings to display peg holes. 
By default, they are displayed at the bottom of the drawings.

Modes and Operations

Set Add Cross Hair 
Mode

When selected, clicking on the drawing will add a cross hair where you 
click. Cross hairs are marks that appear on the same location on every 
drawing in the current layer and which move when you offset a drawing 
with the Shift and Trace tool, and they appear in the Onion Skin rendition 
of neighbouring drawings as well. This allows you to keep track of how 
offset each drawing is. 

Remove All Cross 
Hair

Removes all the cross hairs created for shift and trace.

Reset Selected 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on the 
selected drawings, resetting them to their original position, angle and 
scale.

Reset All Drawings 
Shift Position

Undoes all transformations done with the Shift and Trace tool on all 
drawings, resetting them to their original position, angle and scale. 

Info

Selected Drawings The element name and drawing name of the currently selected drawing.

Position The offset of the current drawing from its original position on the x and y 
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Icon Tool Name Description

axes, in fields, when moved with the Shift and Trace tool.

Scale
The Shift and Trace scale factor of the currently selected drawing, when 
scaled with the Shift and Trace tool.

Rotation
The Shift and Trace rotation angle of the currently selected drawing, in 
degrees, counterclockwise, when rotated with the Shift and Trace tool.

Pivot
The offset, in fields, of the current drawing's pivot point from its centre, on 
the x and y axes. The pivot point is the point from which drawings are 
rotated and scaled.
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Smooth Editor Tool Properties
When you select the Smooth Editor tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Smoothing Style 

The Smoothing Style options allow you to smooth a 
portion of your drawing by tracing a smoothing stroke 
over the zone to optimize or by selecting an area of 
the drawing with the Marquee or Lasso.

Note that by default, the Smooth Editor tool colour is 
yellow, it was changed to orange for screen grab 
clarity.

Show Control Points 

The Show Control Points  option allows you to show 
or hide the Bezier points around lines. When the 
Bezier points are displayed, you can see the result of 
your smoothing and the number of points left on the 
curve. When it is turned off, only the original artwork 
is displayed.

 
Minimum Size and 
Maximum Size 

This is where you set the minimum and maximum 
sizes of your drawing tool which will produce the thick 
and thin effect on your stroke. This works with the 
pressure sensitivity of a pen tablet.

This options is available while using the Brush 
Smoothing  style.

 l Maximum and Minimum Size: Defines the 
maximum and minimum width of the stroke.
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 l Up/Down arrows: Use the up and down 
arrows to set the minimum and maximum size 
value.

Smoothness 

The Smoothness impacts the strength of the 
smoothing result. The higher the value, the more 
points are removed and the smoother the curve. The 
Smoothness range is from 0 to 100; the default value 
is 20.

  Colour 

You can modify the colour of the control points 
displayed on the artwork while working with the 
Smooth Editor tool by double-clicking on the colour 
swatch.
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Stamp Tool Properties
The Stamp tool allows you to create and use stamps, which can contain one or several drawings that can be 
stamped individually or in sequence onto your artwork.

How to access the Stamp tool properties

 1. In the Tools toolbar, select the Stamp  tool.

The tool's properties are displayed in the Tool Properties view.

Stamp Properties

The following options allow you, among other things, to preview your stamp, to change the size of your stamp 
as well as to flip it horizontally and vertically.

Property Description

Preview Area

The Preview area lets you see a preview of what will appear if you draw a stroke with the 
Stamp tool.
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Property Description

Stamp Properties 
Dialog

The arrow button right of the preview area opens the Stamp Properties dialog. 

While the Tool Properties view only gives you access to a few of the stamp properties and a 
list of stamp presets, the Stamp Properties dialog gives you access to all the available options 
for the way your stamp will be applied. For more information on the Stamp Properties dialog, 
see the Stamp Properties Dialog on page 593 section below.

Flip Horizontally 
/ Flip Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 
horizontally or vertically.

 

Maximum Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was used 
to create the stamp. This means that, at 100%, the drawing will be stamped into your artwork 
in its original size.

NOTE 

If the tool is used with a pressure sensitive tablet, the scale of the stamp can be made to 
be relative to the amount of pressure you put on your pen. To do this, you must reducing 
the Minimum Scale property of your stamp in the Stamp Properties dialog. If the 
Minimum Scale setting is left at its default value, which is 100%, the size of the stamp 
will not vary.

Stamp

When using a multi-drawing stamp, this is the number of the drawing in the series that will 
be stamped on the next time you use the Stamp tool. For example, if your stamp has 3 
drawings and this is set to 2, the next drawing that will be stamped on is the second drawing 
in the series. 

If your stamp's Cycle setting is set to Hold, then you have to use this slider to select which 
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Property Description

drawing to stamp with the Stamp tool. 

If your stamp's Reset Cycle for Each Stroke option is enabled, then you can use this slider to 
select which drawing to start each stroke with.

Otherwise, when you draw a stroke with the Stamp tool, the Stamp slider will automatically 
update to the next drawing in the sequence.

TIP 

You can also cycle through the drawings in your stamp by using the Left Arrow and Right 
Arrow keys. 

NOTE 

The Cycle and Reset Cycle for Each Strokee options are available in the Stamp 
Properties dialog. 

Stamp Presets

These options allow you to select, create and manage stamp presets. 

Contrary to the Brush and Pencil tools, creating a Stamp preset is required to use the Stamp tool, as this 
preset will contain the drawings to stamp onto your artwork. A Stamp preset is created by selecting one or 
several layers, then adding a preset to the Stamp Presets list. If several layers are selected, the Stamp will 
contain a series of drawings, which it will stamp onto your artwork in a sequence as you draw strokes with the 
Stamp tool. 

Icon Property Description

  Presets list
The list of Stamp presets. Click on one of the presets to select it and 
use it in your drawing. 

New Brush Preset

Creates a new Stamp preset based on the selected artwork. The 
artwork can either be a selection made with the Select  tool, or by 
selecting a layer. 

If several layers are selected, this will create a multi-drawing Stamp. 
As you draw a stroke with the Stamp tool using a multi-drawing 
stamp, each drawing in the stamp will be applied onto your artwork, 
one after the other. 
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Delete Brush Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains all of the previous options, along with all 
of the following options:

 l New Brush Preset: Creates a new stamp based on the 
selected artwork.

 l Rename Preset:Allows you to rename the currently selected 
preset.

 l Import Brushes:Allows you to import brush presets exported 
from Harmony.

 l Export Brushes:Allows you to export your brush presets into 
an .xml file. 

 l Small Thumbnail: Displays presets in a grid of small 
thumbnails with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork

Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 
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Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool 
will snap against nearby alignment guides.

Stamp Properties Dialog

The Stamp Properties dialog allows you to set more specific settings for your stamp, such as pressure 
sensitivity, spacing, angle, randomness and, for multi-drawing stamps, how to cycle through each drawing in 
the stamp. To open the Stamp Properties dialog, click on the arrow button right of the stroke display area.
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Property Description

Maximum Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was 
used to create the stamp. This means that, at 100%, the drawing will be stamped into your 
artwork in its original size.

Minimum Scale

The minimum scaling factor to apply to the stamp before stamping it onto your drawing. 
When using the Stamp tool with a pressure-sensitive pen tablet, the size of the stamps 
applied onto your artwork will vary between its Minimum Scale and Maximum Scale 
properties, relative to the amount of pressure you apply to the pen.

This setting is relative to the Maximum Scale property. This means that if the Maximum 
Scale is set to 50% and the Minimum Scale is set to 50%, the actual scaling factor applied to 
the stamp will vary between 25% and 50%. 

This setting is also used with the Random Size setting. 
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Property Description

Flip Horizontally / 
Flip Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 
horizontally or vertically.

Roundness & 
Angle

The Roundness and Angle parameters allow you to change the shape and orientation of the 
stamp.

 l Roundness: The vertical scaling to apply to the stamp. Reducing this setting 
squashes the stamp vertically, allowing you to turn round or square stamps into flat 
stamps. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the stamp is rotated, the squashing will 
still be done relative to the stamp's original orientation.

Spacing

Defines the amount of space between each stamp that is applied onto the artwork. The 
larger the value, the greater the space between each stamp. 
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Property Description

Random Size

The percentage of randomness to apply to the size of the stamp. This makes the size of the 
stamp randomly vary between its Maximum Scale and Minimum Scale settings each time it 
is applied to your artwork. 

The greater the value of the Random Size property, the closer to its Minimum Scale the size 
of each stamp can get. For example, if the Random Size setting is set to 50% and the 
Minimum Scale is set to 50%, the size of the stamp will randomly vary between 75% and 
100% of its Maximum Scale. 

Random Angle

The maximum value of randomness to apply to the angle of the stamp. This makes the 
angle of the stamp randomly vary within the range of degrees in this setting, in either 
direction, each time it is applied to your artwork. For example, if the stamp's Angle is set to 
0°, and the Random Angle is set to 180°, each instance of the stamp will be at a random 
angle varying between -90° and 90°.

Random Spacing

The maximum amount of randomness to apply to the spacing of the stamp. Increasing this 
setting makes the distance between each instance of the stamp vary randomly as you draw 
a stroke. At 100%, this makes the distance between each stroke vary between 0% and 
200% of its Spacing property.

Cycle

For multi-drawing stamps, this decides the logic with which to cycle through the sequence 
of drawings in the stamp as you draw a stroke.

 l Forward: Starts by applying the first drawing in the sequence, then the next one, 
and so on until it reaches the last drawing in the sequence, then cycles back to the 
first one.
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Property Description

 l Reverse: Starts by applying the last drawing in the sequence, then the previous one, 
and so on until it reaches the first drawing in the sequence, then cycles back to the 
last one.

 l Forward->Reverse: Starts by cycling forward through the sequence until it reaches 
the last drawing, then cycles backward to the first drawing, and so on.

 l Reverse->Forward: Starts by cycling backward through the sequence until it 
reaches the first drawing, then cycles back to the last drawing, and so on.

 l Random: Applies a random drawing in the sequence each time the stamp is applied. 

 l Hold: Applies a single one of the drawings in the sequence over and over again. 

TIP 

When this option is set to Hold, you can select which one of the drawings is stamped on 
by changing the Stamp setting in the Tool Properties view.

Reset Cycle for 
Each Stroke

For multi-drawing stamps. This makes it so each stroke you draw with the stamp too always 
starts with the first drawing in the cycle, which is decided by the Stamp option in the Tool 
Properties view. 

When disabled, the Stamp tool keeps track of which drawing it was going to stamp next 
when you finish drawing a stroke by storing the number of that drawing in the Stamp 
setting. When this option is enabled, it simply stops updating the Stamp setting. Hence, 
your strokes always start at the drawing selected with that setting. Likewise, you can 
manually decide which drawing to start your strokes with by adjusting the Stamp setting.
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Stroke Tool Properties
When you select the Stroke tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Draw Stroke as 
Straight Lines 

Enable the Draw Stroke as Straight Lines  option if you want the new 
strokes you draw to be a perfect straight line. Disable the option if you 
want the stroke to follow the mouse gesture.

Connect Line Ends 
Enable the Connect Line Ends  option if you want the start or end point of 
your new stroke to connect to your existing strokes to make sure no gaps 
are left in your drawing.

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

Trim Extra Lines

When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 

Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make 
the point where the beginning and end of the stroke meet into a smooth 
curve rather than a hard corner. 
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Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as 
a separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and Colour 
Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also 
be affected when this option is enabled.

Apply to Synced 
Drawing Layers

If the currently selected layer is synced with another layer, the tool will 
work on both the current layer and its synced layer. 

  Smoothness

You can modify the central line smoothness  of your line using this option. 
This parameter smooths the initial movement of your line. Increasing the 
value will result in a smoother line with fewer control points. Use the left 
and right arrows to increment the value by one full unit. Use the Up - 
Down slider to quickly increment the value.
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Text Tool Properties
The Text tool lets you add text fields to your project, in which you can type text, then adjust its formatting 
using various fonts and text attributes. 

With the Text tool selected, you can select text within text boxes you created and change the formatting of 
the selection. You can also select and manipulate text boxes using the Select tool, and change the formatting 
of the entire text box in the Select tool properties. 

How to access the Text tool properties

 l In the Tools toolbar, select the Text  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic Makes the selected text italic.
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Icon Property Description

Align Left

Aligns the text in the selected text box to the left.

Align Center

Aligns the text in the selected text box to the centre.

Align Right

Aligns the text in the selected text box to the right.

Justify

Makes the text in the selected text box take all the horizontal space by 
adjusting the spacing between each word. Text that use a single line 
and text in the last line of a paragraph is aligned to the left.
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Icon Property Description

  Size

Allows you to set the size of the selected text.

  Kerning

Allows you to increase or decrease the spacing between each 
character.

  Auto Kern
Sets the kerning automatically based on the font’s predefined 
standard. 

  Indent

Allows you to increase or decrease the indentation of the first line of 
text in each paragraph.

  Line Spacing

Increases or decreases the space between each line of text.
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Transform Tool Properties 
When selecting the Transform tool, several options are available in the Tool Properties view.

Icon Tool Name Description

Lasso

Sets the selection mode to Lasso, which allows you to select 
multiple items by drawing a lasso around them.

TIP 

When this option is enabled, you can press and hold the 
Alt key to temporarily use Marquee mode.

Marquee

Sets the selection mode to Marquee, which allows you to select 
multiple items by drawing a rectangle around them. 

TIP 

When this option is enabled, you can press and hold the 
Alt key to temporarily use Lasso mode.

Easy Drag
When enabled, you can drag the selection by clicking anywhere 
inside its bounding box. By default, you must click on the artwork 
in the selection to be able to drag it. 

Snapping

Allows you to enable or disable snapping for this tool and all 
other animation and drawing tools that support snapping, as 
well as to select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-
up menu in which you can toggle different snapping modes. You 
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can also click on this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on to re-
enable the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Alignment Guides: While moving the selection 
or one of its control points, it will snap against nearby 
alignment guides.

 l Snap and Align: While moving the selection, the 
rectangular bounding box of the selection will align with 
the rectangular bounding boxes of other elements in your 
scene. If you move one of your selection's control points, 
it will also align with the bounding boxes of other 
elements.

 l Snap to Grid: While moving the selection, the mouse 
cursor will snap against the intersecting points of the 
grid. 

TIP 

To display the grid, select View > Grid > Show 
Grid from the top menu or press Ctrl + '.

Peg Selection Mode

In the Camera view, the Peg Selection Mode limits the selection 
to peg layers instead of drawing layers. This mode is useful 
when you have created a character rig using peg layers for each 
drawing.  That way, you do not accidentally select the drawing 
layer when you want to animate on the peg.

When disabled, the Transform  tool selects the drawing layers.

Bone Selection Mode
When enabled, all bones that exist in a 3D model will be 
displayed. The displayed bones will appear in blue. 
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NOTE 

If the 3D model does not contain any bones, nothing will 
appear when this mode is enabled. 

Mixed Manipulation Mode

Allows the selection and manipulation of different types of 
interfaces, such as pegs and curves, together in the same 
operation.

When enabled, certain deformation controls and extra controls 
will be able to be selected and manipulated with the Transform 
Tool. This will extend the bounding box used by the tool to 
encompass the selected controls. These controls can then be 
transformed at the same time with other selected pegs, 
drawings and compatible controls.

Hide Manipulator Controls
The Hide Manipulator Controls  button lets you hide the 
bounding box and manipulator controls from the Camera view 
when an element is selected.

Flip Horizontal

Flips the current selection horizontally. 

You can also select Animation > Flip > Flip Horizontal from the 
top menu or press 4 or 5.

Flip Vertical

Flips the current selection vertically.  

You can also select Animation > Flip > Flip Vertical from the top 
menu or press 4 or 5.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

  Offset X ad Y

Use the Offset X and Offset Y operation fields to enter specific 
values and precisely reposition the selected shape.

 1. X: Type a value in this field to reposition your selection 
along the X-axis.

 2. Y: Type a value in this field to reposition your selection 
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along the Y-axis.

 3. Up/Down arrows: Use the up and down arrows to 
modify the value in the X or Y value field.

  Width and Height

Use the Width and Height operation fields to enter specific 
values to resize the selected shape with precision.

 1. Width: Type a value in this field to resize the width of 
your selection.

 2. Height: Type a value in this field to resize the height of 
your selection.

 3. Up/Down arrows: Use the up and down arrows to 
modify the value in the Width or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio 
between the Width and Height values.

  Angle

The Angle operation lets you to enter specific values and 
accurately rotate the selected shape.

 1. Angle: Type a degree value in this field to rotate your 
selection.

 2. Up/Down arrows: Use the up and down arrows to 
modify the value in the Angle value field.
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Zoom Tool Properties
The Zoom tool lets you zoom in and out of the Camera, Drawing, Side and Top views. You can also use it to 
reset the zoom level.

How to access the Zoom tool properties

 1. In the Tools toolbar, select the Zoom  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Parameter Description

Zoom In Mode Use the mouse cursor to zoom in to the Camera or Drawing view.

Zoom Out Mode Use the mouse cursor to zoom out of the Camera or Drawing view.

Operations

Icon Parameter Description

Perform Zoom In
Zoom in the Camera or Drawing view. 

The keyboard shortcut is 2.

Perform Zoom 
Out

Zoom out the Camera or Drawing view. 

The keyboard shortcut is 1.

Reset Zoom Restores the current zoom level to 100%.

Reset View Restores the original display by resetting any pan, rotation or zoom actions.

607

Harmony 24 Advanced Reference Guide                          



Chapter 5: Toolbars

Chapter 5: Toolbars
Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a 
toolbar which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it 
with the tools you use most often and hide the ones you don't.

Workspace Toolbars 610

Advanced Animation Toolbar 611

Art Layer Toolbar 612

Deformation Toolbar 614

Display Toolbar 617

Easy Flipping Toolbar 618

Edit Toolbar 619

File Toolbar 620

Flip Toolbar 622

Game Toolbar 623

Mark Drawing Toolbar 624

Mini Playback Toolbar 625

Onion Skin Toolbar 626

Pen Settings Toolbar 628

Playback Toolbar 631

Scripting Toolbar 634

Shift and Trace Toolbar 635

Tool Presets Toolbar 637

Tools Toolbar 638

Workspace Toolbar 644

View Toolbars 645

Camera View Toolbar 646

Drawing View Toolbar 648

Library View Toolbar 649

Reference View Toolbar 650

Port Names Toolbar 651
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Script Editor Toolbar 652

Timeline View Toolbar 656

Xsheet View Toolbar 661
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Workspace Toolbars
Harmony has a series of toolbars that are added by default at the top of the interface. These toolbars can be 
moved on the sides of the interface as well as within specific views. 

All top toolbars can be added by selecting  Windows > Toolbars in the top menu.

Advanced Animation Toolbar 611

Art Layer Toolbar 612

Deformation Toolbar 614

Display Toolbar 617

Easy Flipping Toolbar 618

Edit Toolbar 619

File Toolbar 620

Flip Toolbar 622

Game Toolbar 623

Mark Drawing Toolbar 624

Mini Playback Toolbar 625

Onion Skin Toolbar 626

Pen Settings Toolbar 628

Playback Toolbar 631

Scripting Toolbar 634

Shift and Trace Toolbar 635

Tool Presets Toolbar 637

Tools Toolbar 638

Workspace Toolbar 644
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Advanced Animation Toolbar

The Advanced Animation toolbar contains tools to position and animate layers. The Scale, Translate and 
Rotate tools can be used to reposition the permanent pivot position of a layer. Unlike the Transform tool, each 
tool in the Advanced Animation toolbar performs a single operation, either rotate, scale, translate or scale in 
relation to the camera distance.

How to access the Advance Animation toolbar

 1. Select Windows > Toolbars > Advanced Animation.

Icon Tool Name Description

Translate
Lets you move the selected element along the X and Y 
axes.

Rotate Turns a selected element around its pivot point. 

Scale

Increases or decreases the size of a selected element. 
You can scale an object up to make it larger or down 
to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the 
Camera view as you move them towards or away 
from the camera.

Spline Offset

Lets you reposition the visual trajectory without 
offsetting or modifying your animation. By default, the 
trajectory is located at 0,0,0 fields. If your elements 
were drawn in a different location than the centre of 
the drawing area, it will look like the trajectory is not 
aligned with your drawing. Also, if you have several 
elements attached to one trajectory, you might want 
your trajectory to be at a different location to 
represent the group's motion better.
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Art Layer Toolbar

The Art Layer toolbar lets you access the art layers. By default, only the Line Art and Colour Art are displayed. 
A drawing is composed of two layers, a line layer and a colour layer. The colour layer is always placed under 
the line layer. These layers are accessible in the Drawing or Camera view (using drawing tools). When you 
view the final drawing, you will see the final composition of the lines and colours, not two separate layers.

You can draw and paint in all layers. If you prefer to work in a single layer, everything can be done in the Line 
Art layer.

You can change your preferences to enable the advanced use of layers and have access to four layers instead 
of two:

 l Overlay

 l Line Art

 l Colour Art

 l Underlay

How to access the Art Layer toolbar

 1. Select Windows > Toolbars > Art Layer.

How to enable the Support Overlay and Underlay Arts option

 1. Select Edit > Preferences ( Windows/Linux ) or Harmony Advanced > Preferences ( macOS ).

 2. In the Preferences dialog box, select the Advanced tab.

 3. In the Advanced Options section, select the Support Overlay and Underlay Arts option.

 4. Click OK.

Icon Tool Name Description

Preview Line Art and 
Colour Art

Displays all Art layers.

Overlay Art Makes the Overlay Art layer current.
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Line Art Makes the Line Art layer current.

Colour Art Makes the Colour Art layer current.

Underlay Art Makes the Underlay Art layer current.

613

Harmony 24 Advanced Reference Guide                          



Chapter 5: Toolbars

Deformation Toolbar

T-RIG-007-009

The Deformation toolbar contains the various tools and options used to create a deformation rig. This toolbar 
is displayed in the default interface.

By default, the Deformation toolbar only contains the essential options. If you right-click on the toolbar and 
select Customize, you can add additional buttons.

NOTE 

The Customize option is only available if a toolbar is right-clicked in the space above the Camera 
view. To move the toolbar to the space above the Camera view, either click and drag the toolbar 
directly to the space above, or right-click in the space above and select the toolbar you wish to 
add. 

Default Buttons

Icon Tool Name Description

Rigging Tool

The Rigging tool is used to create a Bone deformation 
chain. You also use it to set up the resting position.

To learn more about the Rigging tool's properties, see 
Rigging Tool Properties on page 569.

Show Selected 
Deformation Chain and 
Hide All Others

Displays the deformation controls for the selected 
element and all of its children in the Camera view, and 
hides the deformation controls for any other element 
in your scene.

Show Selected 
Deformers

Displays the deformation controls for the selected 
element and all of its children in the Camera view. If 
deformation controls for other elements are currently 
visible, they will remain visible as well.

Show Deformation Mesh
Overlay the deformation mesh as a wireframe over 
the drawings.
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Show Manipulator

When several points from a curve or envelope 
deformation chain are selected, this displays a 
manipulator bounding box around them. Using this 
manipulator, you can move, rotate and scale the 
selected points together. 

Reset Current Keyframe

The Reset Current Keyframe copies the resting 
position, the original setup of your skeleton before 
undergoing any deformation, to your current frame. 
Once you have created a deformation chain, you can 
use the Rigging tool to adjust the position and 
appearance of the rig to fit the element. When the 
skeleton is in place, you can use the Reset Current 
Keyframe button to reset the current frame position to 
the resting position.

Enable Deformations

The Enable Deformations button allows you to 
display your drawings in their original state or with 
deformations while creating additional drawings. 
Depending on the artwork you need to create, you 
might need to refer to the other images either 
deformed or in their original position.

NOTE 

Disabling deformations is only a display 
mode. Although drawings will not appear 
deformed in the Camera view, even in Render 
View mode, they will still be deformed in the 
rendered images.
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Optional Buttons

Icon Tool Name Description

Remove All Keyframes
The Remove All Keyframes option removes all 
keyframes on the selected deformation chain.

Show All Controls

The Show All Controls button lets you visualize the 
resting position in red (Setup mode) and the active 
position (Animation) in green at the same time
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Display Toolbar 

The Display toolbar lets you select the different Display nodes available in the node system. 

Harmony Advanced doesn't allow you to add Display nodes. The display selection feature is only available for 
the possible scenario that you need to use a specific Display node created by a Harmony Premium user.

When your scene does not have a Display node, it is automatically set to Display All which uses the Timeline 
view ordering and shows floating nodes from the Node view. You can also set your scene to use Display All 
using the Display toolbar.

NOTE 

If you try to add a peg or other transformation layer in the Timeline view without having a layer 
selected, an error message will display. Make sure to change to Display All. The peg layer will be 
floating in the Node view and will not be visible in the Timeline view.  The Timeline view shows 
only layers that are connected to the Composite node.

If you switch to Display All, you run the risk of not realizing when you have floating nodes that are 
not connected to your composite.  For this reason, it is not recommended to work in Display All 
mode.

How to access the Display toolbar

 1. Select Windows > Toolbars > Display.
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Easy Flipping Toolbar

T-LAY-003-007

The Easy Flipping toolbar lets you rapidly flip through drawings in the Drawing view as is done with paper 
drawings. In order for the features in this toolbar to work, you must be in the Drawing view.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Previous Drawing Displays the previous drawing of your animation.

Next Drawing Displays the next drawing of your animation.

  Slider
Lets you flip forwards or backwards through your 
drawings by moving the slider.

  Loop
Displays drawings in the first frame after you reach 
the last frame of your animation.

Easy Flip
Automatically flips through the drawings based on 
the FPS.

  Preroll

Sets  the number of drawings to be flipped through 
before the starting drawing. The starting drawing is 
determined by the position of the red playhead in the 
Timeline view.

  FPS
Sets the speed of playback in the units of frames per 
second.
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Edit Toolbar

The Edit toolbar contains common operations such as Undo, Redo, Cut, Copy and Paste. These commands can 
also be found in the Edit top menu.

How to access the Edit toolbar

 1. Select Windows > Toolbars > Edit.

Icon Tool Name Description

Undo
Removes the last change made to your project. 
Harmony supports multiple undo, so you can undo 
changes you made in the order you made them.

Redo
Redoes an operation you have undone. This command 
is active only after you use the Undo command.

Cut
Removes selected objects. You can then paste the 
object or its properties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location 
you select in a view.

Create Symbol
Creates a symbol from selected drawing elements in 
the Drawing or Camera view or a layer or cells in the 
Timeline view.
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File Toolbar

The File toolbar contains buttons for common file operations such as New, Save and Open. These commands 
can also be found in the File top menu.

NOTE 

The  New, and  Save As buttons are only available in Harmony Stand Alone. With Harmony 
Server,  Control Center must be used to create scenes.

How to access the File toolbar

 1. Select Windows > Toolbars > File.

Icon Tool Name Description

New (Harmony Stand 
Alone)

Creates a new scene while closing any scene already open. The New 
Scene dialog box opens, asking for directory, name, and resolution 
information.

Open
Displays the Open Scene dialog box where you can browse for a 
scene file.  You can open a new scene from the current one and the 
previous scene will close.

Save
Saves all changes made to the opened scene, drawings, palettes, and 
palette lists.

Save As

Saves the current file with a different name and at a different location.

Saves the current state of a scene as another scene. The Save As 
window prompts you for a new name and a different location for this 
scene before saving it. This will create a complete scene directory for 
the new scene.
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Icon Tool Name Description

NOTE 

The scene name cannot exceed 23 characters.

Import Images Imports bitmap images which you can choose to vectorize.
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Flip Toolbar

The Flip toolbar lets you determine the type of drawing to include in your flipping selection. You can flip 
through the key, breakdown or in-between drawings individually, or view a combination.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Show Key Drawings
Displays key drawings when flipping through 
drawings.

Show Breakdown 
Drawings

Displays breakdown drawings when flipping through 
drawings.

Show In-between 
Drawings

Displays in-between drawings when flipping through 
drawings.

Show Retake Key 
Drawings

Displays retake key drawings when flipping through 
drawings.

Show Retake Breakdown 
Drawings

Displays breakdown retake drawings when flipping 
through drawings.

Show Retake In-between 
Drawings

Displays retake in-between drawings when flipping 
through drawings.
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Game Toolbar

The Game toolbar contains tools for setting anchors and props, as well as exporting to sprite sheets and Easel 
JS.

How to access the Game toolbar

 1. Select Windows > Toolbars > Game.

Icon Tool Name Description

Toggle Anchor Adds the Anchor parameter to the selected layer.

Toggle Prop Adds the Prop parameter to the selected layer.

Export to Sprite Sheets
Opens the Export to Sprite Sheets window where you 
can export your animation as sprite sheets .

Export to Easel JS
Opens the Export to Easel JS window where you can 
export your animation as Easel JS.

623

Harmony 24 Advanced Reference Guide                          



Chapter 5: Toolbars

Mark Drawing Toolbar

The Mark Drawing toolbar lets you identify drawings such as key, breakdown and in-between. The drawing 
Identification feature can help the animator stay well organized and save time when identifying key, 
breakdown or in-between drawings in the Xsheet and Timeline views. 

How to access the Mark Drawing toolbar

 1. Select Windows > Toolbars > Mark Drawings.

Icon Tool Name Description

Mark as Key Drawing Identifies the selected drawing as a key drawing.

Mark as Breakdown 
Drawing 

Identifies the selected drawing as a breakdown 
drawing.

Mark as In-between 
Drawing 

Identifies the selected drawing as an in-between 
drawing.

Mark as Retake Key 
Drawing 

Identifies the selected drawing as a key retake 
drawing.

Mark as Retake 
Breakdown Drawing 

Identifies the selected drawing as a breakdown retake 
drawing.

Mark as Retake In-
between Drawing 

Identifies the selected drawing as a in-between retake 
drawing.
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Mini Playback Toolbar

The Mini Playback toolbar allows you to quickly preview a short span of animation starting a few frames 
before the current frame and ending a few frames after the current frame, at a customizable frame rate.

How to add the Mini Playback toolbar to your workspace

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Mini Playback.

 l Right-click on any existing toolbar and select Mini Playback. 

Icon Tool Name Description

Mini Playback 
Dialog

Open the Mini Playback dialog. This dialog allows you to set the amount of 
frames before and after the current frame to playback when using Mini Playback, 
to set the speed of Mini Playback and to start Mini Playback.

Mini Playback
Begins Mini Playback using the last settings entered in the Mini Playback dialog. 
By default, Mini Playback will play 5 frames before and after the current frame, 
at the scene's frame rate. 
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Onion Skin Toolbar

The Onion Skin toolbar contains a few options that can be used with Onion Skin. Specifically, you can use it to 
quickly toggle the Enable Onion Skin for other elements option, as well as to only display drawings with 
specific markers in the Onion Skin.

How to access the Onion Skin toolbar

 1. Select Windows > Toolbars > Onion Skin.

Icon Tool Name Description

Enable Onion Skin in 
Other Elements

In the Drawing View, when the Light Table is enabled, making other 
layers visible alongside the current layer, this will make the Onion Skin 
for other visible layers appear alongside the Onion Skin for the current 
layer. Drawings for elements above the current layer will appear in 
blue, and drawings for elements below will appear in yellow. 

NOTE 

The drawings from other elements that get displayed in the 
Onion Skin are the drawings that are exposed at the same time 
as the drawings displayed in the current layer's Onion Skin. 

Show Key Drawings Only displays drawings marked as key drawings in the Onion Skin.

Show Breakdown 
Drawings

Only displays drawings marked as breakdowns in the Onion Skin.

Show In-between 
Drawings

Only displays drawings with no marker in the Onion Skin. Drawings 
with no marker are considered in-betweens.

Show Retake Key 
Drawings

Only displays drawings marked as retake key drawings in the Onion 
Skin.

626



Icon Tool Name Description

Show Retake Breakdown 
Drawings

Only displays drawings marked as retake breakdowns in the Onion 
Skin.

Show Retake In-between 
Drawings

Only displays drawings marked as retake in-betweens in the Onion 
Skin.
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Pen Settings Toolbar

The Pen Settings toolbar provides options for enabling and configuring the Pen Stabilizer, which can help you 
draw smooth lines with precision and minutia. It also allows you to access the Pen Pressure Feel dialog, which 
allows you to configure how the pressure you apply to your tablet pen is processed by Harmony to affect the 
size of your drawing strokes. 

NOTE 

For information on how to use the Pen Settings toolbar, refer to the User Guide.

Icon Parameter Description

Pen Stabilizer 
Mode

Allows you to select a method for Harmony to stabilize your drawing strokes. 

Stabilization is a process by which Harmony uses the general direction of your 
drawing strokes to create smooth, stable curves and avoid jittering and sharp 
corners. 

Harmony accomplishes this by his by letting you draw a stroke of a certain 
length without generating artwork right away. After your stroke has reached 
that length, Harmony starts generating an drawing stroke that keeps trailing 
behind your mouse cursor or tablet pen as you draw. Harmony uses the buffer 
between your mouse cursor or pen tablet and the actual drawing stroke to 
generate smooth curves and ignore jittering and small mistakes. 

The way Harmony does this depends on the stabilization method you choose:

 l Stabilizer Off: No stabilization is performed. When you draw a stroke, 
artwork for it is generated immediately. 

 l Average: Harmony calculates the average direction of all of your mouse 
or pen gestures between the end of the actual drawing stroke and the 
current position of your mouse cursor or pen tip, and extends the stroke 
in this average direction, effectively evening out jitter and rounding 
sharp turns. 

 l Pulled String: When you start drawing a stroke, Harmony positions the 
drawing tool where your stroke starts. As you move the mouse or tablet 
pen, the drawing tool remains in that position, but a "string" appears, 
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Icon Parameter Description

linking your drawing tool to your mouse cursor or pen tip.

This string has a certain maximum length. Once that length is reached, 
the string pulls the drawing tool in the direction of your mouse cursor or 
tablet pen.

NOTE 

The distance between your mouse cursor or tablet pen and the 
stroke can be adjusted. For the purpose of demonstration, these 
images were done using the largest supported distance.

Pen Stabilizer 
Distance

This parameter determines how far your drawing strokes trail behind your 
mouse cursor or tablet pen as you draw. 

In the case of the Average technique Harmony lets you draw an invisible stroke 
of a certain length before it starts generating the artwork based on the average 
direction of that invisible stroke. This parameter determines the invisible 
stroke's length.

In the case of the Pulling String, Harmony binds your drawing tool to your 
mouse cursor or tablet pen with a virtual string of a given length. This 
parameter sets the length of that string.

Pen Stabilizer 
Settings

Allows you to enable or disable the following options:

 l Catch Up: When using stabilization, your drawing strokes trail behind 
your mouse cursor or tablet pen. With this option enabled, when you 
stop moving your pen and just leave it pressed against your tablet, the 
brush stroke will progressively catch up to the position of your pen.

NOTES 
 l This option only works if you are drawing with a pen tablet.

 l This option only works with the Average stabilization 
method.

 l Show String: When using the Pulled String method, the virtual string 
binding your drawing tool to your mouse cursor or tablet pen will be 
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Icon Parameter Description

displayed as you draw, allowing you to visualize how the brush stroke 
trails behind your mouse cursor or tablet pen.

 l Eraser: If enabled, strokes with the  Eraser tool will also be 
stabilized. By default, the stabilizer works with the  Brush,   Pencil 
and  Stroke tools. 

Pen Pressure 
Feel

Opens the Pen Pressure Feel dialog, which allows you to configure how 
Harmony processes the pressure you put on your tablet pen before applying it 
to the thickness of your drawing strokes—see Pen Pressure Feel Dialog Box.
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Playback Toolbar

The Playback toolbar allows you to play your animation as well as to set some playback options such as 
looping, audio playback, playback range and playback speed. 

Name Button Description

Play

Plays the scene in the Camera or Drawing 
view. 

You can also select Play > Play or Stop from 
the top menu.

Render and Play

Renders your scene's frames, then opens the 
rendered frames in Play for playback. 

This allows you to preview your scene's 
animation in real time, with the effects 
rendered and with no risk of slowdown. 

You can click and hold this button to switch its 
mode to Record and Play or Test SWF Movie.

Record and Play

Exports your scene as it appears in the Camera 
view into a movie file, then opens it in your 
workstation's default video player. 

This allows you to preview your animation 
without any risk of slowdown, but it does not 
preview the effects in your scene. However, it 
is much faster than Render and Play. 

Test SWF Movie
Quickly exports your scene as a Flash Movie 
(.swf), then opens it in your workstation's 
default web browser.
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Enable Loop

If pressed, your scene will repeat indefinitely 
when playing. Otherwise, it will stop when the 
end is reached.

You can also select Play > Loop from the top 
menu.

Enable Sound

When pressed, your scene's soundtrack will 
play during playback.

You can also select Play > Enable Sound from 
the top menu.

Enable Sound Scrubbing

When pressed, you will hear a sample of your 
scene's soundtrack at the current frame when 
moving your scene's playhead in the Timeline 
view. 

This allows you to easily situate where the 
action is relative to the sound track. 

You can also select Play > Enable Sound 
Scrubbing.

Jog Frames

Allows you to quickly play your scene forward 
or backward to preview your animation. 

Moving the handle towards the right will play 
your scene forward, while moving it towards 
the left will play your scene backward.

The closer to the edge you move the handle, 
the faster the playback will be, allowing you to 
dose the speed at which your scene is played. 
When the handle is at the edge, your scene 
will play at its actual framerate.

Once the head is released, it returns to the 
middle and playback stops.

Frame  
Lets you manually enter the current frame 
number, setting the playhead's position.

Start  
Let's you manually enter the number of the 
first frame to play during playback. 
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TIP 

You can also click on Start (just left 
of the input field) to quickly set the 
Start frame to the current frame.

Stop  

Let's you manually enter the number of the 
first frame to play during playback. 

TIP 

You can also click on Stop (just left of 
the input field) to quickly set the Stop 
frame to the current frame.

FPS (Frames per second)  

Lets you set the amount of frames that should 
be played during every second of playback, 
which is how the playback speed is 
determined.

NOTE 

This does not change the frames per 
second setting in your scene's 
resolution settings.
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Scripting Toolbar

The scripting toolbar allows you to create buttons that run functions in your scripts. You can add one button 
for each function you want to be able to run, and clicking on the button will instantly run the script function 
your linked it to. 

How to add the Scripting toolbar to your workspace

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Scripting.

 l Right-click on any existing toolbar and select Scripting.

Icon Tool Name Description

Manage 
Scripts

Opens the Scripts Manager dialog box where you can add scripts and functions 
to your Scripting toolbar.

Stop Script Stops the execution of a script launched from the Scripting toolbar.
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Shift and Trace Toolbar

The Shift and Trace toolbar allows you to temporarily move, rotate and scale drawings, then trace over them 
in other drawings using Onion Skin. Contrary to Shift and Trace with the Drawing Desk, you can use the Shift 
and Trace toolbar in the Camera view. 

How to access the Shift and Trace toolbar

 1. Do one of the following:

 l In the top menu, select Windows > Toolbar > Shift and Trace.

 l Right-click on any existing toolbar and select Shift and Trace.

NOTE 

You can also select the Shift and Trace  tool from the Tools toolbar, under the pop-up menu of 
the Hand  tool. When the Shift and Trace tool is active, all the commands in the Shift and Trace 
toolbar are available in the Tool Properties view.

Icon Tool Name Description

Shift and Trace Tool

Enables the Shift and Trace tool, with which you can temporarily offset, 
rotate and scale drawings. 

The transformations done on drawings with the Shift and Trace tool are 
only meant to allow you to trace these drawings, and can be undone at 
any time to reset the drawings back to their intended position.

Selecting the Shift and Trace tool also enables Shift and Trace and Onion 
Skin.

Enable/Disable Shift 
and Trace

Enabled by default. When disabled, drawings that were repositioned, 
rotated or scaled with the Shift and Trace tool appear in their original 
position.

Set Add Cross Hair 
Mode

When selected, clicking on the drawing will add a cross hair where you 
click. Cross hairs are marks that appear on the same location on every 
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Icon Tool Name Description

drawing in the current layer and which move when you offset a drawing 
with the Shift and Trace tool, and they appear in the Onion Skin rendition 
of neighbouring drawings as well. This allows you to keep track of how 
offset each drawing is. 

Remove All Cross 
Hair

Removes all the cross hairs created for shift and trace.

Reset Selected 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on the 
selected drawings, resetting them to their original position, angle and 
scale.

Reset All Drawings 
Shift Position

Undoes all transformations done with the Shift and Trace tool on all 
drawings, resetting them to their original position, angle and scale. 
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Tool Presets Toolbar

The Tool Presets toolbar lets you create new tool presets and manage them.

How to access the Tool Presets toolbar

 1. Select Windows > Toolbars > Tool Presets.

Icon Tool Name Description

New Tool Preset
Creates a new tool preset from the current tool 
settings.

Manage Presets
Opens the Manage Tool Preset dialog box where you 
can update, organize, and delete existing presets.
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Tools Toolbar

The Tools toolbar contains the main tools you need to work in Harmony. In the default workspace, this toolbar 
located on the left edge of the application window.  

TIP 

Many toolbar buttons have a keyboard shortcut associated to them. You can check which keyboard 
shortcut is associated to a button by leaving your mouse cursor over the button for a second. If the 
button has a keyboard shortcut, it will be indicated in the tooltip that appears. 

By default, the Tools toolbar hides some of its tools inside pop-up menus. For example, to select the  Cutter 
tool, you must double-click or long-click the  Select tool button, and select  Cutter in the pop-up menu.
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However, it is possible to make the Tools toolbar display each tool as a separate button by enabling the Flat 
Tools Toolbar preference. This makes the selection of tools quicker. 

How to make every tool in the Tools toolbar display in buttons rather than pop-up 
menus

 1. Do one of the following to open the Preferences dialog:

 l Windows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Advanced > Preferences.

 l Press ⌘  + U.

 2. Select the General tab.

 3. In the Options section, check the Flat Tool Toolbar option.

 4. Click OK.

 5. Close and relaunch Harmony.

NOTE 

In Flat Tools Toolbar mode, some tools are hidden from the Tools toolbar by default. To 
customize which tools are displayed in the Tools toolbar, and the order in which they are 
displayed, right-click on the Tools toolbar and select Customize.

How to customize which tools are displayed in the Tools toolbar when it is in Flat 
mode

 1. Right-click on the Tools toolbar and select Customize.

The Toolbar Manager dialog appears. 
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 2. In the Available Tools list, select each tool that you want to add to the Tools toolbar, then click on 
the Add the selected tool to the toolbar  button.

 3. In the Toolbar list, select each tool that you want to remove from the Tools toolbar, then click on 
the Remove the selected tool from the toolbar  button.

Tool Name Icon Description

Select
Allows you to select and reposition, scale, rotate and skew brush 
strokes, pencil lines, shapes and other parts of your artwork.

Cutter
Allows you to cut a part of your artwork, then reposition, scale, 
rotate and skew it. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in 
the current layer.

Contour Editor

Allows you to edit the vector contours of brush strokes, pencil 
lines and shapes in your artwork. You can add, remove, tweak and 
move vector points, move the Bezier handles of the vector points 
as well as  deform vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating 
the points at the centre of its line rather than its contour.

Pencil Editor
Allows you to adjust the thickness of a pencil line at its different 
points and corners, tweak the shape of its extremities and scale its 
texture.
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Smooth Editor
Allows you to optimize contours and lines by removing its extra 
points, making them easier to edit. 

Perspective
Allows you to deform artwork by applying a perspective effect on 
it.

Envelope
Allows you to deform and warp artwork by moving points and 
tweaking lines in a grid. 

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and 
textures in a colour zone. 

Brush
A pressure-sensitive tool for creating a contour shape with a thick 
and thin line effect, as if created with a paint brush.

Stencil Brush
Allows you to  paint over existing artwork within the boundaries of 
that artwork or the boundaries set by selecting the artwork of 
different layers.

Overlay Brush Mode
In Overlay Brush Mode, the existing artwork is used as a mask to 
generate new brush strokes which are added on top, leaving the 
existing artwork untouched.

Repaint Brush Mode
In Repaint Brush Mode, the existing artwork is replaced and 
repainted, ignoring empty zones.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are 
made of central vector lines, making them easier to tweak and edit 
than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the 
colour of one segment at a time. 
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Paint Unpainted
Allows you to quickly fill empty zones in your artwork with a 
colour or texture, leaving filled zones unchanged.

Repaint
Allows you to quickly repaint painted zones in your artwork. 
Empty zones will remain empty.

Unpaint
Allows you to empty filled colour zones of their colour and 
texture.

Stroke
Allows you to create invisible lines that can serve as colour zones 
that can be filled, or close the gaps in existing colour zones.

Close Gap

Allows you to close open shapes so that they can be filled with 
the Paint tool. By drawing a stroke near a small gap in a shape, 
this tool will create a small invisible stroke connecting the two 
closest points around the gap.

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline 
Allows you to draw shapes, segmented lines or complex curved 
lines by clicking to create each point in the sequence of line 
segments. 

Colour Eyedropper
Allows you to select a colour by clicking on a colour in your 
artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured 
pencil line.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking 
where you want its location to be.

Morphing
Allows you to create and configure a morphing sequence, which 
will automatically generate the in-betweens between two 
drawings in the current layer. 
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Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like with a real 
animation disc.

Shift and Trace
Allows you to temporarily move drawings so you can trace over 
them in other drawings using Onion Skin. 

Animate Current Frame

When this option is selected, every time you use the  
Transform or  Advanced Animation tools to 
manipulate an element in your scene, the position of the element 
will be stored in a keyframe at the current frame. This allows you 
to animate elements in your scene without creating keyframes 
manually.

Animate Onion Skin 
Range

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformations 

to an element in your scene, the transformations will be stored as 
keyframes at the beginning and at the end of the current Onion 
Skin range, as well as on every existing keyframe in-between. 
This can be useful if you want to reposition an element that you 
have already animated, but only during a specific range of frames, 
which you can define by enabling Onion Skin and setting the 
Onion Skin range to cover that range of frames.

Animate Off

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformation 

to an element in your scene, the transformations will affect the 
element throughout the whole scene. This can be useful if you 
want to reposition an element after you have already animated it. 

Transform
Allows you to select drawing layers and position, rotate, scale and 
skew them. 

Onion Skin
Displays the previous and next frames of an animation. Useful 
when animating cut-out characters.

Advanced Onion Skin
Enables Advanced Onion Skin, a more flexible kind of Onion Skin 
that can be easily configured using the Onion Skin view.
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Workspace Toolbar

The Workspace toolbar lets you load other workspaces. The first time you start Harmony, the default 
workspace is loaded. Other workspaces are available such as the Hand-Drawn Animation and Compositing 
workspaces; these display different views and toolbars. You can access these workspaces and any you create, 
from the Windows menu and the Workspace toolbar.

How to access the Workspace toolbar

 1. Select Windows > Toolbars > Workspace.

Icon Tool Name Description

  Workspace List Allows you to select an existing workspace.

Workspace Manager
Opens the Workspace Manager where you can 
organize, display, and remove workspace from your 
list.

Save Workspace

When the Automatically Save Workspace preference 
is disabled, the Save Workspace button becomes 
available. This allows you to manually save your new 
workspace configuration.
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View Toolbars
Harmony has a series of view specific toolbars that are only available in a given view. These toolbars can be 
moved only within their view. 

All view toolbars can be added, as long as the view is visible, through the top menu Windows > Toolbars > 
desired toolbar.

Camera View Toolbar 646

Drawing View Toolbar 648

Library View Toolbar 649

Reference View Toolbar 650

Port Names Toolbar 651

Script Editor Toolbar 652

Timeline View Toolbar 656

Xsheet View Toolbar 661
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Camera View Toolbar

Icon Button Description

Show Grid
Displays a grid to align or use for camera 
moves.

Reset All Transformations
Resets all parameters to their default values. 
For example, position x = 0, scale = 1, rotation 
= 0.

Create Colour Art from Line 
Art

Creates invisible strokes allowing you to paint 
your drawings on separate layers.

Flatten
The Flatten  operation is used to merge 
drawing objects and brush strokes into a 
single layer. See Flattening Drawings.

Lock
Locks the layer so that you cannot select it in 
Camera view.

Unlock All
Unlocks all layers of the scene so that you can 
select any one of them.

Show Controls
Display 3D/separate paths for peg or drawing 
layers. Can also show manipulators for 
different effects (e.g. quadmap).

Hide All Controls
Hides all manipulators for peg or drawing 
paths and effects.

Top Light
Allows you to change how much you see in 
the previous/next drawings in onion skin and 
other layers in the Light table mode.

Mirror View
Temporarily flips a drawing space horizontally, 
whether in the Camera or Drawing view. See 
Mirror View.
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Onion Skin Add One 
Previous Drawing

Displays one extra previous drawing to the  
current drawing in Onion Skin.

Onion Skin Reduce One 
Previous Drawing

Displays one less previous drawing to the 
current drawing in Onion Skin.

Onion Skin Reduce One Next 
Drawing

Displays one less following drawing to the 
current drawing in Onion Skin.

Onion Skin Add One Next 
Drawing

Displays one extra following drawing to the 
current drawing in Onion Skin

Flip Horizontal-Animation
Horizontally flip selected layers and create a 
keyframe with opposite value in Scale X 
parameter.

Flip Vertical-Animation
Vertically flip selected layers and create a 
keyframe with opposite value in Scale Y 
parameter.

Drawing Pivot
The Drawing Pivot  tool lets you set the pivots 
on your character.
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Drawing View Toolbar

Icon Button Description

Show Grid
Displays a grid to align or use for camera 
moves.

Show Light Table

Turns on the light table so you can see the 
previous and subsequent active layers in 
washed-out colours. It is useful for seeing the 
other layers when designing, animating or 
cleaning up your animation.  For more 
information, see Using the Light Table.

Create Colour Art from Line 
Art

Creates invisible strokes allowing you to paint 
your drawings on separate layers.

Group
Groups and ungroups selected drawing 
objects and strokes

Top Light
Allows you to change how much you see in 
the previous/next drawings in onion skin and 
other layers in the Light table mode.

Mirror View
Temporarily flips a drawing space horizontally, 
whether in the Camera or Drawing view. See 
Mirror View.

Onion Skin Add One 
Previous Drawing

Displays one extra previous drawing to the  
current drawing in Onion Skin.

Onion Skin Reduce One 
Previous Drawing

Displays one less previous drawing to the 
current drawing in Onion Skin.

Onion Skin Reduce One Next 
Drawing

Displays one less following drawing to the 
current drawing in Onion Skin.

Onion Skin Add One Next 
Drawing

Displays one extra following drawing to the 
current drawing in Onion Skin
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Library View Toolbar

Icon Button Description

Open Library Lets you open a library on your computer.

Close Library Unlinks a library folder from your library list.

New Folder

Creates a new folder in the Library view. 
Before you can create a new folder, you must 
have the right to modify the folder in which 
you are creating the new folder.

Refresh Updates the view and its contents.

View List
Displays the contents of the selected folder as 
a list.

View Details Displays the details of the selected file.

View Thumbnails
Displays the contents of the selected folder as 
a thumbnails.
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Reference View Toolbar

Icon Button Description

Import References
Imports a TVG drawing as a model in the 
Reference view.

Previous
Shows the previous model loaded in the 
Reference view.

Next
Shows the next model loaded in the Reference 
view.

Colour Eyedropper
Activates the Colour Eyedropper tool. This 
tools is also available on the Tools toolbar.

Zoom
Activates the Zoom tool. This tools is also 
available on the Tools toolbar.

Select
Activates the Select tool. This tools is also 
available on the Tools toolbar.

Cutter Selection
Allows to cut a section of the model to paste it 
in your scene.
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Port Names Toolbar

The Port Names Toolbar allows you to view a list of Port Names that can be inserted or selected that will 
affect the Port Filter of the current display.

NOTE 

The Port Names Toolbar will remember up to ten Port Names at a time.
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Script Editor Toolbar

The Script Editor toolbar gives you quick access to some commonly used commands for editing and testing 
scripts in the Script Editor view—see Script Editor View on page 714.

How to access the Script Editor toolbar

 1. Add the Script Editor view to your workspace by doing one of the following:

 l In the top-right corner of an existing view, click on the  Add View button and select Script 
Editor.

 l In the top menu, select Windows > Script Editor.

 2. Click on the Script Editor view to set the focus on it.

 3. In the top menu, select Windows > Toolbars > Script Editor.

Icon Button Description

New Script

Creates a new script. When you click on this button, you are first prompted to 
type in a name for the script. Then, you will be prompted to select which 
location to save the script in:

 l User: Saves the script to a directory in your user preferences directory. 
You will be able to run and edit the script from any scene as long as you 
are logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to 
the preferences for your account on your computer. if you are 
using Harmony Server, the script will be saved to the preferences 
for your Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the 
script to the Harmony database's global script directory. Anyone who is 
logged in to the database will be able to edit and run this script. 

652



Icon Button Description

 l Environment: If you are using Harmony Server, select this option to save 
the script to the current scene's environment. Anyone will be able to edit 
and run the script as long as they are working on a scene inside this 
environment.

 l Job: If you are using Harmony Server, select this option to save the script 
to the current scene's job. Anyone will be able to edit and run the script 
as long as they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will 
be able to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_
GLOBAL_SCRIPT_LOCATION environment variable. This option is only 
available if this environment variable is set.

NOTE 

For more information on script locations, see Script list on page 714.

Import Script

Allows you to import a script from your machine into Harmony. When you click 
on this button, you are prompted to browse for and select a script on your file 
system. Then, you are prompted to select which location to import the script in:

 l User: Saves the script to a directory in your user preferences directory. 
You will be able to run and edit the script from any scene as long as you 
are logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to 
the preferences for your account on your computer. if you are 
using Harmony Server, the script will be saved to the preferences 
for your Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the 
script to the Harmony database's global script directory. Anyone who is 
logged in to the database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save 
the script to the current scene's environment. Anyone will be able to edit 
and run the script as long as they are working on a scene inside this 
environment.

 l Job: If you are using Harmony Server, select this option to save the script 
to the current scene's job. Anyone will be able to edit and run the script 
as long as they are working on a scene inside this job.
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Icon Button Description

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will 
be able to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_
GLOBAL_SCRIPT_LOCATION environment variable. This option is only 
available if this environment variable is set.

NOTES 
 l When you import a script, any user interface (.ui) or icon (.png) file 

that is in the same directory and has the same filename as the script 
will also be imported.

 l For more information on script locations, see Script Editor View on 
page 714.

Delete Script

Deletes the selected script. 

NOTES 
 l You cannot delete a script if it is in the Application Resources location, 

as those are scripts that are installed with Harmony.

 l If you delete a script that was originally in Application Resources but 
which you copied to another location so you could make changes to it, 
the original version of the script in the Application Resources folder 
will be restored to the list. 

Refresh Script 
File List

Refresh the list of scripts in the Script Editor. If there are new scripts in your user 
preferences or your scene's scripts sub-folder, click on this button to be able to 
open them in the Script Editor. 

Set External 
Editor

Allows you to type in the path and name for your preferred text editing 
software.

NOTES 
 l On macOS, only typing the name of your preferred text editing 

software is enough if that application supports the AppleScript Open 
Document protocol. 

 l On Windows and GNU/Linux, unless your text editor is in your 
system's PATH environment variable, you will have to type in the full 
path to the editor. 
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Open with 
External Editor

Opens the selected script in the chosen external text editing software. 

Set Target

Prompts you to select which script and which function to use with the  Run 
and  Debug buttons.

NOTES 
 l You can set the entire script as the target by selecting the <Nothing> 

function from the functions list.

 l You cannot link an entire script to a toolbar button. Only functions 
within scripts can be added as toolbar buttons. Therefore, running or 
debugging an entire script rather than one of its functions should be 
done for testing purposes only.

Run

Runs the target script and function. 

NOTES 
 l If you have not set a target script and function, you will be prompted 

to set one when you click on this button.

 l You can set or change the target script and function by clicking on the 
 Set Target button.

 l If you are editing <<<Sandbox>>>, this button will simply run what 
you typed into the sandbox, regardless of whether another target is 
set.

Debug

Open the target script and function in the Qt Script Debugger, in which you can 
test and debug the function.

NOTES 
 l If you have not set a target script and function, you will be prompted 

to set one when click on this button.

 l You can set or change the target script and function by clicking on the 
 Set Target button.

 l If you are editing <<<Sandbox>>>, this button will simply debug 
what you typed into the sandbox, regardless of whether another 
target is set.

Stop Execution If a script is currently running, this interrupts its execution.
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Timeline View Toolbar

The 3D Graph toolbar works in conjunction with the elements in the 3D Graph view.

How to access the Timeline view toolbar

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Timeline View.

 l Right-click on the space at the top of the Timeline view and, in the context menu, select 
Timeline View.

Icon Name Description

Set Ease Type

Allows you to quickly apply an ease to the selected animation keyframes in the 
camera view.

To set the ease of an animation, simply select the first keyframe in the 
animation, then select the ease type in this drop-down. The ease-in will be 
applied to the selected keyframe, and the ease-out will be applied to the next 
keyframe in the timeline.

The following presets are available:
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Icon Name Description

Icon Preset
Ease-In (Selected 
Keyframe)

Ease-Out (Next 
keyframe)

Linear 0% 0%

Slow ease-in 25% 0%

Medium ease-in 50% 0%

Fast ease-in 75% 0

Fast ease-in / 
ease-out

75% 75%

Medium ease-in 
/ ease-out

50% 50%

Slow ease-in / 
ease-out

25% 25%

Slow ease-out 0% 25%

Medium ease-
out

0% 50%

Fast ease-out 0% 75%

Quick Ease Sets the ease before and after the selected keyframe to 33%.

Quick Ease In Sets the ease before the selected keyframe to 33%.

Quick Ease Out Sets the ease after the selected keyframe to 33%.
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Icon Name Description

Set Ease on 
Selected 
Keyframes

Opens the Set Ease on Keyframes dialog. In this dialog, you can set the ease-in 
(before) and the ease-out (after) on the selected keyframes to a custom 
percentage. 

Set Ease for 
Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog. This dialog allows you to 
adjust the Bezier handles on all the selected animation keyframes in the 
Timeline. 

Create Empty 
Drawing

Creates a drawing in the selected cell, replacing any drawing that may already 
be exposed in that cell and the following ones until it meets another drawing, 
key exposure or a blank cell. 

Duplicate 
Drawing

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, 
this command allows you to instantly start working on a duplicate of the 
current drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Insert Keyframe Adds a keyframe on the selected cell in the Timeline view. 

Delete 
Keyframes

Deletes the selected keyframes.

Set Motion 
Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the 
next keyframe. This means that a value for each frame between the keyframes 
is calculated by Harmony to progress from the value of the previous keyframe 
to the value of the next keyframe. 

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmonydoes not generate any 
animation and the element remains static until the next keyframe. 

Go to Previous 
Keyframe

Goes to the previous keyframe.
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Go to Next 
Keyframe

Goes to the next keyframe.

Add Key 
Exposure

Adds a key exposure to the selected cell. 

Delete Key 
Exposure

Removes key exposures from the selected cells.

Centre On 
Selection

Scrolls the layers list to the currently selected layer. This is useful if you want 
to select a layer in the Camera view, then manipulate its timing Timeline view. 

Create 
Keyframes On

Opens the Create Keyframes On dialog box, in which you can create keyframes 
at every set number of frames within a given range of frames.

Fill Empty Cells

Fills the empty frames in the selection with the exposure just before. For 
example, if you select a range of frame that starts with an exposed drawing 
and then ends with empty cells, all of the empty cells in the selection will be 
filled with the exposed drawing just before the empty cells. 

Paste Mode: All 
Drawing 
Attributes

Sets the Paste Mode to All Drawing Attributes. In this mode, when you cut or 
copy and paste frames in the Timeline view, both the animation keyframes and 
the exposed drawings will be pasted.

Likewise, if you drag and drop frames in the Timeline view, both the animation 
keyframes and the exposed drawings will be moved.

Paste Mode: 
Keyframes Only

Sets the Paste Mode to Keyframes Only. In this mode, when you cut or copy 
and paste frames in the Timeline view, only the animation keyframes will be 
pasted. The exposed drawings will not be pasted.

Likewise, if you drag and drop frames in the Timeline view, only the animation 
keyframes will be moved. The exposed drawings will not be affected.

Paste Mode: 
Exposures Only

Sets the Paste Mode to Exposures Only. In this mode, when you cut or copy 
and paste frames in the Timeline view, only the exposed drawings will be 
pasted. The animation keyframes will not be pasted.

Likewise, if you drag and drop frames in the Timeline view, only the exposed 
drawings will be moved. The animation keyframes will not be affected.

659

Harmony 24 Advanced Reference Guide                          



Chapter 5: Toolbars

Icon Name Description

Add Prefix or 
Suffix

Opens the Add Prefix or Suffix dialog. This dialog allows you to instantly 
rename all the selected layers by adding a prefix or a suffix to their name.
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Xsheet View Toolbar

The Xsheet toolbar contains the common timing operations such as Add Column, Delete Column, Clone 
Column, and so on. These options can also be found in the top menu.
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Chapter 6: Views
The Harmony interface is composed of different views, each one designed for a specific purpose. You can 
modify the location of the views by adding a new view as a tab or as a window. You can also swap the location 
of a view.  

When a view is active, a red rectangle appears around the view. Keyboard shortcuts and top menu options are 
associated with the active view. If a menu option is greyed out, it means it does not apply to the layer, drawing 
or other type of selection or the option does not apply to the active view.

Camera View 663

Colour View 672

Drawing View 678

Drawing Substitutions View 681

Function View 683

Guides View 686

Integrated Help View 690

Layer Properties View 691

Library View 693

Master Controller View 696

Message Log View 698

Metadata Editor View 699

Reference View 701

Onion Skin View 703

Perspective View 710

Python Script Console View 713

Script Editor View 714

Side View 719

Timeline View 721

Tool Properties View 731

Top View 732

Xsheet View 734
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Camera View
The Camera view is the centre of operations in Harmony. In this view, you can draw, paint, animate, set up your 
scene, manipulate objects, open symbols and preview your animation.

The Camera view also has a top and bottom toolbar that you can use to navigate in the view, change the 
display mode or go up your symbol hierarchy. 

How to access the Camera view

Do one of the following:

 l From the top menu, select Windows > Camera.

 l From any of the other views, click the Add View  button and select Camera.

Icon Section Description

View Menu
The View menu contains all the tools and options that you can use in 
the Camera view to draw, animate or set up the scene.
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Icon Section Description

Editing Stack

The Editing Stack menu displays the names of the symbols and their 
hierarchy when you are editing a symbol. You can click on the 
different names to go back up to the different parent symbols or the 
top/current project.

  Camera View Toolbar

The Camera View toolbar contains all the tools and options you can 
use in the Camera view to draw, animate or set up the scene. The 
toolbar can be displayed or hidden by right-clicking on it and 
selecting or deselecting the Camera View toolbar.

Light Table

When you have a drawing layer or drawing selected, the Light Table 
button  button allows you to fade the colours of the other layers so 
you can see the current artwork better as you edit with a drawing 
tool. Note that the light table does not work when using a layer 
editing tool, such as the Transform  tool.

Current Drawing on Top

When this button is enabled, the drawing that you are currently 
editing with a drawing tool is temporarily displayed in front of all the 
other elements. The actual scene is not modified.

Camera Mask

The Camera Mask  button shows or hides Displays a black mask 
around the scene’s frame to avoid seeing the unnecessary artwork. 
This option is handy when you're animating and setting up the scene. 
It allows you to see your scene’s composition better.
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Icon Section Description

You can also access this from the top menu by selecting View > 
Show > Camera Mask.

Proportion Grid

The proportion grid is displayed in the camera view to help with 
proportions and balancing the composition of an image. The grid 
follows the camera frame, similar to camera mask and safe area.

The number of divisions in the proportion grid can be defined by the 
user in the Preferences > Camera > Proportion Grid > Horizontal 
Divisions > Vertical Divisions.

The default is 3 division on each axis to create a rule of third grid. 

TIP 

You can access the Proportion Grid button in the Camera 
View toolbar.

Safe Area 

The Safe Area  button shows or hides Displays the TV safety zone 
and the centre of the camera frame. The safe area adapts to the 
scene resolution, as well as the safety zone and frame’s centre.

You can also access this feature from the top menu by selecting 
View > Show > Safe Area.
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Icon Section Description

Show Alignment Guides

When enabled, alignment guides will be visible in the Camera and 
Drawing views.

This is enabled by default. Disabling this option will hide and disable 
alignment guides, meaning that animation and drawing tools will not 
snap to them, even if the  Snap to Alignment Guides option is 
enabled in the Tool Properties view. 

BBox Selection Style

When you select an object in the Camera view with the Transform 
tool, a bounding box always appears around the object and the 
artwork is tinted in fuchsia, red or yellow. Enabling this option will 
only keep the bounding box and remove the colour tint.

Outline Locked Drawings

Drawings that are locked in the Timeline view (cannot be selected in 
the Camera view) are displayed as wireframes.

Reset View 
The Reset View  button resets any panning, zooming or rotation done 
in the Camera view and returns the display to the initial settings. You 
can also press Shift + M.

Take Snapshot

Saves the preview image of the Camera view in memory as a 
snapshot.

 Harmony stores five snapshots and have a  drop down list with five 
available slots. So if any snapshot was in memory when taking a 
snapshot, it will be overwritten by the new snapshot.
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NOTES 
 l Snapshots are not saved to the scene and are discarded 

when the scene is closed.

Show Snapshot

Displays the snapshot currently in memory. To display the snapshot, 
you must click and hold the button. Releasing it will restore the 
Camera view preview. 

NOTE 

The snapshot is displayed as it was taken, regardless of the 
preview mode of the Camera view. For example, if you took a 
screenshot in Render View mode, and display it while in 
OpenGL View mode, the snapshot will display as it was taken 
in Render View mode. 

  Zoom Menu

The Zoom menu lets you enlarge or reduce the Camera or Drawing 
view display. 

To make the camera frame size always match the size of your view, 
select the Fit to View option. Click the drop-down arrow and select a 
zoom level or press 1 and 2.

OpenGL View Mode 

The OpenGL View Mode  button switches the Camera view to fast 
display, letting you see your animation play in real time. The OpenGL 
display requires less memory. The final look of your effects is not 
shown in the OpenGL View Mode. You must switch to the Render 
View Mode to see your effects.
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Icon Section Description

Render View Mode

The Render View Mode  button switches the Camera view to a fully 
rendered display showing the final image of the current frame. If a 
modification is done to your current frame or if you move to a 
different frame, click the Update Preview button to update the 
display if your preview does not update automatically.The Render 
View Mode display lets you see the final look of your frames 
including effects and antialiasing. You cannot play back your scene in 
Render View Mode. To see your scene fully rendered and to play it 
back, you must press the Render and Play  button in the Playback 
toolbar.

Matte View Mode

The Matte View Mode  button switches the Camera view to a matte 
display showing the alpha channel of the elements in your scene. 
The transparency level ranges from 0 to 100 percent. Zero percent is 
completely transparent and represented by black and 100 percent is 
completely opaque and represented by white. Everything in between 
these extremes has a transparency level somewhere between 1 and 
99 percent and is represented in various shades of grey. 

 l To access the Matte View mode, click on the Render View  
button and select Matte View  from the drop-down menu.

668



Icon Section Description

Depth View Mode

The Depth View mode displays images in a relative white to black 
gradient scale. The object(s) closest to the camera are displayed in 
white and the object(s) furthest from the camera are displayed in 
black. If the position of the last object changes along the z-axis, that 
object will still remain black, so long as it retains its position as the 
object the farthest back. It does not matter where that object is in 3D 
space, it just matters what its position is relative to the other object in 
the same space. The objects closest and farthest from the camera set 
the range of the white to black scale. All the other objects fall 
somewhere in between.

 l To access the Depth View mode, click on the Render View  
button and select Depth View  from the drop-down menu.

  Preview Colour Space

The colour space in which to display the preview image when in  
Render Preview mode. 

You can set this to any colour space supported by Harmony. It is 
recommended to set this to the colour space intended for rendering 
your frames, unless that colour space is not supported by your 
monitor. In the latter case, it’s recommended to set this to the closest 
colour space available that your monitor can display. 
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Icon Section Description

The following colour spaces are available:

 l sRGB: A colour space typically used for standard computer 
monitors. It has the same primaries and white point as Rec. 
709, but has a different gamma transfer curve.

 l Display P3: A colour space commonly used for digital 
projection. It has the same primaries as DCI-P3, the same 
white point as sRGB and the same gamma transfer curve as 
sRGB.

 l P3-D65 PQ: A high-dynamic-range (HDR) colour space that 
uses P3-D65 primaries and perceptual quantization (PQ) as 
the transfer function. This colour space supports higher 
brightness. You have the option to remap 1000, 2000, or 
4000 nits colours to the P3 limited dynamic range. 

Tone mapping reduces the tone values of high-dynamic-
range (HDR) images to make it more suitable for digital 
displays. For no tone mapping, select Un-tone-mapped.

 l Rec. 709: The colour space used for HDTV. It has the same 
primaries and white point as sRGB, but has a different 
gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, 
except with a gamma transfer curve of 2.4 (per ITU-R 
BT.1886). This colour space exists because some editing 
systems use a gamma transfer curve of 2.4 instead of the 
standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV 
(UHDTV). It has a complex gamma transfer curve and 
primaries that cover more of the human-perceivable colour 
space than other colour spaces, especially in the area of 
human-perceivable greens.

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except 
with a simple gamma transfer curve of 2.4 (per ITU-R 
BT.1886). This colour space exists because some editing 
systems use a gamma transfer curve of 2.4 instead of the 
standard gamma curve for Rec. 2020.

 l Rec.2100 PQ:An HDR colour space that uses Rec.2020 
primaries and perceptual quantization (PQ) as the transfer 
function. An additional transform could be selected for 1000, 
2000, or 4000 nits. For no tone mapping, select Un-tone-
mapped.

670



Icon Section Description

NOTE 

You can only select the display colour space in  Render 

View mode. In  OpenGL View mode, the preview image is 
generated in the colour space selected in the Display Colour 
Space drop-down in the Camera tab of the Preferences 
dialog.

TIP 

You can have multiple Camera views in your workspace, each 
set to their own colour space. Hence, you can preview your 
scene on multiple monitors with different colour spaces by 
having a Camera view on each monitor. 

  Drawing Name 
The Drawing Name field displays the name of the selected drawing, 
as well as the layer containing it. If the cell does not contain any 
drawing, an Empty Cell text is shown in the field.

Preview Resolution
The Preview Resolution button sets the resolution of the render 
preview. A lower preview resolution will result in a faster loading 
time when previewing an effect.

  Tool Name 

The Tool Name field displays the name of the selected tool. If you 
temporarily override a drawing tool using a keyboard shortcut, the 
tool’s name will be highlighted in red. You can temporarily override a 
tool by holding its keyboard shortcut without the Alt key. For 
example, the Select tool shortcut is Alt + S. If you hold down the S 
key, you will switch to the Select tool. When you release the key, you 
will return to the tool you were using.

  Frame Number The Frame Number field displays the number of the current frame.

  Selected Colour
The colour swatch displays the currently selected colour in the 
Colour view.
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Colour View
The Colour view is where you create colours and palettes and import existing palettes into your project. The 
Colour view is also necessary for drawing, painting and creating colour styling.

How to access the Colour view

Do one of the following:

 l From the top menu, select Windows > Colour.

 l From any of the other views, click the Add View  button and select Colour.

Palette List Panel

Icon Option Description

View Menu
The View menu contains all the commands and options that you can 
use in the Colour view to manage colours and palettes.
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Collapse/Expand Palette 
List

Allows you to show or hide your palette list and its options. By 
default, the palette list is displayed, but you may want to hide it if you 
are working with a single palette and want to allow more vertical 
space for the colour swatch list.

Add Palette Allows you to create a new palette. 

Remove Palette 

Deletes the currently selected palette. If the colour swatch is used in 
your project, zones painted with colour swatches which have been 
deleted will turn red, easily identifying them so you can repaint them 
with another colour swatch.

Link Palette

Allows you to add a palette from a different location, be it in a scene, 
job, environment or even an element to your palette list. The palette 
will be linked to its original location rather than copied to your 
scene's folder. Hence, if you make changes to the original palette, it 
will affect the colour of elements in your scene. 

If you want to import a palette as a copy into your scene's palette 
library, right-click on your palette list and select Import. You can also 
link to a palette in any location on your machine or network by 
selecting Link to External.

Order Palette List

Moves palettes further up or down the palette list. 

If a palette has been cloned, the highest palette among the original 
palette and its clone(s) will be used by Harmony. 

Edit Palette List Mode 
Indicator

In Harmony Server, this icon appears when you have the modifying 
rights on your scene's palette list. While several users can work on a 
scene at the same time, only one user may have the right to modify a 
palette list at any given time. 
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NOTE 

In Harmony Stand Alone, you can always modify your scene's 
palette list. On Harmony Server, you must  unlock your palette 
list before making modifications to it.

Show Colour Palettes
Shows only colour palettes in the palette list. This is the default 
option.

Show Pencil Texture 
Palettes

Shows only pencil texture palettes in the palette list.

Show All Palettes Shows both colour and pencil texture palettes in the palette list.

Palette List

Icon Description

In Harmony Server, this indicates that you have the rights to modify the palette.

Indicates that the palette is stored at the same level as its palette list. For example, a palette that is 
stored in the scene's palette library and which is listed in the scene's palette list, or a palette that is 
stored in an element's palette library and which is listed in that same element's palette list. 

Indicates that the palette file is stored in an external location, such as a different scene, an element in 
a different scene, a job other than the scene's job, or an environment other than the scene's 
environment. This means the palette is liable to be missing if it is moved from its original location, or if 
the scene is exported from the database into an offline scene or to a different database.

This indicates that the palette is stored at a higher level than its palette list, making it a shared 
palette. For example, a palette in your scene's palette list that is stored in the palette library of the 
scene's job or environment, or a palette in an element's palette list that is stored in the palette library 
of the scene.

Indicates a potentially dangerous situation. For example, a palette file that is stored in one of the 
scene's element folders, but which is added to your scene's palette list. The whole scene can use the 
palette, but since it's stored inside an element, deleting that element will make your whole scene lose 
access to that palette. 
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Colour Swatch List Panel

Icon Option Description

Add Colour Adds a new colour swatch to the bottom of your colour list.

Remove Colour 

The Remove Colour  button lets you delete the currently selected 
colour swatches. If the colour swatch is used in your project, and 
confirmation dialog will appear prompting you to confirm that you 
want to delete the colour. Zones painted with colour swatches 
which have been deleted will turn red, easily identifying them so 
you can repaint them with another colour swatch.

Add Texture 

Allows you to import a bitmap image as a texture, which can be 
painted with just like a colour. When used with the Brush or Paint 
tools, bitmap textures are tiled inside the shape they fill. The 
scaling and position of the texture inside their shape can be 
tweaked with the Edit Gradient/Texture tool. When used with the 
Pencil tool or one of the Shape tools, a bitmap texture will follow 
the pencil line's direction. 
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Set Current Brush Colour 
When enabled, the colour you select in the colour view will be 
selected for the Brush tool. 

Set Current Pencil Colour 
When enabled, the colour you select in the colour view will be 
selected for the Pencil tool, as well as other tools that create 
pencil lines, such as the Line, Rectangle, Ellipse and Polyline tools. 

Set Current Paint Colour 
When enabled, the colour you select in the colour view will be 
selected for the Paint tool.

Link/Unlink Three Colours 

When enabled, the colour you select will be selected for all 
drawing tools. When disabled, you can select individual colours 
for the Brush, Pencil and Paint tools. 

Edit Palette Mode 

In Harmony Server, this allows you to get the modifying rights to 
the selected palettes. 

Since several people can work on any given scene at the same 
time, and a palette can be shared between scenes, palettes may 
be loaded in read-only mode when opening a scene on a Harmony 
database. Then, an user would only be able to edit a palette by 
first activating Edit Palette Mode. This prevents several users from 
making changes on the palette at the same time, since a user 
cannot activate Edit Palette Mode on a palette that is already 
being edited by someone else. This also prevents users from 
accidentally making modifications on important palettes.

Edit Palette Mode Indicator

In Harmony Server, this icon appears when you have the modifying 
rights on the currently selected palette.

NOTE 

In Harmony Stand Alone, you can always modify your 
palettes. 

  Colour Swatch Name 
Each colour swatch available in the Colour view can have its own 
name, making it easy to identify which colour is used to paint what 
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part of your character or background. 

NOTE 

Two colours can have the same name. Harmony identifies 
colours by an identification number. 

  Colour Swatch 

Also referred to as colour pots, the colour swatch is the actual 
colour information for a colour in your palette. It is represented by 
a rectangle displaying the colour in the list. 
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Drawing View
In Harmony, you can draw in both the Drawing or Camera views. Although the two views are similar, there are 
some differences  when it comes to drawing.

Only the selected drawing is displayed by default in the Drawing view. You can use features, such as the light 
table to display the current drawing of all the enabled layers of your scene in washed-out colours, or the 
Onion Skin to display the previous and next drawings of the currently selected drawing layer.

How to access the Drawing view

Do one of the following:

 l From the top menu, select Windows > Drawing .

 l From any of the other views, click the Add View  button and select Drawing.

Icon Section Description

View Menu
The View menu contains all the tools and options that 
you can use in the Drawing view to draw, animate and 
paint.
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  Drawing Area
This is the main space in the Drawing view. It is where 
you draw and where the drawings are displayed.

  Zoom Menu

The Zoom menu lets you enlarge or reduce the 
Camera or Drawing view display. 

To make the camera frame size always match the size 
of your view, select the Fit to View option. Click the 
drop-down arrow and select a zoom level or press 1 
and 2.

  Drawing Name

The Drawing Name field displays the name of the 
selected drawing, as well as the layer containing it. If 
the cell does not contain any drawing, an Empty 
Cell text is shown in the field.

  Tool Name

The Tool Name field displays the name of the selected 
tool. If you temporarily override a drawing tool using a 
keyboard shortcut, the tool’s name will be highlighted 
in red. You can temporarily override a tool by holding 
its keyboard shortcut without the Alt key. For 
example, the Select tool shortcut is Alt + S. If you hold 
down the S key, you will switch to the Select tool. 
When you release the key, you will return to the tool 
you were using.

  Frame Number
This field displays the current frame of the animation 
you are working on.

  Cursor Coordinates
This indicates the position of the your pointer in the 
drawing area.
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  Colour Picker
The Colour Picker allows you to select a colour for 
drawing.
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Drawing Substitutions View
T-H16NEW-002-001

The Drawing Substitutions view allows you to view all the drawings in the selected layer in a list of 
thumbnails, as well as to quickly select which drawing should be exposed at the current frame. 

How to access the Drawing Substitutions view

 1. Do one of the following

 l From the top menu, select Windows > Drawing Substitutions.

 l In the top-right corner of any view, click on the  Add View button and select Drawing 
Substitutions. 

Section Description

View Menu

Opens a menu with the Create Key Exposure option. This option can be enabled or disabled. 
It determines what happens when you set the drawing in the current frame to the same 
drawing as the drawing in the previous frame.

 l When enabled, the exposure of the drawing at the current frame will be separated 
from the drawing in the previous frame with a key exposure. 

 l When disabled, the exposure of the current frame will be merged with the exposure of 
the previous frame. 
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Section Description

Thumbnails

Allows you to select the drawing to be exposed at the current frame. This will also replace the 
drawing for all subsequent frames during which the current drawing is exposed.

Current layer 
name

The name of the currently selected layer. The drawings in the thumbnails list are the drawings 
currently stored in this layer.

Zoom slider Allows you to change the size of the thumbnails. 
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Function View
The Function view lets you edit function curves and parameters. It contains a visual graph for adding, 
removing, and editing keyframes, as well as adjusting the velocity. The Function view allows you to display 
multiple functions in the background as a reference.

How to access the Function view

Do one of the following:

 l From the top menu, select Windows > Function.

 l From any of the other views, click the Add View  button and select Function.

How to display functions in the Function view

 1. Open the Function view.

The Function view is blank until you select the layer containing the functions you want to display.
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 2. To display a function in the Function view, click on the layer containing the functions to adjust in the 
Timeline view.

 3. To select the functions you want to edit, select them in the Function list.

Parameter Description

Function List

When selecting a layer in the Timeline view, all the corresponding functions are 
displayed (if any).  Select the functions you want to see and edit, and hide the ones 
you don't.

Display Toolbar

Allows you to modify how the editing area is displayed. You can hide the grid, 
disable the synchronization with the current frame, reset the zoom level and 
normalize the function display by stacking them one over the other to compare 
them regardless of their value range.

Current Frame Displays the current scene frame.

Selected Keyframe Value Displays the value of the selected keyframe.

Display Advanced Parameter 
Values

Displays the Projection, Bias, Tension and Continuity parameters to adjust the 
curve around the selected keyframe.

Keyframe, Velocity and 
Interpolation Options

This toolbar lets you add and delete keyframes, adjust the velocity curve, adjust 
the segments to motion or stop-motion keyframes and set the velocity to create 
steps instead of a constant progression.

Function Types
This toolbar lets you click on the different function types to enable or disable all 
the listed functions of that type.

Value Scale
Displays the value range for the displayed editing area. It can be referenced to 
know the value of a keyframe.
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Selected Keyframe
The selected keyframe is displayed in red. When selected, the keyframe values 
are displayed in the corresponding fields.

Bezier Handles
The Bezier handles let you adjust the ease in and ease out of each keyframe. The 
more the handle is pulled out horizontally, the slower the animation will be. The 
more the handle is pulled out vertically, the faster the animation will be.

Function Curve
The thin line going from keyframe to keyframe is the actual curve. The section of a 
curve located between two keyframes is called a segment.

Frame Scale
The Frame Scale displays the frame range for the displayed editing area. It can be 
referenced to know the current frame of a keyframe.
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Guides View
The Guides view allows you to add drawing guides to the current scene, to select which guide to use, to 
manage existing guides, to export and import guides and to enable or disable drawing guides as well as their 
various options.

NOTE 

For more information on each type of guide and how to use them, refer to the User Guide.

Icon Name Description

Options

Enable Guide  
Enables or disables drawing guides. When guides are disabled, they are 
not visible and you cannot edit them or use them with drawing tools. 
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Icon Name Description

Align with Guide 

When enabled, when drawing with the  Brush,  Pencil,  Stroke 
and  Line tools tool, the cursor is automatically locked against the axis 
of the currently selected guide that most closely matches the angle of your 
stroke, as if you were drawing against a rule. 

When disabled, the drawing tools are not constrained by the axes of the 
guide, allowing you to draw freely.  The guide's axes act as a visual aids 
only. 

Lock Guide 
When enabled, you cannot do modifications on the currently selected 
guide. This prevents making unwanted modifications to the guide when 
drawing.

Enable Guide with 
Eraser

Allows you to use the Eraser tool with drawing guides. 

Full Cursor Display

When enabled, the guide's axes that go through the mouse cursor in the 
drawing space go throughout the entire drawing space and display even 
when you're drawing.

When disabled, the guide's axes that go through the mouse cursor only 
display over a short distance from the mouse cursor. Also, the guide's axes 
disappear when drawing a stroke. 

Show Reference 
Lines

When enabled, semi-transparent reference lines for each of the currently 
selected guide's axes appear all over your drawing space.

  Number of Lines

Adjusts the amount of reference lines to display in your drawing space.

Guides List

New Guide

Allows you to add a guide to the scene's guides list. You can add a guide 
of one of the following types: 

 l  Ruler

 l  Square Grid

 l  Isometric Perspective

 l  1-Point Perspective
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Icon Name Description

 l  2-Point Perspective

 l  3-Point Perspective (Bird’s-Eye View)

 l  3-Point Perspective (Worm’s-Eye View)

 l  3-Point Perspective (Horizontal Pan)

 l  3-Point Perspective (Vertical Pan)

 l  4-Point Continuous Perspective

 l  4-Point Perspective (Vertical Pan)

 l  5-Point Perspective (Fisheye)

NOTE 

For more information on each type of guide and how to use them, 
refer to the User Guide.

 
New Symmetry 
Guide

Allows you to add a guide to the symmetry guides list. You can add a 
guide of one of the following types: 

 l  Vertical

 l  Horizontal

 l  Dual Axis

Delete Guide Deletes the selected drawing guides from the scene's guides list.

Guides View Menu Opens a menu with the following commands:

 
Rename 
Guide

Renames the selected drawing guide. 

  Cut
Cuts the selected drawing guides from the list and adds them to the 
clipboard. 

  Copy Copies the selected drawing guides to the clipboard. 

  Paste
Pastes drawing guides from the clipboard to the current scene's guides 
list. Pasted guides are inserted under the selected guide.
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Icon Name Description

 
Import 
Guides

Imports drawing guides that were previously exported to a file and inserts 
them at the bottom of the scene's guides list. Duplicate guides are filtered 
out to avoid cluttering the list. 

 
Export 
Selected 
Guides

Exports the selected drawing guides into a file.

  Drawing Guides List

Displays the scene's list of guides and allows you to select which guide to 
display, edit and use.
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Integrated Help View
Use the Integrated Help when you are unsure about what a certain menu item is or the function of a specific 
preference in the Preferences panel.

If you keep the Integrated Help window open for the entire duration of your work session, then you can use the 
forward and backward arrows to scroll through  a history of the help information that you called up during your 
session.

How to access the Integrated Help view

 1. Do one of the following:

 l From the top menu, select Windows > Integrated Help.

 l From any of the other views, click the Add View  button and select Integrated Help.
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Layer Properties View
The Layer Properties editor or view lets you adjust the properties of a layer in the Timeline view The Layer 
Properties can be viewed as a floating window or as a view (docked).

Each layer has its own set of properties that can be modified, including effect and peg layers. Display the Layer 
Properties editor or view if you want to modify some of the layer’s properties, such as the name or the 
antialiasing quality. 

NOTE 

To know more about the parameters displayed in the Layer Properties view, see Layers on page 
348.

How to access the Layer Properties view

Do one of the following:
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 l From the top menu, select Windows > Layer Properties.

 l From any of the other views, click the Add View  button and select Layer Properties.

How to access the Layer Properties editor

 l Double-click on a layer in the Timeline view

 l Right-click on a layer in the Timeline view and select Layer Properties.

 l Select a layer in the Timeline view and press Shift + E.
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Library View
The Library view is used to store elements such as animation, drawings, backgrounds and character models so 
as to reuse in different scenes and projects. You can also use the Library view to create and store symbols, as 
well as to store and import images and sound files. 

To reuse elements from a scene in other scenes, you must create a template so that you can import it into 
different scenes. Templates can contain anything from a single drawing to a whole scene structure. You can 
create a template by creating it in a scene, then copying the elements you want in your template into a library. 
The resulting template is structured like a mini-scene that contains only the elements you copied into it. A 
template does not have any dependencies on the scene it was originally created in. Hence, it can safely be 
imported in any other scene.

Additionally, the Library view's Drawing Substitutions panel allows you to quickly change the current frame's 
exposure to one of the existing drawings in a layer. This is especially useful for animating a cut-out character's 
mouths, hands, eyelids and other such body parts which typically contain several drawings to choose from. 

How to access the Library view

Do one of the following:

 l From the top menu, select Windows > Library.

 l From any of the other views, click the Add View  button and select Library.

Icon Section Description

View Menu
The Library menu lets you access commands related to the Library 
view, importing .swf movies and Illustrator files, add a new folder, and 
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Icon Section Description

refresh the library’s content.

  Preview Window 

The Preview window lets you see the content of the currently selected 
template or symbol in the Template/Symbol list.

  Preview Playback 
The Preview Playback button lets you play back the content of the 
selected template or symbol if it contains more than one frame. Press 
the Play  button to play back the preview.

  Library Folder List 

The Library Folder List displays all the folders linked to the Library 
view. 

There are two default folders:

 l Symbols: This folder is the only folder containing symbols. You 
can organize it by adding subfolders inside.

 l Harmony Advanced Library: This is a default folder found on 
the hard drive in your user documents. This folder can contain 
templates, but no symbols.

You can link new library folders to the Library view and organize them 
with subfolders.

  Library Search tool

When working on a movie or series, you will probably end up with 
many templates and symbols in your library. Using the Search tool, 
you can quickly find the templates and symbols in your folders.
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Icon Section Description

  Template/Symbol List 

The Template/Symbol list displays the templates or symbols 
contained in the selected library folder. You can display the templates 
by right-clicking the symbols’ thumbnails and selecting View > 
Thumbnails.

  Slider

A slider could be used to adjust the display size of thumbnails in the 
Library view.
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Master Controller View
T-RIG3-008-008

The Master Controller view allows you to quickly find, select and display Master Controllers in the current 
scene. 

How to add the Master Controller view to your workspace

 1. Do one of the following:

 l In the top-right corner of an existing view, click on  Add View and select Master 
Controller.

 l In the top menu, select Windows > Master Controller.

Icon Section Description

Filter

  Path

Allows you to select a group in the current scene. When a group is selected, 
only the Master Controllers within that group will be listed in the Master 
Controllers list. This can be useful if you have several characters and only 
want the list of Master Controllers for a specific character. 
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Icon Section Description

  Name

Allows you to filter the Master Controllers in the Master Controllers list by 
their path or name. When you type something in this field, only the Master 
Controllers that contain the text you typed in their full path including their 
name will be listed in the Master Controllers list. 

Master Controllers

 
Master 
Controllers

Allows you to select one of the Master Controllers in your scene. This list 
displays the Master Controllers in your scene with their full path in the group 
hierarchy. Groups in the hierarchy are separated by forward slashes (/).

If a group is selected in the Path list, only the Master Controllers within this 
group will appear in the list. If anything is typed in the Name field, only Master 
Controllers with this text in their full path including their name will appear in 
the list. Otherwise, all the Master Controllers in your scene are listed. 

Refresh List
Refreshes the Path list if there are any changes in the name or hierarchy of 
groups in your scene, as well as the Master Controllers list if there are any 
changes in the Master Controllers in your scene.

Locate and Select 
Master Controller

If a Master Controller is selected in the Master Controllers list, clicking on this 
button will select the actual Master Controller node. It will also make the 
Node View navigate instantly to and focus on that Master Controller node.

Show Master 
Controller

If a Master Controller is selected in the Master Controllers list, clicking on this 
button will display its widget in the Camera view.
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Message Log View
The Message log view displays information gathered during a render task, such as which frames and at what 
time they were each rendered. The view also contains a list of the colour recovery operations.

How to access the Message Log view

Do one of the following:

 l From the top menu, select Windows > Message Log.

 l From any of the other views, click the Add View  button and select Message Log.
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Metadata Editor View

The Metadata Editor view lets you access the information of the props and anchors to be exported to Unity.

NOTE 

Because the Unity game engine does not support Unicode characters, it is recommended to avoid 
using it in scenes intended for games.

How to access the Metadata Editor view

 l In the top-right corner of a view, click the Add View  button and select Metadata Editor.

 l In the top menu, select Windows > Metadata Editor.

Parameter Description

Scene Metadata

This is a list of optional parameters you can create in a scene project to be 
exported to Unity. It will not have any incentive towards your scene assets, but 
can help developers know what to do with the assets contained in your Harmony 
scene. 

Once in Unity, scene Metadata will appear in Inspector view > Metadata when the 
Asset is selected in the Hierarchy view.

Name: Name of the Scene entry. (e.g. game.Armor001)
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Value: This can be anything that describes the state of an object. You could, for 
example, have three different stages of armour: new, damaged and destroyed.

Node Metadata

Displays only the props and anchors held inside your selection. If nothing is 
selected, no information will display. Name and value appear in this box as well. 
Name will show you the associated .tvg name and value will be set as either On 
or Off, depending on whether you want the connection to be set as active or not. 

Once in Unity, scene Metadata will appear in the Hierarchy view.

Name: Name of the selected anchor or prop. (e.g. game.isAnchor). Notice that it 
differs from the drawing layer name on the top-left corner of the Node Metadata 
section.

Value: Can be set to be active (On) or inactive (Off).

NOTE 

For any anchor or prop information created within the Metadata Editor, the naming convention 
must always use the prefix "game.". The term "game." is recognized automatically by Unity as a 
metadata information. For example: game.Armor001.

700



Reference View
When you are drawing, you can use a fully-painted drawing or bitmap image as a reference and load it in the 
Reference view. This drawing or bitmap image can be used and loaded in any of your Harmony scenes.

Once imported, your references will be saved in the scene, and you will not need to re-import them. To load 
your previously used references in the scene, right-click the Reference View Toolbar and select Load Default 
References.

How to access the Reference View

Do one of the following:

 l From the top menu, select Windows > Reference View.

 l From any of the other views, click the Add View  button and select Reference View.

Tool/Menu Item Icon Description

View Menu
The View menu contains all the tools and options that 
you can use to manage references.

  Reference View Toolbar
The Reference View toolbar contains all the tools and 
options you can use in the Reference view to navigate 
through and manage references.
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Colour Eyedropper
Allows you to select a colour by clicking on a colour in 
your artwork. 
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Onion Skin View
The Onion Skin view allows you to quickly configure onion skin. Using this view, you can choose the colour of 
previous and next drawings, which kind of marked drawings to display and whether to measure the span of 
onion skin per frame or per drawing. When using Advanced Onion Skin, you can also use this view to pick 
which drawings are included in the Onion Skin, as well as the opacity of the drawings relative to how far they 
are from the current frame. 

How to access the Onion Skin view

 1. Do one of the following:

 l In the top-right corner of a view, click on the  Add View button and select Onion Skin.

 l In the top menu, select Windows > Onion Skin.

The Onion Skin view is added to your workspace.

A lot of the controls in the Onion Skin view are only accessible when using Advanced Onion Skin. 
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How to enable Advanced Onion Skin

 1. Do one of the following:

 l In the Tools toolbar, click and hold  Onion Skin and select Advanced Onion Skin.

 l In the Onion Skin view, click on the  Advanced Onion Skin button.

 l In the top-left corner of the Onion Skin view, open the  View Menu and select Advanced 
Onion Skin.

The controls for the Advanced Onion Skin are now accessible in the Onion Skin view.

User 
Interface

Section Description

View Menu
Open the Onion Skin view menu, which contains extra options for 
Advanced Onion Skin—see Onion Skin View Menu on page 311.

Previous Drawings Settings

Previous 
drawings 
visibility 
switches

Allows you to select which drawings before the current frame to include in 
the Onion Skin. A drawing that is toggled on will be visible in the Onion 
Skin, and a drawing that is toggled up will be excluded from it. You can 
select a range of drawings, or include and exclude specific drawings 
individually. 
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User 
Interface

Section Description

TIP 

You can quickly select or deselect a range of drawings by clicking 
and holding on one drawing, then dragging the mouse cursor over 
the other drawings you want to toggle. 

Previous 
drawings 
opacity sliders

Allows you to adjust the opacity scale of drawings before the current 
frame. Each slider represents the opacity of one drawing.

By default, moving one of these sliders will move the other sliders so that 
the opacity remain on a gradated scale. In this case, you can start by 
adjusting the opacity on one end, the opacity on another end and then, if 
you want, adjust one of the sliders in-between to make a segmented 
progression.

You can disable this behaviour by unchecking the Link Sliders option in 
the  View Menu in the top-left corner of the Onion Skin view. This 
option is enabled by default. When disabled, you can adjust the opacity of 
each drawing independently. 

Previous 
drawings colour

Allows you to select the colour in which to display the drawings before 
the current frame.
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User 
Interface

Section Description

Onion Skin Settings

Advanced Onion 
Skin

Enables Advanced Onion Skin. Advanced Onion Skin allows you to select, 
on the fly, which drawings to include in your Onion Skin, even if those 
drawings are not consecutive drawings, as well as the opacity scales for 
the drawings before and after the current frame. 

The controls for selecting which drawings to display in the Onion Skin as 
well as their opacity sliders are only accessible when Advanced Onion 
Skin is enabled. Otherwise, when using regular Onion Skin, the opacity of 
drawings in the Onion Skin is determined by the Onion Skin settings in the 
Preferences dialog. The amount of drawings to include in the Onion Skin is 
set using the Onion Skin Add / Reduce One Previous Drawng and Onion 
Skin Add / Reduce One Next Drawing commands, available in the Camera 
and Drawing toolbars as well as in View > Onion Skin in the top menu. 

Onion skin 
opacity slider

Allows you to set the overall opacity of all the drawings in the Onion Skin. 

Include by 
frames or by 
drawings

Allows you to select whether the drawings to include in the Onion Skin 
are selected by frame or by drawing. 

 l By Frames: Selects the drawings to display in the Onion Skin by 
their frame number relative to the current frame. For example, if 
the Onion Skin is set to include 2 drawings before and after the 
current frame, it will include the drawings up to two frames before 
and up to two frames after the current frame, even if those 
drawings are the same as the one in the current frame. This is more 
useful for cut-out animation as it allows you to position a drawing 
relative to its position in adjacent frames.

NOTE 

This option only works in the Camera view. 

 l By Drawings: Selects the drawings to display in the Onion Skin by 
the amount of different drawings before and after the current 
frame. For example, if the Onion Skin is set to include 2 drawings 
before and after the current frame, this will display the nearest two 
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Interface

Section Description

different drawings before and after the drawing in the current 
frame in the Onion Skin, even if those drawings are further than 2 
frames away from the current frame. This is more useful for frame-
by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to 
adjust the extent of the Onion Skin in the Timeline view are 
not available. 

Next Drawings Settings

Next drawings 
visibility 
switches

Allows you to select which drawings after the current frame to include in 
the Onion Skin. A drawing that is toggled on will be visible in the Onion 
Skin, and a drawing that is toggled up will be excluded from it. You can 
select a range of drawings, or include and exclude specific drawings 
individually. 

TIP 

You can quickly select or deselect a range of drawings by clicking 
and holding on one drawing, then dragging the mouse cursor over 
the other drawings you want to toggle. 

Next drawings 
opacity sliders

Allows you to adjust the opacity scale of drawings after the current frame. 
Each slider represents the opacity of one drawing.

By default, moving one of these sliders will move the other sliders so that 
the opacity remain on a gradated scale. In this case, you can start by 
adjusting the opacity on one end, the opacity on another end and then, if 
you want, adjust one of the sliders in-between to make a segmented 
progression.
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User 
Interface

Section Description

You can disable this behaviour by unchecking the Link Sliders option in 
the  View Menu in the top-left corner of the Onion Skin view. This 
option is enabled by default. When disabled, you can adjust the opacity of 
each drawing independently. 

Next drawings 
colour

Allows you to select the colour in which to display the drawings after the 
current frame. 

Marked Drawings Settings

Show Key 
drawings in 
Onion Skin

Only displays drawings marked as key drawings in the Onion Skin.

Show 
Breakdown 
drawings in 
Onion Skin

Only displays drawings marked as breakdowns in the Onion Skin.

Show In-
between 
drawings in 
Onion Skin

Only displays drawings with no marker in the Onion Skin. Drawings with 
no marker are considered in-betweens.
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Show 
RetakeKey 
drawings in 
Onion Skin

Only displays drawings marked as retake key drawings in the Onion Skin.

Show RetakeBD 
drawings in 
Onion Skin

Only displays drawings marked as retake breakdowns in the Onion Skin.

Show RetakeIB 
drawings in 
Onion Skin

Only displays drawings marked as retake in-betweens in the Onion Skin.
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Perspective View
T-HFND-008-016

The Perspective view is used during scene setup. It allows you to see a multiplane scene’s orientation. The 
Perspective view is similar to a 3D display, as it lets you rotate the scene through all possible angles to 
understand the spacing between the elements. You can also position and rotate your layers and the camera 
inside the 3D display to achieve some 3D setup and camera moves.

How to access the Perspective view

Do one of the following:

 l From the top menu, select Windows > Perspective.

 l From any of the other views, click the Add View  button and select Perspective.

Icon Section Description

View Menu
The View menu contains all the tools and options that 
you can use to work in the Perspective view.
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Editing Stack

The Editing Stack menu displays the names of the 
symbols and their hierarchy when you are editing a 
symbol. You can click on the different names to go 
back up to the different parent symbols or the 
top/current project.

  X Control The red circle rotates the view on its X axis.

  Y Control The green circle rotates the view on its Y axis.

  Z Control The blue circle rotates the view on its Z axis.

  Grid This is a perspective (3D) grid reference.

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the Perspective view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

Reset Rotation Resets the rotation of the Perspective view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.
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  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of your 
animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.
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Python Script Console View

The Python Script Console View provides a Python representation of Harmony and its loaded project. This 
allows for custom tools and automation tasks both within Harmony's GUI and external to Harmony from a 
Python Interpreter.

How to access the Python Script Console view

Do one of the following:

 l From the top menu, select Windows > Python Script Console.

 l From any of the other views, click the Add View  button and select Python Script Console.

NOTE 

In order to use the Python Script Console, you will need to have Python 3.9.X installed. Please 
make sure it is installed and available on the system environment PATH.
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Script Editor View
The Scripting view allows you to edit scripts to run in Harmony directly from the application. It displays a list of 
available scripts, from which you can select an existing script, edit it, test it and save it. The Script Editor will 
highlight the syntax of your script for easy reading. 

How to access the Script Editor view

Do one of the following:

 l From the top menu, select Windows > Script Editor.

 l From any of the other views, click the Add View  button and select Script Editor.

Parameter Description

Script Editor 
menu

The menu for this view—see Script Editor View Menu on page 319. 

Script Editor 
toolbar

The toolbar for this view—see Script Editor Toolbar on page 652. 

Script list

The list of script files available as well as their location and their read and write permissions. 
Selecting a script in this list will open it in the editor.

NOTE 

The << Sandbox >> item at the top of the list does not correspond to an actual script file. It 
is a temporary container to type and test code, and its content cannot be saved.
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The file list has three columns: File, Location and Permissions.

 l The File column indicates the filename of each script.

NOTE 

The << Sandbox >> item at the top of the list does not correspond to an actual 
script file. It is a temporary container to type and test code, and its content cannot 
be saved.

 l The Location of the script can be one of the following:

 l Application Folder: Scripts that are packaged and installed with Harmony. By 
default, you cannot edit these scripts until you select them and click on Make 
Editable, at which point you are prompted to copy the script to a location from 
which you can edit them.

Scripts in the Application Resources folder are in the following location:

 l Windows: C:\Program Files (x86)\Toon Boom 
Animation\Toon Boom Harmony 24 
Advanced\resources\scripts

 l macOS: /Applications/Toon Boom Harmony 24 
Advanced/Harmony 
Advanced.app/Contents/tba/resources/scripts

 l GNU/Linux
:/usr/local/ToonBoomAnimation/harmonyAdvanced_
24/resources/scripts

 l User: Scripts that are saved in your user preferences. Those scripts can be 
edited and executed from any scene, provided that you are logged in as the 
same user. 

In Harmony Stand Alone, scripts in the User folder are in the following location:

 l Windows: C:\Users\[username]\AppData\Roaming\Toon Boom 
Animation\Toon Boom Harmony Advanced\2400-scripts

 l macOS: /Users/[username]/Library/Preferences/Toon Boom 
Animation/Toon Boom Harmony Advanced/2400-scripts

 l GNU/Linux:/home/[username]/Toon Boom Animation/Toon 
Boom Harmony Advanced/2400-scripts

In Harmony Server, scripts in the User folder are in the following location:

/USA_DB/users/[username]/HarmonyAdvanced/2400-scripts

 l Scene: Scripts in the scripts sub-folder of the currently open scene. These 
scripts can only be edited and executed when the current scene is open.

 l Job (Harmony Server only): When using Harmony Server, these are the scripts 
saved in the directory of the current scene's jon. These scripts can be edited and 
executed by any user when any scene that is part of this job is open.
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Scripts in the Job folder can be found in the following location:

/USA_DB/jobs/[job name]

 l Environment (Harmony Server only): When using Harmony Server, these are 
scripts saved in the directory of the current scene's environment. These scripts 
can be edited and executed by any user when any scene that is part of this 
environment is open.

Scripts in the Environment folder can be found in the following location:

/USA_DB/environments/[environment name]

 l Global (Harmony Server only): Scripts in the Harmony database's scripts 
directory. These scripts can be edited by any user when any scene in the 
database is open.

Scripts in the Global folder can be found in the following location:

/USA_DB/scripts

 l System Variable: Scripts inside the directory set in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable, if this variable is set. These scripts 
can be edited and executed by anyone on your workstation.

NOTE 

When two or more scripts with the same file name exist in different locations, 
Harmony will give priority to a single one of these scripts. The script given priority 
will be the one listed in the Script Editor and the one executed if it is associated to 
a toolbar button. 

Which script is prioritized is determined by the order of priority of script locations. 
From highest priority to lowest priority, the order goes as follows:

User > Scene > System Variable > Job > Environment > Global > 
Application Resources

An exception to this rule is if you have a script with the same name in both the 
scene folder and your user preferences. In this case, both versions of the script will 
be listed and you will be able to edit both.

 l The Permissions of the script can be one of the following:

 l Read Only: You cannot edit the script in the Script Editor and save your 
changes. 
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NOTES 
 l If the script's location is the Application Resources folder, it will 

always be Read Only to prevent you from making changes to scripts 
packaged with Harmony. However, you can click on the Make 
Editable button below the script editor to make a copy of the script in 
your user preferences folder, after which you can make changes to 
this copy.

 l If the script is in any other location and is Read Only, then it is likely 
that a network administrator made the script or the folder containing 
the script read-only to prevent other users from making unwanted 
changes to it. 

 l Read/Write: You can edit the script in the Script Editor and save your changes.

Editor

A text field in which you can edit the selected script. 

NOTE 

If the selected script is in the Application Resources folder, you will not be able to edit it 
until you click on the Make Editable button.

Search toolbar
Allows you to type in a keyword and search for this keyword within the script. You can use the 

 Next button to go to the next instance of the keyword and the  Previous button to go to 
the previous instance. 

Cancel
If you have made any changes to your script that you have not yet saved, this discards those 
changes and reloads the saved version.

Restore to 
Default

If the selected script is a script that was packaged with Harmony, and which you copied to your 
User folder, to the Scene folder or to the Job, Environment or Global folder to make changes to 
it, you can click on this button to delete this copy of this script and resume using the original 
version of the script that is packaged with Harmony instead. 

IMPORTANT 

This will permanently delete your version of the script and any changes you have made to 
it. 

Verify Verifies that the script has no syntax error. 

Make Editable
If the currently selected script is in the Application Resources folder, you cannot edit it. By 
clicking on this button, the script can be copied to a location where you can edit it. 
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When you click on this button, you are prompted to choose whether to copy in either of these 
locations:

 l User: Saves the script to a directory in your user preferences directory. You will be able 
to run and edit the script from any scene as long as you are logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the preferences 
for your account on your computer. if you are using Harmony Server, the script will 
be saved to the preferences for your Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the script to the 
Harmony database's global script directory. Anyone who is logged in to the database 
will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save the script to 
the current scene's environment. Anyone will be able to edit and run the script as long 
as they are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the current 
scene's job. Anyone will be able to edit and run the script as long as they are working 
on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able to edit 
and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_SCRIPT_
LOCATION environment variable. This option is only available if this environment 
variable is set.

NOTE 

This button will be greyed out if the script is in any location other than Application 
Resources and is read only. 

Save

Saves the modifications you made to the script.

This button replaces the Make Editable button after you have used the Make Editable button to 
copy the script to a location from which you can edit it. 
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Side View
T-HFND-008-015

The Side view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see 
a scene’s stage  from  the side. This lets the camera cone and spacing between the elements to be seen.

How to access the Side view

Do one of the following:

 l From the top menu, select Windows > Side.

 l From any of the other views, click the Add View  button and select Side.

Icon Section Description

View Menu
The View menu contains all the tools and options that 
you can use to work in the Side view.

  Thumbnails

A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can see 
a representation of the FB position of each layer in the 
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camera cone.

  Camera Cone
The camera cone represents the camera’s position and 
field-of-view (FOV). 

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.

  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of your 
animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.
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Timeline View
T-HFND-006-002

To set your animation timing, you will mostly work with the Timeline and Xsheet views. It's extremely useful 
to become familiar with the Timeline view, how it works, and its interface.

The Timeline view is the main view used when adjusting the timing of drawings, adding keyframes and 
ordering layers. The Timeline view displays layers, effects,  sounds, keyframe values, scene length, layer 
names, drawings, keyframes, timing, and frames.

The Timeline view allows you to read your timing from left to right. It represents the scene’s elements in their 
simplest form. You can also see the layers and their names, as well as the drawing’s exposure. The drawing 
name is displayed when you place your pointer over the drawing’s exposure.
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How to access the Timeline view

Do one of the following:

 l From the top menu, select Windows > Timeline.

 l From any of the other views, click the Add View  button and select Timeline.

Icon Section Description

View Menu
The View menu contains all the tools and options that you can use to 
manage models.

Enable/Disable Layer

The Enable/Disable All  button lets you enable or disable layers. Disabling 
a layer makes the scene behave as if it didn't exist, including when 
rendering the scene. For example:

 l A disabled drawing layer will be invisible.

 l A disabled sound layer will be mute.

 l A disabled peg layer will not affect the position of its child layers.

To disable a layer, click the layer's Enable/Disable  button or press D.

To enable a layer, click the layer's Enable/Disable  button or press A.

NOTE 

Next to sound layers, the Enable/Disable layer button will look like 

this: . 

TIP 

You can enable or disable all layers by clicking on the Enable or 
disable all layers  button in the top row.

Enable/Disable Solo 
Mode

Solo mode allows you to only view specific layers in the Camera view and 
hide all others. When solo mode is enabled on one layer, only this layer 
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will be visible. If solo mode is enabled on several layers, and only these 
layers will be visible. If solo mode is not enabled on any layer, all enabled 
layers will be visible.

You can also use solo mode on sound tracks. If solo mode is enabled on 
any sound tracks, only those sound tracks will play during playback.

TIP 

When some layers are in solo mode, you can disable or re-enable 
solo mode on all layers that have it enabled by clicking on the 
Toggle solo mode on or off  button in the top row. 

Add to/Remove from 
Onion Skin

For when the Onion Skin option is enabled, this allows you to enable or 
disable Onion Skin on specific layers.

TIP 

To activate the general Onion Skin preview, in the Tools toolbar, 
click the Onion Skin  button

Lock/Unlock Layer 

The Lock/Unlock Layer button lets you prevent the selection or editing of 
a layer in the Camera view. To select some of the layers without selecting 
others, in the Timeline view, lock the layers you do not want to select. 
When a layer is locked, its name is displayed in red.
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In the top menu, there is a series of locking options. Select Animation > 
Lock > select one of the following:

 l Lock: Locks the currently selected element.

 l Unlock: Unlocks the currently selected element.

 l Lock All: Locks all the elements in the Camera view. 

 l Unlock All: Unlocks all the elements in the Camera view.

 l Lock All Others: Locks all the elements in the Camera view 
except the currently selected one.

Toggle Outline Mode / 
Change Track Colour 

Each drawing layer has a little colour swatch that has two functionalities:

 l Single-clicking a layer's colour swatch toggles Outline mode on 
or off. Outline mode makes the layer display as nothing but the 
outlines of its vector shapes in the Camera view, allowing you to 
see the drawing's shape without it blocking the view of layers 
behind it. 

 l Double-clicking the layer's colour swatch opens a colour picker 
dialog that allows you to change the layer's track colour. The track 
colour displays in the layer's track in the Timeline view, allowing 
you to give special visibility to specific layers. It also determines 
the colour of the layer's outlines if it's in outline mode. 

Show/Hide 
Thumbnails

Expands the layer to display a thumbnail of the drawing in the current 
frame, as well as for each drawing in the timeline. 
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NOTE 

By default, the timeline's zoom level does not allow enough 
horizontal space to fully display the thumbnails of drawings 
exposed for one or two frames only. To see the thumbnails for 
drawings with short exposure, you must increase the timeline's 
zoom level—see Timeline Zoom on page 730.

When a drawing layer is in Show Thumbnails mode:

 l An exposure indicator appears at the right of each exposed 
drawing in the timeline, indicating the amount of frames the 
drawing spans over.

 l An Opacity parameter appears to the left of the layer, allowing 
you to set the layer's opacity level.

TIP 

You can show or hide thumbnails for all drawing layers by clicking 

on the Show/Hide All Thumbnails  button in the top row.

  Opacity

Allows you to set the opacity level of the layer. Click and drag the value 
left or right to decrease or increase the layer's opacity.

NOTE 

This parameter only displays for drawing layers that are in Show 
Thumbnails mode.

Active Drawing Layer 
Indicator

This icon appears next to the active drawing layer, which is the layer you 
draw on when using drawing tools. 

725

Harmony 24 Advanced Reference Guide                          



Chapter 6: Views

NOTE 

The active drawing layer is not always the selected layer. For 
example, if you select a drawing layer, then a peg layer, the peg 
layer will be the selected layer, but the active drawing layer will 
remain the last drawing layer you selected, until you select another 
drawing layer.

Add Layer
The Add Layers  button lets you add new layers to the Timeline view. 
When you click the Add Layers button, a menu appears displaying the 
available layer types.

Delete 
The Delete Layers  button lets you delete the currently selected layers in 
the Timeline view.

Add Drawing Layer
The Add Drawing Layer  button lets you automatically add a new drawing 
layer to the Timeline view. By default, the layer is named Drawing.

Add Peg 

The Add Peg  button lets you add a peg layer to the timeline. If several 
layers are selected, a peg is added and parented to each layer.

 Expand/Collapse

The Expand/Collapse  button is used to display the children layers of a 
parent layer. Once a layer is parented to another layer, it is indented to 
the right and the Collapse/Expand Children button appears on the parent 
layer allowing you to show or hide the child layer.

 Show/Hide Functions

The Show/Hide Functions  button lets you display the functions 
embedded in each layer. The functions are the different coordinates and 
values used to record a layer’s parameters at each frame. This information 
is stored on the function curves using keyframes.

If the layer can be connected to another layer, for example to use a 
drawing layer as a matte, expanding a layer's functions will also list its 
possible connections. You can connect layers by dragging and dropping a 
layer onto another layer's connection. 
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Add/Remove 
Keyframe

Adds a keyframe at the current frame of the selected function or removes 
the keyframe at the current frame of the selected function, if there is one 
already.

NOTE 

This button only displays for function layers.

Previous Keyframe

Moves the timeline cursor to the previous keyframe on the selected 
function.

NOTE 

This button only displays for function layers.

Next Keyframe

Moves the timeline cursor to the next keyframe on the selected function.

NOTE 

This button only displays for function layers.

Function Menu

Displays the Function menu, which allows you to create a new function 
for the function layer, or to link it to an existing shared function.

NOTE 

This button only displays for functions layers, in the Parameters 
column—see Show/Hide Parameters on page 729.

Function Keyframe 

A frame where the value for one or more of the layer's functions is preset. 
The position of each layers in key poses for digital animation is recorded 
in function keyframes. You can grab and move function keyframes as well 
as copy, cut, paste and delete them.

727

Harmony 24 Advanced Reference Guide                          



Chapter 6: Views

TIP 

If you have a keyframe and a drawing selected simultaneously, and 
you wish to delete the keyframe without deleting the drawing's 
exposure by doing one of the following:                         

 l In the Timeline toolbar, click on the Delete Keyframe  
button.

 l Press F7.

 l From the top menu, select Animation > Delete Keyframe 

NOTE 

If a collapsed layer has children that have function keyframes, you 

will see a white square  instead.

Split 

The Split  button lets you split the Timeline view in two sections, allowing 
you to see two different portions of the Timeline view. This can be useful 
if you need to often switch between two specific points of a lengthy 
scene.

Drawing Exposure

In the Timeline view, when a drawing is exposed, it is represented by a 
grey block that extends from the first frame it is exposed to the last frame 
it is exposed. 

View Modes

Lets you choose between different view modes allowing you to decide 
which layers are listed in the Timeline view. This can be useful if you're 
working on a scene with a lot of layers, and you only want layers you will 
be working on to appear in the Timeline view so as to declutter it. The 
following view modes are available:

 l Normal View Mode  will show all the layers in your scene.

 l Selection Only Mode  will hide all the layers that are not 
currently selected, leaving only the currently selected layers in the 
Timeline view. 
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 l View Tagged Layers  will only show layers which you have 
tagged. 

TIP 

You can tag a layer by doing one of the following: 

 l Right click on the layer and select Tag > Timeline Tag.

 l Open the Timeline view menu  and select Edit > Tag > 
Timeline Tag.

Show/Hide 
Parameters

Shows or hides the Parameters column, right of the Layers column. The 
Parameters column displays information on the layer at the current frame, 
depending on the type of layer it is:

 l If the layer is a drawing, it displays the name of the drawing at the 
current frame. 

 l If the layer is a function, it displays the value of the function at the 
current frame. 

 l If the layer is a sound track, it displays the sound track's volume. 

Using the mouse, you can drag the parameter left and right to change its 
value. This is especially useful for quickly changing a drawing's exposure 
at the current frame. 

Show/Hide Additional 
Links

Shows or hides the Additional Links column. The Additional Links column 
displays layers that are connected under the layer, but for other purposes 
than being the parent of those layers. For example, if a layer is used as 
the matte of an effect, the effect will be displayed in that layer's 
Additional Links. 
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If more than one layers are in a layer's Additional Links, only the first of 
these layers will be displayed, followed by the amount of extra linked 
layers there are. 

By clicking on the Additional Links, you can open a menu listing the linked 
layers, and click on one of these layers to navigate to it. 

In the following example, the BOOM_Animation layer is used as the 
matte of Cutter_1 and Cutter_2:

Timeline Zoom

Reduces or increases the width of frames in the Timeline view. Move the 
slider right to increase the width or left to reduce it. You can also press 2 
to zoom in and 1 to zoom out when the Timeline view is focused on.

If you want to reset the Timeline view's zoom, click on the Timeline Zoon 
 icon left of the slider.
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Tool Properties View
T-HFND-004-002

The Tool Properties view contains the most common options and operations related to the currently selected 
tool. When you select a tool from the Tools toolbar, the Tool Properties view updates.

For example, if you choose the Select  tool, the Tool Properties view will display the options and operations 
related to it, such as Snap to Contour, Apply to All Drawings, Flip Horizontal, and Flatten.

NOTE 

To learn more about the options appearing in the Tool Properties view, see Tools Properties on 
page 416.

How to access the Tool Properties view

Do one of the following:

 l From the top menu, select Windows > Tool Properties.

 l From any of the other views, click the Add View  button and select Tool Properties.
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Top View
T-HFND-008-014

The Top view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see 
the scene’s stage  from above. This lets the camera cone and the spacing between the elements be seen.

How to access the Top view

Do one of the following:

 l From the top menu, select Windows > Top.

 l From any of the other views, click the Add View  button and select Top.

Icon Section Description

View Menu
The View menu contains all the tools and options that 
you can use to work in the Side view.

  Thumbnails

A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can see 
a representation of the FB position of each layer in the 
camera cone.
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  Camera Cone
The camera cone represents the camera’s position and 
field-of-view (FOV). 

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.

  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of your 
animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.
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Xsheet View
T-HFND-006-003

The Xsheet view lets you read the timing vertically by displaying it in a grid, with each drawing layer 
represented by a column, each frame of your scene represented by a row, and each exposed drawing 
displayed by its name in the cells. It is meant to work like a traditional animation exposure sheet. 

Using the functions panel, you can also view the functions and keyframes of the motion paths for the selected 
column, with the value of those functions for each frame listed in the cells. 

Contrary to the Timeline view, the Xsheet view does not display pegs, effects or layer hierarchy. Hence, it is 
optimized for traditional and paperless animation, whereas the Timeline view is optimized for digital or cut-out 
animation.

How to access the Xsheet view

Do one of the following:

 l From the top menu, select Windows > Xsheet.

 l From any of the other views, click the Add View  button and select Xsheet.
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Icon Section Description

View Menu
The View menu contains all the tools and options that 
you can use to manage columns and timing.

  View Toolbar
The view toolbar contains all the tools and options 
you can use in the Xsheet view to manage columns 
and timing.

  Xsheet Main Section

The Xsheet view has three sections. By default, only 
the main section is visible. It displays the drawing 
layers, also known as drawing columns.

When using advanced compositing and animation 
techniques, unconnected functions (motion paths) 
also appear in the main section. Unconnected 
functions mean that some motion paths are not 
attached to any particular layer.

When you reconnect functions to a layer, they are still 
visible in the main section.
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  Functions Section

The Functions section is used for more advanced 
techniques. This section displays the functions (paths) 
related to the selected layer in the Timeline view. By 
default, the Functions section is hidden.

In the Xsheet view, click the Expand button located on 
the right side of the main section. Click on the same 
button to collapse it. You can also use the Show 
Column List  button in the Xsheet View toolbar. If you 
select a drawing column in the main section of the 
Xsheet view, the function columns will not be 
displayed. You must select the layer from the Timeline 
view.

  Column List Section

The Column List section allows you to show and hide 
columns in the Xsheet view. When you hide a layer in 
the Xsheet view, it is also disabled in the Timeline 
view.
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You can use the Column List to hide individual 
columns or hide an entire column type (drawing or 
function) from the Xsheet view. By default, the 
Functions section is hidden.

In the Xsheet view, click the Expand button on the 
right side of the main section to show the Functions 
section. Click on the same button to collapse it. You 
can also use the Show Column List  button in the 
Xsheet toolbar.

Go to the Xsheet view menu and select View > Show 
Column List. Click the Expand button on the right side 
of the Functions section to display the Column List 
section.

  Column Header

Each column available in the Xsheet view has a 
header displaying the column’s name. The column’s 
name is the same as the corresponding timeline layer. 
If you rename one or the other, they will both be 
renamed.

A quick access menu is available when you right-click. 
This menu contains the command affecting an entire 
column such as renaming, changing the default 
colour, or deleting a column.

The tooltip that appears when you hover at the top of 
each Xsheet column shows the folder path to the 
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source drawings for that column.

In Harmony, the column header shows the layer’s 
name and the name of the drawing folder to which it 
is linked. If the name of the layer is the same as the 
drawing folder, the drawing folder’s name will not be 
displayed.  To modify the name of the element folder 
independently from the column and layer name, you 
must select the Advanced Element Mode option 
preference in the Advanced tab of the Preferences 
dialog box.

  Current Drawing

A drawing selected in dark red indicates that the 
drawing is currently displayed in the Drawing and 
Camera views. The current drawing selection is not 
linked to the drawing displayed in the Camera view 
since drawings from each visible layer are displayed 
at once.

  Current Frame

The darker frame appearing in the Xsheet view 
represents the current frame.

  Drawing Exposure

In the drawing columns, you can see the drawing 
names and their exposure. You can use any 
alphanumeric symbol to name your drawing. When a 
drawing is exposed over more than one cell, a vertical 
black line is displayed to indicate the continuity of the 
exposure. When there is no drawing in a cell, the cell 
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will be blank.

  Frame Numbers

On the left side of the Xsheet view, the frame 
numbers are shown indicating where you are. These 
read vertically instead of being displayed horizontally 
as they are in the Timeline view.

 l To go to a particular frame, click the frame 
number.

 l To select an entire range of frames, click and 
drag a selection downwards.

  Current Frame Display

At the bottom-right of the Xsheet view, you can see 
the current frame number, as well as the column 
containing the drawing currently displayed in the 
Drawing view.

  Functions Column
The functions columns are displayed in the Functions 
section of the Xsheet view. They represent the motion 
and rotation you applied to a drawing layer. 
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A function column can also be related to an effect. 
Selecting the effect layer shows you the 
corresponding function column in the Xsheet view.

The function columns display the position value or 
effect value on each cell. If there is a keyframe on a 
cell, a black square is displayed. Holding the same 
value for several frames displays a vertical black line.

 
Increase/Decrease 
Exposure

You can quickly increase or decrease the exposure of 
the selected cell by clicking on the up and down 
arrows in the Increase/Decrease Exposure field.

  Overwrite/Insert Modes
The Overwrite/Insert button allows you to decide the 
way the values are inserted into the Xsheet.
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